
"Psychosis, although at times subtle, was pervasive across psychological 
tests and testing situations. When stressors are minimal this patient may 
withdraw into his dream world putting his resentments aside and attempting to 
convey an air of well-being. If these efforts give way under the slightest 
pressure, regulating his angry dismay, stirring up his dejection and his 
feelings of being misunderstood and mistreated, leading him to act out 
momentarily and then to retreat again into fantasy or despondency. Data are 
significant for recurrent periods of more psychotic functioning.” 

- Jane DeSmith PhD, Rochester Regional Forensic Unit -
As quoted on page 17 of the report of Igor Kashtan MD dated 2003-09-11.

Fancy, that! “Got bugs?” †

- AnneRose Blayk f/k/a “Kevin Eric Saunders a/k/a bonze blayk” - COMETMONGER

† - “DEAR SIR OR MADAM… THAT IS NOT A BUG: IT IS A CREATURE FEATURE!”

Here follow the “Release Notes” of a complex delusional system elaborated by one “bonze blayk” in 
the form of a ‘computer program’ as part of his, her, or its dream world; note the extraordinary 
circumstantiality therein and fixation on minor issues, which he, she, or it has previously expressed 
in the statement “God is in the details,” and bizarre obsession with “Bug fixes,” indicating a need for 
treatment oriented towards addressing formication induced by unremitting abuse of Substance-D. - 
The Penultimate Psychiatrist
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            About dataComet

________________________________________________________________

   The dataComet-Secure application, resources, and on-line documentation are 
Copyright 2001-2006 databeast, Inc., All Rights Reserved.  Reverse 
compilation or disassembly of dataComet-Secure is expressly forbidden.  
Unlicensed redistribution or export of this encryption software is also 
forbidden.

   dataComet-Secure will function as a demo for 30 days.

       <USER_REGISTRATION_DATA>

   See <http://www.databeast.com/order.html> for information on purchasing 
dataComet-Secure.

       ______________________________________________________

   dataComet-Secure is an AppleScriptable Macintosh OS X Telnet/SSH SOCKS 
application featuring PC-ANSI, VT220, & TN3270 terminal emulation, SCP, 
ZMODEM, and IND$FILE file transfer, multiple sessions, flexible and easy-to-
use key remapping, edit windows, macro recording, and web browser support. 

   Emulations supported include:

      * 16-color PC-ANSI and SCO-ANSI;
      * DEC VT52 (Heath-19), VT100, VT102, and VT220;
      * IBM Models 3278 and 3279 Color with extended attributes.

   Documentation on dataComet is available on-line in the "Help" menu.  
dataComet's on-line documentation makes detailed help available 
instantaneously:  

   "Control-Click" on a menu, dialog item, or control to bring 
      up the dataComet documentation describing the item;

   "Control-Command-Key" brings up the documentation for 
      the menu command which the key triggers!

   Users can download a demo copy of dataComet-Secure from <http://
www.databeast.com/download.html>.  dataComet-Secure incorporates strong 
encryption algorithms, and it may not be redistributed without a license.  
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Please note that all use of dataComet-Secure requires that you accept the 
following license provisions:

      ___________________________________________________

   dataComet-Secure License Provisions for Export Control:

Beta versions of dataComet-Secure may not be exported from the United States.

I understand that dataComet-Secure is subject to U.S. export controls on 
products incorporating strong encryption, and that I am not allowed to 
redistribute dataComet-Secure without a license.  Redistribution of this 
software to unlicensed parties is forbidden, and may constitute a Federal 
felony.

I understand that the requested software, dataComet-Secure, is subject to 
export controls under the Export Administration  Act and that this software 
may only be transmitted, exported,  or re-exported  under the laws, 
restrictions and regulations of the U.S. Bureau of Industry and Security 
(BIS) or foreign agencies or authorities.

I affirm that I will comply with the restrictions above, and further affirm 
that I am not an agent for any entity subject to any legal restrictions on 
the export or use of encryption items from the U.S.  In particular, I am not 
a national of Cuba, Iran, North Korea, Sudan, or Syria, nor am I listed by 
the BIS as a specially designated national or denied person.

       ___________________________________________________

          Contacting databeast, Inc.
       ___________________________________________________

         databeast, Inc.
         1668 Trumansburg Rd.
         Ithaca, NY  14850-9213

       ___________________________________________________

           Reporting bugs
       ___________________________________________________

      Please use the Bug Report form below to send your bug reports to:
         <mailto:datacomet.support@databeast.com>
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                 dataComet-Secure Bug Report:

      Mac model:
 System Version: 
  Connection(s): (Telnet, SSL Telnet, SSH1/2, Shell, Serial)
Bug description: Using dataComet-Secure 10.2.1r2 we observed...

(If possible, please provide enough detail to reproduce the bug, and include 
any dataComet crash log(s) found using the "Console" application.  This 
application is usually located in the "/Applications/Utilities/" folder, and 
should launch if you Command-Click this URL:  <file:///Applications/
Utilities/Console.app>.  The crash log is found under this Console "File" 
menu path:  "Open Quickly" -> "Files" -> "~/Library/Logs" -> "CrashReporter" 
-> "dataComet-Secure.crash.log".)

       ___________________________________________________

           Credits
       ___________________________________________________

   dataComet is derived from Comet, "The Cornell Macintosh Terminal 
Emulator," which was originally developed by Kevin Eric Saunders (a/k/a bonze 
blayk!), with contributions by John Lynn and Peter Hoyt, for Cornell 
Information Technologies under the general direction of Dick Cogger, Mark 
Oros, and Karen Fromkes (successively).

   Thanks are due to Simon Tatham for the PuTTY SSH source code and Tatu 
Ylonen for inventing and sharing the original implementation of SSH; to Doug 
Hornig for the basic TextEdit code; to Per Lindbergh for vttest; and to Erny 
Tontlinger for the excellent Terminal 2.2 code.  My thanks go out likewise to 
MIT, Cornell, Brown, the University of Texas at Austin, NCSA, the National 
Science Foundation, and the American taxpayer for Kerberos and DES.  

   My sincerest thanks also to the loyal Comet beta testers at Cornell; there 
are too many to list, but special thanks are due to Steve Worona, Bill 
Garrison, Karen Fromkes, Sanjay Hiranandani, Gail Honness, and Larry Chace 
("May the sPam be with you!").

       Happy Comet Trails!  

         bonze Anne Rose Blayk, President   
               (F/K/A "Kevin Eric Saunders a/k/a bonze blayk")
         <mailto:bonze@databeast.com>
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           "Felicity is everywhere... 
                     yet she's not a thing to be lightly grasped;
             For here you'd hold, not the name of a rose, 
                         but a fragile-thorny flower-asp..." 

                                      ——  bonze blayk

       ___________________________________________________

   dataComet Copyright Notices:

   DATABEAST, INC. MAKES NO REPRESENTATIONS OR WARRANTEES, EXPRESS OR 
IMPLIED.  By way of example, but not limitation, DATABEAST, INC. MAKES NO 
REPRESENTATIONS OR WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY 
PARTICULAR PURPOSE OR THAT THE USE OF THIS SOFTWARE OR DOCUMENTATION WILL NOT 
INFRINGE ANY PATENTS, COPYRIGHTS, TRADEMARKS, OR OTHER RIGHTS.  Databeast, 
Inc. shall not be held liable for any liability with respect to any claim by 
the user or any other party arising from use of the program.

       ___________________________________________________
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            0. Overview of dataComet and dataComet-Secure

________________________________________________________________

   dataComet, "The Telnet Client Productivity Tool"

dataComet/dataComet-Secure documentation.  (Rev. 9/16/09) 
Copyright 1996,2001,2002 databeast, Inc. All Rights Reserved.
Portions Copyright 1986,1993 Cornell University;
Portions Copyright 1984 Massachusetts Institute of Technology.

PLEASE NOTE THIS DISCLAIMER:  NO WARRANTEES, express or implied, are made 
regarding the fitness of this software for use in any application whatsoever.  
THE USER assumes all liability for damage to hardware, software, or data 
which may result from its use.

       _____________________________________________________________

   This document has information on (select and use "Find..." to go to the 
section):

   Using dataComet and dataComet-Secure
         FAQ and Problem Solving
         Shortcuts
         dataComet Feature Summary
         dataComet-Secure Feature Summary
         dataComet System requirements
         dataComet session documents
         Editing text documents
         dataComet Help
         The Documents folder
         The Sessions folder
         dataComet emulators
         "Foreign" character translation and font support
         Macros (command scripts)
         AppleScript and dataComet
         Scrollback buffering
         File Transfer (SCP, ZMODEM, IND$FILE)
         Launching sessions using Internet Config
         Performance notes

   Installing dataComet
         The Fonts folder and font resources
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         The "dataComet keyboard" resource
         dataComet-Secure "Security" folder
         Installing Kerberos Support
 

___________________________________________________

   Using dataComet and dataComet-Secure
___________________________________________________

       ___________________________________________________

         FAQ and Problem Solving
       ___________________________________________________

   For help with Frequently Asked Questions and problem solving, see the Help 
document "A0. Problem Solving".

       ___________________________________________________

         Shortcuts
       ___________________________________________________

   See the Help document "0.1. Shortcuts" for information on basic keymapping 
and the numerous mouse click and command key shortcuts available in dataComet 
and tips for using them.  Also listed are a number of menu command variations 
available when holding down the Shift- and/or Option- keys when the command 
is selected.  You may want to print out "0.1. Shortcuts" to use as a 
reference; if you want to know what function a key command will perform, you 
can use "Control-Command-Key" to automatically find any documentation on the 
Command-key combination.

       ___________________________________________________

         dataComet Feature Summary
       ___________________________________________________

   dataComet emulator window configurations and text window contents are 
saved as individual documents which can be launched directly from the Finder.  
Modeless dialogs make it easy to tailor session configurations for different 
hosts.  dataComet supports AppleEvents.  Command-clicking URLs in dataComet 
windows launches helpers to open files and web pages.  

   Emulators:  dataComet offers multiple VT220, PC-ANSI, and IBM 3279 color 
terminal emulator windows with searchable scrollback buffers.  dataComet 
automatically draws variable-width fonts as mono-spaced fonts; users can set 
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the character height and width of all fonts for maximum legibility.  Sessions 
can be configured so they are automatically logged to a file.

   Text Editing:  dataComet also offers text editing windows whose contents 
can be sent to a host by making a selection and pressing the Enter key (or 
Command-Return to break a line and send it to a host, easing use of host-
based Chat programs).  Users can use keyed commands to search, move the 
cursor by characters, words, or lines, and reformat text by adding or 
removing line breaks.

   Macros:  dataComet includes powerful macro commands which can be invoked 
through keystrokes, mouse clicks, configurable on-screen buttons, and menu 
items.  Macros can also be set to execute on host session open and close.  
Macros can be recorded automatically as the user interacts with the host to 
ease macro creation.  An AppleScript interface allows other applications to 
open dataComet documents, execute dataComet macros, and monitor session 
status.

   Interfaces:  dataComet supports VT220, PC-ANSI, SCO-ANSI, and IBM 3279 
TN3270 terminal emulations.  dataComet offers connections through Telnet, 
Shell sessions, and serial ports or modem devices.  Network firewalls can be 
traversed using a SOCKS V4 proxy.  (Note that serial access is supported only 
for the ASCII emulators--serial dialup access to IBM mainframe hosts requires 
the use of an IBM 7171 or similar VT100 <-> 3279 channel translator at the 
host end.)

   File Transfer:  dataComet offers SCP file transfers over Telnet 
connections, and ZMODEM transfers over both serial and Telnet connections.  
The standard IND$FILE file transfer protocol is supported for TN3270 
connections to IBM mainframes.  Downloads using these protocols can all 
perform automatic file opening using Internet Config File Mappings.  

   Public Access Terminals:  dataComet also supports special configurations 
for computers intended to be used as public-access terminals, which require 
enhanced security; a launch macro can be configured to disable commands which 
are inappropriate for your application.

   dataComet supports user-configurable international character translation 
for the Macintosh character set, with character translation tables provided 
for ISO-Latin-1, DEC Multinational, PC-ANSI, IBM ALA, and IBM 3270. 

   dataComet is fully internationalizable through customization of the on-
line documentation and the 'MENU' and 'STR#' resources incorporated in the 
program.  
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       ___________________________________________________

         dataComet-Secure Feature Summary
       ___________________________________________________

   dataComet-Secure adds support for SSL/TLS Telnet, Kerberos 5 Telnet, the 
SSH1 and SSH2 Secure Shell terminal protocols, and the SCP "Secure Copy" file 
transfer protocol to standard dataComet for secure access to ASCII hosts.  
(TCP and X-Window tunnelling are NOT supported.)  All features of dataComet, 
including ZModem file transfers, work with SSH and SSL/TLS connections.  SSH 
features currently supported include automatic SSH protocol selection, client 
authentication using user passwords (and under SSH1, using RSA public keys), 
encryption using Triple-DES or Blowfish, and data compression using zlib.  
Host public keys are maintained in files using the standard "known hosts" 
format (e.g., a "NiftyTelnet SSH Known Hosts" document can be copied directly 
to dataComet's "Security" folder and used as-is).  More information on SSH 
configuration is available in the Help document "3. Dialogs".

   Passwords can be stored in session documents in encrypted form to speed 
logins while maintaining security.  You can use one secret Master Passphrase 
to unlock all your session passwords.  In addition, you can use the "Lock" 
command to prevent use of dataComet until a master passphrase is entered, so 
that you can leave sessions open on your unattended computer without 
seriously compromising security.  The password encryption is performed using 
strong encryption (Triple-DES, 168 bits).

       ___________________________________________________

         dataComet System requirements
       ___________________________________________________

   MacOS 10.3.9 or later is required; dataComet and dataComet-Secure are 
Universal Binaries compatible with both PowerPC and Intel-based Macintoshes 
and releases of MacOS up to 10.6 (Snow Leopard).

       ___________________________________________________

         dataComet session documents
       ___________________________________________________

   dataComet uses dataComet documents to retain session configuration 
information between launches.  If you create macros after launching from a 
document or saving a configuration, they are automatically saved in the 
document.  The "Comet Default" document is a special document which is 
automatically created in the "{User}/Library/Preferences/dataComet 
Preferences/" directory under your username "{User}".  This document contains 
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session configuration data which is used as a default when you use the File 
menu "New..." command to make a new document, and  also contains global 
configuration data which applies to all sessions.  To make it easy to access, 
the "Comet Default" document appears first in the list of documents in the 
"File" menu "Sessions" submenu.

   If you create a new document by choosing "Reconfigure Session" and 
changing the name, the new document will have the same settings, macros, and 
other attributes as the source document.  

   Note that some of the more exotic configuration options in dataComet are 
available only as macro commands, e.g., disabling mouse-click cursor 
positioning on a per-session basis.  Including these macro commands in a 
Connection macro will allow you to configure a session so it executes them 
automatically when the session is opened.

       ___________________________________________________

         Editing text documents
       ___________________________________________________

   You can open text windows with no associated session by holding down the 
Shift key when using the File menu "New..." or "Open..." commands or by 
dropping the documents onto the dataComet application.  Edit windows are 
TextEdit windows, and can hold up to 32K of text.

   Each host session has a ".edit" window in addition to the window 
containing the emulator screen.  The session name is used as the first part 
of the window name, with ".edit" added as a suffix.  This window is provided 
for use as a handy text scratchpad to save text and commands used with a 
connection; the ".edit" window's contents are loaded automatically when the 
session document is opened.

   You can send a text selection or the current line to the next frontmost 
emulator session by pressing Enter or Command-Return.  You can execute macros 
in edit windows by pressing Shift-Enter or Shift-Command-Return, which causes 
either the selection or the current line (if no selection has been made) to 
be executed.  See "2. Menus" ("Using the Edit menu") for more information on 
the .edit window.

   When documents are saved, the document's creator ID is changed to 
dataComet's ID only if the Option key is held down; otherwise the document's 
default type and application will be left unchanged.  
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       ___________________________________________________

         dataComet Help
       ___________________________________________________

   The Apple Help menu allows you to open dataComet documentation.  Documents 
placed in the Help folder contained in the dataComet application bundle will 
be included in the list, so you can place your own text documents in the 
folder for convenient access.  

   HELP!  When the documentation is left in the folder as distributed, you 
can use a shortcut to quickly get help on command keys and menu and dialog 
items:

      Control-"Click" on a menu, dialog item, or control brings up  
          the dataComet documentation describing the item.

      Control-Command-"Key" also brings up the documentation for 
          the menu command which the key triggers.

       ___________________________________________________

         The Documents folder
       ___________________________________________________

   The "Documents" submenu in the File Menu allows you to open documents 
placed in the "Documents" folder (located in your "Documents" folder in the 
folder "dataComet/Documents").  Documents placed in the Documents folder will 
be included in the list, so you can place frequently-used text documents in 
the folder for convenient access.

       ___________________________________________________

         The Sessions folder
       ___________________________________________________

   The "Sessions" submenu in the File Menu allows you to open dataComet 
session documents placed in the "Sessions" folder (located in your 
"Documents" folder in the folder "dataComet/Sessions"; session documents can 
also be placed in the dataComet application bundle "Contents/Resources/
Sessions" folder).  By default, new session documents are saved in the 
Sessions folder.  Documents placed in the Sessions folder will be included in 
the list, so you can place frequently-used session documents in the folder 
for convenient access.
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       ___________________________________________________

         dataComet emulators
       ___________________________________________________

   dataComet allows you to connect to the two major types of host computer 
using either a TCP/IP network or serial/modem lines to make the physical 
connection; dataComet requires Apple's MacTCP TCP/IP driver to make Telnet 
TCP/IP connections.  Using dataComet, you can connect to either an IBM 
mainframe running an operating system such as VM/CMS or MVS, which uses the 
EBCDIC character set, or other hosts such as those running an operating 
system such as UNIX or VMS, which use the ASCII character set.  

   See the Document "1. Emulators" for more information on the emulators 
included in dataComet.

       ___________________________________________________

         "Foreign" character translation and font support
       ___________________________________________________

   dataComet supports character translation tables; see "Translation" in "2. 
Menus and dialogs".  These translation tables use the same format as NCSA 
Telnet's translation tables.  To add different tables to dataComet you can 
place the document containing the 'taBL' resources in the dataComet 
application bundle "Contents/Resources/User" Folder before launching 
dataComet; the new translation tables will be added to those in the 
Translation menu list.  Translation tables are automatically selected when 
you select a Comet-Font; for other fonts the default character translation is 
Macintosh <-> ISO-Latin-1 for emulator windows.

   You can use "Shift-Paste" to translate from a Macintosh font to the target 
window's font when Pasting.  Other translation features include using the 
"Translation" command to translate edit window text from the Macintosh 
character set and back...  see "0.1 Shortcuts" and "2. Menus" for more 
details.

   dataComet sessions can use fonts other than the default font (which is 
Comet Mona, a Macintosh font, for both ASCII and 3270 connections).  
Proportional fonts are drawn as if they were fixed width fonts so that any 
font can be used with the emulators.  If characters in alternate fonts do not 
appear as they should in ASCII sessions, check to make sure that 8-bit 
characters are enabled in your session (for example, PINE must be configured 
to use ISO-8859-1 as its character set in order to use extended character 
sets).
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       ___________________________________________________

         Macros (command scripts)
       ___________________________________________________

   dataComet offers macros which allow the user to create scripts to execute 
routine operations automatically.  These can be stored as text in an edit 
window, or associated with a keystroke or other program states... see the 
document "4. Macros" for more information.

       ___________________________________________________

         AppleScript and dataComet
       ___________________________________________________

   dataComet offers an AppleScript interface which allows the user to control 
dataComet by sending plain text, executing macros, testing connection status, 
and performing Copy and Paste operations.  See the document "5. AppleScript" 
for more information.

       ___________________________________________________

         Scrollback buffering
       ___________________________________________________

   dataComet supports scrollback buffers for both 3270 and ASCII emulations 
which preserve screen character attributes (e.g., inverted or boldface text).  
The Edit menu "Clear buffer" command clears the text from the buffer.  The 
Edit menu "Find" and "Find again" commands allow you to search the buffer, 
and the File menu "Print" command prints either the selection range or the 
current screen (if no selection has been made).  

   By default dataComet scrollback records an unlimited amount of text; you 
may want to set the scrollback buffer size in the dataComet Preferences 
"Session" dialog.  Each line scrolled takes three times as much space to 
store as the length of the line, so 100 lines of an 80-column session takes 
24K of memory.  

       ___________________________________________________

         File Transfer (SCP, ZMODEM, IND$FILE, TFTP)
       ___________________________________________________

   dataComet supports different techniques for transferring files:  SCP, 
ZMODEM, IND$FILE, and session logging.  
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   SCP (Secure CoPy) is a file transfer method used for transferring files on 
SSH connections; dataComet's SCP also allows you to use SCP on Telnet 
connections.

   ZMODEM is the standard method for tranferring files over serial 
connections to a host, and also works well for performing file transfers over 
Telnet connections.  It offers superior reliability over FTP or TFTP 
tranfers, since it uses an additional CRC checksum to help guarantee that 
data has not been corrupted during the transfer.  

   IND$FILE is the standard file transfer protocol for use with TN3270 
connections to IBM mainframes.  

   Session logging, which you enable in the File menu, allows you to save 
lines from your session in a file as they are cleared or scroll off the top.

   For more information, see the document "6. File Transfer".
          
       ___________________________________________________

         Launching sessions using Internet Config
       ___________________________________________________

   Under OS X, you must use Microsoft Internet Explorer to configure Internet 
Config, since the "System Preferences" dialogs do not allow user control of 
Internet Config to select your preferred Telnet/TN3270 application or file 
mappings for file transfers.  Internet Explorer's "Preferences..." "Protocol 
Helpers" and "File Helpers" dialogs allows you to control these mappings.  
Internet Explorer is no longer supported by MicroSoft, but you can download 
the last released version of IE from <http://www.pure-mac.com/downloads/
internetexplorerdl.html>.

   How Internet Config launches work:  dataComet supports 'GURL' AppleEvents, 
which allow other applications to notify dataComet that a Telnet session 
should be opened.  When dataComet receives a 'GURL' AppleEvent, it opens a 
session to the host and places the URL specification in the session's .edit 
window.  If the session name matches the name of a document that has been 
saved in the "Sessions" folder, the session document will be opened, so that 
configuration changes will be retained between sessions (along with notes 
made for use with the connection in the session's .edit window).  

       ___________________________________________________

         Performance notes
       ___________________________________________________
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   If you notice that your Macintosh is performing sluggishly, check to see 
whether you've left a web browser page open which is running a script.  
"Cute" pages running scripts which present spinning globes, etc., can degrade 
performance dramatically even when run in the background.  The only cure is 
to close the browser window or go to another, less power-hungry browser page.

   If you wish to check to verify that an application or web page is gobbling 
CPU cycles, you can use the Activity Monitor utility provided by Apple, which 
you can launch by Command-clicking on this link:  <file:///Applications/
Utilities/Activity Monitor.app>.

___________________________________________________

   Installing dataComet
___________________________________________________

       ___________________________________________________

         The Fonts folder and font resources
       ___________________________________________________

   The fonts dataComet uses for various emulations are included in the 
"Fonts" folder in the application's home folder.  You should drag the font 
suitcase files into one of the OS X System Font Folders such as the /Library/
Fonts directory; this will ensure correct results when displaying graphics 
characters on-screen, printing, and displaying special characters in the 
Macro dialogs (which can use the Comet-Chicago font to display buttons in 
text fields).  

   Fonts in the current release include:

      Comet Chicago
      Comet ALA (3270 American Library Association character set)
      Comet ALA Bold
      Comet APL (3270 APL character set)
      Comet APL Bold
      Comet DEC-Multinational
      Comet DEC-Multinational Bold
      Comet Latin-1
      Comet Latin-1 Bold
      Comet Mona (mono-spaced Macintosh character set)
      Comet Mona Bold
      Comet PC-ANSI
      Comet PC-ANSI-Bold
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        ___________________________________________________

         The "dataComet keyboard" resource
       ___________________________________________________

   The Macintosh keyboard layout maps some Option-key combinations into 
foreign characters.  This can cause confusing results when using key macros, 
so the "dataComet keyboard" keyboard layout is provided to disable remapping 
of Option-key combinations.  

   For more information on installing the "dataComet Keyboard" keyboard 
layout under OS X, see the Help document "A2. dataComet keyboard".

       ___________________________________________________

         dataComet-Secure "Security" folder
       ___________________________________________________

   The "Security" folder in dataComet's home folder and the "{User}/Library/
Preferences/dataComet Preferences/Security" folder contain documents which 
dataComet will use for authentication.  Documents containing host public keys 
placed in these folders will be used for verifying the identity of hosts to 
which you connect; all documents in these folders are scanned at startup 
time, and lines that appear to contain valid host keys are added to tables in 
memory for lookups when SSH host connections are being authenticated.  

   The public key files must be 'TEXT' type documents, and must use either 
the standard ssh_known_hosts or ssh_known_hosts2 formats.  This allows files 
to be copied directly from standard SSH "known hosts" files on UNIX hosts.

   Host keys added by dataComet will be saved in files named 
"known_hosts.dataComet" (SSH1) and "known_hosts2.dataComet" (SSH2) using the 
standard format.

       ___________________________________________________

         Installing Kerberos Support
       ___________________________________________________

   dataComet-Secure supports Telnet connections authenticated using the 
Kerberos 5 protocol.  This may require that you configure the Kerberos 
package.  Kerberos support is bundled with Mac OS X.

________________________________________________________________
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            0.1. Shortcuts
  
________________________________________________________________
  
      dataComet documentation.  (Rev. 3/16/2010) 
      Copyright 1995 databeast, Inc. All Rights Reserved.
  
      ___________________________________________________
 
        Summary of special key-action combinations
 
          The following list summarizes the functions 
        modified by the Option, Shift, and Control keys.
      ___________________________________________________
 
   HELP!

      Control-"Click" on a menu, dialog item, or control to bring up  
          the dataComet documentation describing the item.

      Control-Command-"Key" brings up the documentation for 
          the menu command which the key triggers.

   Standard Macintosh commands:

      Command-"." cancels macros, printing, and other actions.

   Standard Macintosh Keyboard keys:

     "Ins", "Delete ->", "Page up", "Page down", "Home", and "End"
          perform the "normal" Macintosh window function.  (To send 
          VT220 keys using these keys, hold down the Shift key,
          or select the dataComet Preferences Keypad pane item 
          "VT220 named FKeys sent without Shift key down".)

   Scroll Wheel actions:

      Holding down the "Option" key while wheeling scrolls by pages.

   Mouse Click actions:

      Clicking on a selection and dragging it will perform 
          a Drag and Drop operation.
      Shift-Drag will copy an emulator selection in Table mode.

dataComet-Secure Online Documentation - Author: Bonze Anne Rose Blayk 21/231



      Option-Drag will omit carriage returns in an emulator 
          selection.

     "Go Away Button" closes a window (and session, if any).

     "Zoom Button" zooms a window out to maximum size.
      Shift-"Zoom Button" zooms a window in to a width of 
          75 characters rather than out to maximum print width.
      Option-"Zoom Button" miniaturizes a window rather than 
          zooming it.

      Command-"Title Bar" lets you drag a window without bringing it
          to the front.  If the window is frontmost and you 
          Command-click on the window name, a popup list of the 
          window's folder hierarchy will appear; selecting a folder
          from this list will open that folder.
      Option-"Title Bar" drags a session window and its .edit window 
          together.

      Option-"Grow Box" resizes the window and renegotiates the 
          size with host.  (Not all Telnet hosts support this 
          option.)

      Command-"Click" in a window will select a word and call 
          Internet Config to resolve it as a URL (with "mailto:"   
          as the default if there is no URL class at the beginning).
      Command-"Click" on an emulator button brings up a dialog 
          to set the macro for the button. 
      Command-"Click" on the shaded area of the button bar adds 
           a new macro button.  (Buttons with no title are  
          disabled.)
      Command-"Menu Macro select" allows you to redefine a menu  
          macro.

      Option-"Click" in the emulator window moves the host cursor.
          (Note that emulator mouse clicks can be customized using  
          Macros).
      OR
          You can change this behavior using the "Global"   
          Preferences dialog item "Option-click sends cursor 
          motion key sequences"; when this item is turned off, 
          simple clicks move the host cursor, and then...
      Option-"Click" in the emulator screen resets the emulator 
          selection without re-positioning the cursor; it also  
          causes the emulator to select whole lines if you drag  
          the mouse.
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      Control-"Click" in an emulator window performs an IBM 3270  
          light pen select operation, when possible, and otherwise  
          performs a "word select/copy/Paste" operation which Pastes
          the word you click on into the emulator at the host cursor 
          position.
      Control-"Click" in an edit window sends the selection to the 
          next frontmost emulator window, except for session.edit
          windows, which always send the selection to the session
          with which they are associated.

   ASCII Keyboard Control Characters and function keys:

      Control-"Key" sends an ASCII control character.

      Control-Option-"Key" can make meta-characters for EMACS:

         Control-Option-"Key" sends an ASCII meta-character.
         Control-Shift-Option-"Key" sends an ASCII meta-shift-
             character.
         Control-Shift-"Key" sends a meta-control-character.

      Option-"Key" meta-characters:
         When the "dataComet Keyboard.rsrc" is installed and 
         selected, and the "VT100" option "Option is meta key"  
         is enabled, you can use more straightforward keys to  
         make meta-characters:
   
         Option-"Key" sends an ASCII meta-character.
         Shift-Option-"Key" sends an ASCII meta-shift-character.
         Option-Control-"Key" sends a meta-control-character.

      VT220 function keys:  

           The VT220 function key mappings can be changed to  
              alternate mappings using the "Host menus and 
              keymapping" menu in the "New…"/"Reconfigure Session…"  
              and "VT100" Preferences dialogs.

             "F1" -> F1, "F2" -> F2, etc.
                   ("Help" is F15, and "Do" is F16.)

             "Shift-"   adds 12 so "Shift-F1"   -> F13, etc.
             "Control-" adds 24 so "Control-F1" -> F25
                                   "Control-Shift-F1" -> F36
             "Option-"  adds 48 to send other function keys:
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                Find               Option-"F1"  -> "F49"
                Insert Here        Option-"F2"  -> "F50"
                Remove             Option-"F3"  -> "F51"
                Select             Option-"F4"  -> "F52"
                Previous Screen    Option-"F5"  -> "F53"
                Next Screen        Option-"F6"  -> "F54"
                PF1                Option-"F7"  -> "F55"   
                                       or "clear" (keypad)
                PF2                Option-"F8"  -> "F56"   
                                       or "=" (keypad)
                PF3                Option-"F9"  -> "F57"   
                                       or "/" (keypad)
                PF4                Option-"F10" -> "F58"   
                                       or "*" (keypad)

                Toggle Auto Print  Shift-Option-"F1" -> "F61"     

           Use Shift to send VT220 Function keys on the keyboard:

                Find               "home"       + Shift
                Insert Here        "ins"        + Shift
                Remove             "del"        + Shift
                Select             "end"        + Shift
                Previous Screen    "page up"    + Shift
                Next Screen        "page down"  + Shift

           The FKeys can also be sent with the buttons on the left 
           hand side of the window; press the '?'/'M' button to s
           see the labels.

   IBM Keyboard PF keys:

      Control-"Key" or keypad key sends IBM 3270 PF keys (see PF 
           menu);

           "Return" -> IBM Enter; Shift-"Return" -> Line Feed;

           "F1" -> PF1; Shift adds 12 so Shift-"F1" -> F13, etc.
               ... see the document on Emulators for more
                   information.
 
           The IBM PF Keys can also be sent with the buttons on 
           the left side of the window; press the '?'/'M' button  
           to see the labels.
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   Edit window Keyboard -> Host commands:  

     "Enter (KP)" sends text from the topmost .edit window to a  
           host;
      Command-"Return" breaks a line and sends it to a host;

      Shift-"Enter (KP)" executes the text as a macro;
      Shift-Command-"Return" breaks a line and executes it as  
           a macro;

          Note that the Enter key commands listed here are very  
          useful when pasting boilerplate text!  Macintosh-native 
          fonts are automatically translated to the host character 
          set selected using the "Translation" menu for the target 
          host window; the target host window is the next topmost 
          connected emulator window.

   File Menu commands:

      Shift-"New…" opens a new edit window.
      Shift-"Open…" opens all documents as text documents.
      Option-"New…" opens a Shell session (under OS X only).
      Shift-Option-"Terminal Session…" opens a clone of the 
          topmost window. 
      Option-"Open…" opens a session document without opening the 
          connection.

      Option-"Save text as" sets a text document's creator type so 
          it will be opened using dataComet (dataComet's ID is 
          '3278').

      Shift-"Save text as" saves the window position and font info
          so you can save these parameters in non-dataComet 
          documents (these are automatically updated for dataComet 
          documents).

      Shift-"Open Log…" selects a file to save VT100 print streams
          rather than printing them.
      Option-"Open Log…" selects a file to log all session data 
          transmissions for debugging purposes.
      Shit-Option-"Open Log…" logs session data as it is displayed,
          rather than scrolled off or cleared, so that extra line
          feeds are not added to the log (like NCSA Telnet's 
          logging).

      Shift-"Print…"/Shift-Print selection…" print without 
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          displaying the Print dialog.

      Option-"Quit" quits dataComet without querying the user to  
          close 
          connections and save documents (no save is performed).

   Transfer Menu commands:

      Shift-"Upload" can be used to accept a download (by default
          AutoReceive is enabled, so usually this is not necessary).

   Edit Menu commands:

      Shift-"Copy" and …
      Shift-"Append screen to .edit window" perform a TEXT screen 
          copy (adding a space at the end of each line and a 
          carriage return for each two carriage returns).
      Option-"Copy" copies the emulator selection as a Table.

      "Paste" automatically translates from Macintosh fonts to 
          other fonts using the Translation selected for the 
          target window if translation of host output is enabled.
      Shift-"Paste" forces translation.
      Option-"Paste" suppresses translation.

                  Edit window Paste only:

         Option-"Paste" does a search before pasting ("Repeat 
             Paste").
         Shift-Option-"Paste" does a "Replace all" operation.

      Shift-"Clear buffer" resets the emulator (including 
          automatically backmapping all VT100 graphics characters 
          in the buffer to fix garbage from invalid SO command 
          characters).

      Shift-"Select All" selects the current screen rather than the 
          entire scrollback buffer.

      Shift-"Find" does a search backwards.
      Option-"Find" does a search using the current selection.

      Shift-Option-"Go to line…" goes directly to the end of the 
          scroll buffer without presenting the dialog.

      Shift-"Record session" records the emulator session 

dataComet-Secure Online Documentation - Author: Bonze Anne Rose Blayk 26/231



          including the host commands received and characters  
          sent to the host.  
      Shift-Option-"Record session" records the emulator session  
          including the Telnet layer interactions.
      You can turn off literal session recording by selecting 
          "Record Session" again with no modifiers.

   Edit -> Selection Menu commands:

      Shift-"Cursor Key" extends the selection range (edit only).
      Option-"Cursor Key" moves by words (left/right) 
           or sentences (Up/Down).

      Shift-"Match Brackets" matches backwards.

   Edit window text reformatting commands:

      The "¶" button toggles display of paragraphs wrapped/unwrapped
         (same as Option-"Add Returns").
      The "+¶" button wraps selected text by inserting carriage  
          returns (same as Shift-"Add Returns").
      The "-¶" button unwraps selected text by replacing carriage 
          returns with spaces (same as "Remove Returns").

      "Page up" and "Page down" refer to the Edit menu commands:

      Shift-"Page up" shifts text left by deleting tabs.
      Option-"Page up" and the "<<" button shift text left.
      Shift-Option-"Page up" and the "|<<" button delete ALL 
          leading spaces and tabs in the selected text.

      Shift-"Page down" shifts text right by inserting tabs.
      Option-"Page down" and the ">>" button shift text right.
      Shift-Option-"Page down" shifts selected text in an edit 
          by inserting '>' characters.
      
      The "#" button brings up the "Cursor Word Count…"  
          modeless dialog.

   Window Menu commands:

      Shift-"Close session" causes a close without macro execution.

      Shift-"Window Menu Select" redirects output to the selected  
          window.
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      Shift-"Zoom" closes a Session connection.

      Option-"Toggle .edit window" switches macro execution for a 
          session-linked .edit window into the edit window, as  
          opposed to executing the macro in the emulator window 
          context.

      Shift-"Toggle .edit window" brings up the "Go to Line…"
          dialog.  

   Control Menu commands:

      When you select a Font, Size, or Leading, only the screen  
          settings are set to the same value by default.
          You can also set the print settings independently:
 
              Option-"Font"    changes the print setting.
              Option-"Size"             "
              Option-"Leading"          "

      Shift-"Translation" selects the Translation table so that
          characters received from the host are NOT translated to 
          the Mac character set, so you can use the Comet-Fonts  
          and use standard Mac Option-key combinations to enter 
          "foreign" characters;  this way only characters SENT 
          to the host are translated.

                  Edit window Translation only:

     "Translation" translates the selection in an edit window from 
          the Macintosh character set TO the selected set.
      Option-"Translation" translates the selection in an edit 
          window back into the Macintosh character set FROM the  
          selected set.

   Macro Menu commands:

      Shift-"Record actions for macro" records a session without  
          generating match strings (this is useful for recording  
          3270 or other page-mode screen macros which have a  
          fixed page layout with changing data).

      Shift-"Dump macros into .edit" dumps a character table 
          into the frontmost edit window.
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      Option-"Dump macros into .edit" dumps a table of the
          current CSV macro settings into the a new edit window.

      Command-Menu macro item allows you to modify a macro added  
          to the "Macros" menu using the "Add Menu Macro…" command.
 
________________________________________________________________
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            0.2. Tips

________________________________________________________________

      dataComet documentation.  (Rev. 1/27/08) 
      Copyright 1998 databeast, Inc. All Rights Reserved.

   This document has information on (select and use "Find..." to go to the 
section):

         Using dataComet
         The edit window "Enter" key
         Chat and Talk interaction ("Command-Return") 
         Recording macros
         Editing and executing macros ("Shift-Enter")
         Reformatting web page text

       ___________________________________________________

         Using dataComet
       ___________________________________________________

   This document offers some pointers on using dataComet to get maximum 
productivity.  

   dataComet is especially useful in managing sessions with UNIX hosts.  
These pointers also apply to other hosts, though the commands will differ 
under operating systems such as digital's VMS and IBM's VM and MVS.

    The key to minimizing time and effort using dataComet is using the edit 
window and macro features.  Host commands are sometimes complex and obscure; 
dataComet allows you to save complicated host commands or shell scripts in an 
edit window and execute them by selecting them and pressing the "Enter" key, 
which sends them to the host.  (Commands which are one line long can be 
selected by placing the cursor anywhere on the line containing the command 
you wish to execute.)

       ___________________________________________________

         The edit window "Enter" key
       ___________________________________________________

   As a simple example, take the UNIX command which lists files by 
modification date:
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ls -lt

   After opening a session, you can execute the command above by bringing 
this window to the front, placing the cursor on the line containing "ls -lt", 
and pressing the "Enter" key.  If you have multiple session windows open, the 
command will be sent to the frontmost window with an open connection.

   The value of saving these commands in an edit window becomes more obvious 
when you are executing more complex commands.  For example, suppose you want 
to see a list of UNIX files sorted by size.  The "ls" command doesn't have an 
option to sort by file size, so you need to "pipe" the output of the "ls" 
command into the "sort" command:

ls -l | sort +3rn -4

   Here's another example.  Suppose you want to view a list of today's web 
hits without moving to the directory and using an editor:

cat /home/www/logs/databeast.com/19`date +%y%m%d`.accesses

   (Note this example won't work for you unless you change the directory "/
home/www/logs/databeast.com/" to the directory which contains your own web 
hit logs.)

       ___________________________________________________

         Chat and Talk interaction ("Command-Return") 
       ___________________________________________________

   The "Command-Return" key is used like the "Enter" key in an edit window, 
with the simple difference that "Command-Return" adds a line break at the 
cursor position before sending the line to the host.

   This makes it easy to use "chat" and "talk" programs on the host.  You can 
type a line to send in an edit window and then send it to the host with 
"Command-Return"; if you want to edit the line before sending it, you can 
change the line, and then send it using either "Enter" or "Command-Return".

       ___________________________________________________

         Recording macros
       ___________________________________________________

   You can use the "Macros" menu "Record actions for macro..." command to 
automatically record interactions with a host and generate a macro.  When 
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you're finished recording, select the "Record end--ready to Paste" command, 
and then Paste it into and edit window or the macro dialog.

   When you have a command working correctly, you can add a macro to execute 
the command if you use it frequently.  To make a key macro, bring up the 
"Control Macro..." dialog (Command-D) and press the key you wish to remap.  
You can also add a global menu macro by using the "Macros" "Add Menu 
Macro..." command, or add a button macro by pressing on the button with the 
Option key held down.  (See the document "4. Macros" for more information on 
adding macros and the commands available.)

   All macro editing uses the same basic dialog, which offers buttons to 
enter commonly used keys on the VT220 and IBM 3270 keyboard.  

       ___________________________________________________

         Editing and executing macros ("Shift-Enter")
       ___________________________________________________

   After you've prepared a key macro using dataComet's "Record Actions for 
Macro..." command, you may want to edit it (especially on ASCII hosts, you 
will want to replace unnecessary "!D\002" two-second delays inserted by the 
automatic macro generator with "!D\000" delays (no delay).

   These delays are automatically inserted because some ASCII host 
applications present command prompts before they're ready to receive input, 
so the greater speed with which a macro executes may wind up sending a 
command to the application which the application will then drop, resulting in 
a failed macro.

   Only testing can tell whether a delay is adequate for a given host 
application.

   You use an edit window to modify and test macros to be sure they work 
reliably before placing them in a key, menu, or button by using the "Shift-
Enter" key.  This key works like the "Enter" key, but tells the emulator 
window which receives the text to interpret it as a macro.  

   The "Command-Shift-Return" key functions in the same way, but breaks off 
the line before sending the text to the emulator window.
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       ___________________________________________________

         Reformatting web page text
       ___________________________________________________

   Web browsers often copy text with lines broken at odd places, and 
sometimes present you with pages of offset text which, when copied, yield 
text which has leading spaces.  Copies of these pages need to be reformatted 
when they are pasted into a Macintosh document.

   If you're copying text from a browser page and want to reformat it into a 
usable form using dataComet, you can do the following:  copy the text in the 
browser, switch to a dataComet edit window, paste the text, strip the leading 
spaces and tabs, unwrap the text by deleting carriage returns, and edit it.

   After you switch to dataComet, you can use key commands for the remaining 
tasks:

         Shift-Command-N     New text window
               Command-V     Paste
               Command-Z     
               Command-Z     Undo twice to select Paste range
  Option-Shift-Command-[     Strip all leading spaces and tabs
         Shift-Command-/     Unwrap (strip Carriage Returns)

   If you use this command sequence frequently, you can execute it with a 
single keystroke by defining a key macro containing them (remember, it's easy 
to record different command sequences using "Record actions for macro"):

      !\001\065!\002\005!\002\001!\002\001!\002\173!\002\082

   If you're preparing the text to be entered in a host editor, you can then:

    Shift-Command-=     Resize window to 75 characters wide
          Command-/     Wrap (add Carriage Returns)
              Enter     Paste through to the next frontmost session

________________________________________________________________
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            1. Emulators

________________________________________________________________

      dataComet documentation.  (Rev. 1/27/08) 
      Copyright 1995 databeast, Inc. All Rights Reserved.

   This document has information on (select and use "Find..." to go to the 
section):

         Using ASCII terminal emulators
         VT220 function key mapping
         UNIX connections
         Using dataComet with EMACS
         Using dataComet with PC-ANSI hosts
         Using the ASCII menu
         Using dataComet with the IBM 7171

         Using the 3279 emulator (and ASCII IBM key mode)
         Using the IBM "IBM" menu
         Using the IBM "3270" menu
         Using the IBM "5250" menu

         Using the "VT100" Preferences panel...   see "3.1. Dialogs"
                   "Color" Preferences panel          "3.1. Dialogs"
                   "Keypad" Preferences panel         "3.1. Dialogs"

       ___________________________________________________

         Using ASCII terminal emulators
       ___________________________________________________

   Many hosts use the ASCII (American Standard Code for Information 
Interchange) character set to simplify communication with other computers; 
for example, a Digital VAX running VMS,  almost all UNIX systems, and 
Macintosh or PC-DOS systems.  You can use either VT100, VT102, VT220, 
Heath-19, or PC-ANSI emulation with these hosts; the VAX requires one of the 
VT emulators.

   The buttons at the top and left side of the window provide a convenient 
method of sending frequently used commands to the host with the mouse.   You 
can set the buttons to send a macro instead of the default VT100 control 
sequences by clicking on the button while holding the Command key down.  
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   You can select text on the screen with the mouse to Copy, Paste, Append, 
or Print.  

   If the "Views" Preferences panel item "Show cursor-buttons at left of 
window" is enabled, the cursor is set to button numbers which appear when you 
move the cursor up and down the left margin of the window.  By default, these 
send key sequences equivalent to the Keypad keys in VT100 Application mode.  
You can see the labels for the buttons when you click on the '?' control at 
the top left of the window.

      If the "Views" Preferences panel item "Show status bar at top of 
window" is  enabled, there are 11 buttons at the top of the emulator window 
which perform functions useful with hosts which use ASCII terminals:

         _____________________________________________________

            Key       Function
         _____________________________________________________

            CR        Enter a line of text or a command.
            LF        Send an ASCII Line Feed character.
            ESC       Send an ASCII Escape character.
            CTL-S     Stop transmission to your terminal.
            CTL-Q     Restart transmission to your terminal.
            DEL       Send an ASCII DEL character.
            Break     Send a break.
            CTL-C     Usually used to abort a command.
            CTL-U     Usually used to abort a command.

         _____________________________________________________

   To the right of the buttons are two counters; the left one shows the 
packets sent to the network, the right one shows the packets received.

   Moving the mouse over a point on the terminal screen and pressing the 
mouse button while holding down the Option key moves the terminal cursor to 
the underlined position.  (You can also turn off the "Global" Preferences 
panel option "Option-click sends cursor motion key sequences" if you want to 
be able to position the cursor without holding down the Option key.)  

   Please note that if you click again while the cursor is still moving, it 
will not move to the point you expect it to!  If the cursor does not go to 
the proper position on the first mouse click, try it again; the presence of 
tabs in the text may cause incorrect positioning.  When using the UNIX vi 
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editor, you can use "vi cursor motion" to get around this problem, in 
addition to speeding the process up.  ("vi cursor motion" does have a minor 
problem in that it does not handle wrapped lines properly.)

   You can modify ASCII key mapping using options in the "VT100" Preferences 
panel; the default keymapping has:

                 `   ->  Escape
         Backspace   ->  Delete

       ___________________________________________________

         VT220 key mapping
       ___________________________________________________

   On the Apple extended keyboard, there are additional function keys 
available at the top of the keyboard and in between the keyboard and keypad.  

   The "ins", "home", "end", "x->", "page up", and "page down" keys are 
mapped by default to perform the expected local Mac-like function (i.e, 
paging and character deletion).  To send VT220 keys, hold down the Shift key 
while pressing the key.  You can use the "Keypad" Preferences panel to switch 
so that the keys send VT220 keys ordinarily and perform the local functions 
when shifted.

   You can also use the "Keypad" Preferences panel to control whether the 
keypad keys function as regular numeric keys or as "Application" keys which 
send special escape sequences; if you have problems using the keypad with an 
application, try using this panel to switch the setting.

   The keys at the top of the keypad are mapped to PF1 - PF4.  The keys at 
the top of the keypad are mapped to F1 - F15 (shift to map F1 -> F13, F2 -> 
F14, etc., up to F8 -> F20).  In VT100 mode the keys send the following 
sequences:
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          ______________________________________________

            Key          VT key name     Sends
          ______________________________________________

            home         FIND           \027[1~
            help         Insert Here    \027[2~
            X->          Remove         \027[3~
            end          Select         \027[4~
            page up      Prev Screen    \027[5~
            page down    Next Screen    \027[6~

            clear        PF1 (Gold)     \027OP
            =            PF2 (Help)     \027OQ
            /            PF3            \027OR
            *            PF4            \027OS
            F1           PF1 (Gold)     \027OP
            F2           PF2 (Help)     \027OQ
            F3           PF3            \027OR
            F4           PF4            \027OS
            F5           Print          \027OT
            F6           F6             \027[17~
            F7           F7             \027[18~
            F8           F8             \027[19~
            F9           F9             \027[20~
            F10          F10            \027[21~
            F11          F11            \027[23~
            F12          F12            \027[24~
            F13          F13            \027[25~
            F14          F14            \027[26~
            F15          F15 (Help)     \027[28~

            ^-F1         F13            \027[25~
            ^-F2         F14            \027[26~
            ^-F3         F15            \027[28~
            ^-F4         F16 (Do)       \027[29~
            ^-F5         F17            \027[31~
            ^-F6         F18            \027[32~
            ^-F7         F19            \027[33~
            ^-F8         F20            \027[34~

            NOTE that the host can also set the function 
            keys using UDK escape sequences.  You can also
            select alternate function key mappings using
            the "Host menus and function keys" item in the
            "New..." or "Reconfigure Session..." dialog.
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          ______________________________________________

                Application mode keypad
          ______________________________________________

            +                           \027Ol
            -                           \027Om
            .                           \027On
            0                           \027Op
            1                           \027Oq
            2                           \027Or
            3                           \027Os
            4                           \027Ot
            5                           \027Ou
            6                           \027Ov
            7                           \027Ow
            8                           \027Ox
            9                           \027Oy
            ENTER                       \027OM

          ______________________________________________

            * '\027' is the Escape character

       ___________________________________________________

         UNIX connections
       ___________________________________________________

   Resizing the terminal window when the host doesn't support Telnet Window 
Size negotiation:  If your host does not have the correct terminal size set 
after you change the window size, you need to issue the following commands 
(e.g., where you want to set the size of your window to 50 rows X 80 
columns):

   stty rows 50 columns 80
   echo '[2J[r'

   The second command clears the screen and resets the terminal's scrolling 
region to the full size of the screen so all the rows specified will be used 
before scrolling occurs.

   To get 8-bit connections:  UNIX terminal drivers normally do not pass 8 
bit characters. To enable proper handling of ISO-Latin or other character 
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sets which have more than 128 characters, add the following lines to 
your .cshrc: 

      tty -s
      if ($status == 0) stty cs8 -istrip -parenb

   If you don't use csh, add equivalent code to your shell's start up file.  
(Note that it is necessary to check whether your standard I/O streams are 
connected to a terminal. Only then should you reconfigure the terminal 
driver.)

       ___________________________________________________

         Using dataComet with EMACS
       ___________________________________________________

   dataComet offers reliable performance with EMACS editor sessions.  
"Control-Option" sends a meta-character; "Control-Shift" sends a meta-
control-character.  You can also use the "VT100" Preferences panel item 
"Option is Meta Key" to set up the Option key to serve as a Meta Key (see 
description below).  Alternatively, you can set the eight bit of the 
character to make it a Meta key using the !CM macro, which you need to 
associate with a key using a key macro.

       ___________________________________________________

         Using dataComet with PC-ANSI hosts
       ___________________________________________________

   Note that you should have the "Comet PC-ANSI" font selected; if this is 
not the case, box characters will appear as odd characters.  (This is 
ordinarily automatic, but may not be set correctly if you reconfigure a 
session as a PC-ANSI session after connecting as a VT100).

       ___________________________________________________

         Using the ASCII menu
       ___________________________________________________

   The "ASCII" menu comes up when you are connected to a host as an ASCII 
terminal.  These show the keyboard mapping for ASCII control keys and key 
shortcuts.  The interpretation of these Control Characters depends on the 
host and application being used.
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   ________________________________________________________________

                          ASCII Control characters…

      Hex   Name             Control-      The Usual Effect
   ________________________________________________________________

      $00  "NUL"             @ or space      
      $01  "SOH"             A     
      $02  "STX"             B     
      $03  "ETX"             C      Abort process (UNIX)
      $04  "End-of-Trans"    D      Terminate input (UNIX)
      $05  "ENO"             E     
      $06  "ACK"             F     
      $07  "Bell"            G      Ring the bell
      $08  "Backspace"       H      Move backwards and overwrite
      $09  "Tab"             I      Tab to next field
      $0A  "Line Feed"       J      Move down one line
      $0B  "Vertical Tab"    K      Move to next vertical tab
      $0C  "Form Feed"       L      Eject page
      $0D  "Return"          M      Move to beginning of line
      $0E  "Shift-Out" (SO)  N      Select alternate character set
      $0F  "Shift-In"  (SI)  O      Restore standard character set
      $10  "DLE"             P     
      $11  "XON"             Q      Resume transmissions (try 
                                    Control-Q if there's no echo!)
      $12  "DC2"             R     
      $13  "XOFF"            S      Suspend transmissions
      $14  "DC4"             T     
      $15  "NAK"             U     
      $16  "SYN"             V     
      $17  "ETB"             W     
      $18  "CAN"             X     
      $19  "EM"              Y     
      $1A  "SUB"             Z      Terminate input (DEC VMS)
                                    Suspend process (UNIX)
      $1B  "Escape"          [      Terminate input (UNIX vi)
                                    Cancel input or screen, usually
      $1C  "FS"              \     
      $1D  "GS"              ]     
      $1E  "RS"              6     
      $1F  "US"              _     
      $7F  "Delete"          ?, Backspace or Option-Backspace

   ________________________________________________________________
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       ___________________________________________________

         Using dataComet with the IBM 7171
       ___________________________________________________

   Use the Heath-19 emulator and turn on the "Use IBM menus and key mapping" 
option in the "VT100" Preferences panel if you want to communicate with an 
IBM mainframe through the 7171 ASCII terminal adapter.  This mode allows you 
to run programs such as the XEDIT full-screen editor as if you were using an 
IBM 3278 terminal.  Buttons and menu items are provided which allow you to 
conveniently send the commands the 7171 accepts as the equivalent of keys on 
the 3278 terminal.  When the 7171 requests your terminal type, type in "C19".  
(The C19 definition must be loaded into the 7171 configuration for this to 
work correctly.)

       ___________________________________________________

         Using the 3279 emulator (and ASCII IBM key mode)
       ___________________________________________________

   dataComet provides an emulation of the IBM 3279 color display terminal; it 
allows you to run programs such as FILELIST or the XEDIT full-screen editor 
just as if you were using an IBM 3279 terminal.  Buttons and menu items are 
provided which allow the user to conveniently send the commands produced by 
keys on the 3279 terminal.

   Moving the mouse over a point on the terminal screen and pressing the 
mouse button while holding down the Option key moves the terminal cursor to 
the mouse cursor's position.  (You can also turn off the "Global" Preferences 
panel option "Option-click sends cursor motion key sequences" if you want to 
be able to position the cursor without holding down the Option key.)  

   You can select text on the screen with the mouse to Copy, Paste, Append, 
or Print.  

            ________________________________________

               Key Assignments (see IBM menus also)

               Key              3270 Action
            ________________________________________

               Return           Enter
               Shift-Return     New Line
               Option-Return    PA2
               Control-Return   Clear
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               Enter            Enter
               Shift-Tab        Back-Tab
               Backspace        Backspace, Delete
            ________________________________________

   The Backspace key changes its behavior when the 3270 emulator is put into 
"Insert" mode.  Ordinarily it performs a Backspace-Space-Backspace, so that 
the text to the right of the cursor is left in its original position.  When 
Insert mode is ON, the Backspace key will perform a Backspace-Delete, so that 
the text to the right of the cursor shifts to the left.

   You can also use the Command, Shift, and Option keys to control which 
action you wish the Backspace to perform.  When Command is held down while 
Backspace is pressed, the character to the right of the cursor is deleted, 
and the remaining text is shifted left.  When the Option key is held down, 
the result is a Backspace-Delete, as is the case in Insert mode.  When the 
Shift key is held down, the standard Backspace-Space-Backspace will be 
performed.

   If the "Views" Preferences panel item "Show cursor-buttons at left of 
window" is enabled, the cursor is set to button numbers which appear when you 
move the cursor up and down the left margin of the window.  By default, these 
send the PF keys from 1 through 24.  You can see the labels for the buttons 
when you click on the '?' control at the top left of the window.

   If the "Views" Preferences panel item "Show status bar at top of window" 
is  enabled, there are 11 buttons at the top of the emulator window which (by 
default) perform actions available on 3270-type terminal keys.  (See "2. 
Menus", "Using IBM menus" for a description of their functions.)

   To the right of the buttons are two counters; the left one shows the 
packets sent to the network, the right one shows the packets received.  

   A "HOST BUSY" indicator appears at the top of the screen when one the host 
system is busy processing your command; the host will not accept new commands 
from an Enter or PF key until the "HOST BUSY" indicator goes off.

   IMPORTANT NOTE:  You can enhance your communications efficiency when using 
the 3270 emulator by making sure that XEDIT has "SET FULLREAD OFF" in your 
PROFILE XEDIT file; XEDIT-based applications such as RICEMAIL may need to 
have this option turned off also to get optimal performance.  FULLREAD mode 
causes an extra 2,000 bytes to be sent with every PF-keystroke in the Action 
menu.
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       ___________________________________________________

         Using the IBM "IBM" menu
       ___________________________________________________

   The "IBM" menu contains 3270 Local keys which move the cursor and modify 
the screen without notifying the host of any changes.
      
   ________________________________________________________________

     Function             The Usual Effect
   ________________________________________________________________

     "Up"             Moves the cursor.
     "Down"                  "
     "Left"                  "
     "Right"                 "
     "Home"           Move the cursor to the top left of the screen
                         or the first input field.
     "BS-BLANK/BS-DEL"
                      Backspaces and blanks (or deletes if Insert 
                         mode is on).
     "Delete"
     "BS-BLANK"
     "BS-DEL"
     "DEL"            Delete the character at the cursor position.
     "Erase EOF"      Erase from cursor to End of Field.
     "Erase Input"    Erase all input fields on the screen.
     "Field-Tab"      Move to the beginning of the next field.
     "Field-Backtab"  Move to the beginning of the previous field.
     "Insert"         Go into Insert mode (inserts characters at
                      the cursor as long as there are spaces
                      at the end of the current field).
     "Newline"        Move to the beginning of the next line.
     "Reset"          Cancel Insert or clear KBD-lock (KBD-lock is 
                      displayed on the right side of the screen).
     "Cursor Select"  Performs light pen operation.
     "DUP"            Enters a DUP character (may vary if not using 
                         a Macintosh font)
     "Field Mark"     Enters a Field Mark character (ditto)
     "Record Separator"
                      Enters a Record Separator character (ditto)

   ________________________________________________________________
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       ___________________________________________________

         Using the IBM "3270" menu
       ___________________________________________________

   This menu contains Program Function (PF), Program Attention (PA), and 
other keys will send the current screen to the host and signal the host to 
interpret the screen.  The interpretation of these "PF keys" varies depending 
on the application; "The Usual Effect" listed is the most common use of the 
key.

   ________________________________________________________________

     Function             The Usual Effect
   ________________________________________________________________

     "Enter"          Enter a line of text or a command.
     "PA1"            Programmed Attention-1 (Toggles CP-mode).
     "PA2"            Advance screen from "MORE…" or "HOLDING".
     "PA3"            Programmed Attention-3 (application-defined).
     "Attn"           Interrupts the current process.
     "Clear"          Advances screen from "MORE…" and clears the 
                      input area.
     "SysReq"

     "PF1"            Help
     "PF2"  
     "PF3"            Quit
     "PF4"  
     "PF5"  
     "PF6"  
     "PF7"            Page Back
     "PF8"            Page Forward
     "PF9"  
     "PF10"  
     "PF11"  
     "PF12"  
     "PF13"  
     "PF14"  
     "PF15"  
     "PF16"  
     "PF17"  
     "PF18"
     "PF19"  
     "PF20"  
     "PF21"  
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     "PF22"  
     "PF23"  
     "PF24"
   ________________________________________________________________
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       ___________________________________________________

         Using the IBM "5250" menu
       ___________________________________________________

   The "5250" menu sends commands which allow you to use IBM 5250 commands 
when using the 3270 emulation.  Many of the commands are similar to the 
commands for the 3270 (see above).

         ________________________________________________________________

           5250 Functions
         ________________________________________________________________

           "Help"  
           "3270 Help"  
           "5250 Clear"  
           "Print"  
           "Attributes"  
           "Test Req"  
           "Roll Down"  
           "Roll Up"  
           "Field Exit"  
           "Error Reset"  
           "5250 SysReq"  
           "Record BS"
         ________________________________________________________________

       ___________________________________________________

         Using the IBM "Set Attributes" menu
       ___________________________________________________

   The IBM "Set Attributes" menu allows you to select an attribute to be 
applied to the IBM 3279 screen.  If a selection has been made, unprotected 
characters in the selection range are set to the selected attribute.  If no 
selection is made, the selected attribute will be used for newly-typed 
characters.
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   The attributes available in applications which support attribute entry 
are:
       
   ________________________________________________________________

      Attribute 
   ________________________________________________________________

     "Default Color"                Use field color set by host
     "Red"
     "Green"
     "Yellow"
     "Blue"
     "Pink"
     "Turquoise"
     "White"

     "Default Highlight"            Use field highlight set by host
     "Blink"
     "Reverse"
     "Underscore"

     "APL Font"                     Enter characters from the APL
                                    alternate font
   ________________________________________________________________

   Note that to use the APL font, you need to enter "SET APL ON" on the host.  
Note that the APL font is mapped differently from the "standard" IBM APL 
keyboard.

________________________________________________________________
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            1.1 VT100 Command Set 

      Digital, ANSI-X3.64, ISO-6429, ECMA-48, PC-ANSI and SCO-ANSI commands

_____________________________________________________________________________

      dataComet documentation.  (Rev. 1/27/08) 
      Copyright 1995 databeast, Inc. All Rights Reserved.

      ___________________________________________________

   This document has information on (select and use "Find..." to go to the 
section):

         Modes
         Programmable LEDs
         Programmable UDKs (User Defined Keys)
         Cursor Movement Commands
            SCO-ANSI sequences
            Additional ISO-6429 (ECMA-48) sequences
         Screen Editing (Erase/Insert/Delete)
         Line Size Commands (Double-Height and Double-Width) 
         Character Attributes
            SCO-ANSI colors
         Protected Area Attributes
         Scrolling Region
         Tab stops
         Printing
         Character Set (G0 and G1 Designators)
            PC-ANSI graphics characters
            SCO-ANSI graphics characters
         Cursor Position Report
         Status Report
         Identify
         Reset
         Confidence Tests
         VT52 Compatible Mode
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   _______________________________________________________________________

         ANSI Compatible Mode
   _______________________________________________________________________

      Note that the '!C>command\000' macro allows you to set any of 
      the modes listed below in a key macro.

      "\nnn" -> a decimal number representing a character, e.g.,
      "\027" -> <ESCAPE>.  This encoding allows you to use the
      strings listed below directly in dataComet macros.

      Unless otherwise noted, all command sequences listed 
      are supported by dataComet.

   _______________________________________________________________________

         Modes
   _______________________________________________________________________

                                  To Set                   To Reset
      Mode Name             Mode        Sequence      Mode        Sequence

      ANSI/VT52 mode        ANSI         \027<        VT52        \027[?2l
      Autowrap              On           \027[?7h     Off         \027[?7l
      Column mode           132 Col      \027[?3h     80 Col      \027[?3l
      Cursor invisible      Invisible    \027[?25h    Visible     \027[?25l
      Erasure mode          Erase all    \027[6h      Protected   \0276l
      Insert mode           Insert       \027[4h      Overwrite   \027[4l
      Line feed/new line    New line     \027[20h     Line feed   \027[20l
      Nat'l character set   ASCII        \027[?42h    Local Nat'l \027[?42l
      Origin mode           Relative     \027[?6h     Absolute    \027[?6l
      Print form feed       Add FF       \027[?18h    No FF added \027[?18l
      Print extent          Whole page   \027[?19h    Scroll rgn. \027[?19l
      Send/Receive mode     Local echo   \027[12h     Remote echo \027[12l
      Scrolling mode        Smooth       \027[?4h     Jump        \027[?4l
      Screen mode           Reverse      \027[?5h     Normal      \027[?5l

      Backarrow key         Backspace    \027[?67h    Delete      \027[?67l
      Control Transmission  7-bit        \027 F       8-bit       \027 G
      Cursor key mode       Application  \027[?1h     Cursor      \027[?l
      Key auto repeat       On           \027[?8h     Off         \027[?8l
      Keyboard action       Locked       \027[2h      Unlocked    \027[2l
      Keypad mode           Application  \027=        Numeric     \027>
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   _______________________________________________________________________

         Programmable LEDs
   _______________________________________________________________________

      \027[Ps;Ps;...Psq

      Ps =   0 or None   All LEDs Off
                  1      L1 on
                  2      L2 on
                  3      L3 on
                  4      L4 on

      Any other parameter values are ignored.

   _______________________________________________________________________

         Programmable UDKs (User Defined Keys)
   _______________________________________________________________________

      \027PPc;Pl|Key1/Str1;...,KeyN/StrN\156

      \027PPc;Pl;Pt;Pm|Key1/Name1?Str1;...,KeyN/NameN?StrN\156  
             (dataComet Button Bar UDK, optional)

      Pc is the clear parameter

         0   Clear all keys
         1   Clear only keys with new settings

      Pl is the lock parameter (used to select target)

         0   FKeys and Button Bar
         1   FKeys only
         2   Button Bar only
         3   Execute a URL string
         4   Execute a dataComet macro

         dataComet always Locks the FKeys and Buttons; this
         parameter is used to specify which items are affected.

      Pt is the type parameter (dataComet Button UDK, optional)

         0   "Classic" mapping (default if not specified)
         1   dataComet mapping
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      Pm is the macro parameter (dataComet Button UDK, optional)

         0   StrN is plain text (default if not specified)
         1   StrN should be interpreted as a dataComet macro

     "KeyN" is a string indicating which PFkey/Button is to be remapped.

     "StrN" is a string parameter with the string to send when the PFkey 
         or button is pressed.

      The command must always be terminated with the String Terminator 
      sequence, either the ST character (\156) or "\027\" (ESC-\).

      ____________________________________________________

                   dataComet mapping
             ________________________________

      "KeyN" "1" = F1, "2" = F2, etc.; 
          KeyN from "1" - "24" apply to the controls in the Button Bar.  
          KeyN from from "101" - "164" apply to the labels and buttons 
               on the left hand side of the emulator screen ("101" = 1).

      "NameN" is a string parameter with the button name, terminated by a 
          '?'.  This parameter is required to set a host-defined button in 
          the button bar which is displayed at the top of the dataComet 
          emulator window.

       dataComet mapping uses plain ASCII for the string parameters,
          so the button name and macro are easier to create and maintain.
               
       Here's an example which works with UNIX, setting F1 (and the first
       button) to execute a macro with a delay, and F2 to send "ls -lt":

cat << 'EOT'
[1;0;1;1|1/Wham?echo !D\003WHAMMO\010;2/lt?ls -lt\010\
'EOT'

       Here's an example which executes the macros immediately:

cat << 'EOT'
[1;4;1;1|1/Wham?echo !D\003WHAMMO\010;2/lt?ls -lt\010\
'EOT'

dataComet-Secure Online Documentation - Author: Bonze Anne Rose Blayk 51/231



       Here's an example which opens a URL (note the "/?" separators 
       are still included even though no Fkey number or title 
       is used in this example):

cat << 'EOT'
[1;3;1;1|/?<http://www.datacomet.com>\
'EOT'

      ____________________________________________________

             ________________________________

                   "Classic" mapping

               KeyN is one of the following
             ________________________________

                      F1        1
                      F2        2
                        etc.  ...
                      F16      16   (dataComet extension)

                      F6       17   (Standard)      
                      F7       18
                      F8       19
                      F9       20
                      F10      21
                      F11      23
                      F12      24
                      F13      25
                      F14      26
                      F15      28
                      F16      29
                      F17      31
                      F18      32
                      F19      33
                      F20      34
             ________________________________

              StrN is a "Classic" UDK string,
                  encoded in hexadecimal 
                    (i.e., 'N' = 4E)
             ________________________________
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   _______________________________________________________________________

         Cursor Movement Commands
   _______________________________________________________________________

      Cursor up                            \027[PnA
      Cursor down                          \027[PnB
      Cursor forward (right)               \027[PnC
      Cursor backward (left)               \027[PnD
      Direct cursor addressing             \027[Pl;PcH   or
                                           \027[Pl;Pcf
      Index                                \027D
      Next Line                            \027E
      Reverse index                        \027M
      Save cursor and attributes           \0277
      Restore cursor and attributes        \0278
      DECBI Back Index Char                \0276
      DECFI Forward Index Char             \0279

            SCO-ANSI sequences from ANSI X3.64

      Cursor Back Tab (CBT)                \027[PnZ
      Cursor Next Line (CNL)               \027[PnE
      Cursor Previous Line (CPL)           \027[PnF
      Horizontal Position Absolute (CHA)   \027[PnG   or
                                   (HPA)   \027[Pn'   or
                                           \027[Pn`
      Horizontal Position Relative (HPR)   \027[Pna
      Vertical Position Absolute (VPA)     \027[Pnd
      Vertical Position Relative (VPR)     \027[Pne 

      Scroll Up (SU)                       \027[PnS
      Scroll Down (SD)                     \027[PnT 
    
            Additional ISO-6429 (ECMA-48)sequences

      Cursor-Horizontal-Tab (CHT)          \027[PnI
      Scroll Left (SL)                     \027[Pn @   (space-@)
      Scroll Right (SR)                    \027[Pn A   (space-A)

   _______________________________________________________________________
    
      * Pn = decimal parameter in string of ASCII digits (default 1)
      * Pl = line number (default 0); Pc = column number (default 0)
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   _______________________________________________________________________

         Screen Editing (Erase/Insert/Delete)
   _______________________________________________________________________

      Erase from cursor to end of screen   \027[J  or \027[0J
      From beginning of screen to cursor   \027[1J
      Entire screen                        \027[2J
      From cursor to end of line           \027[K  or \027[0K
      From beginning of line to cursor     \027[1K
      Entire line containing cursor        \027[2K
      Erase Characters (ECH ECMA-48)       \027[PnX

      Insert line                          \027[PnL
      Delete line                          \027[PnM

      Insert characters                    \027[Pn@
      Delete characters                    \027[PnP
      
      Repeat last char (REP ECMA-48)       \027[Pnb

   _______________________________________________________________________

         Line Size Commands (Double-Height and Double-Width) 
   _______________________________________________________________________

      Change this line to double-height top half       \027#3
      Change this line to double-height bottom half    \027#4
      Change this line to single-width single-height   \027#5
      Change this line to double-width single-height   \027#6

   _______________________________________________________________________

         Character Attributes
   _______________________________________________________________________

      \027[Ps;Ps;Ps;...,Psm

      Ps =   0 or None   All Attributes Off
                  1      Bold on
                  3      Italic on (shown as bold)
                  4      Underscore on
                  5      Blink on
                  7      Reverse video on
                  8      Invisible on
                 10      Normal font
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                 11      Alternate font
                 12      Alternate font shifted +128
                 22      Bold off
                 23      Italic off
                 24      Underscore off
                 25      Blink off
                 27      Reverse off
                 28      Invisible off
  
                Colors:   Foreground  Background

                Black         30          40
                Red           31          41
                Green         32          42
                Yellow        33          43
                Blue          34          44
                Magenta       35          45
                Cyan          36          46
                White         37          47

                Variant:  Foreground  Background

                Black         <0          =0
                Red           <1          =1
                Green         <2          =2
                Yellow        <3          =3
                Blue          <4          =4
                Magenta       <5          =5
                Cyan          <6          =6
                White         <7          =7

         Use of this Variant command is strongly discouraged.
         It conflicts with the ANSI standard, and is provided 
            only to support some applications which use it.

         Any other parameter values are ignored.

      __________________________________________________________

            SCO-ANSI colors
      __________________________________________________________

      Select foreground color              \027[=PsF
      Select background color              \027[=PsG
      Select reverse color                 \027[=PsH
      Select reverse background color      \027[=PsI
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      Select graphic color                 \027[=PsJ  Not Supported
      Select graphic background color      \027[=PsK  Not Supported

      Select intense background            \027[=PnD
      Set color mode from 16 to 8 colors   \027[=PnE
         Also XENIX                        \027[3;Pnm
      Unselect Background Color Erase      \027[=PnL
         Pn 0 = Off, Pn 1 = On

      XENIX color selector sequences
         Normal colors                     \027[2;P1;P2m
         Reverse colors                    \027[7;P1;P2m

         P1 = foreground color
         P2 = background color

      Report current colors selected       \027[=PsM
      Ps =   0  Report normal colors
             1  Report reverse colors
             2  Report graphic colors
      The report format is "forecolor# backcolor#\010" 
         the numbers are sent as ASCII decimal strings

                     SCO-ANSI Color Table
         __________________________________________________

            Ps      Color             Ps      Color
         __________________________________________________

            0       Black              8      Grey
            1       Blue               9      Lt. Blue
            2       Green             10      Lt. Green
            3       Cyan              11      Lt. Cyan
            4       Red               12      Lt. Red
            5       Magenta           13      Lt. Magenta
            6       Brown             14      Yellow
            7       White             15      Lt. White
         __________________________________________________

         SCO-ANSI color selection sequences with 16 background colors
            are supported when the SCO-ANSI terminal type is selected.

   _______________________________________________________________________

         Protected Areas
   _______________________________________________________________________
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      Start Protected Area                 \027V
      End Protected Area                   \027W

         DEC Protected Character attribute
  
      Unprotected                          \0270"q    or
                                           \0272"q
      Protected                            \0271"q

         DEC Selective Erase (preserves protected areas)

      Erase from cursor to end of screen   \027[?J  or \027[?0J
      From beginning of screen to cursor   \027[?1J
      Entire screen                        \027[?2J
      From cursor to end of line           \027[?K  or \027[?0K
      From beginning of line to cursor     \027[?1K
      Entire line containing cursor        \027[?2K

   _______________________________________________________________________

         Scrolling Region
   _______________________________________________________________________

      \027[Pt;Pbr

      Pt is the number of the top line of the scrolling region;
      Pb is the number of the bottom line of the scrolling region 
         and must be greater than Pt.
      (The default for Pt is line 1, the default for Pb is the end 
         of the screen)

   _______________________________________________________________________

         Tab stops
   _______________________________________________________________________

      Set tab at current column      \027H
      Clear tab at curent column     \027[g   or   \027[0g  *
      Clear all tabs                 \027[3g                *

         * see \027[Png PC-ANSI variant below
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   _______________________________________________________________________

         Printing
   _______________________________________________________________________

       Print screen                  \027[i   or   \027[0i
       Print without display on      \027[5i 
       Print without display off     \027[4i 
         
       Auto print on                 \027[?5i
          (lines print as cursor moves off line w/ LF, VT, or FF)

       Auto print off               \027[?4i
       Print cursor's display line  \027[?1i
      
   _______________________________________________________________________

         Character Set (G0 and G1 Designators)
   _______________________________________________________________________

      Character Set               G0 Designator   G1 Designator

      United Kingdom (UK)            \027(A          \027)A
      United States (USASCII)        \027(B          \027)B
      Graphics characters            \027(0          \027)0
         and line drawing set
      Alternate character ROM        \027(1          \027)1
      Alternate character ROM        \027(2          \027)2
         graphics characters

      Lock Shift G0                  \015
      Lock Shift G1                  \014
      Lock Shift G1 Right            \027~
      Lock Shift G2                  \027n
      Lock Shift G2 Right            \027}
      Lock Shift G3                  \027o
      Lock Shift G3 Right            \027|
      Single Shift G2                \027N
      Single Shift G3                \027O
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      __________________________________________________________

            PC-ANSI graphics characters
      __________________________________________________________

      Output character <char> for display            \027<char>    
         when <char> is greater than 159

              <char>      <result>
  
              160      -> 127 
              161-191  -> 1-31 
              192-223  -> 128-159

      and

      Output character <char> for display            \027[Png
         where Pn > 5 (to avoid conflict with 
         ANSI Clear Tab command)

         Use of this command is strongly discouraged.
         It conflicts with the ANSI standard, and is provided 
            only to support some applications which use it.

      __________________________________________________________

            SCO-ANSI graphics characters
      __________________________________________________________

      Output character <char> from the               \027=<char>g
         alternate graphics set

   _______________________________________________________________________

         Cursor Position Report
   _______________________________________________________________________

         Invoked by                  \027[6n
         Response is                 \027[Pl;PcR

          * Pl = line number; Pc = column number
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   _______________________________________________________________________

         Status Report
   _______________________________________________________________________

         Invoked by                  \027[5n
         Response is                 \027[0n  (terminal ok)
                                     \027[3n  (terminal not ok)

   _______________________________________________________________________

         Identify
   _______________________________________________________________________

         Invoked by                  \027[c  or  \027[Oc
         Response is                 \027[?1;PsC

      Ps =   0   Base VT100, no options
             1   Processor option (STP)
             2   Advanced Video option (AVO)
             3   AVO and STP
             4   Graphics processor option (GO)
             5   GO and STP
             6   GO and AVO
             7   GO, STP, and AVO

         Alternately invoked by \027Z (not recommended.)

   _______________________________________________________________________

         Reset
   _______________________________________________________________________

      \027c

   _______________________________________________________________________

         Confidence Tests
   _______________________________________________________________________

      Fill Screen with "E"s         \027#8
      Invoke Test(s)                \027[2;Psy
         Ps =   1                   Power-up self test
         8                          Repeat selected test(s)
                                    indefinitely (until failure or power off)
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   _______________________________________________________________________

         VT52 Compatible Mode

      _____________________________________

      Cursor Up                       \027A
      Cursor Down                     \027B
      Cursor Right                    \027C
      Cursor Left                     \027D
      Select Graphics character set   \027F       (selects Bold in dataComet)
      Select ASCII character set      \027G
      Cursor to home                  \027H
      Reverse line feed               \027I
      Erase to end of screen          \027J
      Erase to end of line            \027K
      Direct cursor address           \027Ylc     (see note 1)
      Identify                        \027Z       (see note 2)
      Enter alternate keypad mode     \027=
      Exit alternate keypad mode      \027>
      Enter ANSI mode                 \027<

      NOTE 1: Line and column numbers for direct cursor address are single
         character codes whose values are the desired number plus
         37 (in Octal). Line and column numbers start at 1.

      NOTE 2: Response to \027Z is \027/ Z.

_____________________________________________________________________________
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            2. Menus

________________________________________________________________

      dataComet documentation.  (Rev. 2/20/2010) 
      Copyright 1995 databeast, Inc. All Rights Reserved.

   This document has information on (select and use "Find" to go to the 
section):

         Using the dataComet-Secure menu
         Using the File menu
         Using the Edit menu
         Using the Cursor menu
         Using the Control menu
         Using the ASCII menu         (see "1. Emulators")
         Using the IBM menus          (see "1. Emulators")
         Using the Telnet menu
         Using the Serial menu
         Using the Macros menu
         Using the Window menu

       ___________________________________________________

         Using the dataComet-Secure menu
       ___________________________________________________

   "About dataComet..."/"About dataComet-Secure...":  Information on the 
application.

   "Preferences":  Brings up the Preferences panel so you can change the 
configuration of "Global" settings and the options available for session 
windows:

   "Global":  The "Global" Preferences panel allows you to control several 
important features of dataComet.  All the other items in the Preferences 
panels affect only the topmost window.

   "Printing":  Allows you to configure printing parameters which aren't 
included in the "Page Setup..." dialog.

   "Session":  The Session Preferences panel allows you to control various 
features associated with each window, such as whether it will shrink when you 
switch applications in MultiFinder and the keymapping for the emulator being 
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used.

   "Views":  Allows you to show or hide the controls around the emulator 
screen.

   "VT100":  Allows you to configure items specific to the ANSI/VT100 
emulator.

   "3270":  Allows you to configure items specific to the IBM 3278/3279 
emulator.

   "Color":  The Color Preferences panel allows you to assign different 
colors to different field types on the emulator screen, using the standard 
Color Picker dialog.  You can use Copy and Paste to copy the 16 colors from 
one dataComet "Color" Preferences panel to another.

   "Keypad":  Allows the user to choose which of several keypad 
configurations will be used.  

   "Transfer", "SCP", "ZModem", "IND$FILE:  These Preferences panels allow 
you to control file transfer options.  See "6. File Transfer" for more 
information.

       ___________________________________________________

         Using the File menu
       ___________________________________________________

   "New":  This submenu is used for creating new windows:

   > "Terminal Session…":  Creates a new session; the "Configure Terminal 
Session…" dialog comes up, which allows you to choose the connection type you 
wish to use, the terminal type you wish to use, and the host address.  (For 
more information, see the Help document "3. Dialogs" section titled:  "Using 
the "New…"/"Configure Terminal Session" dialog".)  The "Comet Default" 
document is used as a template for new sessions, so that a new session's 
connection type, terminal type, window positions, font size, etc., will be 
the same as your "Comet Default" document.  

   > "Text Window":  Creates a new edit window named "Untitled".

   > "Shell":  A shortcut for opening a local Shell session to use the BSD 
UNIX command line on your own OS X machine.

   > "Clone":  Opens a new window with the same settings and properties as 
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the current topmost window.

   "Open…":  Calls up the Standard File Dialog to open a dataComet session 
document (or, if you hold down the Shift key, a text-only document).  When a 
connection is made, the session's Connection Macro (see "Set Connection 
Macro" in the Macro Menu) will be executed. 

   "Close":  Close the session document associated with the top window and 
release all storage associated with the session.

   "Save Configuration…":  Saves a document's configuration.  If you change 
the name of a document, the new session will use the current session's 
configuration as a template; key macros are copied to the new document.

   "Documents":  This submenu allows you to open saved dataComet text 
documents quickly; the documents listed first are those saved in the 
dataComet application home folder, those listed after the bar are those saved 
in the dataComet Preferences folder.

   "Sessions":  This submenu allows you to open saved dataComet session 
documents quickly; the documents listed first are those saved in the 
dataComet application home folder, those listed after the bar are those saved 
in the dataComet Preferences folder.

   "Transfer":  This submenu allows you to control file transfers.  More 
options are available in the "Transfer" Preferences panel.

   "Save screen as…":, "Save selection as…":, "Save text as…":  Presents a 
Standard File Dialog so you can select a file in which to save either the 
current emulator selection (or the whole screen if no selection has been 
made), or the contents of the text window.  Saving will delete any text 
already in the file.

   "Append screen to…":, "Append selection…":, "Append text to…":  Works like 
the command above, except it will append data to the file you select rather 
than deleting existing text.

   "Save screen…":, "Save selection…":, "Save text…":, "Save text as":  Saves 
the data in the file which has been opened by the "Save as" or "Append to" 
commands.  This will delete any text already in this file.  If no file has 
been selected, you will be presented with the Standard File Dialog so you can 
choose one.

   "Append screen to":, "Append selection":, "Append text to":  Works like 
the command above, except it will append data to the file you have already 
selected.
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   "Open Log…":  Presents the Standard File dialog so you can choose a file 
in which to log your session.

   "Log session in":  Allows you to turn session logging to the file selected 
with "Open Log" on and off .

   "Page Setup…":  Allows you to set up the printer when you are printing 
using the standard Print dialogs.

   "Print screen…":, "Print selection…":  By default, this item presents the 
standard Print dialog so you can print the emulator screen, a selection from 
the screen and scrollback buffer, or the .edit text.  This delivers a 
faithful rendering of the screen using the entire character set.  

   "Print lines off top":  All lines which scroll off the top or are cleared 
from the emulator screen will be printed.

   "Page Eject":  Prints a page if text has accumulated in the print buffer.  
Pressing the Shift key resets the page number without performing a page feed.

   "Quit":  Quits dataComet.  You will be prompted to close any open 
connections which are currently open, and will be prompted to save changes 
that you have made to session configuration settings.  

       ___________________________________________________

         Using the Edit menu
       ___________________________________________________

   "Undo":  Undo applies to the latest Cut command in an edit window.

   "Cut":  If the .edit window is in front, this command cuts the selection 
range and copies it into the Clipboard.

   "Copy":  Makes a copy of the screen or the selection (if one exists) or 
the text selection and copies it into the Clipboard.  

   "Shift-Copy" copies an emulator window selection as wrapped text (to 
handle wrapped lines without adding spurious returns).

   "Paste":  Pastes the contents of the Clipboard into the screen or text at 
the current cursor location.  In edit windows, "Option-Paste" performs a 
"Repeat Paste" operation (i.e., "Find selection" followed by "Paste"); 
"Shift-Option-Paste" performs a "Replace all".  (Note that ASCII pastes are 
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handled as a macro; to interrupt an ASCII paste to the host you need to abort 
the macro by pressing "Command-.", and then send an interrupt to the host.)

   "Clear":, "Clear buffer":  If the .edit window is in front, the "Clear" 
command clears the selection range.  If "Clear buffer" appears, then the 
whole emulator scrollback buffer is cleared.

   "Select All":  Selects the whole emulator scrollback buffer or .edit 
window text.

   "Table Mode for Copy and Save":  If the beginning of the selection range 
is less than the end of the selection range when you do a Copy or Save, only 
the text in between the beginning column and ending column of the range will 
be copied, so that you can exclude portions of the table.  When this mode is 
on, the "Session" Preferences panel item "Tab threshold" controls whether 
runs of blanks will be converted into Tab character to assist in copying 
tables from the terminal screen and pasting them into programs such as 
spreadsheets.  

   "Append file to .edit window…":  Presents the Standard Get File dialog and 
appends the TEXT format file you select to the session's .edit window.

   "Append screen to .edit window":, "Append selection to .edit window":  
Appends the screen or selection to the end of the session's .edit window.  

   "Record session":  When this mode is on, the contents of the emulator 
screen will be automatically appended to its .edit window when the emulator 
screen is cleared or lines scroll off the top.

   "Page up":  Move up one page in the scrollback buffer or the .edit window.

   "Page down":  Move down one page in scrollback buffer or the the .edit 
window.

   "Go to line…":  Offers a dialog to jump to a line number in a window.  A 
return will cause the cursor to move to the end of scrollback buffer or the 
the .edit window.

   "Find…":  Offers a dialog to enter a text string you want to find in the 
scrollback buffer or the .edit window.  The current selection is 
automatically placed in the dialog.  You can hold down the Shift key to 
search backwards.

   "Find Again…":  dataComet will try to find the last string for which you 
searched.  You can hold down the Shift key to search backwards. 
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   "Add Returns":  Adds a Carriage Return at the end of each line in 
the .edit window selection so the text can be pasted into a host document 
without lines overflowing.

   "Remove Returns":  Removes any Return from the .edit window selection 
which does not have adjacent Return or spaces.

       ___________________________________________________

         Using the Cursor menu
       ___________________________________________________

   Some of these items only affect edit windows.

   "Set":  Set the cursor position to be in the current screen.

   "Show":  Display the current selection.

   "Delete ->":  Delete the character to the right of the cursor, or the 
selection and the character to the right of the selection.

   "Shift Left":  Shift the lines in the selection left and delete any spaces 
found in the first columns.

   "Shift Right":  Shift the lines in the selection right and insert a space 
in the first column.

   "Match brackets":  Sets the selection to the text inside the next pair of 
brackets, which include quotes and brackets.  Holding down the Shift key 
searches backwards.  (You can modify the behavior of bracket matching by 
modifying the 'BRCK' resource in dataComet, which specifies the bracket 
pairs).

   "Left":  Moves the cursor left one character.

   "Word Left":  Moves the cursor left one word.

   "Down":  Moves the cursor down one line.

   "Sentence Down":  Moves the cursor right one sentence.

   "Up":  Moves the cursor up one line.

   "Sentence Up":  Moves the cursor left one sentence.
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   "Right":  Moves the cursor right one character.

   "Word Right":  Moves the cursor right one word.

   "Execute":  Executes the text as a macro in the context of the frontmost 
host.

   "Send":  Send the selection range or paragraph to the next frontmost host 
window as text.  

   "Word Count…":  Brings up the "Cursor Word Count…" modeless dialog, which 
displays a count of lines, words, and characters in the current selection.

   "Use Selection for Find":  The next Find command will use the selected 
text when performing a search.

       ___________________________________________________

         Using the Control menu
       ___________________________________________________

   "Lock":  The "Lock" command enhances security by allowing you to disable 
keying and menu commands in dataComet-Secure until a master passphrase is 
entered, preventing unauthorized users from tampering with your open sessions 
or opening session documents for which you have entered passwords.  (This 
command is not available in dataComet.)

   "Internet Config…":  Unfortunately OS X does not provide an interface for 
editing Internet Config settings, though the services still work.  If 
supported, this command would launch Internet Config so you can easily modify 
the File Mappings used by dataComet's ZMODEM, SCP, and IND$FILE 
implementations.  Currently the only method of altering these file mappings 
is to download Internet Explorer, which still works under OS X as of Snow 
Leopard (10.6).

   "Record Beep…":  The Record Beep dialog allows you to record a sound which 
will be used in place of the system beep when a host sends a Bell to a 
dataComet emulator window.  If you have copied a sound resource into the 
Scrap and Paste it into a dataComet window, the sound will be saved and used 
as the session's Beep sound.

   "Delete Beep":  Deletes the beep you've recorded to supplant the system 
beep.

   "Font":  Allows you to set the fonts used for screen drawing and printing.  
Selecting a font from the list sets the font which will be used on-screen.  
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You can change the font used for printing by holding down the Option key; the 
selected print font is marked with a '>' if it differs from the screen font.  

   Selecting a Font will automatically set the translation for Comet-Fonts 
and standard Macintosh fonts; for other, non-standard fonts (e.g., an 
alternate "ISO-Latin-1" font) you will need to set the translation manually.  
If a font with the same name ending in "Bold" will be selected automatically 
for the Bold font; if none exists, dataComet draws bold characters using the 
selected font; you can still select an alternate Bold font manually.

   "Size":  Allows you to set the font sizes used for screen drawing and 
printing.  Selecting a size from the list sets the font size which will be 
used on-screen.  You can change the font size used for printing by holding 
down the Option key; the selected print font size is marked with a '>' if it 
differs from the screen font.  

   "Leading":  Allows you to change the font leading for both emulator and 
text windows, so you can select whatever line height you prefer if the 
default height is not to your liking.  

   "Width":  Allows you to change the font width used on the emulator screen.  
This can help make proportional fonts more readable. 

   "Bold Font":  Allows you to set the font used for drawing text with bold 
attributes in the emulator screen.  "Use Normal Font": lets you disable font 
bolding.

   "Control Font":  Allows you to set the font used in the text drawn in the 
area around the emulator screen.

   "Translation":  Allows you to select character translation tables for 
remapping input and output from the host character set (e.g., ISO 
Latin-1/8859-1) to the "standard" Macintosh character set and back.  When 
used with a native Macintosh font such as Monaco, this allows you to use the 
standard keyboard layout supplied with your system, and eases pasting text 
into your Macintosh at some loss of exactitude.  If you want to correctly 
display all the characters in a font such as ISO Latin-1 or PC-ANSI (PC-850) 
you can use a dataComet font and select "Shift-Translation".  NOTE that 
Translation table names use '<>' for ASCII tables and '{}' for IBM EBCDIC 
tables, e.g., "Mac <> ISO Latin-1" and "Mac {} IBM1145_Spanish".

   "National":  Allows you to select a National Replacement Character Set, 
which translates some ASCII characters into "foreign" characters.  For the 
VT100, these characters are #, @, [, \, ], ^, _, `, {, |, }, and ~.  
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       ___________________________________________________

         Using the Telnet menu
       ___________________________________________________

   "Type my address at cursor":  Enters your Internet address at the cursor 
position.  This is useful with file transfer programs such as TFTP.

   "Send Telnet command":  A hierarchical menu which allows you to send 
Telnet commands, which give a standard way of performing some common 
operations with diverse hosts.

    "Erase character":  Delete the character to the left of the 
                        cursor.
         "Erase line":  Erase the current line of input.
      "Are you there":  Send a request to the host to confirm that a 
                        connection still exists.
  "Interrupt process":  Abort the current job on the host.
       "Abort output":  Abort the output from the current job on 
                        the host.
              "Break":  Send a Telnet Break to the host.

   "7-bit characters", "8-bit characters":  This setting allows you to set 
the character size for host communications.  Select to switch between the two 
options.

   "Send after return", "Send characters promptly":  Wait to send command 
lines to the host until the Return key is pressed (not applicable to 3270 
emulation).  Select to switch between the two options.

   "Local echo", "Remote echo":  Echo characters locally and have the host 
stop "echoing," or sending each character received back to the emulator (not 
applicable to 3270 emulation).  Select to switch between the two options.  

   "My Address   -- xxx.xxx.xxx.xxx":  Displays your Internet address.  
Selecting this menu item sends the address to the host.

   "Host Address -- xxx.xxx.xxx.xxx:pp":  Displays the Internet address of 
your host, and the  port to which you are connected.  Selecting this menu 
item sends the address to the host.

   "Host Name    -- HostName":  The name of the host to which you are 
connected.  Selecting this menu item sends the host name to the host.
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       ___________________________________________________

         Using the Serial menu
       ___________________________________________________

   "Send Sytek Escape":   This command offers a convenient method for sending 
the standard <Ctl-A><Ctl-B> character sequence used to escape to the Sytek 
command level when you are connected to a host over Sytek.

   "XON-XOFF", "Hardware handshake":  You can configure the serial port to 
use two different kinds of handshaking to help guarantee that no data is lost 
when it is transmitted between the modem and your Macintosh.  

   Hardware handshake is the preferred option.  A special cable is required 
to use hardware handshake, which uses two of the RS-232 lines (CTS and DTR, 
for output and input flow control respectively) to signal that the modem or 
Macintosh can't handle more data immediately.  Your modem must also be 
properly configured for hardware handshake to work:  for USR modems, 
configuring it with "AT&F&B1&H1&I0&R2&W" should work.  Selecting hardware 
handshake disables the menu items "Hang up phone" and "Hang up on close," 
which use the DTR line to signal the modem to hang up.  

   If you lack a cable which can support hardware flow control, you will use 
XON-XOFF to help control data transfer.  You can configure a USR Courier to 
do this correctly using "AT&F&B1&H2&I1&R1&W".

   "Reset 8th bit":  Clears the high bit of a data byte, which may contain 
garbage when connections 8 data bits are used with hosts which leave garbage 
in the high bit (e.g., UNIX).  This allows transparent ZMODEM functionality.

   "Baud":  The items under this heading set the speed at which the port will 
communicate.  

   "Parity":   The items under this heading set parity checking.

   "Data Bits":   The items under this heading set the number of data bits.

   "Stop Bits":   The items under this heading set the number of stop bits.

   "Hang up phone":  Drops the DTR line on the serial connection to the 
modem.  This should cause your modem to hang up; if it does not, check your 
modem and cable configuration.
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       ___________________________________________________

         Using the Macros menu
       ___________________________________________________

   "Macros" are command sequences that are triggered by a keystroke or button 
press.  See "4. Macros" for more information on macros.

   "Record Actions for Macro…":  Starts recording of keystrokes, selections, 
and menu item choices as a macro.  This option tries to generate correct '!
Z\255' macro "waitfor" strings (and for ASCII sessions a 2-second delay after 
the match) so that host interactions can be easily automated.  While 
recording, there is an automatic delay when characters are typed to obtain 
the the best results with ASCII hosts, where there is a delay before the host 
echoes the character back.  

    NOTE that when recording IBM 3270 sessions the '!Z\255' macro wait 
commands which are automatically generated may fail when using full-screen 
oriented applications where the data changes in different records but the 
screen format and prompt remain the same.  In such cases performance is 
greatly enhanced by cutting out the macro wait commands.  (You can hold down 
the Shift key when selecting the menu item or use the '!Ra' macro command to 
turn macro wait generation off when recording macros.)

    NOTE that if you use a macro to open a new window or select another 
window, macro commands on the front window's command queue which have not yet 
been executed will be transferred to the new window's command queue.  If you 
want to define a macro which includes further commands for the current window 
after opening or selecting another window, use the "!W}" macro command to 
cause subsequent macro commands to be directed to the current window. 

   "Record end--ready to Paste":  Ends macro recording and places a copy of 
the macro into the Scrap so it can be pasted into a macro dialog text box or 
the .edit window.

   "Dump Macros into Text Window":  Brings up and edit window listing keys 
which have had key macros defined.  If the macro is only a single character, 
a three digit decimal number is also printed to make it easier to copy and 
paste the key into the Key macro dialog.   If you hold down the Shift key, a 
table displaying the character set will be dumped instead. 

   "Key Macros On": Switches the use of key macros on and off, so that the 
standard keyboard interpretation can be easily restored.

   "Define Macros…":  Brings up a dialog which allows the user to remap the 
keyboard and keypad by associating a key with a macro command.  In general, 
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key macros are sequences of characters and commands executed when a key 
associated with a macro is pressed.  The macro dialog is also used to control 
the titles and macros associated with Macro menu user macros and emulator 
buttons.  See "4. Macros" for more information on key macros.

   "Set dataComet Launch macro…":  Presents the "Define Macros" dialog and 
allows you to set a macro command sequence to be executed when dataComet is 
launched.  This macro can be used to configure dataComet to run as a secure 
kiosk terminal.  (See the document "A3. Public Terminal Kiosk Configuration" 
for more information on this configuration option.)

   "Set dialup macro…":  Presents the "Define Macros" dialog and allows you 
to set a global modem dial macro which is executed before the "Connect to:" 
telephone number string for Serial connections is sent.  This is only 
executed if the "Connect to:" string is present.

   "Add Macro Button…":  Presents a macro entry dialog which allows you to 
add a macro button to the panel at the above the emulator screen.

   "Set Single-click macro…":  Presents a macro entry dialog which allows you 
to set a macro command sequence to be executed when you click the mouse in 
the emulator screen to move the cursor (this supplants either Click or 
Option-Click depending on the "Global" Preferences panel setting for "Option-
click sends cursor motion key sequences".  When this option is selected, you 
must press Option-click to send this macro).

   "Set Double-click macro…":  Presents a macro entry dialog which allows you 
to set a macro command sequence to be executed when you double-click the 
mouse in the emulator screen.  E.g., on a UNIX machine, you could set the 
double click macro to "!EW!ECvi !EV" to allow you to edit a file name listed 
in the emulator window by double-clicking on it (this is another variation on 
the useful Click/Copy/Paste function performed by Control-Click).  If no 
Double-click macro is set, dataComet will select the current word at the 
cursor by default.

   "Set Connection macro…":  Presents a macro entry dialog which allows you 
to set a macro command sequence to be executed when a connection is made.  
This is useful for partially automating logins, but PLEASE… don't put your 
passwords in Connection macros!  Use the "!QS" macro to prompt the user for 
the password instead.

   "Set Close macro…":  Presents a macro entry dialog which allows you to set 
a macro command sequence to be executed when a connection is closed.  In 
order to ensure that the screen is properly displayed, you may need to add a 
delay at the end of the macro; dataComet will close the connection if it is 
not already closed by host actions initiated by your macro.
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   "Add Menu Macro…":  Brings up the "Define Macros" dialog and prompts you 
for the name of a new user-defined macro to add to the Macro menu.  You can 
modify existing user-defined macros in the Macro menu by selecting them using 
"Command-Menu Select".  Note that menu macros are always global, and like 
other global settings they are saved in the "Comet Default" document.

       ___________________________________________________

         Using the Window menu
       ___________________________________________________

   "Close session":  Closes a session with a host.

   "Abort session":  Closes a session with a host without going through the 
closing negotiations with the host; if an host connection is failing to 
connect promptly, or you know you've lost a serial connection, you can use 
this command to save some time; ordinarily you should use "Close session".

   "Re-open session":  Allows you to attempt to re-open a session which has 
failed to open or has been closed.  If a connection is made, the session's 
Connection Macro will be executed.

   "Reconfigure session…":   Lets you use the "Configure Session" dialog to 
reconfigure a session after you have created or opened it.  You can change to 
name to create a "clone" of the current session with the same settings and 
macros as the current session.

   "Scrollback buffering":  Lets you turn scrollback buffering in the 
emulator window on and off.  Note that when this feature is used with 
sessions on IBM mainframes, screens are saved when the user enters a PF key; 
thus, if the user allows screens to automatically page on the IBM host, they 
will NOT be saved.

   "Toggle .edit Window":  Bring the .edit window associated with the topmost 
emulator session to the front.  Holding down the Option key will allow you to 
direct macro execution, including key macros, into the .edit window, and will 
change the appearance of the mouse cursor and place a '>' in front of the 
menu item to indicate that an alternate macro mode is enabled.

   Note that usually macro output in an emulator session is directed into the 
emulator window, so that key macros will be sent into the emulator window 
even when the .edit window is frontmost; in this respect there is a 
significant difference between .edit windows associated with sessions and 
other text windows.  This option allows you to redirect macros into the .edit 
window, so that it's possible to use global key macros in the .edit window 
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context also.

   Shift-"Toggle .edit Window":  Brings up the "Go to Line..." dialog.  

   "Minimize":  Shrinks the window to the Dock or to a small icon.  If data 
arrives while a session window is miniaturized, the icon is highlighted.  The 
icon position is automatically saved when the document is closed.

   "Zoom":  Zooms the window in the same way as clicking the zoom box.

   "Next":  Select the next window in the window menu list.  "Option-Tab" is 
used as the command key, since Apple pre-empts all Command-Tab key 
combinations for application switching; pressing "Shift-Option-Tab" selects 
the previous window.

   "Bring All to Front":  Brings all dataComet windows to the first layer of 
windows.

   Window List:  A list of session/window names follows; the first 9 are 
associated with the Command keys 1-9.  Selecting the item brings the window 
to the front.

   Items in the list of sessions may have marks to indicate special 
conditions.  Active host sessions are maked with a bullet; Telnet sessions 
which have terminated abnormally are marked with a cross.  Minimized windows 
are marked with a '-'; minimized session windows are marked with a '±' if 
they are connected.

________________________________________________________________
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            3. Dialogs

________________________________________________________________

      dataComet documentation.  (Rev. 7/14/10) 
      Copyright 1995 databeast, Inc. All Rights Reserved.

   This document has information on (select and use "Find..." to go to the 
section):

         "Using modeless configuration dialogs"
         Using the "New…"/"Configure Terminal Session" dialog
         Using the Telnet "Configure…" dialog
         Using the SSH "Configure…" dialog
         Using the SSH "Keys…" dialog
         Using the SSH "Make key…" dialog
         Using the "Kerberos Login" dialog

         Using the "Global" Preferences panel
         Using the "Printing" Preferences panel
         Using the "Session" Preferences panel

         Using the "Define macros" dialog...    see "4. Macros"

       ___________________________________________________

         "Using modeless configuration dialogs"
       ___________________________________________________

   The modeless configuration dialogs allow you to control window settings 
and dataComet's global configuration.  Settings take effect immediately when 
an option is changed.  To cancel changes made in a dialog window, use the 
"Revert" button, the "Undo" command, or press Command-'.'.

   In order to make dialog option changes to a session document permanent, 
you need to use the File menu command "Save configuration...".  You will be 
prompted to save the settings when a window closes if the settings have been 
modified.  (Note that "Control" menu settings for Font, Size, Leading, Width, 
Bold Font, Control Font, Translation, and National are saved automatically 
when a window is closed.)

   When you select another document window, the settings in the Preferences 
panel change to reflect the settings for that window.  The menu commands 
other than Close, Copy, Paste, Undo, and Select All apply to the frontmost 
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document window.  

   You can Control-Click on a Preferences panel item to jump to the 
description of the item in this document.  You can click on the Preference 
panel names in the bar at the top of a Preferences panel to open other 
Preferences panels.

       ___________________________________________________

                    "Reconfigure Session…"

         Using the "New…"/"Configure Terminal Session" dialog
            in Window menu as:  "Reconfigure Session…":
       ___________________________________________________

   This dialog allows you to configure the most fundamental parameters 
affecting a window, including: 

   "Window Type":  You can select "Shell" to create a local Shell session, or 
select "Serial", "SSH", or "Telnet" to create a new session window to connect 
with a remote host (which will have its own ".edit" window in which you can 
save frequently used commands and boilerplate text).  

   "Shell" creates a new local shell session, like a session opened using 
Apple's "Terminal" application.  This will execute the "/usr/bin/login" UNIX 
command in a new window.  

   "Serial" allows you to  make direct Serial Port connections to a modem or 
terminal server.  You can enter the phone number in the "Connect to:" field 
to dial a number automatically.

   "SSH" selects the Secure Shell protocol, which adds authentication and 
encryption features so session data, e.g., passwords, can't be traced by 
systems crackers.  The SSH "Configure..." button brings up a dialog which 
allows you to customize SSH session options.  Enter the host name or its IP 
address in the "Connect to:" field.  

   "Telnet" lets you make Telnet TCP network connections.  The Telnet 
"Configure..." button brings up a dialog which allows you to customize Telnet 
session options.  Enter the host name or its IP address in the "Connect to:" 
field.  Options for Telnet include:

   - "Initiate SSL/TLS":  Open a session with an SSL/TLS Handshake 
negotiation without waiting for a Telnet "Start TLS" command from the host; 
if a socket number is not specified, it will default to socket 992.  If this 
option is not selected, dataComet will only initiate SSL/TLS when a "Start 
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TLS" command is received from the host; note that it will always negotiate 
SSL/TLS when a "Start TLS" command is received.

   - Telnet "Authenticate" and "Encrypt" security options are available for 
Kerberos 5 connections, which require that you are connecting to a host which 
supports Kerberos 5.  

   - "Authenticate" uses Kerberos to log in to a host in a secure fashion, so 
system hackers can't crack your accounts by logging network traffic.  The 
"Alt. ID" field below "Authenticate" allows you to enter your host login 
name, which will be needed if it differs from your Kerberos Principal ID (see 
information on "Username" below).  You can make automatic Kerberos 
connections, skipping the login dialog, if you enter your Kerberos password 
in the "Password" field (see below).

   - "Encrypt" adds another layer of security by encoding all your 
communications with the host so that it's very difficult to eavesdrop on your 
transmissions.

   - The "Fwd Creds" option allows you to forward your Kerberos credentials 
to the host so you can access network services on other hosts through your 
Telnet connection (generally this should be disabled unless you actually need 
to do this).

   "Terminal Type":  This popup menu allows you to select the preferred 
terminal type.  The "Automatic" terminal type will default to a VT100 on a 
serial connection; on a Telnet connection "Automatic" will negotiate the 
"best" terminal type to use with the host.  Note that a few hosts may not 
perform terminal type negotiations correctly, so "Automatic" mode may fail.  
In particular, you will need to set the PC-ANSI terminal type manually to get 
correct results when connecting to many bulletin board systems (BBS).

   The "Alt. ID" field lets you enter an alternate Telnet Terminal Type 
string if the default string doesn't work correctly with your host.  
Generally you should use this with a specific terminal type selected rather 
than "Automatic."  (You can set this field back to an empty string to disable 
this feature.)

   "Host menus and function keys":  This popup menu allows you to select 
alternate menus when you're connecting to a host which ordinarily expects a 
terminal type which has different Program Function (PF) keys, but which can 
use an alternate terminal type if you enter special key sequences to 
substitute for the standard Function keys.  This option makes it much easier 
to use a VT100 emulator with an IBM 3270 mainframe, or to use the IBM 3270 
emulator with an AS/400 host.  For UNIX hosts, alternative function key 
mappings are listed here by the "TERM" name commonly associated with the 
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keymapping.

   "Username":  This field allows you to enter the name of your host account.  
This is sent automatically for SSH and Kerberos Telnet logins, but not for 
plain Telnet logins.  You can make automatic Kerberos connections, skipping 
the login dialog, if you also enter your Kerberos Principal password in the 
"Password" field.

   "Password":  This field allows you to enter the password for your host 
account.  The password is stored in an encrypted form, with your Master 
Passphrase as a secret key.  This is sent automatically by SSH or Kerberos 
when password authentication is selected.  WARNING:  be careful to "Lock" 
your sessions if you use this feature, and to select a Master Passphrase 
which will be difficult to guess!

   "Connect to:"  This field is used to enter either a host name (for SSH and 
Telnet connections) or a telephone number (for Serial connections).  

   If you are making a Telnet connection, this field must contain the IP 
address or domain name of the host to which you wish to connect.  

   "Port:"  If you need to specify a port number other than the standard SSH, 
Telnet, or SSL/TLS port numbers (22, 23, and 992 respectively), you can enter 
the port number here.

   "SOCKS proxy":  This controls whether the Host Name/Address which follows 
is to be used as a proxy so connections can traverse network firewalls.

   "Global":  By default, this control is on; it allows you to select a 
global SOCKS default host for all Telnet sessions.  If you turn it off, you 
can enter a SOCKS proxy to be used for this session alone.

   "SOCKS Username":  The SOCKS username (in case this is required).

       ___________________________________________________

                    Telnet "Configure…"  

         Using the Telnet "Configure…" dialog
       ___________________________________________________

   This dialog allows you to configure special options for a Telnet session.

SSL/TLS options:

   "SSL/TLS version":  Allows you to select a specific version of SSL/TLS to 
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use for SSL/TLS connections.

   "Allow expired host certificate":  Allows you to connect to a host with an 
expired SSL/TLS certificate.

   "Allow any root certificate":  Allows you to connect to a host when the 
host has an untrusted root certificate.

   "Verify host domain name":  SSL/TLS will check the host domain to to 
prevent host name spoofing when this option is on.

Kerberos Options:

   "Authentication":  Allows you to select a protocol for performing 
authentication with hosts for a Telnet session.  The checkbox can be used to 
disable Authentication.  Currently only Kerberos 5 is supported.  

   "Encryption":  The checkbox can be used to disable Encryption.  Telnet 
allows the selection of a number of different encryption algorithms, which 
encrypt the plain text of your session so that eavesdroppers cannot (easily) 
decipher it.  "DES3" Triple-DES encryption is the most secure option; 
generally you should use it rather than DES.  Note that if no lock picture 
appears in the left bottom side of the emulator window after you connect, the 
session is not being encrypted; some hosts may not support DES3 encryption 
over Telnet sessions.

   "Compression":  This option is not yet supported.  

   "WILL SGA (Berkeley linefeed fix)":  Causes dataComet to send WILL SGA, 
the Telnet Send-Go-Ahead option, in order to get BSD UNIX derivatives to 
handle carriage returns correctly.

   "WILL NAWS (Negotiate Window Size)":  Causes dataComet to send WILL NAWS, 
the Telnet option which allows the host screen size to be adjusted 
automatically if you change the size of a dataComet emulator screen.

   "Display log messages on-screen":  Display the Telnet logon messages on 
the emulator screen.  This can help debug connection problems, and shows the 
Telnet options that are available on the host and which options are actually 
selected for the session.
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       ___________________________________________________

                    SSH "Configure…"  

         Using the SSH "Configure…" dialog
       ___________________________________________________

   This dialog allows you to configure a "Secure Shell" (SSH) session.  
Support for these options is only included in dataComet-Secure.

   "SSH Version":  There are two different SSH protocols, SSH1 and SSH2.  
This option allows you to force an SSH2 host to select SSH1 or SSH2 rather 
than allowing it to make the choice.

   "Encryption":  SSH allows the selection of a number of different 
encryption algorithms, which encrypt the plain text of your session so that 
eavesdroppers cannot easily decipher it.  Triple-DES is the most secure 
option; Blowfish is somewhat faster than 3-DES but probably not quite as 
secure.

   "Compression":  SSH can compress the data stream, which enhances security 
and may speed up (or slow down) sessions substantially; the speed increase 
(or decrease) will be directly proportional to the ratio between the speed of 
your computer and the speed of the network connection (e.g., if you have a 
Macintosh G3, a session with compression on is much faster on a slow dialup 
connection, still significantly faster with an Ethernet connection, and 
possibly slower if you have a direct Gigabit Ethernet connection to a very 
fast host).  

NOTE that using compression requires an extra 250K bytes of memory per 
session!

   "MAC type":  SSH2 helps guarantee communications security by adding a 
"Message Authentication Code" field to each data packet.  The "SHA-1" 
protocol is used by default.

   "Authentication":  SSH offers several different methods of 
"authenticating" your identity to the host.  Passwords are the same as your 
usual host password, with the major difference that under SSH passwords are 
encrypted so eavesdroppers can't use network "sniffers" to steal your 
password.  RSA and DSS "public key authentication" methods are used by SSH1 
and SSH2, respectively; dataComet-Secure only supports RSA public key 
authentication.  RSA keys must be saved in the ":dataComet 
Preferences:Security:" folder.  NOTA BENE:  Maintaining security while using 
a public key REQUIRES that the private key be encrypted using a Passphrase 
(which can be the same as your Master Passphrase) and should not be shared 
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with other users.  

   "Keys…":  This button brings up a dialog which allows you to create, save, 
view, and copy public keys, so you can copy and paste them into host key 
files.

   "Use Key…":  This button allows you to select the private key file which 
will be used for an SSH session if you select one of the public key methods 
in the "Authentication" popup menu.  

   "Display log messages on-screen":  Display the SSH logon messages on the 
emulator screen.  This can help debug connection problems, and shows clearly 
the SSH options that are available on the host and which options are actually 
selected for the session.

   "Don't allocate PTY (host terminal handler)":  This option allows you to 
skip creating a "pty" on the host, which is used to control the interface to 
applications on the host which need terminal control information.  (You will 
almost always want this option off!)

   "Execute command (rssh)":  Allows you to execute a command on the host and 
then close the session automatically.  You can enter the command to be 
executed in the text field below.

       ___________________________________________________

         Using the SSH "Keys…" dialog
       ___________________________________________________

   This dialog allows you to manage RSA keys for user authentication of SSH1 
"Secure Shell" sessions.  (Use of RSA keys with SSH2 is not yet supported by 
dataComet.)

   The "Key File..." button allows you to open a key file in the dataComet 
"Security" Folder in the "dataComet Preferences" Folder so you can view and 
copy the public portion of the key, and save the key with a new name and 
passphrase if you wish.

   The "Public Key" field shows the public key for the key.  This is the key 
which is added to the host file "~/.ssh/authorized_keys" to enable you to log 
on to the host using your key rather than a password.  You can copy the 
Public Key in this field and then paste it into "authorized_keys" file using 
a host editor.  NOTE that you should make every effort to keep the private 
portion of the key file private, including using a passphrase to encrypt it.  
If someone copies your private key, the can log on to your account, just as 
if you had given them a password for a password-protected account.
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   The "Fingerprint" field shows the fingerprint of the key, which is a 
condensed representation of the key useful for verifying (e.g., in a 
telephone conversation) that a key is valid.

   The "Make Key…" button brings up a dialog which allows you to generate a 
new key.

   The "Save Key…" button allows you to save a key.

       ___________________________________________________

         Using the SSH "Make key…" dialog
       ___________________________________________________

   This dialog allows you to generate RSA keys.

   The "Key Size" field allows you to specify a size other than the usual 
1024-bit key length.  If you want your encrypted communications to remain 
secure over a long period of time, you should use more than a size greater 
than 1024, probably 2048.  Note that it takes substantially more time to 
generate the key and to verify it when making a host connection when you use 
a larger key.
   
   The "Comment" fields allows you to enter a comment, which will be appended 
to the newly generated key.

   The progress bar indicates roughly the amount of work left in generating 
the key.

       ___________________________________________________

         Using the "Kerberos Login" dialog
       ___________________________________________________

   This dialog allows you to log in with a Kerberos ID and password.  It is 
brought up automatically if you do not already have a valid Ticket from the 
Kerberos server.  You should enter your Kerberos ID in the "Principal" field; 
for example, "wpenn@UPENN.EDU", and your Kerberos password in the "Password" 
field.

   "Custom Ticket lifetime (min.):"  This option lets you select a custom 
expiration time for the "Ticket" which the Kerberos server will send to your 
computer so it can prove your identity to other computers.  Selecting a 
shorter lifetime makes it even more difficult for system crackers to gain 
access to your accounts, but may require you to re-enter your password more 
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frequently when using some services; the default lifetime is 10 hours (600 
minutes).

   "Allow ticket forwarding":  This option lets you allow Macintosh 
applications which use Kerberos to forward your ticket to a network host or 
server so that it can in turn verify your identity with other hosts or 
servers.  Enabling this option poses some security risk, since crackers may 
breach security on a multi-user host/server and try to collect tickets to use 
to violate the privacy of your accounts.  Unless you need it, this option 
should be left turned off.

       ___________________________________________________

                    "Global…"  

         Using the "Global" Preferences panel
       ___________________________________________________

    The global configuration is automatically saved in the "Comet Default" 
document when you quit dataComet.  If you find that dataComet tends to crash 
on launching, try throwing out the "Comet Default" document in the System 
Folder.  

   "Change Passphrase":  dataComet-Secure allows you to save your session 
passwords encrypted using a master passphrase so you can speed up logins 
without seriously compromising the security of your passwords.  If you wish 
to change your master passphrase, you can use this button to update the 
session passwords saved in the session documents store in the "dataComet 
Preferences" folder with a new password.  (Note that passwords saved in 
session documents in other folders must be updated manually).

   "Splash Delay":  When a registered copy of dataComet is launched it 
defaults to a 3-second minimum splash display; turning off this item will 
clear the splash screen ASAP (rather than waiting to better display the 
support contact information which may be included in the splash screen).
  
   "Show "New session" dialog on launch":  Automatically display a "New..." 
dialog when dataComet is launched.

   "Open "Comet Default" automatically on launch":  Opens the "Comet Default" 
document without presenting the "New..." dialog.  

   "Hide all session .edit windows":  Hides all session .edit windows for 
users who don't wish to use them.

   "Append ".txt" suffix to text window names":  Adds the standard ".txt" 
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suffix to text window name when the "Save text as..." dialog is used.  (This 
option does not apply to the "session.edit" windows.)

   "Quit automatically when all windows closed": Quit the application when 
there are no open windows.

   "Option-click sends cursor motion commands":  Allows you to switch between 
requiring a simple mouse Click and an Option-click to send cursor key 
movement commands in ASCII emulator windows.  Prior to 4.5.2, dataComet used 
a simple click; however, some host applications don't handle cursor key 
motion sequences properly, and in addition other Telnet applications require 
Option-click, so Option-click is now required by default.  (3270 emulator 
windows still position the cursor automatically with a simple mouse click.)

   "Don't constrain emulator window size":  Allows you to resize windows so 
they span across two monitors.  This is off by default so all window controls 
will always be accessible when a window size larger than the available screen 
area is selected.

   "Expire Kerberos tickets on Quit":  Expires Kerberos tickets created 
through a dataComet-Secure session automatically when you quit dataComet.  
This option enhances security, and is on by default.

   "Update all Finder -> dataComet document links automatically": When this 
option is enabled, all dataComet text documents and session documents in the 
Documents and Sessions folders will be updated automatically so they open the 
last-launched copy of dataComet when they are opened from the Finder or the 
Dock; this allows correct linking of dataComet documents with the dataComet 
application, even though Snow Leopard no longer associates application 
documents with applications according to the document Type and Creator codes.

   "Display an alert once when a new release is available": 
   "Display an alert once when a new Beta release is available":
These options allow you to disable dataComet update notifications.

   "Display bitmap fonts for selected fonts and sizes": When this option is 
enabled, dataComet will scan its list of fonts and sizes, and disable 
antialiasing for drawing when a match is found, so that a font can be drawn 
with a bitmap representation.

   "View Font List": Allows you to view and edit the list of fonts and sizes 
which are to be drawn with antialiasing disabled.

   "Use text cursor only":  If you disable this item a double underscore 
cursor is used to show the mouse cursor position within the active emulator 
window.
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   "Hide cursor in background windows":  The emulator cursor will be hidden 
if the emulator window is not in front.  

   "Copy screen if no selection":  If this option is on, a "Copy" command 
copies the whole emulator screen when there is no selection.  You can turn 
this off if you find you have a problem with inadvertently copying and 
pasting the screen when you try to make a selection first but fail to select 
anything.  (Note that this will affect the execution of dataComet Copy 
commands used in an AppleScript.) 

   "Update Scrap only on switch":  dataComet uses the TextEdit Scrap to 
contain the results of a Copy or Cut command, and updates the Application 
Scrap in parallel to ensure that extensions which rely on the Application 
Scrap will work correctly (e.g., QuickKeys & CopyPaste).  This option allows 
you to conserve memory by updating the Application Scrap only when leaving 
dataComet.

   "Reset emulator selection after Copy":  When this option is on, a Copy, 
Save, or Append command will reset the selection range to no selection, so 
the whole screen becomes the default selection range for the next Copy, Save, 
or Append.  If you want the selection to remain fixed on the screen so you 
can the same selection on successive screens, turn this off.

   "Clear scrollback buffers automatically":  This option allows you to free 
memory when it runs short by automatically clearing the scrollback buffers 
for emulator sessions which are currently in the background and not currently 
processing output; thus, if you alternate between several sessions configured 
with "unlimited" scrollback buffering, you won't need to repeatedly clear 
background buffers manually to allow fresh lines to scroll in the topmost 
window.

                   "File Transfer options":

   "Always do dialog to rename files":  Before transferring a file, dataComet 
will present a Standard File dialog allowing you to select (upload) or rename 
(download) the file.  This is off by default.

   "Archive overwritten files in ".back"":  This option automatically appends 
the contents of a file to "filename.back" before the download commences and 
overwrites the file.
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       ___________________________________________________

                    "Printing…"

         Using the "Printing" Preferences panel
       ___________________________________________________

   "Add page numbers at bottom of page":  Page numbers will be added. 

   "Print using Color map": allows color printing.  

   "Print lines scrolled off top":  All lines scrolled off the top or cleared 
will be printed (this duplicates the Menu item "Print lines off top").

   "Show "Print..." Dialog when printing host print streams": allows you to 
disable print dialogs when printing VT100 print streams.

   "Eject page when host turns off stream printing":  Some host applications 
repeatedly turn VT100 print streams on and off in the process of printing a 
page.  This option allows you to configure dataComet to handle this without 
starting a new page every time stream printing is turned off; note that when 
this option is enabled you may have to use the "Page Eject" command in the 
File menu to print out accumulated print data if the application fails to 
send a Form Feed.

   "Print scrolling region only": is a VT100 print option, usually selected 
by the host.

   "Screen Font": Allows you to set the font used for drawing on-screen from 
the dialog.

   "Print Font": Allows you to set the font used for printing from the 
dialog.

    "Size": These popup menus allow you to set the size of the font used for 
drawing on-screen or when printing.

   "Printing Margins":  These items allow you to set the margins (in 72nds/
inch) when printing.  
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       ___________________________________________________

                    "Session…"

         Using the "Session" Preferences panel
       ___________________________________________________

   This dialog allows you to control the configuration of the session which 
is currently on top.

   "Only one session per document":  Setting this option causes dataComet to 
leave the document file open, so that double-clicking on it will bring the 
old session to the foreground and re-open it if it has been closed, rather 
than opening a brand new session.  When this option is NOT selected dataComet 
closes the session document after getting the settings and macros from the 
document; in this case opening or double-clicking on the same document again 
will open a new, separate session window with the same host.

   "Connect automatically":  Open the connection automatically when the 
document is opened.

   "Open session without terminal type negotiation":  Some TCP/IP hosts 
(particularly terminal servers) may not negotiate terminal types correctly, 
or may not open a session by sending some data to dataComet; if this occurs, 
you cannot send keystrokes to the host, and the button bar is left grayed 
out.  Setting this option will allow you to send characters to such a host.

   "Require session close from host":  When this option is selected and the 
user attempts to close a session without logging out first, the user will be 
presented with an alert noting that the session must be closed from the host.  
Note that choosing the Window menu "Abort session" command will still abort a 
session without presenting the dialog.

   "Close window when session closes":  Will close the window and its 
corresponding document automatically when your session is closed or aborted.

   "Prompt before closing if session open": When this option is set, you will 
receive an alert requesting approval when you close the window and the 
session is still open.

   "Reopen session automatically on failure":  dataComet will try to re-open 
the session it automatically if it fails to open or is closed by an abnormal 
failure.

   "Miniaturize window on application switch":  When you switch from 
dataComet to another application the window will automatically shrink to a 
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small icon and expand after returning.  (See the "Miniaturize" menu command.)

   "Notify when new data arrives while in background":  Sets the dataComet 
icon to "bounce" when dataComet is in the background and new data arrives for 
the session.

   ____ "lines in scrollback buffer (zero = no limit)": allows you to set the 
maximum number of lines to save in the emulator screen scrollback buffer.  

   ____ "Tab threshold (zero = copy all spaces)": allows you to set the 
threshold for converting spaces into tabs when the Edit menu item "Table Mode 
for Copy and Save" is on.

   ____ "Session keepalive (in seconds, zero = off)": enables a session 
keepalive so that dataComet periodically sends a Telnet Timing Mark (or a 
NULL character for serial sessions) to the host.  This feature helps keep 
sessions from being terminated when connecting to hosts that have a session-
inactivity timeout.  NOTE that some hosts with obsolete TCP/IP software 
absolutely must have a keepalive set in order to maintain a session!  
However, ISPs strongly disapprove of the use of keepalives, so this option is 
off by default.

   "Prefer vertical cursor":  The emulator cursor will normally be displayed 
as a vertical bar, and will shift to block or underline when in Insert mode.  
Usually the reverse is the case, with the vertical cursor used to indicate 
that the emulator is in Insert mode.

   "Use block cursor":  Allows you to change the emulator cursor from an 
underline to a block.

   "Blink cursor":  Determines whether the cursor will blink or stay on 
continuously.

   "Don't Beep":  Turns off the terminal bell.

"Edit window" items for controlling transfers to the session's .edit window:

   "Delete Returns in session.edit automatically on download":  If you 
download a file with the same name as the session with ".edit" appended, it 
will be added to the session's .edit window; this option allows you to have 
the Carriage Returns at the end of each line stripped out automatically.

   "Add Returns to session.edit automatically on upload":  Like the above, 
except that Carriage Returns will be added automatically to the end of the 
lines where the text was wrapped in the .edit window.
________________________________________________________________
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            3.1. Dialogs

________________________________________________________________

      dataComet documentation.  (Rev. 2/20/2010) 
      Copyright 1995 databeast, Inc. All Rights Reserved.

   This document has information on (select and use "Find..." to go to the 
section):

         Using the "VT100" Preferences panel (ASCII)
         Using the "3270" Preferences panel (IBM 3270)
         Using the "Color" Preferences panel
         Using the "Keypad" Preferences panel
         Using the "Keypad" Preferences panel
         Using the "Views" Preferences panel

         Using the "Define macros" dialog...    see "4. Macros"

       ___________________________________________________

         Using the "VT100" Preferences panel (ASCII)
       ___________________________________________________

   This dialog allows you to control the configuration of the emulator for 
the session which is currently on top when it is an ASCII connection.

   "Host menus and function keys":   Allows you to select function key 
mappings.  The "IBM 3270" and "IBM 5250 (AS/400)" options allow you to 
connect to an IBM EBCDIC host indirectly using an ASCII emulator, for example 
using a modem or through a UNIX machine running tn3270, and get menus and key 
mappings which send the equivalents of IBM function keys.  A number of ASCII 
function key mappings are also provided for various ANSI/VT100 terminal 
variants; the names parallel the UNIX termcap or terminfo terminal entry 
names, e.g., "ncsa", "linux", "scoansi", "xterm", etc.

   "Return key sends:":, "Carriage Return":, "Line Feed":  If the box for CR 
is checked, return sends a CR; if the box for LF is checked, an LF will be 
sent.  If both are checked, CR-LF is sent.  (You can always send a Line Feed 
by pressing Control-Return.)

   "Map ` to Escape":  Applies to ASCII terminal emulation.  Maps the '`' key 
to the ESCAPE key.  (You can still send a '`' by pressing Control-'`'.)
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   "Map delete to Delete (v. BS)":  Applies to ASCII terminal emulation.  
Makes the key at the top right of the keyboard (variously labeled "Backspace" 
and "Delete") send a Delete character rather than a Backspace.  (You can 
still send a Backspace by pressing Control-Backspace.)

   "Option is Meta Key":  When the option key is down, metafy the character 
by sending an <ESCAPE> before sending the character.  This is usually used 
with EMACS.  The dataComet-Keyboard resource must be installed in the 
"Library/Keyboard Layouts/" file for this to work for all characters 
(otherwise E, I, N, U, and ` will misbehave, see the document "A3. dataComet 
Keyboard").

   "Send vi commands to position cursor":  Applies to ASCII terminal 
emulation when using the UNIX vi editor.  This mode allows the cursor to be 
positioned more accurately and also sends fewer characters. 

   "XOFF    Ctl-":   Host output is held soon after you input this character 
rather than waiting for the host to hold output.  "XON    Ctl-": works the 
same way for "resume output".  "KILL    Ctl-": currently is not used.

   "Size:  Rows": & "Columns":  You can use these fields to customize the 
size of the emulator.  NOTE that you will have to configure your host to 
recognize any size other than 24 rows X 80 columns if the host does not 
accept Telnet window size negotiations.  Only emulator sizes with less than 
256 rows and total are less than 32000 characters are valid.

   "Answerback:":  The answerback message dataComet sends back to the host 
when it receives a Control-E from the host.

   "Do CR-LF when LF received (newline mode)":  Interpret linefeed characters 
sent from the host as newlines (carriage return-linefeeds).

   "Do CR-LF when CR received":  Add a linefeed character when a CR is 
received from the host.

   "Wrap text when line overflows":  Causes characters past the right margin 
to wrap down to a new line rather than being ignored.

   "VT100-wrap (wrap at column 81)":  Allows you to disable the VT100 
"feature" (designated in termcap entries with "xn" for "Xanthippe glitch") 
which makes the cursor wait to wrap at the end-of-line (so if a character is 
placed in column 80, and then a linefeed character is received, only one 
linefeed is performed).

   "Backspace wraps":  Allows the cursor to wrap back to the end of the 
previous line when a BS is received.  This is not standard VT100 behavior, 
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but works well when entering long command lines in UNIX.

   "Use VT100 jump scrolling mode":  Configures the ASCII emulators so that 
they will not update the screen immediately when the cursor goes above or 
below the scrolling area, but will wait until all the data from the host has 
been processed.  This can speed up the display with some applications, since 
scrolling takes a lot of time.

   "Do blink":  You can use this for special cases in which you wish to 
disable the "Blink" attribute in a VT100 display.

   "Do underscore":  You can use this for special cases in which you wish to 
disable the "Underscore" attribute in a VT100 display.

   "Log Erase":  Logs lines which are partially erased in the scrollback 
buffer and session log.

   "Update display promptly on clear":  When this option is set, dataComet 
displays all data before it is cleared.  Otherwise, it delays drawing until 
all processing of current host data is complete.

   "Display full Apple character set":  Sets the VT100 class emulators to 
display characters from 128 through 159 rather than interpreting them as 8-
bit control codes--as they are in standard ANSI/VT220 terminals.  (This 
option is useful for displaying Mac OS X host characters more faithfully.)

   "Paste Pacing": options allow you to configure ASCII pastes to work 
reliably with your host in cases where the host is slow.  If "Wait for 
character echo": is set, dataComet will wait for each character sent to be 
echoed before sending the next character.  If you set "ticks/line":, 
dataComet will pause for that number of ticks (1/60ths of a second) before 
sending the next line; "ticks/char": pauses for the given number of ticks for 
each character.

       ___________________________________________________

         Using the "3270" Preferences panel (IBM 3270)
       ___________________________________________________

   This dialog allows you to control the configuration of the session which 
is currently on top when the connection is made using the 3270 emulator.

   "IBM Terminal Type":  "IBM 3270-2 (24 X 80)":, "IBM 3270-3 (32 X 80)":, 
"IBM 3270-4 (43 X 80)":, "IBM 3270-5 (27 X 132)":, "IBM 3270 Custom":  Allows 
you to set screen sizes other than the standard 24 row by 80 column display, 
using the "Size:      Rows": and ... .  NOTE that not all applications will 
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use the larger display area.

   "Use Extended Base Colors for 3279":  Turns on Base Color mode for mapping 
attributes to color when the 3279 color emulator is used, so Intense 
characters are Red and Protected characters are Blue.

   "Use IBM 5250 menus and function keys":  Modifies menus and PF key 
mappings so you can easily use commands available on IBM AS/400 5250 terminal 
sessions, using the default host 3270 PF key mappings for 3270 <-> 5250 
emulation.

   "Disable fallback to 24 X 80 screen":  Allows you to disable host-selected 
fallback to the 24 X 80 default screen size from larger screen sizes, 
preserving the contents of the scrollback buffer in cases where the default 
screen size is only temporarily reset and not actually used.

   "Typeahead: allow input when System Busy":  The Typeahead option allows 
you to set the emulator so it will discard all input when the SYS (system 
lock) light is on, as would a genuine IBM 3270 display.  Thus, if typeahead 
is turned off, for a moment after the Enter key or a PF key is pressed, no 
input will be accepted from the keyboard, and all pending keyboard events 
will be discarded.  If typeahead is on, keyboard input will be discarded only 
in the event of a "keyboard lock" condition, signified by the KBD light on 
the right of the screen, or if an error occurs in processing a command.  
(Note that when the Keyboard lock condition occurs, it can be cleared by 
either pushing the Reset button or executing the Reset menu command.)

   The IBM 3270 video display terminal distinguishes between null characters 
and spaces, yet displays both as blank spaces.  Because this distinction 
fails to deliver "what you see is what you get," we have two options for 
handling nulls:

   "Send Imbedded 3270 Nulls as Blanks":  Causes the emulator to substitute 
blanks for nulls which are in the middle of text within a field.

   "Squeeze out blanks at end of field in Insert mode":  Causes blanks to be 
treated like nulls so that blanks at the end of a field will be deleted as 
you insert text in the middle of the field.

   "Shift whole field when deleting characters":  Causes the whole field, 
rather than just the portion of the field on the current line, to shift to 
the left when a character is deleted.

   "Use starting cursor position as margin when pasting":  Causes pastes to 
move the cursor back to the original starting column on the next row rather 
than to the beginning of the next row.
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   "Erase EOF when pasting to clear previous contents":  Clears the remainder 
of the current field before moving to the next line.

       ___________________________________________________

                    "Color"

         Using the "Color" Preferences panel
       ___________________________________________________

   The "Color" Preferences panel allows you to turn color mapping on and off 
and set the color map for a session.  The VT100 and 3270 emulators allow you 
to associate character attributes (such as "bold font") with different 
foreground and background colors; you can also select the button "Host 
Selects Colors" with VT220 and PC-ANSI mode to use host ANSI color sequences 
to set the color independently of other character attributes and map bold 
characters to the Intense color to display 16-color PC-ANSI screens.  (Note 
that you may need to do a screen refresh to see the correct color mapping on 
a screen.)

   Clicking on a color brings up the standard Macintosh "Choose Color" 
dialog.  Note that dataComet does not modify the Macintosh Color Palette, so 
the appearance of a color on the display may differ from the field displayed 
in the "Choose Color" dialog if you are only displaying 16 colors on your 
monitor.  This is set in the Monitors Preferences Panel; this provides few 
colors into which to map your color choice in the Color Dialog into the 
existing 16 color Pallette.  (Not modifying the Palette avoids nasty changes 
in the appearance of other applications when the Palette is changed.)

   To simplify copying color settings from one session to another, you can 
Copy the settings displayed for one Color dialog and Paste them into the 
Color dialog for another session.

   "Color mapping on":  Use colors rather than black and white when 
displaying an emulator screen.

   "Background Color Erase":  On by default, so that the currently selected 
background color fills areas which are erased.  Some applications may work 
better with this option off.

   "Host selects colors":  Let color control sequences received from the host 
determine the color used for characters in the emulator screen rather than 
selecting colors based on character attributes.

   "… except Background":  Lets you select background colors yourself, even 
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when Host selects colors is enabled.

   "Use 16 colors":  Allows you to select 16-color colormaps for the VTxxx 
terminals.  NOTE that this disables support for double-high and double-wide 
characters.

   "Show Extended map":  Displays and allows you to modify the extended color 
range for host-selected PC-ANSI highlighted characters, and to modify the 
color mapping for Underlined attributes for VT100 attribute mapping.

   "Default Colors":  Resets the current color map to the default map for the 
selected terminal type and setting for "Host selects colors".  (Holding the 
Shift key down while pressing this button lets you select the default 16-
color PC-ANSI map when VT100 or VT220 emulation has been selected, or normal 
8-color mapping when PC-ANSI emulation has been selected.)

       ___________________________________________________

                    "Keypad…"

         Using the "Keypad" Preferences panel
       ___________________________________________________

             "Set VT100/VT220 Keypad:" options:

   "Automatic":  The VT100 keypad configuration is controlled by the host 
application.  Host application control sequences to change the keypad 
functions are ignored if the following options are used:

   "Calculator":  The keypad sends the characters associated with the labels 
in the "Set Keypad..." drawing, allowing you to exit PF key modes and send 
numeric keys.  The arrow keys use the standard codes.

   "Calculator-Alternate":  The keypad sends numeric keys; the arrow keys 
send the special PF-Application arrow key codes so they will work correctly 
with applications which expect them. 

   "PF-Application":  The keypad sends the VT100 codes associated with the 
Keypad Application mode.  The arrow keys send special PF-Application codes.

   "PF-Alternate":  The keypad sends the VT100 codes associated with the 
Keypad Alternate Application mode, but the arrow keys use the standard codes.

   "VT220 named FKeys sent without Shift key down":  Usually the six function 
keys in the middle of the keyboard perform local Macintosh functions, and you 
need to hold down the Shift key to send the VT220 FKeys which are associated 
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with these keys.  This option swaps these functions, so that Shift is 
required instead to perform the local Macintosh functions.

                  3270 keypad options:

   The "Function 1", "Function 2", and "Function 3" keyboards provide 
convenient alternative keymappings for the keypad for interacting with IBM 
hosts.

                  Shared options:

   "Switch Standard keyboard +/- keys to match picture":  The Macintosh 
Standard and Extended keyboards have the '+' and '-' keys swapped.  This 
setting allows you to remap the two keys so they're swapped back, producing 
the PF and other keys as they appear in the "Set Keypad..." pictures.

       ___________________________________________________

                    "Views…"

         Using the "Views" Preferences dialog
       ___________________________________________________

   "Show buttons at top of window":  Show the buttons at the top of a session 
window.  You can set these buttons to execute macros by using Command-Click 
to bring up the "Define Macros" dialog.

    "Show status bar at top of window":  Show button controls and session 
status indication at the top of an emulator window.    You can set these the 
button controls by using Command-Click to bring up the "Define Macros" 
dialog.

  "Show packets sent counter":  Show the number of packets sent to the host.

   "Show packets received counter":  Show the number of packets received from 
the host.  

   "Show session timer at top of window":  Maintain a session timer.  This 
timer can be reset to zero using the '!Cr' macro.

   "Show cursor-buttons at left of window":  Displays numbers corresponding 
to a macro (the list is displayed by holding down the '?'/'M' indicator at 
the top left of an emulator window; this is visible when "Show status bar at 
top of window" is enabled).  Clicking when the number is displayed will 
execute that macro (or a default function key).  You can set these macros by 
using Command-Click to bring up the "Define Macros" dialog.
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   "Show horizontal scrollbar at bottom of window":  Allows you to hide the 
horizontal scrollbar at the bottom of an emulator window.

   "Show cursor position":  Displays the emulator cursor position in the 
horizontal scrollbar display area (row followed by column number).

   "Use Mouse position":  When "Show cursor position" is enabled, this option 
allows you to display the emulator row and column position to which the mouse 
cursor points.

________________________________________________________________

dataComet-Secure Online Documentation - Author: Bonze Anne Rose Blayk 97/231



            4. Macros

________________________________________________________________

      dataComet documentation.  (Rev. 6/15/10) 
      Copyright 1995 databeast, Inc. All Rights Reserved.

   This document has information on (select and use "Find…" to go to the 
section):

         Using Macros
         Using the Macro menu (see 2. Menus)
         Using the "Define Macros…" dialog
            Entering text and macro commands
            Entering Escape and other ASCII control characters

               Macro commands

         Moving the Host Cursor
         Finding a string or setting the selection
         Sending Function keys
         Controlling the emulator
            Display Literal mode
            Selecting National Character Sets
         Keymap command
         Menu commands
         File and Print commands
         File Transfer commands
         Edit commands
         Window selection and output redirection commands
         Telnet commands
         Scripting commands
            Delay
            Loop
            Loop break
            Query the user to enter a string
            Inform the user using the prompt line or an alert
            Match String
            Match case
            Triggers
            Scripted login example with user prompt for password
         Menu numbers (table)
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      ___________________________________________________

         Using Macros
      ___________________________________________________

   dataComet allows you to record macros to perform functions such as moving 
the cursor, making a selection, or appending the selection to a file.  
Dialogs in the Macro menu allow you to paste in or enter a sequence of macro 
commands; macros can also be entered and executed in the .edit window.  
Pressing the "Shift-Enter" key while an edit window is the frontmost window 
causes the current line or selection to be executed as a macro (pressing the 
Enter key alone sends the selection as plain text).  

   You can execute the examples below in the frontmost emulator session by 
selecting them and pressing "Shift-Enter".

   There are many other ways in which you can trigger dataComet macros:

      *  With key-combinations you enter on the keyboard (such as  
         Control Option A, set using "Define macros…" in the  
         Macro menu);

      *  With a mouse single- or double-click (set using "Set   
         single-click macro…" or "Set double-click macro…");  

      *  You can also define a macro to execute when a connection 
         with a host is complete ("Set Connection macro…") or when 
         the user closes the connection ("Set Close macro…");   

      *  You can define macros as menu items in the "Macro" menu.

      *  Command-clicking on button controls brings up a dialog  
         which allows you to rename the control and set it to  
         execute a macro when clicked.

   The Key Macro on/off switch is in the Macro menu; when macros are on, an M 
appears in a box on the top left hand side of the screen.  When a key macro 
is currently executing, the M appears in reverse video; the reverse M also 
appears if keystrokes are pending execution in the key queue.  If you wish to 
cancel the execution of a macro or pending keystrokes, use Command-'.'.
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      ___________________________________________________

                    Macros…

         Using the "Define Macros…" dialog
      ___________________________________________________

   When the dialog for entering key macros comes up, you have three options:  
select a key by pressing it, select a macro button or menu by command-
clicking on it, or show a list of macros currently associated with keys and 
buttons.  

   "Press the key-combination you want to remap…":  When this prompt appears, 
you can press a key-combination (or command-click on a button or menu macro); 
the dialog will show you the name of the key, and will allow you to enter 
actions (text and commands) you want the key-combination to produce.  If 
there is a key macro associated with that key, the actions associated with 
the key will be displayed, and the Delete button will be enabled.  

   Note that holding down the mouse button when you press the key-combination 
will identify the key as an "Alt-key," and such a macro will only be matched 
if the "ALT" state is set using the "!CA" command documented below (this 
allows you to switch keyboard configurations with a keystroke, and is used 
with library keymapping).  When the "ALT" state is on, the boxed "M" which 
shows that key macros are on changes to an "m". 

   There are several check boxes in the dialog:

   "Global":  This check box shows whether a key macro is a global macro 
which can be used by all sessions (saved in the "Comet Default" document).  
Setting it on allows you to set a key macro as a global macro.

   "Ignore Caps Lock":  Ignore the caps lock key when matching key macros.  

   "Use Command Font":  Use the "Comet Chicago" font, which displays common 
macro commands as buttons.  If this option is off, the frontmost window's 
font is used.  If you want to enter international characters, this option 
needs to be off.

   You can modify the macro text by entering new text or using copy and paste 
with the Command-C and Command-V keys.  Command-. cancels your modifications 
to the key macro.  When you are finished, you must press the Set button if 
you want the changes to take effect. The program will then alert you if your 
entry has errors in the length of the codes.  (PLEASE NOTE that the codes are 
not checked for validity until you execute a key macro by typing the key when 
you have quit the dialog and Key Macros are set on!  Alerts will then inform 
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you of any errors.)   If there is no error, the macros are updated 
immediately; there is no need to save the configuration to save the key 
macros in the document.  If you decide not to change the text, you should 
press the Cancel button.  You can then quit if you wish, or add, remove, or 
modify other keys.

            Entering text and macro commands

   Text which you enter in the key macro window can be interpreted as either 
plain text or commands.  Individual characters stand for themselves--except 
for '!' & '\', which can be entered by using '!!' and '\\'.  These two 
characters are special:  '!' is used to introduce a command; '\' is used to 
enter a number, specified using three decimal digits, such as "\010".   This 
numeric entry can be used either in place of a character, or to enter a 
decimal numeric value.  

   Ordinary text can be entered directly in the text-editing field of the 
dialog.  Commands are entered as a '!' (exclamation point) followed by a pair 
of characters; the first character selects a class of action, and the second 
the particular type of this action.   In IBM mode, the macro dialogs present 
buttons to perform input of all the IBM function keys.  (PLEASE NOTE that 
dataComet does not automatically map the Return key to produce an "Enter," so 
you need to press the "Enter" button to send an Enter command to the host 
using a macro.)

            Entering Escape and other ASCII control characters

   ASCII control characters can be entered by pressing the Control key and 
the character ('a' through 'z', Space, '[', ']', '\', '@', '^', '_', or '?').  
Note that you can enter the Escape control character (which sometimes appears 
in host application documentation as "^[" or <ESC>) by pressing the "esc" key 
or Control-[.

   The action classes and associated characters available in both ASCII and 
the "IBM Keymapping" modes are as follows:  
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      ___________________________________________________

         Moving the Host Cursor
      ___________________________________________________

   Move to X-coordinate:  (X) followed by a decimal number specifying the 
column number (0-255).

      !X\000

   Move to Y-coordinate:  (Y) followed by a decimal number specifying the row 
number (0-32).  The Y command always positions the cursor in column 0.

      !Y\000
      !Y\002!X\049  position the cursor on 50th column of the 3rd line

   Move the cursor:  (M), and a code:

      !ML   Move the cursor to the left;
      !MD   Move the cursor down;
      !MU   Move the cursor up;
      !MR   Move the cursor right.

   The IBM 3270 also supports:

      !M0   Move the cursor home;
      !M<   Move the cursor backwards one field;
      !M>   Move the cursor forward one field;
      !MN   Do a Newline.

      ___________________________________________________

         Finding a string or setting the selection
      ___________________________________________________

   Search forward or backward for a string:  ('!/>' or '!/<'), followed by a 
string terminated with another macro or null ASCII character.  

      !/>make!D\001

   To make a selection:  you must use four commands to set a selection range, 
each of which uses a number to specify the position on the screen numbered 
from 0; when all four codes have been received, the selection will be made.  
(Note also the "!Ea" macro above which selects the current screen only, and 
"!EA" which selects the screen and the entire scrollback buffer.)
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      !S\000   selection start Y position, followed by the position 
               number;
      !T\000   selection start X position, followed by the position 
               number; 
      !U\023   selection end Y position, followed by the position 
               number;
      !V\080   selection end X position, followed by the position 
               number.

      !S\000!T\000!U\002!V\080

   Shift selection left:  (<) followed by the number of spaces to shift the 
selection.

      !<\005

   Shift selection right:  (>) followed by the number of spaces to shift the 
selection.

      !>\080

   Set selection length:  (#) followed by the new length.

      !#\004

      ___________________________________________________

         Sending Function keys
      ___________________________________________________

      !P\001 through !P\036 map to PF keys 1 through 36 for both ASCII and 
IBM emulations.

   Send VT220 keys:

      !P\128      Find
      !P\129      Insert
      !P\130      Remove
      !P\131      Select
      !P\132      Previous Screen
      !P\133      Next Screen
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   Send 3270 PF action keys:

      !P\000      Sys Request
      !P1         PA1
      !P2         PA2
      !P3         PA3
      !PC         Clear
      !PE         Enter

   Send 3270 local keys:

      !A          Backspace blank (that's a space there!)
      !AB         Backspace delete
      !AD         Delete character to right (x->)
      !AE         Erase to end of field
      !AI         Toggle insert mode
      !AR         Reset
      !AS         Light pen select at the mouse position 
      !As         Light pen select at the cursor position

      !AX         Erase Input

      !AA         Display attribute bytes
      !AC         Toggle Base Color attribute mapping

   Setting 3270 extended attributes:

      !aZ         Reset the color attribute to the default color
      !aR         Red
      !aG         Green
      !aY         Yellow
      !aB         Blue
      !aP         Pink
      !aT         Turquoise
      !aW         White

      !aX         Reset the character attribute to the default
      !aA         Blink
      !aS         Reverse
      !aD         Underline

         If a selection has been made, the selection is set;
         otherwise succeeding characters are set to the attribute.
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      ___________________________________________________

         Controlling the emulator
      ___________________________________________________

   Perform an emulator action:  (C) followed by a code:

      !CA   Set the ALT (mousedown state) modifier bit for all 
            keypresses.  This allows you to have an Alternate macro 
            set.
      !Ca   Set ALT off.
      !CB   Hide the Desktop from the user (for kiosk security).
      !CC   Close the session without a dialog.
      !CE   Show the .edit window.
      !Ce   Show the terminal emulator window.
      !CD   Show MacTCP smoothed round-trip time and time-out
            in the upper right corner of the screen.
      !Cd   Show MacTCP packets sent and received in the upper 
            right corner of the screen.  This is the default.
            The send counter becomes inverted when a resend
            is performed.
      !CF   Close the copyright/help textwindow.
      !CH   Don't update the display.
      !CS   Update the display as usual.
      !Cs   Display the mouse cursor position in the emulator window 
            status bar.
      !CI   Draw each character promptly as it is processed (ASCII 
            only).
      !Ci   Wait to update the screen:  draw characters en masse.
      !CM   Set the top bit (meta-bit) of the next ASCII character. 
      !CN   Makes a bell sound and sets the Apple Task menu to 
            flash if dataComet is in the background. 
      !Cp   Set an IBM PF key to page when pasting text (default 
            is Enter). 
      !CR   Restore line 25.
      !CT   Turn on cursor positioning using the mouse.
      !Ct   Turn off cursor positioning.
      !CUstring\000
            Interpret a string as a URL and open it.
      !CV   Turn on VT100 auto-print (i.e., print line on 
            CR, LF, FF).
      !Cv   Turn off VT100 auto-print.
      !CZ   Toggle fast drawing mode (useful for library data entry 
            checking).
      !C>string\000
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            send a string, usually a VT100 parameter, directly 
            to the emulator.

      Display Literal mode

      !CL   Display all characters sent and received as literals 
            in the .edit window.  In IBM mode, the streams are 
            presented in an intelligible format; ASCII mode is 
            presented raw.  This mode is very useful for debugging 
            or analyzing host application output to the emulator.
      !Cl   Display Telnet layer transmissions also.

      Selecting National Character Sets

   For VT100 emulators you can select a National Character Set which is 
mapped into ISO-Latin-1, or the Macintosh character set if a "Control 
Translation" menu mapping is selected (for this mapping to work correctly, 
you must select a Macintosh font such as Monaco).  

   The '!N\000' and '!n\000' macros set the G0 and G1 fonts, respectively.  
The character sets are selected using a numeric argument:

           \000  US-ASCII
           \001  ISO-Latin 1
           \002  British
           \003  Dutch
           \004  Finnish
           \005  French
           \006  French Canadian
           \007  German
           \008  Italian
           \009  Norwegian/Danish
           \010  Spanish
           \011  Swedish
           \012  Swiss
           \013  Portugese
           \014  DEC Supplementary
           \128  VT Graphic Symbols
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      ___________________________________________________

         Keymap command
      ___________________________________________________

      !K\nnn   Select the keymap (000-nnn).

           \000  Automatic
           \001  IBM 3270
           \002  IBM 5250 (AS/400)
           \003  ncsa (NCSA Telnet)
           \004  linux
           \005  scoansi
           \006  xterm / VT420f
           \007  386at (Intel SysV)
           \008  wyse-60
           \009  UNIX tn3270

      ___________________________________________________

         Menu commands
      ___________________________________________________

   Macros from !\000 to !\031 correspond to the menu items from left to 
right, with the items numbered from 1 (i.e., "!\<3-digit menunum>\<3-digit 
itemnum>").  Adding 64 to the item number sets the shift key for the menu 
item execution; adding 128 to the item number sets the Option key for the 
menu item execution; adding 160 to the item number sets the Shift-Option keys 
for the menu item execution; adding 192 to the item number disables it.  
(Macro recording provides an easy way to get an item's macro equivalent, 
since menu items selected are included in the macro.)  Menu number 31 
corresponds to the Finder menu at the far right (these items can only be 
disabled, not executed).

      !\001\001   Execute the "File New" menu item to open a new 
                  session.  
      !\001\065   Execute the "File New" menu item to open a new 
                  text document.  
      !\001\129   Disable the "File New" menu item.
      !\031\192   Disable the Finder menu.
      !\031\193   Disable the "Hide Comet" Finder menu item.

   See "Menu numbers (table)" below for a complete list of the available 
menus.
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      ___________________________________________________

         File and Print commands
      ___________________________________________________

   Perform a file action:  (F) followed by a code:

      !FA   Append the selection to a file.
      !FB   Append the selection to a file selected through a
            Standard Put File dialog.
      !FD   Print the window selection using dataComet's serial
            print routine.
      !Fd   Perform a print page eject.
      !FF   Bring the Finder or application launchpad to the
            front, closing sessions which are not configured
            to stay open on Mandarin sleep events.
      !Ff   Bring the Finder or application launchpad to the
            front without closing any sessions.
      !FP   Print the emulator screen using Apple's standard Print 
            Manager routines.
      !Fp   Print the .edit window.
      !Fq   Print selection in the .edit window.
      !FS   Save the selection in a file; if a file has not been 
            opened, a Put File dialog will be performed.
      !FT   Save the selection in a file; always present the Put 
            File dialog.
      !FV   Toggle VT100 auto-print mode (the "Local Print" key).
      !Fv   Set VT100 auto-print off.

            Opening Documents and Sessions:

      Note that the following commands for opening files need to have path 
names specified with colons ':' rather than slashes '/':

      !FOfilename\000
            Open a document by name relative to dataComet's home 
                         application folder, e.g.,

               !FO::Resources:Help:0.1. Shortcuts\000

      !Fofilename\000    Open relative to the dataComet/ folder (in 
                         the user's ~/Documents/ folder)
      !FWfilename\000    Open relative to the home Documents folder
      !Fwfilename\000    Open relative to the dataComet/Documents/ 
                         folder
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      !FXfilename\000    Open relative to the home Sessions folder
      !Fxfilename\000    Open relative to the dataComet/Sessions/ 
                         folder

      ___________________________________________________

         File Transfer commands
      ___________________________________________________

   The following commands work with IND$FILE and X-, Y-, and Z-Modem.

   Perform a file transfer action:  (f) followed by a code:

      !fUfilename\000
            Upload a file using the default serial transfer method.
            When using IBM IND$FILE, this sets the local file name;
               the appropriate local option settings (below) and 
               text of the IND$FILE command specifying the host 
               file name and host options should follow (with an 
               ENTER command to execute it).

      !fFfoldername
            Set the download folder, e.g.,

               !fF:Downloads:\000

            IND$FILE options:
        
      !fA   ASCII mode.
      !fa   Binary mode.
      !fC   CR/LF translation.
      !fc   No CR/LF translation.
      !fP   Protect local file.
      !fp   Don't protect local file.
      !f+   Append to local file.
      !f-   Overwrite local file.
        
            Dump/Trace options:
        
      !fT   Trace packets.
      !ft   Don't trace packets.
      !fD   Dump packets.
      !fd   Don't dump packets.
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      ___________________________________________________

         Edit commands
      ___________________________________________________

   Perform an editing action:  (E) followed by a code:

      !ES   Use the standard text mode when copying the selection.
      !ET   Use the Table mode when copying the selection.

      !EA   Select the whole screen buffer or text.
      !Ea   Select the current emulator screen.
      !EL   Select the line where the mouse cursor is located.
      !El   Select the line where the emulator cursor is located.
      !EW   Select the word where the mouse cursor is located 
            (the default double-click action).
      !Ew   Select the word where the emulator cursor is located 

      !EB   Append the selection to the session's .edit window.
      !Eb   Append the selection to the session's .edit window 
            without returns.
      !EC   Copy  the selection to the Clipboard.
      !Ec   Copy  the selection to the Clipboard without returns.

      !EM   Execute the selection range from the .edit window.
      !Em   Send the selection range from the .edit window to the 
            host.
      !EX   Cut the selection range (works only with the .edit 
            window).
      !Ex   Clear the Clipboard.
      !EV   Paste the selection into the emulator  screen or 
            the .edit window.

      !B\000   Append the emulator screen to the logs & scrollback 
               buffer.
      !B\nnn   Append a line (001-nnn) to the logs & scrollback 
               buffer.
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      ___________________________________________________

         Window selection and output redirection commands
      ___________________________________________________

   Bring a window to the front (w) followed by the number associated with it 
in the Window menu:

      !w\001

   Perform a window action (W) followed by a code:

      !WSwindowname\000   
            Bring a window to the front; WS followed by the       
            window name and terminated with another macro or null 
            ASCII character.

      !W>windowname\000      
            Make a window the output window, so that typed 
            characters, PF keys, macro characters, and pastes 
            will appear in the named window.

      !W>\000      
   
            Make the emulator window the output window, so that 
            typed characters, PF keys, macro characters, and pastes 
            will appear in the emulator window, even though the 
            .edit window is on top.

      !W}   Reset the output window to the standard output.

            NOTE: All keys and macros are routed to a session's 
            .edit window if it is the front window.

      ___________________________________________________

            Telnet commands
      ___________________________________________________

      !tA   send Are You There;
      !tB   send Telnet Break.
      !tC   send Interrupt;
      !tU   send Abort;
      !tx   send Erase Character;
      !tX   send Erase Line.
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      !ta   Type IP address at cursor.

      !tM   disable Return key remapping
      !tm   allow Return key remapping (i.e., the following items)
      !tR   Return sends Carriage Return
      !tr   Return does not send Carriage Return
      !tL   Return sends Line Feed
      !tl   Return does not send Line Feed
      !tN   VT100 newline mode on
      !tn   VT100 newline mode off

      !tu   Type username at cursor
            The username set in the "Reconfigure Session…" 
            dialog can be sent to the host using this command.

      ___________________________________________________

         Scripting commands
      ___________________________________________________

   Record user input as macro commands:  (R) followed by a code:

      !RB   begin recording;
      !RE   end recording and place the recording in the scrap for
            pasting into the .edit window or key macro dialog.

   Delay:  (D) followed by the number of seconds to wait specified as \nnn, 
e.g. "!D\001".

   Delay Ticks:  (d) followed by the number of ticks (1/60 seconds) to wait 
specified as \nnn, e.g. "!d\001".

   Loop:  (L) followed by the number of times to repeat the sequence of macro 
commands which follows; this sequence must be terminated by an entry 
containing "!L\000" (loop zero).  Using '\255' for the count will cause the 
loop to continue until the Command-. "cancel" key is pressed.

      !L\001echo hello !L\000

   Loop break:  (l) followed by a level, \001 or \002.  

      !l\001   break out of a match case.
      !l\002   break out of a match case and any enclosing Loop.
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   Query the user to enter a string:  (Q) followed by P, followed by the 
prompt, followed by a "!Q". macro command to terminate the prompt string.  
The user's response will be sent out to the host.  To enter a password, use 
"!QS" to replace the characters with dots.  Both the query and the response 
must be under 256 characters.

       !QPEnter ID:!QQ

   Inform the user using the prompt line or an alert:  (q) followed by 'a' if 
you wish an alert, or 'b' if you want to sound the bell; otherwise the prompt 
line in the button bar is set.

       !qaThis is an alert!!\000

          or

       !qb!qzThis is a 25th line prompt!!\000

          or, finally

       !qz\000

will clear the prompt line.

   Match String:  Delay session macro processing until host output matches 
string:  (Z) followed by a number indicating the number of seconds to wait 
before aborting; if the number is '\255', it waits forever if the string is 
not matched.  This entry is followed by a list of characters to match, 
terminated by any non-character macro command (usually a Delay entry).  (See 
"Scripted login example" below for an example of how you can use this macro 
command.)

   Match case:  Execute a macro when host output matches a string:  (z) 
followed by a number indicating the number of seconds to wait before aborting 
(if the number is '\255', it continues waiting until a "!l\001" breaks out of 
the match case loop or a "!l\002" breaks out of a repeat loop containing the 
match case macro; Note:  match case macros cannot contain a loop), AND THEN 
followed by a string terminated by a macro, ANOTHER !z\000 (the numeric 
argument is ignored for following cases), string, macro, ..., TERMINATED by 
a !Z\000.  Processing of macro commands on the macro queue and new keystrokes 
is delayed until the match is found.

   Triggers:  If you use "!Z\001", the match case macro is interpreted as a 
trigger, and the processing of macro commands and new keystrokes continues 
while the match case waits for matches and handles them.  
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   Here's an example of a match case macro:

sleep 1; cat shoplist
!z\030dog!D\000echo food >> shopitems
!z\255kitty!D\000echo litter >> shopitems
!z\255frog!D\000echo flies >> shopitems
echo End of list >> shopitems
!l\001!Z\000

produces

   litter
   food
   litter
   litter
   food
   flies

when shoplist is a file containing

   dog kitty kitty dog frog kitty dog

Note that matching "flies" breaks out of the loop, and that the "cat" in "cat 
shoplist" is also matched!

      ___________________________________________________

            Scripted login example with user prompt for password:

!Z\030login:!D\000myloginname!Z\030password:!D\000!QSEnter password:!QQ

            Scripted login example with user prompts for userid and password:

!Z\030login:!D\000!QPEnter User ID:!QQ!Z\030password:!D\000!QSEnter 
password:!QQ

            Scripted login example with userid and password from 
configuration:

!Z\030ogin:!D\000!tu\013!Z\030assword:!D\000!tp\013
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      ___________________________________________________

         Menu numbers (table)

         A list of the menu numbers which are used in macros 
              to select (or disable) menu items.  
      ___________________________________________________

         Menu #   Name                     Submenu <- of ...
     
           \000   dataComet-Secure
           \001   File
           \002   Edit
           \003   Window
           \004   Control
           \005   Macros
           \006   Telnet
           \007   Serial
           \008   ASCII
           \009   Transfer <-               File
           \010   IBM
           \011   3270
           \012   Help
           \013   Cursor <-                 Edit
           \014   Send Telnet Command <-    Telnet
           \015   Font <-                   Control
           \016   Size <-                   Control
           \017   Leading <-                Control
           \018   Width <-                  Control
           \019   Bold Font <-              Control
           \020   Control Font <-           Control
           \021   Translation <-            Control
           \022   National <-               Control
           \023   Sessions <-               File
           \024   5250
           \025   Documents <-              File
           \026   Set Attributes <-         IBM
           \027   SSH
           \028   New <-                    File
      ___________________________________________________

________________________________________________________________
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            4.1. macrocodes.h

________________________________________________________________

      dataComet documentation.  (Rev. 7/5/2010) 
      Copyright 2010 databeast, Inc. All Rights Reserved.

/*
This include file defines the internal result codes used in translating
user events into actions for the terminal emulator.  Each result code
is two bytes long, the first byte is the class type, and the second
is an entry id for that type. 

*/

/* token classes */

#define RSLT_MENUCLASS   0x1F    /* reserve up to RSLT_ASCI for menus */

#define RSLT_DISABLE     '-'     /* disable a token class, "--" indicates capability 
                                    string follows */

#define RSLT_COMMENT     '"'     /* '!"\nnn' used for placing a comment in a macro,  
                                    terminated by \000  */

#define RSLT_ASCI        ' '     /*  ascii character */
#define RSLT_ASCI_TRANS  '@'     /* '@' ascii character, translated before adding to  
                                    the macro queue */
#define RSLT_LCAC        'A'     /*  IBM local action key */
#define RSLT_SETATTR     'a'     /* 'a' IBM set attributes */
#define RSLT_BUFFER      'B'     /* 'B' append to log, edit, screen buffer */
#define RSLT_EMC         'C'     /*  emulator control */
#define RSLT_DELAY       'D'     /* 'D' delay */
#define RSLT_DELAYTICKS  'd'     /* 'd' ticks delay */
#define RSLT_EDIT        'E'     /* 'E' EDIT action */
#define RSLT_FILE        'F'     /* 'F' FILE action */
#define RSLT_FILETRANS   'f'     /* 'f' FILE Transfer action */
#define RSLT_VARSET      'G' /* 'G' "Get" variable -- set $\nnn from macro string  
                                    -- "!$\nnn" puts */
#define RSLT_VARCOPY     'g' /* 'g' "Get" variable -- set $\nnn from selection --  
                                    "!$\nnn" puts */
   /* H, I, J */

#define RSLT_LOOP        'L'     /* 'L' LOOP with count argument */
#define RSLT_LOOPBREAK   'l'     /* 'l' LOOP BREAK with level argument */
#define RSLT_KEYMAP      'K'     /* 'k' select keymap # */
#define RSLT_MVCR        'M'     /* 'M' IBM cursor movement key */
#define RSLT_MENUNAME    'm'     /* 'm' execute named menu item in menu \nnn */

dataComet-Secure Online Documentation - Author: Bonze Anne Rose Blayk 116/231



#define RSLT_VTG0        'N'     /* 'N' set (national) char set */
#define RSLT_VTG1        'n'     /* 'n' set (national) char set */

/* O */

#define RSLT_PFKY        'P'     /* 'P' IBM program function key */
#define RSLT_PROCESS     'p'     /* 'p' actions on CSV variables/row selections */
#define RSLT_QUERY       'Q'     /* 'Q' do user query */
#define RSLT_INFORM      'q'     /* 'q' do user notification in 25th line */
#define RSLT_RECORD      'R'     /* 'R' record macro -- "watch me mode" */
#define RSLT_SEL1        'S'     /* 'S' selection Y start */
#define RSLT_SEL2        'T'     /* 'T' selection X start */
#define RSLT_SEL3        'U'     /* 'U' selection Y end */
#define RSLT_SEL4        'V'     /* 'V' selection X end */
#define RSLT_TELNET      't'     /* 't' Telnet commands */
#define RSLT_WINDNAME    'W'     /* 'W' window selection action */
#define RSLT_WIND        'w'     /* 'w' window selection action */
#define RSLT_XCURS       'X'     /* 'X' cursor movement to x loc */
#define RSLT_YCURS       'Y'     /* 'Y' cursor movement to y loc */
#define RSLT_MATCH       'Z'     /* 'Z' delay for input match failure; failure sets  
                                    RSLT_TESTMACROFAIL */
#define RSLT_MATCHCASE   'z'     /* 'z' additional table entry input match */

#define RSLT_CSV         '¢'     /* Put CSV or other labelled string; failure sets 
RSLT_TESTMACROFAIL */
#define RSLT_VAR         '$'     /* '$' -- Put \nnn global string */

#define RSLT_SEARCH           '/'  /* search for a string; failure sets  
                                      RSLT_TESTMACROFAIL  */
#define RSLT_SELSHIFTLEFT     '<'  /* shift the selection #to the left */
#define RSLT_SELSHIFTRIGHT    '>'   /* shift the selection #to the right */
#define RSLT_SELLENGTH        '#'   /* set the selection length */

/* The item values for each class follow below */

/* strings are terminated with a '\000' */

/* RSLT_WINDNAME 'W' entries */

#define WIND_INPUT            '<'  /* make the following string naming a window the  
                                      input window; failure sets RSLT_TESTMACROFAIL */
#define WIND_OUTPUT           '>'  /* make the following string naming a window the   
                                      output window; failure sets RSLT_TESTMACROFAIL  
                                      */
#define WIND_INPUT_RESET      '{'  /* revert to standard input */
#define WIND_OUTPUT_RESET     '}'  /* revert to standard output */
#define WIND_SELECT           'S'  /* make the following string naming a window the   
                                       top window failure; failure sets   
                                       RSLT_TESTMACROFAIL */

/* RSLT_ASCI ' ' entries */
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/* the entry for the RSLT_ASCI type is the character to send */

/* RSLT_LCAC 'A' entries */

#define BACKSP_BLANK          ' '     /* space */
#define IBM_SHOWATTR          'A'     /* show IBM attribute characters in display */
#define BACKSP_DEL            'B'     /* B */
#define IBM_BASECOLOR         'C'     /* toggle IBM base color display */
#define DEL_CHAR              'D'
#define ERASE_EOF             'E'
#define INSRT                 'I'
#define RESET                 'R'
#define MOUSE_EXEC            'M'
#define IBM_SELECT            'S'
#define IBM_SELECTCURS        's'
#define INPUT_ERASE           'X'
#define INPUT_ERASEALL        'x'
#define IBM_DUPCHAR           'd'

/* RSLT_SETATTR 'a' entries -- set IBM attributes */

#define TIBMDEFAULTCOLOR      'Z'
#define TIBMRED               'R'
#define TIBMGREEN             'G'
#define TIBMYELLOW            'Y'
#define TIBMBLUE              'B'
#define TIBMPINK              'P'
#define TIBMTURQUOISE         'T'
#define TIBMWHITE             'W'

#define TIBMBACKDEFAULTCOLOR  'z'
#define TIBMBACKRED           'r'
#define TIBMBACKGREEN         'g'
#define TIBMBACKYELLOW        'y'
#define TIBMBACKBLUE          'b'
#define TIBMBACKPINK          'p'
#define TIBMBACKTURQUOISE     't'
#define TIBMBACKWHITE         'w'

#define TIBMDEFAULTHIGH       'X'
#define TIBMBLINK             'A'
#define TIBMREVERSE           'S'
#define TIBMUNDERSCORE        'D'

#define TIBMFONT              'F'
#define TIBMFONTOFF           'f'

/* RSLT_EMC 'C' entries */

#define EM_ALTMACRO           'A'     /* set the ALT (mousedown state) modifier bit */
#define EM_NORMMACRO          'a'     /* always set ALT off */
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#define EM_SHIELD             'B'     /* expand a "blank" window to be a shield for   
                                         kiosk */
#define EM_SHIELDPASS         'b'     /* set a password to reenable all items... */
#define EM_CLOSE              'C'     /* Close the emulator session */
#define EM_RTTSHOW            'D'     /* show RTT rather than packet counts */
#define EM_RTTHIDE            'd'     /* hide RTT */
#define EM_EDIT               'E'     /* show the textwindow */
#define EM_TERM               'e'     /* show the emulator */
#define EM_FILLCLOSE          'F'     /* close the copyright/help textwindow */
#define EM_HIDE               'H'     /* don't update the display */
#define EM_INDMODE            'I'     /* draw each char immediately as received */
#define EM_INDMODEOFF         'i'     /* don't draw as received */
#define EM_COLORFUDGE         'K'     /* use Index2Color to speed color mapping */
#define EM_COLORFUDGEOFF      'k'     /* don't */
#define EM_LITERAL            'L'     /* display literals in ASCII emulators */
#define EM_TELNETLITERAL      'l'     /* display telnet literals */
#define EM_METAFY             'M'     /* make ASCII key a meta-key (set top bit) */
#define EM_NOTIFY             'N'     /* post user notification if in background */
#define EM_IBMPASTEPF         'p'     /* set paste pf for 3270 to execute on wrap for 
paging */
#define EM_RESTORE            'R'     /* restore line 25 */
#define EM_RESETTIMER         'r'     /* reset session timer */
#define EM_SHOW               'S'     /* update the display as usual */
#define EM_SHOWCURPOS         's'     /* display cursor position */
#define EM_TRACKON            'T'     /* cursor tracking on */
#define EM_TRACKOFF           't'     /* cursor tracking off */
#define EM_URL                'U'     /* execute URL string */
#define EM_VTAUTOPRINT        'V'     /* toggle automatic printing */
#define EM_VTAUTOPRINTOFF     'v'     /* automatic printing OFF */
#define EM_WAITCLICK          'W'     /* wait for a click result before handling other 
macros */
#define EM_MACRO              'X'     /* execute selection as a macro */
#define EM_OUTPUT             '>'     /* pipe string into the emulator */

/* RSLT_LOOP 'L' entries*/

/* DO WHILE loop begin: the entry for this class is the
   number of times to repeat the loop as '\nnn'; a 0 will cause the loop to be 
skipped, a 255 will cause the loop to continue until interrupted by a "Command-.".
*/

/* RSLT_DELAY 'D' entries */

/* the entry is the time in seconds you wish to delay processing tokens as '\nnn' */

/* RSLT_EDIT 'E' entries */

#define ED_SELALL             'A'
#define ED_SELSCREEN          'a'
#define ED_APPEND             'B'
#define ED_APPENDNOCR         'b'
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#define ED_COPY               'C'
#define ED_COPYNOCR           'c'
#define ED_GOTO               'G'
#define ED_GOTOMOUSE          'g'
#define ED_LINESELECT         'L'
#define ED_LINESELECTCURS     'l'
#define ED_SENDMACRO          'M'
#define ED_SENDTEXT           'm'
#define ED_SELRESET           'R'
#define ED_STDMODE            'S'
#define ED_APPENDTABLE        's'
#define ED_TABLEMODE          'T'
#define ED_COPYTABLE          't'
#define ED_PASTE              'V'
#define ED_PASTENOTRANS       'v'
#define ED_WORDSELECT         'W'
#define ED_WORDSELECTCURS     'w'
#define ED_WORDSELECTWRAP     'Y'
#define ED_WORDSELECTCURSWRAP 'y'
#define ED_CUT                'X'
#define ED_CLEARSCRAP         'x'

/* RSLT_FILE 'F' entries */

#define RF_APPEND             'A' /* append window selection to file with   
                                           dialog; failure sets RSLT_TESTMACROFAIL */
#define RF_APPENDTO           'B' /* append window selection to file with   
                                           dialog; failure sets RSLT_TESTMACROFAIL */
#define RF_PRINTDRAFT         'D'
#define RF_PRINTPUSH          'd'
#define RF_FINDER             'f'
#define RF_FINDERCLOSE        'F'
#define RF_PRINTSCREEN        'P'
#define RF_PRINTTEXT          'p'
#define RF_PRINTTEXTSEL       'q'
#define RF_PRINTSCRAP         'Q'
#define RF_PRINTBUF           'R'
#define RF_PRINTASCBUF        'r'
#define RF_SAVE               'S' /* save window selection to file;   
                                           failure sets RSLT_TESTMACROFAIL */
#define RF_SAVEAS             'T' /* save window selection to file with dialog;   
                                           failure sets RSLT_TESTMACROFAIL */

#define RF_PRINTVT            'V'

   // select volume and open file commands are below
   // open a file using the following string naming a file

#define RF_OPENHELP        'H'          /* open document by name using the dataComet   
                                           "Help" folder in application bundle */
#define RF_NAME            'N'          /* open document by name using macro default 
folder */
#define RF_OPENAPPVOL      'O'          /* open document in Application folder */
#define RF_OPENPREFS       'o'          /* open document in User's Preferences folder 
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*/
#define RF_OPENDOC         'W'          /* open document in user's dataComet   
                                           applicationfolder "Documents" folder */
#define RF_OPENDOCPREFS    'w'          /* open document in user's "dataComet   
                                           Preferences/Documents" folder */
#define RF_OPENSESS        'X'          /* open document in user's dataComet    
                                           application folder "Sessions" folder */
#define RF_OPENSESSPREFS   'x'          /* open document in user's "dataComet    
                                           Preferences/Sessions" folder */
#define RF_SETVOL          'Y'          /* set default volume for macro command file    
                                           opens to decimal numeric volume # */
#define RF_SETDIR          'y'          /* set default directory for macro command    
                                           file opens to decimal numeric volume # */
#define RF_OPENUSERDIR     'U'          /* open file in user home folder */
#define RF_SETUSERDIR      'u'          /* set macro default folder to user directory    
                                           to use for subsequent opens */
#define RF_SETVOLSTRING    'v'          /* set macro default folder to string    
                                           following command */

#define RF_CSVLOAD         '¢'          /* load CSV data file  (US: Option-4) failure;   
                                           failure sets RSLT_TESTMACROFAIL */
#define RF_CSVSEPARATOR    ','          /* set the field separator to be used when    
                                           loading CSV tables; default is ',' */

   // Use RSLT_CSV !¢\nnn to put values

/* RSLT_CSV '¢' entries */

// Send data item entries are in the form !¢\nnn where:
// \000 sends the name of the file loaded
// \nnn ... are the strings loaded, by position

/* RSLT_PROCESS !p entries */

#define RSLT_CSVNEXTROW       '+' /* select next row of CSV values */
#define RSLT_CSVPREVROW       '-' /* select previous row of CSV values */
#define RSLT_CSVFIRSTROW      '1' /* select first row of CSV values */
#define RSLT_CSVLASTROW       '$' /* select last row of CSV values */
#define RSLT_CSVENDBREAKLOOP  'e' /* test used after !p+ ; if end of values,   
                                           cancel enclosing loop */
#define RSLT_CSVENDCANCEL     '.' /* test used after !p+ ; if end of values,  
                                           cancel all remaining macros */
#define RSLT_TESTMACROFAIL    '?'       /* test whether a macro command, e.g., file  
                                           open or match string, has failed, and  
                                           aborts the macros currently executing for  
                                           this session if true 
                                           Can be followed by a string, in which case  
                                           a Cancel Macro query will be performed  
                                           using the string */
#define RSLT_MACROFAILRESET   '/'       /* reset RSLT_TESTMACROFAIL macro command  
                                           failure flags */
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/* RSLT_FILETRANS 'f' entries */

/* args < 32 are run_zmodem = emdp->zmodem args */

#define FT_folder       'F'
#define FT_upload       'U'
#define FT_abort        'x'

#define FT_ASCII        'A'
#define FT_binary       'a'
#define FT_CRLF         'C'
#define FT_noCRLF       'c'
#define FT_protect      'P'
#define FT_overwrite    'p'
#define FT_append       '+'
#define FT_noappend     '-'

#define FT_trace        'T'
#define FT_notrace      't'
#define FT_dump         'D'
#define FT_nodump       'd'

/* RSLT_MVCR 'M' entries (IBM cursor motion) */

#define HOME            '0'
#define BACK_TAB        '<'
#define TAB_FWD         '>'
#define DOWN_ARROW      'D'
#define LEFT_ARROW      'L'
#define NEW_LINE        'N'
#define RIGHT_ARROW     'R'
#define UP_ARROW        'U'

/* RSLT_PFKY 'P' entries (IBM AND VT220 Program Function keys) */

#define IBMSYSREQ      \00

#define PF1            \001
#define PF2            \002
#define PF3            \003
#define PF4            \004
#define PF5            \005
#define PF6            \006
#define PF7            \007
#define PF8            \008
#define PF9            \009
#define PF10           \010
#define PF11           \011
#define PF12           \012
#define PF13           \013
#define PF14           \014
#define PF15           \015
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#define PF16           \016
#define PF17           \017
#define PF18           \018
#define PF19           \019
#define PF20           \020
#define PF21           \021
#define PF22           \022
#define PF23           \023
#define PF24           \024
#define PF25           \025
#define PF26           \026
#define PF27           \027
#define PF28           \028
#define PF29           \029
#define PF30           \030
#define PF31           \031
#define PF32           \032
#define PF33           \033
#define PF34           \034
#define PF35           \035
#define PF36           \036

#define PF37           \037
#define PF38           \038
#define PF39           \039
#define PF40           \040
#define PF41           \041
#define PF42           \042
#define PF43           \043
#define PF44           \044
#define PF45           \045
#define PF46           \046
#define PF47           \047
#define PF48           \048

#define PA1            \049
#define PA2            \050
#define PA3            \051
#define IBMATTN        \065
#define CLEAR          \067
#define IBMDETECT      \068
#define ENTER          \069

#define PFSHIFT        \085
#define PFDUBSHIFT     \087

#define ASPF1          \096   /* 5250 PF keys */
#define ASPF2          \097
#define ASPF3          \098
#define ASPF4          \099
#define ASPF5          \100
#define ASPF6          \101
#define ASPF7          \102
#define ASPF8          \103
#define ASPF9          \104
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#define ASPF10         \105
#define ASPF11         \106
#define ASPF12         \107

#define VTFIND         \128
#define VTINSERTHERE   \129
#define VTREMOVE       \130
#define VTSELECT       \131
#define VTPREVSCREEN   \132
#define VTNEXTSCREEN   \133

#define VTPF1          \134
#define VTPF2          \135
#define VTPF3          \136
#define VTPF4          \137

/* the entry for the RSLT_YCURS type is the desired row numbered from 0 as \nnn */

/* the entry for the RSLT_XCURS type is the desired column numbered from 0 as \nnn */

/* RSLT_QUERY 'Q' entries -- any two RSLT_QUERY entries bracket the prompt */

#define QUERY_BEEP           'b'
#define QUERY                'Q'
#define QUERY_END            'E'
#define QUERY_CR             'R'
#define QUERY_SILENT         'S'
#define QUERY_MACROCANCEL    'M' /* cancel macro if Cancel pressed */

/* RSLT_INFORM "!q" entries -- terminated by \000 or another macro command; empty 
string resets 25th line */
#define INFORM_BEEP 'b'

/* RSLT_RECORD 'R' entries*/

#define RECORD_ALLDATA       'A'
#define RECORD_NODATA        'a'
#define RECORD_BEGIN         'B'
#define RECORD_END           'E'
#define RECORD_PAUSE         'P'
#define RECORD_IBMALLDATA    'I'
#define RECORD_IBMNODATA     'i'

/* the entry for the RSLT_SEL actions is the desired location numbered from 0 as \nnn 
*/

/* RSLT_TELNET 't' entries */

#define TNMYOUTHERE          'A'

dataComet-Secure Online Documentation - Author: Bonze Anne Rose Blayk 124/231



#define TNMBREAK             'B'
#define TNMINTERRUPT         'C'
#define TNMABORT             'U'
#define TNMERASECHAR         'x'
#define TNMERASELINE         'X'

#define TNMCRNOMAPON         'M'
#define TNMCRNOMAPOFF        'm'
#define TNMCRTOLFON          'L'
#define TNMCRTOLFOFF         'l'
#define TNMVTNEWLINEON       'N'
#define TNMVTNEWLINEOFF      'n'
#define TNMCRTOCRON          'R'
#define TNMCRTOCROFF         'r'

#define TNMSENDADDR          'a'     /* type telnet address */
#define TNMSENDPASS          'p'     /* type password */
#define TNMSENDUSERNAME      'u'     /* type username */
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            5. AppleScript

________________________________________________________________

      dataComet documentation.  (Rev. 1/27/08) 
      Copyright 1995 databeast, Inc. All Rights Reserved.

   This document has information on (select and use "Find..." to go to the 
section):

         Using AppleScript with dataComet
            Sample AppleScript Copy and Paste
            Executing an AppleScript
         dataComet's AppleScript Suites
            Required Suite 
            URL Suite 
            dataComet Custom Suite 
            Mandarin Suite 
         "status" report format

      ___________________________________________________

         Using AppleScript with dataComet
      ___________________________________________________

   dataComet supports AppleScript commands which allow the user to control 
dataComet through scripts.  All dataComet macro functions are accessible 
through the "execute" event, which submits a macro string to dataComet for 
execution by the target window.

   Currently AppleScript recording is not supported by dataComet.  You can, 
however, record a dataComet macro using "Record macro..." and then use the 
results in an execute command.  Note that '\' characters in the macro 
commands must be doubled ("\\") in order to prevent your AppleScript Script 
Editor application from interpreting them as special characters.

   If you want to your script to cause dataComet to quit, use the AppleScript 
"quit" command rather than a dataComet macro, so that dataComet can handle 
the Quit case properly by returning a value to the calling script indicating 
the command has been completed prior to actually executing the Quit command.

   See "Sample AppleScript" in the Extras folder for an example script which 
opens a session with a UNIX host, executes a command, copies the command 
output, and closes the window.  This example includes a number of useful 
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script routines.

      ___________________________________________________

            Sample AppleScript Copy and Paste
      ___________________________________________________

         global copyresult

         set copyresult to ""

         tell application "dataComet"

         execute "!WSYourWindowName\\000!Ce"
         -- Select a window by name; 
         -- "!Ce" guarantees the emulator is in front, 
         -- rather than the session's .edit window.
         
         execute "!S\\000!T\\000!U\\003!V\\000"
         -- Select the first 3 lines in the emulator screen.
         
         copy

         end tell

         set copyresult to the result
         -- copy the result of the dataComet copy; 
         -- NOTE:  this must be immediately after the "copy" command  
         -- in the "tell" statement to work correctly in the  
         -- background!

         doedit(copyresult)

         return

         -- paste text into a new Scriptable Text Editor window

         on doedit(edittext)
         tell application "Scriptable Text Editor"
         activate
         set the clipboard to edittext
         make window
         paste
         end tell
         end doedit
      ___________________________________________________
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   The AppleScript dataComet "copy" command waits for up to 45 seconds for 
dataComet macros executing in the frontmost session to be completed before 
copying the window selection to try to guarantee that select/copy macro 
scripts will work smoothly.  NOTE that during this wait all applications on 
your Macintosh will have to wait for the loop to complete; if you're using a 
complicated macro to display and select text, it's best to check whether the 
"status" of a session contains "Executing" before performing a copy; this way 
you can be absolutely certain that complex selection macros will copy the 
selection you really want.  (See "Sample AppleScript" for an example using 
the "status" command.)

   More sample script snippets which might be useful...

      ___________________________________________________

         -- note that some Applescript variables may need to be  
         -- coerced to "text"; otherwise it will abort the script  
         -- with the error message "incorrect data type" 

           send (thisorderedlist as text)

         -- This is a sample prompt line.  
         -- Note that in an "execute" command you need to use 
         -- a "!!" to sends a "!" to the host.

            execute "!qzThis is a 25th line prompt!!!qz"

         -- This clears the prompt line.

            execute "!qz!qz"

         -- uploadtext(copyresult, "uploadtext.txt")
         -- uploads an  AppleScript text object via a UNIX cat 
         -- command.
         -- Note that 8-bit characters won't pass unless the host 
         -- is set to read them (see "UNIX connections" in 
         -- "1. Emulators").

            on uploadtext(thetext, filename)
            tell application "dataComet"
            send "cat >" & filename & " <<'###EOF###'" & return
            send thetext
            send return & "'###EOF###'" & return
            end tell
            end cat
      ___________________________________________________
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      ___________________________________________________

            Executing an AppleScript
      ___________________________________________________

   Save the script as an "Application" with "Never show startup screen" 
checked.  To easily execute the script from dataComet, first place the script 
(called, say, "PrintBarcode") in the System "Apple Menu Items" folder.  You 
can then set a dataComet button or key to execute a dataComet macro of the 
form "!m\000\127\127PrintBarcode\000".

      ___________________________________________________

         dataComet's AppleScript Suites
      ___________________________________________________

         _____________________________________________

            Required Suite 

            Events that every application should support

         _____________________________________________

            open: Open the specified object(s)

               open  alias -- list of objects to open

            print: Print the specified object(s)

               print  alias -- list of objects to print

            quit: Quit application

               quit

            run: Sent to an application when it is double-clicked

               run
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         _____________________________________________

            URL Suite 

            Standard Suite for Uniform Resource Locators

         _____________________________________________

            geturl: opens a Telnet connection specified by a URL

               geturl  string -- a Telnet URL
               Result:  small integer -- result code

         _____________________________________________

            dataComet Custom Suite 

            Suite of AppleEvents for interfacing to dataComet

         _____________________________________________

            targetwindow: sets the window to use as a target

              targetwindow string  -- optional window name, 
                                      -- default front
              Result:   small integer  -- result code

               If the targetwindow is not specified in a script,
               the frontmost window is used as the target for
               the following commands.  

               You can use the argument "frontwindow" to 
               reset the target window for a script to whichever
               window happens to be frontmost.

            status: returns status for the target window

               status
               Result:  string -- text description of status

            send: sends text to the target window

               send string -- text to send
               Result:  small integer -- result code
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            execute: executes a string as a dataComet macro

               execute string -- a dataComet macro
               Result:  small integer -- result code

            cut: cuts the selection in the target window

               cut
               Result:  string -- the cut text

            copy: copies the selection in the target window

               copy string -- optional string overrides selection 
               Result:  string -- copied text

            paste: pastes into the target window at the cursor 
                   position

               paste string -- optional string sets clipboard 
                            -- before paste
               Result:  small integer -- result code

      ___________________________________________________

      ___________________________________________________

         "status" report format
      ___________________________________________________

   The status inquiry returns a string containing a list of tab-delimited 
strings which can help in monitoring the status of the frontmost session.  
The string may contain the following names and status indications:  
"WindowName LineCount CharCount SessionType TermType NewData ConnectionStatus 
3270Status MacroStatus".  You can use the MacroStatus returned by the 
"status" call to synchronize scripts by using a '!Z' or '!z' macro at the end 
of an "execute" call to guarantee that the host has sent an indication that 
its output is complete (this is application-dependent, since you must rely 
how the host application draws its screens).

E.g., you might receive the following status reports:

         "\"fedworld.gov\" 857 68560  Telnet ANSI.SYS NewData
Closed"
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   or

         "\"Scratch Pad\" 22 186 EditOnly".
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         _____________________________________________

            WindowName:        Window name:  

               ".edit" will be appended if a session's .edit window 
                is in front.

            LineCount:         Count of lines in window

            CharCount:         Count of characters in window

            SessionType:       Session type: 

               "EditOnly"
               "Telnet"
               "Serial"

            TermType:          Session terminal type:

               "VT100"
               "VT102"
               "VT220"
               "H19"
               "ANSI.SYS"
               "IBM-3278-"

            NewData:           Session has received new data:

               ""
               "NoData"
               "NewData"

            ConnectionStatus:  Session connection status:

               ""
               "Opening"
               "Connected"
               "Closing"
               "Closed"

           3270Status:         Session status for IBM 3270 session:

               ""
               "Running"
               "MORE"
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               "VM Read"
               "CP Read",
               "Holding"

            MacroStatus:       Macro execution status

              "Waiting"
              "Executing"

         _____________________________________________

      ___________________________________________________

________________________________________________________________
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            6. File Transfer
  
________________________________________________________________
  
      dataComet documentation.  (Rev. 2/20/2010) 
      Copyright 1997, 2010 databeast, Inc. All Rights Reserved.
  
   This document has information on (select and use "Find..." to go to the 
section):
  
         File transfer overview
         File transfer menu options
         AutoLaunch and Internet Config "File Mappings" 
         File transfer with IBM hosts using IND$FILE
         Using the "IND$FILE…" command dialog
         The "IND$FILE" Preferences panel
         File transfer with SSH hosts using SCP
         Using the "SCP…" command dialog
         The "SCP" Preferences panel
         Using Z-Modem
         Using X-Modem
         The "ZModem" Preferences panel
             "Z-Modem"
             "X/Y-Modem"
         "Transfer" Preferences panel options
             "ASCII Default"
             "Download":  Options affecting downloads
             "Upload":  Options affecting uploads
         File transfer progress dialog

       ___________________________________________________

         File transfer overview
       ___________________________________________________

   The folder in which the session document is located is the default folder 
for up- and down-loading, unless "Comet Default" is the document being used, 
in which case the default download folder is the application's home 
directory.  To switch folders you can use the File menu commands "Set 
download directory" or "Type file name at cursor" (the latter also inserts a 
file name at the cursor position).  These commands use the standard file 
interface.  When you create a new file by saving text or downloading a file, 
the file is set by default to be a dataComet document; you can cause files to 
be saved with a different document type by using the "Set default file 
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type..." dialog before you download the file.  Alternatively, when SCP, 
IND$FILE, or Z-Modem downloads are performed, the type may be set using 
MacBinary or BinHex document information, or Internet Config may be used to 
map file extensions to a document creator.

   When files are downloaded, dataComet checks the file name, and processes 
filenames with certain suffixes in special ways.  (The suffix is the portion 
of a filename at the end which is  preceded by a '.')  These suffixes are:

   ".rename" 

   Offers the user a chance to rename the file.

   ".edit"

   When you do a file download to a file with the same name as a 
session's .edit window, the downloaded text will be automatically appended to 
the window.  Likewise, an upload using  a session's .edit window name will 
cause dataComet to save the  window before the upload is performed.  (E.g., 
this is performed when a session is named "theory", and you download a file 
named "theory.edit".)   You can automatically add or delete  carriage returns 
in your text using options in the "Session" Preferences panel dialog, so that 
you can more conveniently use the TextEdit text wrapping on your Mac and have 
the paragraphs reformatted properly for your host.

   AutoLaunch and automatic wrapping options in the "Transfer" Preferences 
panel provide an alternative to using the ".edit"  feature when Z-Modem is 
used for file transfer.

   When using Z-Modem, filenames ending in ".bin" and ".hqx" will be decoded 
using MacBinary and BinHex protocols, respectively.

       ___________________________________________________

         AutoLaunch and Internet Config "File Mappings" 
       ___________________________________________________

   If Internet Config is installed and IC suffix-file mappings are enabled, 
binary mode will be selected automatically for both uploads and downloads 
according to the settings in the Internet Config "File Mappings"--i.e., the 
"Binary" setting and "Not for incoming"/"Not for outgoing" settings for that 
file type.  

   For IC downloads the document's file type and creator are set to those 
specified for the file's extension in the Internet Config "File 
Mappings" (e.g., ".doc" is set as an MSWord document; ".txt" is set as a 
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TextEdit document).

   For IC uploads filenames have appropriate extensions (e.g., ".jpg") added 
automatically.  This is off by default.

   Unfortunately Internet Config is no longer fully supported under MacOS X.  
You can change the Internet Config "File Mappings" by launching Internet 
Explorer; Internet Explorer's "Preferences..." "Protocol Helpers" and "File 
Helpers" dialogs allows you to control these mappings.  

   If Internet Config is NOT installed, MacBinary and BinHex files are set to 
the type and creator specified in the original document.  Text files are set 
to type 'TEXT', using the creator you're specified for this session in the 
File menu item "Set default file type...".  Files containing a ".sit" 
extension will be opened using StuffIt Expander.

       ___________________________________________________

         File transfer menu options
       ___________________________________________________

   This list contains the file transfer options in the menu which are not 
duplicated exactly in the File transfer dialog (see below).

   "Type file name at cursor…":  Brings up a directory dialog box for you to 
select a file whose name you want to type on the dataComet screen.  The 
download directory is set to the last directory you use.

   "Download - Set directory…":  Bring up a Macintosh Standard File dialog 
which allows you to choose a default download directory.  (You need to select 
a file in the directory to get it to select a directory, otherwise the 
Standard File dialog opens the directory selected in the  list… a "Set 
Directory" button will eventually be added to this dialog by dataComet to 
address this Standard File defect.)

   "Upload…":  Presents a dialog to select a document to upload using the 
default file transfer Protocol selected in the "File Transfer" dialog.  If 
the current window is an edit window, the edit document is saved and uploaded 
automatically without a dialog.  If Internet Config is installed, dataComet 
appends file suffixes appropriate for that document (e.g., TextEdit documents 
will have ".txt" appended).  When using an IBM host and the IND$FILE 
protocol, the IND$FILE dialog will come up to allow you to select the host 
file name.  If you are connected to an ASCII host, the "rz" or "rx" program 
is automatically invoked on the host, with appropriate parameters depending 
upon whether the file is a text or binary file.  (To avoid automatic host 
program invocation, you can use "Option-Upload"; you will then need to type 
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the host command yourself).

   Uploading folders:  When Z-Modem is used, you can upload all the documents 
in a folder using the "Upload..." dialog by clicking on the "Transmit" button 
with the mouse (pressing the Return key when a document is selected will 
upload the document; for folders, however, pressing the Return key opens the 
folder rather than uploading it).  To make maintaining remote directories 
quick and easy, Z-Modem "Newer" mode is set for folder uploads, so existing 
files are uploaded only if they are updated versions.

   To guarantee that a file is uploaded even when it's not newer, you can 
upload only one document at a time; for single documents dataComet Z-Modem 
uploads always overwrite the destination file.

   NOTE that after uploading a file to a host, you may need to change file 
permissions in order to make a file publically accessible if the file is part 
of a web page or is to be retrieved from an FTP server.  (E.g., under UNIX 
the file permissions need to be set using "chmod 644 filename"; likewise new 
directories may need to be made readable using "chmod 755 directoryname".  
Other operating systems have similar security features, so if network file 
accesses fail check the permissions on the file or directory.)

   "Download…":  Accepts a download from the host using the default protocol.  

   "Compuserve QuickB…":  NOT CURRENTLY SUPPORTED.  Presents a dialog to 
perform a QuickB file transfer.  

   "X-Modem Transmit", "Receive":  Performs an upload or download using X-
Modem rather than the default protocol.

   "Y-Modem Transmit", "Receive":  Performs an upload or download using Y-
Modem rather than the default protocol.

   "Z-Modem Transmit", "Receive":  Performs an upload or download using Z-
Modem rather than the default protocol.

       ___________________________________________________

         File transfer with IBM hosts using IND$FILE
       ___________________________________________________

   The IND$FILE file transfer protocol can also be used to transfer files 
between the Macintosh and an IBM mainframe.  You can enter the file transfer 
command directly in the host screen, or use the "IND$FILE" dialog to compose 
the command.  You can bring up this dialog using the "Upload..." command 
(Command-U) in the File menu "Transfer" submenu.
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   Files may be transferred in either ASCII or Binary mode.  In ASCII mode 
characters are translated between IBM's EBCDIC character encoding and ASCII 
character encoding by the mainframe, and spaces are stripped from the ends of 
lines by the host when a download to the Mac is performed.

   One can also add "CRLF" to specify translation of Carriage Returns.  The 
IBM host adds a Carriage Return and LineFeed to the end of each record; 
dataComet's IND$FILE will convert the CR/LF pairs to the Macintosh CR 
standard line terminator or vice-versa.  You can specify automatic wrapping 
or unwrapping of lines for uploads and downloads, respectively, using the 
options in the "Transfer" Preferences panel, along with other encoding 
options such as MacBinary or BinHex.

   Normally you will use either "ASCII CRLF" or plain Binary to perform a 
file transfer.

       ___________________________________________________

         Using the "IND$FILE…" command dialog
       ___________________________________________________

   This dialog helps you construct a valid host command to perform a file 
tranfer with an IBM host using the IND$FILE protocol.  

   The dialog will try to automatically construct a plausible target file 
name if you enter a name and then use the Tab key to enter a name field which 
is not yet set.  

   Pressing the "Get/Put" button or the Return key will execute the transfer 
(you may need to enter a Clear or PA2 to continue the transfer after the 
command is entered if the host goes into a HOLDING state).  If you need to 
add options not available in the dialog, you can hold down the Shift key 
while OK'ing the dialog, and the command will be typed on the 3270 screen 
without being Entered.

   "Folder…":  Presents the standard file dialog to allow you to select an 
upload/download folder.

   "Mac file…":  This button brings up the standard file dialog so you can 
select a Macintosh file.  If a host name is not yet specified, a plausible 
target host file name, transfer options, and file encoding (e.g., BinHex) 
will be automatically selected; you can change the name and Options if you 
wish.

   "Host file":  This field contains the name of the host file, which must be 
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in the form of a valid IBM file specification (normally, this file 
specification is of the form "NAME TYPE VOLUME" where the NAME and TYPE are 
limited to 8 letters, and the VOLUME specifies the logical disk to be used 
(by default the "A" drive).

   Options:

      "ASCII CRLF":  ASCII with CR/LF interpretation.
           "ASCII":  ASCII without CR/LF interpretation.
     "Binary CRLF":  Binary with CR/LF interpretation.
          "Binary":  Binary.
     
       "Overwrite":  Erase the target file before the transfer.
          "Append":  Append the file being transferred to the 
                     target file.
         "Protect":  Disallow over-writing of existing Mac files 
                     on download.
     "Put to host":  Make a PUT command to upload a file from 
                     the Mac.
   "Get from host":  Make a GET command to download a file to 
                     the Mac.
   
   "Transfer…":  Brings up the "Transfer" Preferences panel, which allows you 
to select general options controlling the transfer, for example, automatic 
text wrapping and unwrapping.

   "IND$FILE…":  Brings up the IND$FILE configuration dialog, which allows 
you to select more options for controlling the transfer.

       ___________________________________________________

         The "IND$FILE" Preferences panel
       ___________________________________________________

   "IND$FILE command":  Enter an alternative command name if the host does 
not use "IND$FILE" to execute the file transfer.

      "Host OS":       The Operating System on the IBM host 
                       determines the format and options 
                       applicable for the command string.

         "TSO":
         "CICS":
         "VM/CMS":
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      "Record Type":   Selects host record type and length.
                       (Applies only to uploads to some OS types.)
      
         "Default":
         "Fixed":
         "Variable":
         "Undefined":
         "Logical Length":
         "Block Size":
      
      "Allocation":    Selects host file allocation variables.
                       (Applies only to uploads to some OS types.)
      
         "Default":
         "Tracks":
         "Cylinders":
         "AVBlock":
         "Primary":
         "Secondary":

       ___________________________________________________

         File transfer with SSH hosts using SCP
       ___________________________________________________

   The SCP (Secure Copy) file transfer protocol can be used to transfer files 
and folders over Secure Shell connections made with dataComet-Secure.  To 
start a file transfer, you can use the "SCP…" dialog, which will help you 
construct an SCP command that will perform the transfer.

   SCP may make error reports. These include "filename: not a regular file", 
which indicates that a directory specified as a target was skipped, and 
"ambiguous target" which indicates that multiple file or directory names were 
used in the SCP command in an amiguous fashion.  Other reports, such as 
"protocol error:"  "unexpected <newline>", "lost connection", or "expected 
control record", indicate that an internal error has occurred.

       ___________________________________________________

         Using the "SCP…" command dialog
       ___________________________________________________

   "Folder…":  Selects a Mac folder as a source for uploads or target for 
downloads.

   "Mac File…":  This button brings up the standard file dialog so you can 
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select a Macintosh file.  You can also enter a filename directly in the 
field;   you can use '*' and '?" in the name as wild card characters to 
transfer multiple files.

   "SCP Directory":  Specifies a host directory, used for directory and sub-
directory transfers.  

   "SCP File":  Specifies the host file(s) to transfer (primarily for 
downloads).

   "Copy sub-directories":  Allows transfers of all files and directories in 
the selected directory.  

   NOTE that if you leave all the text fields empty, the contents of the 
folder (or directory) will be transferred, including sub-directories and 
their contents if "Copy sub-directories" is on.

   Options:  "Automatic", "Binary", "ASCII":  Allows selection of file 
transfer types; files transferred in ASCII mode may be extensively 
reformatted, while files transferred using Binary mode are not modified in 
any way.  Selections made in the "Transfer" Preferences panel controlling CR 
mapping, text wrapping, document launching, etc. may also apply, depending on 
the transfer mode.

       "Overwrite":  Erase the target file before the transfer.
          "Append":  Append the file being transferred to the 
                     target file.
         "Protect":  Disallow over-writing of existing Mac files 
                     on download.
     "Put to host":  Make an SCP command to do uploads from the Mac.
   "Get from host":  Make an SCP command to do downloads to the Mac.

   "Transfer…":  Brings up the "Transfer" Preferences panel, which allows you 
to select general options controlling the transfer, for example, automatic 
text wrapping and unwrapping.

   NOTE that only one SCP file transfer can be executed at a time.  

       ___________________________________________________

         The "SCP" Preferences panel
       ___________________________________________________

   "OS":  In the future these radio buttons will allow selecting a default 
SCP command for different operating systems.  Currently only systems that 
allow excecution of the "UNIX": shell command are directly supported; "DOS": 
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is not.  You may be able to use the Customized SCP command option described 
below to make an SCP file transfer.

   "Default SCP command:":  Shows the default SCP command.  dataComet's 
implementation of SCP allows the SCP file transfers with the context of a 
normal terminal session, rather than requiring a separate SSH session to 
perform a download.  Doing this requires that dataComet issue a command to 
the host, executing a separate shell, turning off interpretation of special 
characters, entering the "scp" command, and finally restoring the original 
terminal settings.  

   "Use RCP command":  Use the "rcp" command to execute file transfers on the 
host command line, for cases where the host does not have SCP installed.

   "Use customized SCP command:": allows you to issue a customized command if 
the default command does not work properly with a host.

   "File modes":, "Directory modes":  These arrays of check boxes allow you 
to set the permissions which will be set on files and/or folders which are 
uploaded to the host.  By default, dataComet saves the host mode flags in the 
"last backup date" field in the file or folder's file description when they 
are downloaded.  If the "File modes" or "Directory modes" check boxes are on, 
the selected modes are used; if they are turned off, the mode flags saved in 
the "last backup date" field will be sent to the host, allowing preservation 
of the UNIX file permissions.

       ___________________________________________________

         Using Z-Modem
       ___________________________________________________

   If you're doing file transfers, Z-Modem is the best protocol to use if it 
is available on your host.  Here are some suggestions for using Z-Modem with 
dataComet with its default settings for file transfer...

   To download text files using dataComet's Z-Modem, you can use 

      sz mytextfile

without specifying the '-a' to transmit text files, since by default newlines 
are automatically converted to Macintosh CR format (see below for the dialog 
option which allows you to change this setting).

   To download a file which is a binary when this automatic text translation 
option is on, you can use 
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      sz -b mybinaryfile

which will turn off the text translation option.

   When the download has completed, dataComet will convert MacBinary (.bin) 
and BinHex files (.hqx), and then AutoLaunch the resulting document with the 
selected helper application.  

   You can use the "Upload..." menu item (Command-U) to select a file or 
folder to upload; the "rz" command will be automatically run on the host (you 
can hold down the Option key to suppress automatic "rz" command invocation).

   If you use the "Upload..." command when a dataComet edit window is 
frontmost, the edit window will be saved and uploaded to the next frontmost 
host session.  (Note that this is not the case if this is a session's .edit 
window, in which case the dialog is still displayed).

   NOTE that only one Z-Modem or X-Modem file transfer can be executed at a 
time.  You can still do work in other windows during a file transfer, 
including emulator sessions, but you cannot perform Z-Modem or X-Modem 
downloads using another session until the current file transfer is complete.

       ___________________________________________________

         Using X-Modem
       ___________________________________________________

   If you're using X-Modem, note that you download a file the file extension 
you append when prompted for a filename will be used to determine the 
filetype for transfer character mapping, CR conversion, and other options; if 
no suffix is appended to the filename (i.e., ".txt"), downloaded files will 
be transferred in binary mode.

       ___________________________________________________

         The "ZModem" Preferences panel
       ___________________________________________________

          _____________________________________________
          
             "Z-Modem"
          _____________________________________________
          
   "Timeout (seconds)":  Number of seconds to wait before performing a retry 
(default 10).
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   "Maximum retries":  Number of retries to perform before giving up on a 
file transfer (default 10).

   "Receive Buffer size":  Allows you to specify the size of the buffer; zero 
is the default, which automatically selects a size appropriate to the type of 
connection.

         "Transmit:":  The following options affect Uploads.

   "Sub-packet length":  Allows you to limit the size of sub-packets to help 
compensate for bad connections (default 1024).  You should use a shorter sub-
packet length if you find that transfers are performing numerous retries due 
to errors.

   "Window limit":  Allows you to set a limit on how many bytes are sent to 
the receiving end at one time (default 4096).  Setting the Window limit to 0 
(zero) may speed uploads; the default is 4096 because in some cases hosts may 
not be able to handle input processing quickly enough.

   "ZCRCQ spacing":  Allows you to require periodic ZAKS (acknowledgments 
that data has been received) from the receiving end (default 0, which implies 
that ZAKS are not required).

   "Escape all control characters":  Allows you to escape all control 
characters over connections which use them for connection control purposes.  
Try this if you find that connections fail mysteriously.

          _____________________________________________
          
             "X/Y-Modem":
          _____________________________________________

   "1K":  "Off":, "Auto":, "CRC-1K":  Selects the packet size (128 vs. 1024 
bytes/packet).  "CRC-1K" will attempt to negotiate 1K blocks with the host; 
"Auto" mode will accept 1K blocks if selected by the host YModem program.

   "Batch":  "Off":, "On":, "RR":  Selects Y-Modem batch mode.  "RR" is 
supposed to be compatible with the "Red Ryder" (a/k/a "White Knight") 
implementation of Y-Modem.

   "Timeout":  " 5":, "10":, "15":  Selects a timeout value in seconds 
(default 10).

   "Use CRC":  Use a CRC (Cyclical Redundancy Check) to ensure that data is 
not garbled in transmission.
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       ___________________________________________________

         "Transfer" Preferences panel options       
       ___________________________________________________

   "Folder…":  Selects a target folder for downloading.  This is 
automatically saved as a string in the session document.

   "Options…":  Opens the dialog which allows you to select options for 
controlling X/Y/Z-Modem file transfers.

   "IBM IND$FILE…":  Opens the dialog which allows you to select options for 
controlling IBM IND$FILE transfers. 

   "Translate TEXT":  Enables translation of characters from the Macintosh 
character set to host character set and vice versa, using the table selected 
for the session with the "Control Translation" menu.  (Note:  this option 
does not apply to IND$FILE transfers, since the host performs the ASCII 
translation.)

          _____________________________________________
          
             "ASCII Default":
          _____________________________________________

   "Z-Modem":, "X/Y-Modem":, "SCP":  Selects a default protocol to use for 
file transfer.  

   "Options":  Brings up a dialog which allows you to fine-tune X/Y/Z-Modem 
settings...

          _____________________________________________
          
             "Download":  Options affecting downloads
          _____________________________________________
          
   "AutoReceive":  Automatically receive Z-Modem downloads.  Incoming data 
from the host is scanned for the Z-Modem string which prefaces a download, 
and automatically accepts the file, so that you don't need to execute a 
"Download…" menu item after entering the host command "sz filename".

   "AutoLaunch":  Automatically launch a downloaded document after performing 
MacBinary or BinHex decoding.  The "File Mappings" settings from Internet 
Config are used if IC has been installed.  E.g., if you download a correctly-
named GIF file, "whatever.gif", the GIF image will automatically be displayed 
by JPEGView; if you download "index.html", the web page will be displayed by 
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your browser.

   "AutoDecode":  Allows you to disable automatic decoding of BinHex and 
MacBinary transfers.

   "CR/LF -> CR":  Automatically detect and convert text files to Macintosh 
format.  DOS uses CR/LF pairs, and UNIX uses LF (LineFeed) characters to 
indicate the end of a line rather than a single CR (Carriage Return), which 
is used on the Mac to start a new line.  This is on by default.

   "UnWrap ¶":  Automatically unwrap downloaded text files into Mac TEXT 
format (Carriage Returns appear only at the end of paragraphs; CRs or LFs 
denoting the end of lines are stripped).

   "IC Suffix -> Type":  Turns on Internet Config suffix mapping on 
downloads, so that file types are derived from the IC "File Mappings" 
settings, rather than the options below:

      "TEXT App":  The default helper application for TEXT files 
                   when IC is not used.  This is '????' by default, 
                   so that the system will use the file suffix to
                   determine the application to use.

      "BIN App":   The default helper application for BINARY files
                   when IC is not used.  This is '????' by default.

      "BIN Type":  The default file type for BINARY files
                   when IC is not used.  This is '????' by default.

   IC file mappings supersede information in MacBinary and BinHex headers on 
downloads, allowing you to use an application different from the original 
document's creator.  IC file mappings are also used to determine whether a 
file should be uploaded as a text or binary file.

          _____________________________________________
          
             "Upload":  Options affecting uploads
          _____________________________________________

   "No Encoding":  Disable file encoding when uploading.

   "MacBinary":  Use MacBinary protocol to encode files when uploading.  This 
preserves a document as a Macintosh format file.

   "BinHex":  Use BinHex protocol when uploading.  This preserves a document 
as a Macintosh format file; BinHex is less efficient than MacBinary, however, 
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files encoded using BinHex can be transferred over connections which can only 
transmit 7-bit characters, so it is still the standard for the distribution 
of binary files.

   "Encode TEXT":  Encodes 'TEXT' documents when uploading, in addition to 
other documents, which are always encoded when MacBinary or BinHex is 
selected.

   "Wrap @": ____:  Wraps outgoing TEXT at the specified column.  

   "DeTab":  Expands tabs to spaces.  The edit field allows you to select the 
tab stop to which a TAB will be expanded.  (Currently applies only to IBM 
IND$FILE transfers.)

   "IC Type -> Suffix":  Toggles Internet Config suffix mapping on uploads, 
so that file suffixes are derived from the IC "File Mappings" type/creator 
settings, rather than:

      "TEXT suffix":  A suffix which is appended to uploaded TEXT 
                      files when IC is not used.

       ___________________________________________________

         File transfer progress dialog
       ___________________________________________________

   "Total":  The total number of bytes in the file to be transferred.

   "Done":  The number of bytes transferred.

   "Remaining":  The number of bytes remaining to transfer.

   "Bytes/sec":  An estimate of the number of bytes per second transferred.

   "Blocksize:":  The Z-Modem block size (or in X-Modem, the block number).

   "Errors":  The number of errors seen transmitting the current packet.

   "Time":  Beneath this label the "Time Done" is displayed to show the total 
elapsed time for the file transfer.  Further down the "Time Remaining" is 
displayed to provide an estimate of how much time remains before the transfer 
is completed.
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   Transfer labels:

         "BinHex":  The file being transferred is a BinHex file, 
                    downloaded files will be decoded automatically.        
    "MacBinary I":  
   "MacBinary II":  The file is a MacBinary file; downloaded files
                    will be decoded automatically. 
       "CR -> NL":  The TEXT file being uploaded is being converted.
       "NL -> CR":  The TEXT file being downloaded is being 
                    converted.
           "Wrap":  The TEXT file being transferred is having its 
                    lines wrapped to or from Macintosh format.
         "Launch":  The downloaded file will be opened 
                    automatically.

   Z-Modem States:

         "ZRINIT":  A file download is being negotiated. 
     "ZCHALLENGE":  Responding to file download request.
        "ZRQINIT":  A file download is being requested.
         "->ZNAK":  A ZNAK has been sent to request a packet resend.
    "ZFILE error":  An error occurred transmitting a File header.
      "ZSINIT ok":  File upload negotiation OK.
   "ZSINIT error":  An error occurred negotiating an upload.
       "ZFREECNT":  The space available on your disk was requested.
       "hdr-ZNAK":  A ZNAK has been sent to request a header resend.
      "hdr-ZFILE":  A File transfer Name/Header is being 
                       transmitted.
       "hdr-ZEOF":  The End-Of-File for a transfer has been seen.
      "hdr-ZSKIP":  The receiver wants to skip the file.
      "hdr-ZDATA":  Data transmission is starting.
   "data-TIMEOUT":  A timeout has occurred while waiting for data.
     "data-ERROR":  An error occurred receiving a data packet.
     "data-ZCRCW":  A data packet was received with a frame end and
                       an ACK request.
     "data-ZCRCQ":  A data packet was received with an ACK request.
     "data-ZCRCG":  A data packet was received.
     "data-ZCRCE":  A data packet was received with a frame end.  
    "hdr-TIMEOUT":  A timeout has occurred while trying to transmit 
                       a header.
      "hdr-ERROR":  An error has occurred while trying to transmit 
                       a header.

       ___________________________________________________

________________________________________________________________
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            6.1 ZMODEM command options - copied from UNIX man() 
  
________________________________________________________________

SZ(1)                                                       SZ(1)

NAME

       sx, sb, sz - XMODEM, YMODEM, ZMODEM file send

SYNOPSIS

       sz [-+abdefkLlNnopqTtuvyYZ] file ...
       sb [-adfkqtuv] file ...
       sx [-akqtuv] file
       sz [-oqtv] -c COMMAND
       sz [-oqtv] -i COMMAND
       sz -T

DESCRIPTION

       Sz uses the ZMODEM, YMODEM or XMODEM error correcting pro-
       tocol to send one or more files over a dial-in serial port
       to a variety of programs running under PC-DOS, CP/M, Unix,
       VMS, and other operating systems.

       Sz is not intended be called from cu(1) or other  communi-
       cations  programs.  Unix flavors of Omen Technology's Pro-
       fessional-YAM communications software  are  available  for
       dial-out applications.  (Reg.)

       Sz sends one or more files with ZMODEM protocol.

       ZMODEM  greatly simplifies file transfers compared to XMO-
       DEM.  In addition to a  friendly  user  interface,  ZMODEM
       provides  Personal  Computer and other users an efficient,
       accurate, and robust file transfer method.

       ZMODEM provides complete END-TO-END data integrity between
       application  programs.  ZMODEM's 32 bit CRC catches errors
       that sneak into even the most advanced networks.

       Advanced file  management  features  include  AutoDownload
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       (Automatic  file Download initiated without user interven-
       tion), Display of individual and total  file  lengths  and
       transmission  time  estimates,  Crash  Recovery, selective
       file transfers, and preservation of exact  file  date  and
       length.

       The  -y option instructs the receiver to open the file for
       writing  unconditionally.   The  -a  option   causes   the
       receiver  to  convert  Unix  newlines  to  PC-DOS carriage
       returns and linefeeds.

       "Sb" batch sends one or more files  with  YMODEM  or  ZMODEM
       protocol.   The initial ZMODEM initialization is not sent.
       When requested by the receiver, sb supports YMODEM-g  with
       "cbreak"  tty  mode,  XON/XOFF flow control, and interrupt
       character set to CAN (^X).  YMODEM-g  (Professional-YAM  g
       option)  increases  throughput  over  error  free channels
       (direct connection, X.PC, etc.)  by not acknowledging each
       transmitted sector.

       On  Unix systems, additional information about the file is
       transmitted.  If the receiving program uses this  informa-
       tion,  the transmitted file length controls the exact num-
       ber of bytes written to the output dataset, and the modify
       time and file mode are set accordingly.

       "Sx"  sends  a single file with XMODEM or XMODEM-1k protocol
       (sometimes incorrectly called "ymodem").   The  user  must
       supply  the  file  name to both sending and receiving pro-
       grams.

       Iff "sz" is invoked with $SHELL set and  iff  that  variable
       contains  the  string  rsh  or rksh (restricted shell), "sz"
       operates in restricted mode.   Restricted  mode  restricts
       pathnames  to  the  current  directory and PUBDIR (usually
       /usr/spool/uucppublic) and/or subdirectories thereof.

       The fourth  form  sends  a  single  COMMAND  to  a  ZMODEM
       receiver  for execution.  "Sz" exits with the COMMAND return
       value.  If COMMAND includes spaces or  characters  special
       to the shell, it must be quoted.

       The fifth form sends a single COMMAND to a ZMODEM receiver
       for execution.  "Sz" exits as soon as the receiver has  cor-
       rectly received the command, before it is executed.
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       The  sixth  form  (sz -T) attempts to output all 256 code
       combinations to the terminal.  In you  are  having  diffi-
       culty sending files, this command lets you see which char-
       acter codes are being eaten by the operating system.

       If "sz" is invoked  with  stdout  and  stderr  to  different
       datasets,  Verbose  is  set  to  2, causing frame by frame
       progress reports to stderr.  This may be disabled with the
       qq option.

       The meanings of the available options are:

       \      (backslash)  (VMS)  Force the next option letter to
              upper case.

       +      Instruct the receiver to append transmitted data to
              an existing file (ZMODEM only).

       a      Convert  NL  characters  in the transmitted file to
              CR/LF.  This is done by the sender for  XMODEM  and
              YMODEM, by the receiver for ZMODEM.

       b      (ZMODEM) Binary override: transfer file without any
              translation.

       c COMMAND
              Send COMMAND to the receiver for execution,  return
              with COMMAND's exit status.

       d      Change all instances of "." to "/" in the transmit-
              ted pathname.  Thus, C.omenB0000  (which  is  unac-
              ceptable  to  MSDOS  or  CP/M)  is  transmitted  as
              C/omenB0000.  If the resultant  filename  has  more
              than 8 characters in the stem, a "." is inserted to
              allow a total of eleven.

       e      Escape all control characters; normally XON,  XOFF,
              DLE, CR-@-CR, and Ctrl-X are escaped.

       f      Send  Full  pathname.   Normally directory prefixes
              are stripped from the transmitted filename.

       i COMMAND
              Send COMMAND to the receiver for execution,  return
              Immediately upon the receiving program's successful
              recption of the command.
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       k      (XMODEM/YMODEM) Send files using 1024  byte  blocks
              rather than the default 128 byte blocks.  1024 byte
              packets speed file transfers  at  high  bit  rates.
              (ZMODEM  streams  the  data  for  the best possible
              throughput.)

       L N    Use ZMODEM sub-packets of length N.  A larger N (32
              <=  N  <= 1024) gives slightly higher throughput, a
              smaller N speeds error recovery.   The  default  is
              128  below  300  baud,  256 above 300 baud, or 1024
              above 2400 baud.

       l N    Wait for the receiver to acknowledge  correct  data
              every  NN (32 <= N <= 1024) characters.  This may be
              used to avoid network overrun when XOFF  flow  con-
              trol is lacking.

       n      (ZMODEM)  Send  each  file if destination file does
              not exist.  Overwrite destination  file  if  source
              file is newer than the destination file.

       N      (ZMODEM)  Send  each  file if destination file does
              not exist.  Overwrite destination  file  if  source
              file  is newer or longer than the destination file.

       o      (ZMODEM) Disable automatic selection of 32 bit CRC.

       p      (ZMODEM)  Protect  existing  destination  files  by
              skipping transfer if the destination file exists.

       q      Quiet suppresses verbosity.

       r      (ZMODEM) Resume interrupted file transfer.  If  the
              source  file  is  longer than the destination file,
              the transfer commences at the offset in the  source
              file  that  equals  the  length  of the destination
              file.

       rr     As above, but compares the files (the portion  com-
              mon  to  sender  and  reciever) before resuming the
              transfer.

       t tim  Change timeout to tim tenths of seconds.

       u      Unlink the file after successful transmission.
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       w N    Limit the transmit window size to N bytes (ZMODEM).

       v      Verbose  causes a list of file names to be appended
              to /tmp/szlog .  More v's generate more output.

       y      Instruct a ZMODEM receiving  program  to  overwrite
              any existing file with the same name.

       Y      Instruct  a  ZMODEM  receiving program to overwrite
              any existing file with the same name, and  to  skip
              any  source files that do have a file with the same
              pathname on the destination system.

       Z      Use ZMODEM file compression to speed file transfer.

EXAMPLES

   ZMODEM File Transfer (Unix to DSZ/ZCOMM/Professional-YAM)

       % sz -a *.c

       This  single command transfers all .c files in the current
       Unix directory with conversion (-a) to end of line conven-
       tions appropriate to the receiving environment.  With ZMO-
       DEM AutoDownload enabled, Professional-YAM  and ZCOMM will
       automatically  recieve  the files after performing a secu-
       rity check.

       % sz -Yan *.c *.h

       Send only the .c and .h files that exist on both  systems,
       and are newer on the sending system than the corresponding
       version on the receiving system, converting  Unix  to  DOS
       text format.

       $  sz -\Yan file1.c file2.c file3.c foo.h baz.h (Reg.)(for
       VMS)

   ZMODEM Command Download (Unix to Professional-YAM)

        cpszall:all
           sz -c "c:;cd /yam/dist"
           sz -ya $(YD)/*.me
           sz -yqb y*.exe
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           sz -c "cd /yam"
           sz -i "!insms"

       This Makefile fragment uses sz to issue commands  to  Pro-
       fessional-YAM to change current disk and directory.  Next,
       sz transfers the .me files from the  $YD  directory,  com-
       manding  the  receiver  to  overwrite the old files and to
       convert from Unix end of line conventions to  PC-DOS  con-
       ventions.   The third line transfers some .exe files.  The
       fourth and fifth lines command Pro-YAM to change directory
       and  execute  a PC-DOS batch file insms .  Since the batch
       file takes considerable time, the -i form is used to allow
       sz to exit immediately.

   XMODEM File Transfer (Unix to Crosstalk)

       % sx -a foo.c
       ESC
       rx foo.c

       The  above three commands transfer a single file from Unix
       to a PC and Crosstalk with sz translating Unix newlines to
       DOS  CR/LF.   This combination is much slower and far less
       reliable than ZMODEM.

ERROR MESSAGES

       "Caught signal 99" indicates the program was not  properly
       compiled, refer to "bibi(99)" in rbsb.c for details.

SEE ALSO

       rz(omen),    ZMODEM.DOC,   YMODEM.DOC,   Professional-YAM,
       crc(omen),     sq(omen),     todos(omen),     tocpm(omen),
       tomac(omen), yam(omen)

       Compile  time  options required for various operating sys-
       tems are described in the source file.

VMS VERSION

       The VMS version does not support wild cards.   Because  of
       VMS  DCL, upper case option letters muse be represented by
       \ proceding the letter.

       The current VMS version  does  not  support  XMODEM,  XMO-
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       DEM-1k, or YMODEM.

       VMS C Standard I/O and RMS may interact to modify the file
       contents.

FILES

       /tmp/szlog  stores  debugging  output  (sz  -v) (szlog on
       VMS).

TESTING FEATURE

       The command "sz -T file" exercises the Attn sequence error
       recovery  by  commanding errors with unterminated packets.
       The receiving program should  complain  five  times  about
       binary  data  packets  being too  long.  Each time "sz" is
       interrupted, it should send a  ZDATA  header  followed  by
       another defective packet.  If the receiver does not detect
       five long data packets, the Attn sequence  is  not  inter-
       rupting the sender, and the Myattn string in "sz.c" must be
       modified.

       After 5 packets, "sz" stops the "transfer" and prints  the
       total  number  of characters "sent" (Tcount).  The differ-
       ence between Tcount and  5120  represents  the  number  of
       characters   stored  in  various  buffers  when  the  Attn
       sequence is generated.

NOTES
       Sz is not intended be called from cu(1) or other  communi-
       cations  programs.   Unix  flavors  of  Omen  Technology's
       Professional-YAM communications software are available for
       dial-out applications.

       If  a  program that does not properly implement the speci-
       fied file transfer protocol causes sb to "hang"  the  port
       after a failed transfer, either wait for sb to time out or
       keyboard  a  dozen  Ctrl-X  characters.   Every   reported
       instance  of  this  problem  has  been  corrected by using
       ZCOMM, Pro-YAM, DSZ,  or  other  program  with  a  correct
       implementation of the specified protocol.

       Many programs claiming to support YMODEM only support XMO-
       DEM with 1k blocks, and they often don't  get  that  quite
       right.   XMODEM  transfers add up to 127 garbage bytes per
       file.  XMODEM-1k and  YMODEM-1k  transfers  use  128  byte

dataComet-Secure Online Documentation - Author: Bonze Anne Rose Blayk 156/231



       blocks to avoid extra padding.

       YMODEM  programs  use  the  file length transmitted at the
       beginning of the transfer to prune the file to the correct
       length;  this  may  cause  problems with source files that
       grow during the course of the transfer.  This problem does
       not  pertain to ZMODEM transfers, which preserve the exact
       file length unconditionally.

       Most ZMODEM options are merely  passed  to  the  receiving
       program;  some  programs  do  not  implement  all of these
       options.

       Circular buffering and a ZMODEM sliding window  should  be
       used  when  input  is  from pipes instead of acknowledging
       frames each 1024 bytes.  If no files  can be  opened, "sz"
       sends  a ZMODEM command to echo a suitable complaint; per-
       haps it should check for the  presence  of  at  least  one
       accessible file before getting hot and bothered.

       A  few  high  speed  modems have a firmware bug that drops
       characters when the direction of high  speed  transmissson
       is  reversed.  The environment variable ZNULLS may be used
       to specify the number of nulls  to  send  before  a  ZDATA
       frame.   Values of 101 for a 4.77 mHz PC and 124 for an AT
       are typical.

BUGS

       On at least one BSD system, sz would abend it got within a
       few  kilobytes  of  the  end of file.  Using the "-w 8192"
       flag fixed the problem.  The real cause is  unknown,  per-
       haps a bug in the kernel TTY output routines.

       The  test  mode leaves a zero length file on the receiving
       system.

RZ(1)                                                       RZ(1)
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NAME

       rx, rb, rz - XMODEM, YMODEM, ZMODEM (Batch) file receive

SYNOPSIS

       rz [- +abepqtuvy]
       rb [- +abqtuvy]
       rx [- abceqtuv] file
       gz file ...
       [-][v]rzCOMMAND

DESCRIPTION

       This  program  uses  error correcting protocols to receive
       files over a dial-in serial port from a  variety  of  pro-
       grams  running under PC-DOS, CP/M, Unix, and other operat-
       ing systems.  It is invoked from a shell prompt  manually,
       or  automatically  as a result of an "sz file ..." command
       given to the calling program.

       Rz is not intended be called from cu(1), or other communi-
       cations  programs.  Unix flavors of Omen Technology's Pro-
       fessional-YAM communications software  are  available  for
       dial-out applications.  (Reg.)

       "Rz" (Receive ZMODEM) receives files with the ZMODEM batch
       protocol.  Pathnames are supplied by the sending  program,
       and  directories  are  made  if  necessary (and possible).
       Normally, the "rz" command is automatically issued by  the
       calling  ZMODEM  program, but some defective ZMODEM imple-
       mentations may require starting rz the old fashioned  way.
       Rz  does  not  support ZMODEM Crash Recovery, compression,
       and other ZMODEM features.  Unix flavors of  Professional-
       YAM  may  be linked to "rz" and used in place of this pro-
       gram to support these ZMODEM features.

       "Rb" receives file(s) with YMODEM, accepting either standard
       128  byte sectors or 1024 byte sectors (YAM sb -k option).
       The user should determine when the 1024 byte block  length
       actually  improves throughput without causing lost data or
       even system crashes.

       If True YMODEM (Omen Technology trademark)  file  informa-
       tion  (file  length,  etc.)   is received, the file length
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       controls  the  number  of  bytes  written  to  the  output
       dataset,  and the modify time and file mode (iff non zero)
       are set accordingly.

       If no True YMODEM file information is received, slashes in
       the  pathname  are changed to underscore, and any trailing
       period in the pathname is eliminated.  This conversion  is
       useful for files received from CP/M systems.  With YMODEM,
       each file name is converted to lower case unless  it  con-
       tains one or more lower case letters.

       "rx" receives a single file with XMODEM or XMODEM-1k proto-
       col.  The user should determine when the 1024  byte  block
       length  actually improves throughput without causing prob-
       lems.  The user must supply the file name to both  sending
       and receiving programs.  Up to 1023 garbage characters may
       be added to the received file.

       "gz" is a shell script which calls sz to command Pro-YAM or
       ZCOMM  to  transmit  the  specified files.  Pathnames used
       with gz must be escaped if they have special  significance
       to the Unix shell.

          EXAMPLE: gz "-a C:*.c D:*.h"

       "rz" may be invoked as "rzCOMMAND" (with an optional leading -
       as generated by login(1)).  For  each  received  file,  rz
       will  pipe the file to ``COMMAND filename'' where filename
       is the name of the transmitted file with the file contents
       as standard input.

       Each file transfer is acknowledged when COMMAND exits with
       0 status.  A non zero exit status terminates transfers.

       A typical  use  for  this  form  is  rzrmail  which  calls
       rmail(1)  to post mail to the user specified by the trans-
       mitted file name.  For example,  sending  the  file  "caf"
       from  a  PC-DOS  system  to rzrmail on a Unix system would
       result in the contents of the DOS file "caf" being  mailed
       to user "caf".

       On  some  Unix systems, the login directory must contain a
       link to COMMAND as login sets  SHELL=rsh  which  disallows
       absolute  pathnames.   If invoked with a leading ``v'', rz
       will report progress to /tmp/rzlog.  The  following  entry
       works for Unix SYS III/V:
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                 rzrmail::5:1::/bin:/usr/local/rzrmail

       If  the  SHELL  environment  variable includes rsh or rksh
       (restricted shell), rz will not accept absolute  pathnames
       or  references  to  a parent directory, will not modify an
       existing file, and removes any files received in error.

       If rz is invoked  with  stdout  and  stderr  to  different
       datasets,  Verbose  is  set  to  2, causing frame by frame
       progress reports to stderr.  This may be disabled with the
       qq option.

       The meanings of the available options are:

       a      Convert files to Unix conventions by stripping car-
              riage returns and all characters beginning with the
              first Control Z (CP/M end of file).

       b      Binary (tell it like it is) file transfer override.

       c      Request 16 bit CRC.  XMODEM file transfers  default
              to  8 bit checksum.  YMODEM and ZMODEM normally use
              16 bit CRC.

       D      Output file data to /dev/null; for testing.   (Unix
              only)

       e      Force sender to escape all control characters; nor-
              mally XON,  XOFF,  DLE,  CR-@-CR,  and  Ctrl-X  are
              escaped.

       p      (ZMODEM)  Protect:  skip  file  if destination file
              exists.

       q      Quiet suppresses verbosity.

       t tim  Change timeout to tim tenths of seconds.

       v      Verbose causes a list of file names to be  appended
              to /tmp/rzlog .  More v's generate more output.

       y      Yes, clobber any existing files with the same name.
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EXAMPLES

       (Pro-YAM command)
       <ALT-2>
       Pro-YAM Command: sz *.h *.c
       (This automatically invokes rz on the connected system.)

SEE ALSO

       ZMODEM.DOC,   YMODEM.DOC,   Professional-YAM,   crc(omen),
       sz(omen), usq(omen), undos(omen)

       Compile  time  options required for various operating sys-
       tems are described in the source file.

NOTES

       ZMODEM's support of XOFF/XON flow  control  allows  proper
       operation  in many environments that do not support XMODEM
       uploads.  Unfortunately, not all timesharing systems  sup-
       port  input flow control.  The TTY input buffering on some
       systems may not adequately buffer long blocks or streaming
       input at high speed.  You should suspect this problem when
       you can't send data to the  Unix  system  at  high  speeds
       using ZMODEM, but YMODEM-1k or XMODEM-1k, when YMODEM with
       128 byte blocks works properly.

       The DSZ or Pro-YAM zmodem l numeric parameter may  be  set
       to  a  value between 64 and 1024 to limit the burst length
       ("zmodem  pl128").   Although  this  compromises  ZMODEM's
       throughput,  ZMODEM's superior reliability remains intact.

       If a program that does not properly implement  the  speci-
       fied  file  transfer protocol causes rz to "hang" the port
       after a failed transfer, either wait for rz to time out or
       keyboard   a  dozen  Ctrl-X  characters.   Every  reported
       instance of this  problem  has  been  corrected  by  using
       ZCOMM,  Pro-YAM,  DSZ,  or  other  program  with a correct
       implementation of the specified protocol.

       Many programs claiming to support YMODEM only support XMO-
       DEM  with  1k  blocks, and they often don't get that quite
       right.

       In the case of a few poorly designed microcomputers, send-
       ing serial data to a tty port at sustained high speeds has
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       been known to cause lockups, system halts, kernel  panics,
       and  occasional antisocial behaviour.  This problem is not
       unique to rz; CRT terminals with block  mode  transmission
       and  line  noise have the same effect.  When experimenting
       with high speed input to a system, consider rebooting  the
       system  if  the  file  transfers are not successful, espe-
       cially if the personality of the system appears altered.

       The Unix "ulimit" parameter must be  set  high  enough  to
       permit large file transfers to Unix.

       32  bit  CRC  code courtesy Gary S. Brown.  Directory cre-
       ation code from John Gilmore's PD TAR program.

BUGS
       Rz is not intended be called from cu(1), or other communi-
       cations  programs.  Unix flavors of Omen Technology's Pro-
       fessional-YAM communications software  are  available  for
       dial-out applications.

       Rz  does  not  support ZMODEM Crash Recovery, compression,
       and other ZMODEM features.  Unix flavors of  Professional-
       YAM may be linked to "rz" to support these features.

       Pathnames  are  restricted  to  127 characters.  In XMODEM
       single file mode, the pathname given on the  command  line
       is still processed as described above.  The ASCII option's
       CR/LF to NL translation merely deletes  CR's;  undos(omen)
       performs a more intelligent translation.

VMS VERSION

       The VMS version does not set the file time.

       VMS  C  Standard  I/O  and RMS may interact to modify file
       contents unexpectedly.

       The VMS version does not support invocation as "rzCOMMAND" ..
       The  current  VMS  version  does  not support XMODEM, XMO-
       DEM-1k, or YMODEM.

       According to the VMS  documentation,  the  buffered  input
       routine  used  on the VMS version of rz introduces a delay
       of up to one second for each protocol  transaction.   This
       delay  may  be significant for very short files.  Removing
       the "#define BUFREAD" line from rz.c will  eliminate  this

dataComet-Secure Online Documentation - Author: Bonze Anne Rose Blayk 162/231



       delay at the expense of increased CPU utilization.

       For high speed operation, try increasing the SYSGEN param-
       eter TTY_TYPAHDSZ to 256.

       The VMS version causes DCL to generate a  random  off  the
       wall  error message under some error conditions; this is a
       result of the incompatibility of the VMS  "exit"  function
       with the Unix/MSDOS standard.

ZMODEM CAPABILITIES

       Rz  supports incoming ZMODEM binary (-b), ASCII (-a), pro-
       tect (-p), clobber (-y), and append (-+) requests.   Other
       options  sent  by  the sender are ignored.  The default is
       protect (-p) and binary (-b).

       The Unix versions support ZMODEM command execution.

FILES

       /tmp/rzlog stores  debugging  output  generated  with  -v
       option (rzlog on VMS).

________________________________________________________________
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            A0. Problem solving

________________________________________________________________

      dataComet documentation.  (Rev. 1/27/08) 
      Copyright 1995 databeast, Inc. All Rights Reserved.

   This document has information on (select and use "Find..." to go to the 
section):

         General notes
         Fonts
         "How do I select a separate print font size?"
         Function keys don't work
         dataComet crashes on launch
         Pressing Return in ASCII emulators gets two responses
         IBM mainframe QMF application shows "GDDM" error
         Funny characters appear in 3270 displays
         Serial problems

       ___________________________________________________

         General notes
       ___________________________________________________

   Compatibility:  dataComet-X and dataComet-Secure X are compatible with OS 
X 10.2 and later.  

   Menu-key equivalents are superseded by macro keys, but the menus are not 
corrected.

   If you try to download a file to a locked disk, after the file transfer 
fails you will not be able to access that particular file again until you 
quit and restart dataComet; you will not be able to completely dismount the 
disk because the file will be "busy", although you can eject the disk, unlock 
it, and access other files.

       ___________________________________________________

         Fonts
       ___________________________________________________

   You will obtain best results in screen display with Comet-Fonts in the 9, 
12, or 16 point sizes.  Note that the Comet Fonts must be installed in the 
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Fonts folder under OS X before they will be available.  These fonts allow 
display of special graphics characters used by VT100, PC-ANSI or SCO-ANSI, 
and IBM terminals.  

   Versions of dataComet after 10.0.2 include TrueType fonts so printing of 
these characters is fully supported under OS X; if you select smaller sizes 
other than 9, 12, or 16 for on-screen display, you get a TrueType rendition, 
which may not appear as legible.

       ___________________________________________________

         "How do I select a separate print font size?"       
       ___________________________________________________

   dataComet allows you to select a print font and size different from your 
normal screen font and size:  hold down the Option key while selecting the 
font from the "Control->Font->" submenu to select a separate print font; hold 
down the Option key while selecting the "Control->Size->" submenu to select a 
separate print font size.  The separate print font and size will be marked 
with a '>' character in the submenu.

       ___________________________________________________

         Function Keys don't work
       ___________________________________________________

   Dashboard and Exposé, among other MacOS X applications, are configured to 
use some of the Function keys.  You can free up the Function keys by opening 
the System Preferences "Dashboard & Exposé" panel and changing the 
keymappings.  You can change other Function key remappings that might be in 
effect by opening the System Preferences "Keyboard & Mouse" panel and 
selecting "Keyboard Shortcuts".

       ___________________________________________________

         dataComet crashes on launch
       ___________________________________________________

   dataComet may crash when launched if the "Comet Default" document in the 
dataComet Preferences folder has become corrupted (in User Preferences/
dataComet Preferences under OS X or the System Folder/Preferences/dataComet 
Preferences under OS 9).  Try deleting the document and launching again.

dataComet-Secure Online Documentation - Author: Bonze Anne Rose Blayk 165/231



       ___________________________________________________

         Pressing Return in ASCII emulators gets two responses
       ___________________________________________________

   If you get two lines or skip the "password:" line on login after pressing 
Return, try changing the settings for "Return key sends:" "Carriage Return", 
"Line Feed" in the "Control Emulator" dialog.  dataComet ASCII sessions 
default to the Telnet standard and sends CR-LF when return is pressed; 
sometimes hosts are configured to interpret BOTH as Carriage Returns, so you 
get two responses when you press Return once:  one responding to the line you 
entered, and one responding to an "empty" line.

       ___________________________________________________

         IBM mainframe QMF application shows "GDDM" error
       ___________________________________________________

   If you get a message like this from your IBM mainframe host when 
attempting to use dataComet:

DSQ40079 GDDM error ADM0088 E QUERY VALUE ERROR: TOKEN '*', HDR X'001C8186', 
O FF X'1B'.  Severity 8.

you can fix it by enabling the "Control Color..." dialog item "… except 
Background" so that dataComet will report that it doesn't offer background 
colors.

       ___________________________________________________

         Funny characters appear in 3270 displays
       ___________________________________________________

   If you see odd characters appearing in a 3270 display, you should try 
selecting the font again (preferably Comet Mona, a standard Macintosh font, 
or Comet ALA for NOTIS library system access).

   You can also correct this by manually selecting the "Control Translation" 
setting; this is performed automatically when you select a font.  Note, 
however, that no EBCDIC mappings are currently provided for "3270 {} Comet 
ISO-Latin-1", "3270 {} Comet DEC Multinational", or "3270 {} Comet PC-ANSI", 
so extended ASCII characters > 128 will not be translated correctly for these 
special non-Macintosh character sets.
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       ___________________________________________________

         Serial problems
       ___________________________________________________

   These are often the most complex and difficult problems to resolve due to 
the variety of settings possible and the vagueness of the RS-232C port on 
most modems (which is interfaced to an RS-422 port on the Macintosh).  This 
warning also applies if you're using a USB to serial adapter to make a serial 
connection. 

   If you're using hardware handshake, which is the preferred mode, make sure 
that you have a cable which supports hardware handshaking.  If you are 
experiencing data loss or errors in transmission, try lowering the baud rate 
to 19,200 or 9600; if your cable is not of good quality and there is a lot of 
EMI present (Electro-Magnetic Interference) from other computers or 
electronic devices, the signals on the cable may be corrupted by the 
interference.

________________________________________________________________
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            A1. dataComet & dataComet-Secure X Release Notes

________________________________________________________________

      dataComet documentation.  (Rev. 7/23/2012) 
      Copyright 2010 databeast, Inc. All Rights Reserved.
    
   This document has information on (select and use "Find..." to go to the section):

         Known Bugs in the current version

         Release Notes:

         dataComet-X for OS X:
           10.2.2
           10.2.1r2   10.2.1r1    10.2.1      10.2.1b2    10.2.1b1
           10.2.0     10.2.0b3    10.2.0b2    10.2.0b1    

         dataComet-Secure X for OS X:
           10.2.2
           10.2.1r2   10.2.1r1    10.2.1b2    10.2.1b1
           10.2.0     10.2.0b3    10.2.0b2    10.2.0b1    

   A version of dataComet for OS X without encryption support built in is being made available as "dataComet X".  dataComet, 
unlike dataComet-Secure, can be redistributed freely as shareware without complying with Federal Export controls which apply to 
dataComet-Secure.  In other respects dataComet is identical to dataComet-Secure for Mac OS X.

       ___________________________________________________

         Known Bugs in the current version
       ___________________________________________________

 * dataComet fonts do not work with the OS X "Keyboard Viewer" Input menu option.  (Under Snow Leopard they now work with the 
"Character Viewer" palette.)

 * NOT bugs:  The Console application reports errors when dataComet is launched stating "com.apple.fontd[114] FODBCheck: foRec-
>annexNumber != kInvalidAnnexNumber (0)", and the Font Book application lists a "Problems" with "'FOND' font association 
usability" when the Comet bitmap fonts are validated, stating "2 serious errors were found.  Do not use these fonts."  For some 
reason OS X since Leopard has been reporting errors with bitmap fonts which are not embedded along with TrueType fonts; however, 
these are the only problems reported, and the fonts continue to work fine.

       ___________________________________________________

         10.2.2 -Secure                          6/25/12
         10.2.2 -X     
       ___________________________________________________

Features:

 * Added Code Signing security feature for dataComet and dataComet-Secure releases so that Mountain Lion's new GateKeeper system 
will recognize them as applications by an identified developer. 

       ___________________________________________________

         10.2.1r2 -Secure                        1/17/12
         10.2.1r2 -X     
       ___________________________________________________

Bug Fixes:

 * Fixed a bug which caused dataComet to crash when "Scrollback Buffering" was turned on and the scrollback buffer was cleared, 
or the emulator window was resized.

 * dataComet should no longer crash if the dataComet "Preferences..." dialog panel is opened when no other windows are open.
 
 * The estimate of the current speed of file transfers in the File Transfer Progress dialog is now more accurate.

       ___________________________________________________

         10.2.1r1 -Secure                         8/5/10
         10.2.1r1 -X     
       ___________________________________________________
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Bug Fixes:

 * MAJOR BUG FIX:  Creating a new terminal session will no longer cause dataComet to crash after the session connection is 
completed.  This was occurring when the session had the Control menu Translation option set by default; the translation table 
resource file was being closed, resulting in the disappearance of the table from memory and failure when the emulator attempted 
to read from the translation table.

 * SSH2 connections will now open a session cleanly the first time through when the login name has not already been saved as the 
session's Username (which appears in the "Configure Terminal Session..." dialog).  A preliminary dialog for entering the login 
user name before initiating SSH user authorization negotiations has been added to fix this problem.

 * The Command-R key combination once again executes the Window menu "Re-open Session" command, as in earlier versions of 
dataComet.

 * The font width setting in the "Control" menu "Width" menu is now ignored when printing.

 * Horizontal scrolling in edit windows using the mouse has been fixed so that no scrolling is performed when text in the edit 
window is displayed as wrapped text.  This avoids a condition where the text could be scrolled to the right, but could not 
scrolled back to the left margin, requiring the window to be resized to display the text correctly.

 * The '¥" mark in the Window menu window list indicating that a terminal session is open is now set correctly on a consistent 
basis.

 * The File menu "Page Eject" command will now force printing and reset VT100 print streaming mode if a VT100 print stream has 
not received a VT100 "End print stream" control sequence from the host.

       ___________________________________________________

         10.2.1 -Secure                          7/20/10
         10.2.1 -X     
       ___________________________________________________

Bug Fixes:

 * Backspace now works with Undo, but does not set the Clipboard, so Paste will paste the text in the Clipboard from the previous 
Copy or Cut command.

 * The ".txt" suffix is now added automatically to text documents when they are first saved; performing a "Save as..." for an 
existing document with ".txt" added will delete the old edit document if the name is otherwise the same.

 * dataComet edit windows now have their window resources and dataComet 'usro' Finder -> dataComet link set promptly when they 
are first saved.

 * dataComet "session.edit" windows are now brought to the front when the document is opened from the Finder and the document is 
already open, rather than opening a new window.

       ___________________________________________________

         10.2.1b2 -Secure                         7/6/10
         10.2.1b2 -X     
       ___________________________________________________

Features:

 * Emulator window drawing routines have been modified so display of text files transmitted from the host will be processed 2-3X 
faster, with screen updates of the current page of large files occurring every second rather than every two seconds.

 * Added support for Keyboard Interactive mode in SSH, along with a dialog to perform the Challenge/Response interaction.  SSH 
sessions are configured by default to use the session password as the response, and skip the dialog when there is only one 
Challenge from the host; this feature can be disabled using the "Use session password automatically" checkbox in the "Configure 
SSH" dialog (which is reached from the Configure Terminal Session dialog).

 * Added a Cancel Macro dialog to display a string and query the user whether she wishes to cancel the current macro, along with 
a "!QM" macro command to post the dialog.  The "!p?" RSLT_TESTMACROFAIL macro command can now also have an optional string 
appended to it (ending with "!\000"), in which case failure will bring up the Cancel Macro dialog with the string used as a 
prompt.

 * Added more macro failure conditions which can be tested using the "!p?" macro command; these are documented in the dataComet 
Help document "4.1. macrocodes.h" as "sets RSLT_TESTMACROFAIL" conditions.

Bug Fixes:

 * Define Macro dialog:
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   - Button, Menu, and Connection macros are now updated reliably when the "Set" button is pressed; previously this worked 
correctly only once without closing and reopening the dialog.
   - The correct button name and macro contents are displayed when sessions are switched using the popup menu.
   - The text field in the dialog now displays "\000" for NUL characters in the macro, since only Comet Fonts contain a 
corresponding glyph for the "^@" NUL character.

 * Macros:

   - The "!L\nnn" loop command has been fixed so the correct number of loops are performed; existing macros containing loop 
commands may need to be modified to accomodate this change.
   - Nested "!L\nnn" loops now work correctly.
   - The "!Z\nnnSTRING\000" wait for string command now works when embedded in loops.

 * The text cursor or selection range in the frontmost edit window should now be displayed (or hidden) correctly when the 
"Find..." dialog is being used when switching windows.

       ___________________________________________________

         10.2.1b1 -Secure                        5/24/10
         10.2.1b1 -X     
       ___________________________________________________

Features:

 * dataComet now draws selected fonts with antialiasing disabled so bitmap fonts can be displayed.  This feature is implemented 
using a list of fonts and sizes to be drawn with antialiasing disabled.  This provides a huge improvement over earlier 
implementations of this feature in dataComet.  (In the Beta implementation of this feature, this list is saved in a text 
document, "xFont List", which can be edited by the user by selecting the "View Font List" button in the Preferences Global 
Preferences panel.)
   
 * dataComet now checks the databeast.com website and presents an alert to inform you when a new version is available.  You can 
disable this feature in the dataComet "Preferences" "Global" panel.  (This feature can also be completely disabled for site 
distributions by placing a "GetVersionDisabled" file in the dataComet application bundle's "Resources" folder.)

 * Session and text document windows now have a popup menu at the top of the vertical scroll bar which contains a sorted list of 
open documents to make switching windows easier.

 * Cloned, multiply launched, new Shell, and untitled windows now have a number appended to the Window title to help 
differentiate between these windows.  When the configuration of a numbered Session window is saved, the document name in the 
"Save Configuration" dialog defaults to the original Session document name, so saving a numbered Session window will, by default, 
update the source Session document.

 * The dataComet application, session document, and text document icons have been updated, along with the splash screen.

Session Enhancements:

 * You can now set Telnet sessions so Telnet protocol interpretation is disabled, enabling dataComet to conduct raw TCP sessions.  
Telnet menu options selecting "7-bit characters"/"8-bit characters", "Send after return"/"Send characters promptly", "Local 
echo"/"Remote echo" are now saved in the session configuration and applied when a Telnet session is in raw mode.

 * dataComet-Secure now includes support for sending stored passwords over unencrypted Telnet and Serial sessions, so you can log 
in to sessions automatically by incorporating the "!tu" "Send username" and "!tp" "Send password" macros in a Connection Macro.  
This "Macro" password is transmitted once, and only once, per session.  The "Configure Terminal Session" now allows you to enter 
a password for these types of connections in the "Password" field; this type of password, however, is saved in a location 
separate from the password for the more secure session types.

 * An option to "Prompt before closing if session open" has been added to the Preferences "Session" panel, so one can disable the 
alert requesting an OK before closing a session window when a session is still open.

 * The Serial menu now has a "Local Echo" item to allow you to enable local echo on serial sessions.

 * Mouse single-clicks in an IBM 3270 session window now move the cursor immediately.

Menu enhancements:

 * The "Control" -> "Size" submenu now includes "Larger" and "Smaller" commands to change the font size; these commands have been 
assigned to the Command-'+' and Command-'=' keys.  

 * Selecting a window from the "Window" menu for a Session document now brings up both the emulator and its .edit window in their 
prior order, and no longer alternates between the emulator and .edit windows; pressing the Control key while selecting a window 
brings only the emulator window forward; pressing the Option key while selecting a window brings only the .edit window forward.

 Menu key command changes:

 - Command-',' now brings up the dataComet "Preferences" dialog rather than executing the "Match Brackets" command.
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 - Command-''' and Command-'"' execute the "Match Brackets" command.  (The "Scrollback Buffering" command no longer has
   a command-key equivalent.)

 - Command-'E' now executes the Mac standard "Use Selection for Find" command.  You can then use "Find Again..." (Command-'G') 
   to find the string.

 - Command-';' now executes the "Toggle .edit Window" command.

 - Command-':' now executes the "Go to Line..." command.

 - Command-'+' and Command-'=' make the screen font size larger or smaller.
  
 - Command-'\' executes the Zoom command.

 - Command-'|' executes the Window menu "Close Session" command.

 - Command-Option-'/' is now used to execute the Cursor menu "Add Returns" command, since Apple now uses it for a default 
   Shortcut.

Dialog Enhancements:

 * The dataComet "Preferences" panels now contain a popup menu with a list of open documents, allowing you to view session 
configurations for different sessions easily.  The dataComet "Preferences" dialog now saves its position so the next time you 
open it, it will appear in the same place on the screen.

 * The dataComet "Preferences" "Printing" panel now has popup menus allowing you to view and select the font and font size 
settings for both onscreen display and printing.  The Control menu "Font" and "Size" submenus now set only the on-screen font and 
its size by default; you can set the Print font and size from these menus by holding down the Option key.

 * A Help dialog has been added to improve help for modal dialogs, such as the "Configure Terminal Session" dialog; Control-
Clicking on an item in a modal configuration dialog will open the Help dialog and display the information for that item.

 * A number of improvements were made to the "Define Macros..." dialog:

   - A popup menu containing a list of open documents now allows you to view settings for other documents easily.

   - Pressing the "Set" button now leaves the selected macro displayed to make editing of macros in other documents easier.  To 
select a new key for remapping, one must now Press the "Cancel" button.

   - A "+ Button" button has been added to the macro dialog to make it easy to add a new button to an emulator's session 
document.

   - The "Use Command Font" checkbox may now be toggled when a macro is displayed, so it's now easier to switch between the 
Command Font, with its graphic renditions of PF keys, and the font selected for displaying the document.

   -  An "Alt-key" checkbox has been added to the dialog so Alt keys can be set without holding down the mouse button.  Toggling 
the checkbox will refresh the key display so the macro can be viewed easily viewed in both the standard and Alt-key states.
   
Macro Enhancements:

 * The area which displays macro buttons at the top of an emulator window now resizes dynamically depending on the number of 
buttons, and the maximum number of buttons per window has been increased to 256 from 24.

 * A new macro command, '!""string\000' has been added so that comments can be incorporated in macros.  The string after this 
command is ignored when macros are executed.
 
 * Macros have been added to simplify opening files which are not in one of dataComet's default open folders:

 - "!Fv":  "!Fvvolumname\000" sets the default folder to use for files subsequently opened with the "!FN" and "!F¢" macro 
commands.

 - "!FN":  "!FNfilename\000" opens a file in the currect macro default folder.

 - "!Fu":  Sets the default directory for opening user macro commands to the user's home directory.

 - "!FUfilepath":  Opens "filepath" in the user's home directory.

 * Added macros for support of global variables:

   - "!$\nnn":  Put global string numbered 'nnn'
   - "!G\nnn":  "Get" variable numbered 'nnn' from following 
      macro string terminated by '\000'
   - "!g\nnn":  "Get" variable numbered 'nnn' from selection
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 * Macros have been added to facilitate loading and transmitting files with data in a CSV format.  These commands are:

 - "!F¢":  "!F¢filename\000" loads data from a file with fields separated by a delimiter into an array of 255 strings.

 - "!¢\nnn" sends the string corresponding to the number to the host.

 - "!,\nnn" sets the field delimiter to a value other than the default value of ','.  (Note that the Tab character is '\009'.)

 * Other macros have been added to support CSV data file processing:

   - "!p+":  select next row of CSV values
   - "!p-":  select previous row of CSV values
   - "!p1":  select first row of CSV values
   - "!p$":  select last row of CSV values
   - "!pe":  test used after "!p+": if end of values, cancel 
             enclosing loop
   - "!p.":  test used after "!p+":  if end of values, cancel 
             all remaining macros
   - "!p?":  tests for error condition in macro command execution
             and aborts macros for the session if an error
             occurred; automatically reset when tested.
   - "!p/":  resets error condition code.

Bug Fixes:

 * CRITICAL:  Remedied a failure to catch SIGPIPE signals when a terminal session was not closed properly from the host end, 
which could cause dataComet to terminate abruptly.  (Note that dataComet sessions do not process data from the host when you have 
scrolled back in the session's scrollback buffer, so connections may be terminated if the host sends data and requires an 
acknowledgment while you are scrolled back.  This deficiency will be remedied in a future release.)

 * Fixed a problem where key macro keycodes were being translated improperly when interpreted on PowerPC vs. Intel machines, so 
that key macros created on one platform could not be used on the other platform.  Keycodes will now be interpreted correctly 
regardless of the type of machine on which they were created; 10.2.0 users must download 10.2.1b1 for this fix to work properly.

 * The size of the button macro name field in the emulator structure has been increased from 63 to 255 so entering a button name 
longer than 63 characters in the "Rename button" dialog will no longer cause a crash.

   Connection fixes:

 * More informative error notices have been added to assist in the interpretation of SSL connection errors. 

 * Connection Macros are now executed only once for Shell sessions; they had been executing twice.

 * Telnet linemode ("Send after Return" in the Telnet menu) now works correctly.

 * Session connections made through TCP (SSH, Telnet, Telnet/SSL) are now deemed to be open as soon as a receive call returns 
data; this was highly unlikely to cause a problem, but avoids a situation where an attempt to send data to the host might fail.

 * Cancelling a Page Setup print-format dialog triggered by host-driven print streaming (VT100) will now cancel printing the 
datastream rather than resulting in repeated Page Setup dialogs.

   Window handling fixes:

 * The emulator screen position is now saved correctly when the session document is closed; in 10.2.0, the position was only 
saved if the window had been zoomed.

 * A zoomed emulator window will now appear on the same monitor when more than one monitor is in use.

 * Command-Clicking on a document window title now brings up the standard MacOS file path popup menu, allowing you to view the 
file path and open folders in the Finder easily.
 
 * The Window menu "Next" command (option-tab) now proceeds to the next open window rather than stopping the cycle if a Session 
window has a closed connection.

 * The appearance of emulator windows has been improved.  The packet counters and timer are now greyed out when the session is 
closed, and the Rows and Columns fields at the bottom of the emulator screen now have more area allocated to them.

   Dialog fixes:

 * Dialogs have been fixed so the text cursor appears when the curosr is over the active text field.

 * The appearance and functionality of the "Find" dialog has been improved.  The "Backwards" checkbox has been replaced by a 
"Previous" button.  The "Replace" command now works correctly when the "Replace" text is empty.
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 * The "Define Macros..." dialog now always displays the ASCII character zero (NUL), which is used in dataComet macros to 
terminate strings, as '\000' rather than the Comet Fonts "^A" character to avoid confusion.

  * The "Configure Terminal Session" dialog has been improved so that tabbing to the next field works in a sensible fashion, and 
clicking on a text field which does not apply to the current connection type produces a brief popup message rather than an 
annoying alert -- and now it's not possible to enter text in that field.

 * The default session type for a "New" session is now Telnet (or SSH for dataComet-Secure) rather than a "Shell" session.

 * Entering an empty address in the "Configure Terminal Session" "Connect to:" field now works correctly to connect to the 
machine's own IP address.

 * The File Transfer Progress dialog now displays byte counts with commas.
  
 * Fixed the File Transfer Progress dialog so the transfer counts are only updated once a second; this yields a substantial 
improvement (~80%) in file transfer performance when using ZModem.

 * IND$FILE IBM file transfers now display an update on the transmitted file length in the emulator prompt area.

   Edit window fixes:

 * Several problems with edit windows have been fixed; extra lines should no longer appear in the window when text is pasted into 
the window.

 * dataComet's edit windows now interpret linefeed characters in files so they display correctly, and saves them back to the file 
as linefeeds.  Edit windows will now reliably load up to the maximum 32,767 character limit, rather than failing to load the last 
2,000 characters of a file which is over 30,000 characters in length.

 * Saving a new Session configuration now always creates a new .edit companion text document, so a "Save text" command will 
succeed when the session document is reopened, even when the .edit document was not saved the first time around.

 * Changing the font in edit windows now takes effect immediately, rather than after the font size is changed.

 * The '<<' and '>>' "Shift Text" buttons at the bottom left corner of edit windows now repeat when they're held down.

   Menu fixes:

 * Saving a new session document to the global sessions folder now updates the Sessions submenu.

 * Submenus have been fixed so they display more rapidly when you move the cursor over them to select an item from them.
 
 * The 3270/5250 menus no longer shift position when the 5250 menu is toggled on and off in the 3270 preferences panel.  The 
Macros menu now always appears before the Window menu.

 * Window Minimize and Maximize events are now handled better; the window's menu item in the Window menu is marked to show the 
window has been Minimized, and you can expand the window by selecting the item.

   File transfer fixes:

 * SCP/RCP file transfers are now enabled in dataComet X, providing an alternative to using ZModem.  SCP transfers in dataComet X 
are not encrypted (note that the "scp" file transfer protocol is the same as UNIX's "rcp" with a security layer wrapped around 
it.)  Also, the SCP file transfer dialog no longer automatically brings up the Select File dialog when it's selected from the 
menu to perform an upload.

   Printing fixes:

 * Emulator screen printing:  color banding which appeared when printing an emulator screen in color has been improved, so it 
should not appear unless a font is being drawn in double-wide/double-high modes (VT100).  Also, the emulator cursor position may 
have appeared in screens printed in a very small size; this has also been fixed.

       ___________________________________________________

         10.2.0 -Secure                           2/5/10
         10.2.0 -X     
       ___________________________________________________

Bug Fixes:

 * Modified mouse-click processing so Right-Click will be handled as a Control-Click.  Control-Clicking in emulator windows no 
longer adds a Return (or Enter) after the selection is pasted; macros using the "!AM" command will need to be modified to add a 
Return after the "!AM" command.
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 * Modified dataComet's handling of the IBM 3270 Read Modified All command when a Select AID is processed so a mouse Control-
Click on a Pen-Detect field will work correctly.

 * Modified serial device name handling to use "cu" device names rather than "tty" device names so devices supported by the 
latest Keyspan drivers appear in the pop-up list of serial devices.

       ___________________________________________________

         10.2.0b3 -Secure                        10/5/09
         10.2.0b3 -X     
       ___________________________________________________

Bug Fixes:

 * Fixed problem with text windows which caused spurious line returns to be added when pasting text.

Features:

 * Zooming or resizing an emulator window now changes the font size so it fills the new screen area.

 * Interpretation of Brown TN3270 documents has been enhanced so that most parameters are handled correctly.

       ___________________________________________________

         10.2.0b2 -Secure                        9/14/09
         10.2.0b2 -X     
       ___________________________________________________

Bug Fixes:

 * Modified handling of demo time calculations.

       ___________________________________________________

         10.2.0b1 -Secure                        9/10/09
         10.2.0b1 -X     
       ___________________________________________________

Features:

 * The applications are now compiled as Universal Binaries for native support on both Intel and PowerPC architectures.  Shell 
sessions are significantly faster on Intel machines.

 * The Comet fonts are now embedded in the application so graphics characters will display correctly even when the fonts have not 
been copied into the /Library/Fonts folder.

 * The "Configure Session" dialog now includes a separate field for entering the port to use when connecting to a host address.

Bug Fixes:

 * Native Intel support avoids triggering a bug which apparently affects all PowerPC binaries running under the Rosetta 
translator, where a keystroke may intermittently cause the Window Server to crash, placing the user back at the Login screen.  
(The crash will appear in the Console logs as occurring when "UCKeyTranslate" is called.)

 * Opening a Kerberos Telnet connection no longer causes dataComet-Secure to crash under Snow Leopard.

 * SSH connections now prompt the user for a password after a login failure when a Master Password has been entered incorrectly 
or the password set in a "Session Configuration" dialog is incorrect.

 * SSH2 connections should now handle password change requests correctly.

 * The cursor no longer blanks out during SCP file transfers.

 * The Comet fonts have been modified so the bold "D" character renders correctly under Snow Leopard.

________________________________________________________________
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            A1.1 dataComet & dataComet-Secure X Release Notes

________________________________________________________________

      dataComet documentation.  (Rev. 2/6/10) 
      Copyright 1995, 2010 databeast, Inc. All Rights Reserved.
    
   This document has information on (select and use "Find..." to go to 
the section):

         Known Bugs in the current version

         Release Notes:

         dataComet-X for OS X:

           10.1.1      10.0.6      
           10.0.5      10.0.4      10.0.3      10.0.2    

         dataComet-Secure X for OS X:

           10.1.1      10.1.0      10.0.6      10.0.5      10.0.4
           10.0.3      10.0.2      10.0.1      10.0.0      
           10.0.0b4    10.0.0b3    10.0.0b2    10.0.0b1

       ___________________________________________________

         10.1.1 -Secure                          6/21/08
         10.1.1 -X     
       ___________________________________________________

Bug Fixes:

 * Dramatically improved the screen drawing speed when text antialiasing is in effect.  Also fixed a bug where antialiasing was 
not correctly initialized; if a session had not been opened in which anti-aliasing was NOT in effect, the font for a session with 
antialiasing would not be imaged correctly, resulting in an ugly appearance.

 * Fixed a bug in the SSH Configuration "Keys..." dialog which would cause the application to hang if there was a previously 
selected Key file which was no longer present.

 * Reverted to requiring holding down the Option key to resize the emulator rows/columns size to avoid distorting displays for 
applications which can't handle resize operations.

       ___________________________________________________

         10.1.0 -Secure                          6/21/08
       ___________________________________________________

Features:

 * Added support for Telnet/TN3270 SSL/TLS secure connections.

       ___________________________________________________

         10.0.6 -Secure                          3/31/08
         10.0.6 -X     
       ___________________________________________________

Bug Fixes:

 * Fixed a VT100 bug which sometimes manifested itself in the OpenVMS EVE editor, occasionally causing "Command" to appear in a 
text area when the DO key was pressed and the SPLIT WINDOW command was in effect.  

 * Fixed VT100 stream printing so Tabs are expanded.

 * Fixed cursor selection in emulator windows so selections are offset properly; 10.0.5 introduced a bug which shifted the start 
of the selection range.

       ___________________________________________________

         10.0.5 -Secure                           3/1/08
         10.0.5 -X     
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       ___________________________________________________

Bug Fixes:

 * Fixed a bug which prevented the macro buttons from working under OS X 10.5 (Leopard).

Features:

 * The macro buttons can now be displayed or hidden independently of the prompt area of the emulator screen (using the "Views" 
Preferences panel).

       ___________________________________________________

         10.0.4 -Secure                          2/19/08
         10.0.4 -X     
       ___________________________________________________

Features:

 * Support for anti-aliasing has been added; by default the "Global" Preferences panel has anti-aliasing enabled for all windows 
with the font size set to a size greater than 12 points.

 * Shell session performance has been enhanced.

 * Added "Hide all session .edit windows" option in the "Global" Preferences panel to enable users who don't wish to use .edit 
windows to hide them on a global basis.

 * Emulator windows are now resized without holding down the Option key, and the modeless configuration dialogs are now promptly 
updated to reflect the new window size.

 * The "Control Font" and the "Define Macro..." dialog font size is now set at 12 points to improve legibility on high-density 
displays.

 * Added a "Require session close from host" configuration option in the "Session" Preferences panel so user can't close a 
session without first closing the session on the host.

 * Emulator windows now hide the macro buttons if the "Views" Preferences panel option "Show buttons at top of window" is off.

 * Added an "Add Macro Button..." menu item to make adding macros to emulator windows more intuitive.

 * The default TEXT and BIN creators are now '????' rather than '3278' so TextEdit (or other user selected editor) opens 
documents.

 * dataComet and dataComet-Secure are now built using Apple's Xcode development system.

Bug Fixes:

 * Fixed a bug in display handling code which could cause crashes.

 * Fixed vulnerabilities identified in SSH1 RSA encryption and SSH2 which could allow Man-In-The-Middle attacks.

 * Fixed several SCP file transfer bugs:

   - SCP uploads over SSH2 connections no longer cause a crash when the file is larger than 120K.

   - SCP uploads of large files over encrypted Kerberos connections no longer suffer from file corruption due to repeated 
encryption of the same block of data.

   - SCP now works correctly when uploading a text file with line Wrap enabled.

   - SCP now works over Shell connections to remote hosts using OS X's built-in SSH client.

 * Enabled Control-C as interrupt character for Shell sessions.

 * Fixed URL handling so "telnet:" and "tn3270:" URLs open a Telnet session and an "ssh:" URL opens an SSH session.  To help 
enable AppleScript control of sessions, URL sessions no longer present "Save session configuration" dialogs when they are closed.

 * Removed alert that was presented on execution of "Connection" macro for Shell.

 * Fixed a bug which limited pastes imported from other applications to 32K.

 * Enabled editing and execution of macro buttons when connection is closed.

 * The "Option is Meta Key" option in the "VT100" Preferences panel now works correctly when the "dataComet Keyboard" is 
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installed.

 * "Views" show packet counter options now work interactively.

 * Fixed problems with VT100 screen display areas appearing inverted when a variable-width font was selected and color mapping 
was off.

 * Fixed bugs in VT100 screen display when "Background Color Erase" mode was selected when characters were deleted or inserted 
and color mapping was off.

 * The "Word Count" window now displays the correct value for the words and lines in a selection.

 * The user beep sound now plays when emwindow is front window.

 * Applications can now be selected when the "TEXT App" and "BIN App" buttons are pressed in the "Transfer" Preferences panel.

 * File transfer extensions such as ".txt" are no longer added to file names when they are already present in the file name.

 * Fixed the "TEXT suffix" field in the "Transfer" Preferences panel so it is blanked correctly when it has not been entered (it 
was not being blanked when switching to a session for which it had been entered and then back to a session for which it has not 
been entered).

 * Printing text with characters from extended character sets in a text window no longer results in wrong characters appearing 
due to unnecessary character translation.

 * Fixed position of page number so it is centered correctly when printing.

 * The "Host Name" menu item in Telnet & SSH menus is now the host name rather than window name.

 * Fixed "Save Text as..." dialog so new session.edit window saved in Sessions folder by default.

 * Selecting a minimized dataComet document now activates the window.

 * The top window is now re-activated correctly after "Replace" option used when "Save configuration..." dialog is executed.

 * A new Shell document now comes up with window size and print font size set to the size selected for the "Comet Default" 
document.

 * The IBM 3270 "Attn" command now sends a Telnet "Break" command rather than a Telnet "Interrupt" command.

 * Changed IND$FILE file transfer dialogs so '.' is not translated into '¥' when download host file names are converted to 
Macintosh file names.  Fixed the IND$FILE file transfer dialog so it no longer automatically sets the filename when a mouse click 
is used to select the file name text field (tabbing into the file name field still sets the file name automatically).

 * File transfer no longer aborts a file launch when "AutoLaunch" is set and the original file creator cannot be found, since 
Launch Services can launch alternate applications without the original file creator application being present.
  
 * Fixes to the "Configure Terminal Session" dialog:

   - Switching between SSH & Telnet connections now works without closing the emulator window.

   - An alert is posted immediately when when attempting to change Session bype while connected.

   - Shell reconfiguration can be performed while connected.

   - You can now reconfigure open Shell sessions without getting an error message.

   - The "Telnet Configuration..." dialog now sets Authentication and Encryption checkboxes correctly when it is brought up.

 * Fixes to the "Define Macro..." dialog:

   - Fixed a bug which could leave menu items disabled when a new text document was opened while the "Define Macro..." dialog was 
active.

   - Fixed the "Define Macro..." dialog so clicking twice on the menu bar dismisses menu rather the resulting in additional menu 
drop-down display.

   - Macro dialogs were not handling Minimize properly; now they won't minimize when a macro is selected.

   - Changed "Show all" macro text display so user not prompted to save dumped macros when closing window.

   - Menus are no longer disabled after cancelling Save for new text window when in Macro dialog.

       ___________________________________________________
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         10.0.3 -Secure                          10/5/04
         10.0.3 -X     
       ___________________________________________________

Bug Fixes:

 * Fixed a bug occurring with CopyPaste where a "v" would appear in the emulator window when attempting to execute a Paste 
command.

 * The macro buttons at the top of the emulator screen are now rearranged when the window size is changed so they wrap at the 
right edge of the window.

 * All files are now enabled in the Open File dialogs used by the "Open...", "Type file name at cursor" and Edit menu "Append 
file to .edit window" menu commands and the Transfer menu "Text App", "Bin App", and "Bin Type" buttons.  You can now set the 
Transfer dialog "Text App", "Bin App", and "Bin Type" file creator and types by entering text manually.  (Applications are not 
enabled in the Open File dialog, which makes it more difficult to use the Transfer dialog file type/creator buttons; entering the 
types manually may also be necessary since under OS X some applications don't set the Macintosh file type or creator when they 
create files.)

 * The emulator screen clipping is now set correctly when the emulator window is smaller than the size of the emulator area; this 
bug would cause the vertical scrollbar to be overdrawn.
  
 * 9, 12, and 16 are now underlined in the "Size" menu to highlight the available bitmap font sizes supplied with dataComet; 
these may give you more readable text than TrueType fonts at these sizes.

 * Fixed a bug which caused IND$FILE configuration settings, e.g., TSO Host transfer type, to be ignored.

       ___________________________________________________

         10.0.2 -Secure                           3/9/04
         10.0.2 -X
       ___________________________________________________

Features:

 * Beta versions of TrueType fonts are included in this distribution to support printing of the special character sets under Mac 
OS X in addition to allowing larger font sizes in emulator displays.  (The old Comet-fonts, which are currently implemented as 
bitmap fonts ('NFNT' resources), unfortunately cannot be printed under Mac OS X; pages containing these characters would fail to 
print.)

Bug Fixes:

 * The Window menu "Bring All to Front" can now be recorded in a macro; likewise the "Quit" command will be recorded and executed 
correctly in macros.

 * Fixed the function-key handling code so that the PowerBook "fn" function key will produce Shift-Function PF keys.  
(Unfortunately Apple's latest updates do not support detection of the Option and Control keys when used with the "fn" key.)

 * Fixed a bug which could cause pasting over 16K of text into an emulator window to hang a session.

 * Fixed the IBM menu so the IBM Select Cursor menu item will work when it is selected.
 
 * When 8-bit control sequences are selected in the VT100/VT220 emulator, sending CSI[ (0x9b-[) will now work even though the 
additional '[' is redundant.
 
 * Fixed ZModem transfers so that the host flag to convert newlines to the native host newline is set when a file being uploaded 
is not a binary file (according to the flags set in Internet Config).  This should fix problems uploading text files to VMS 
hosts.

"Configure Terminal Session" fixes:

 * If the Control menu "Lock" item is disabled (for kiosk applications) or the Master Password dialog is cancelled the password 
entered in the "Configure Terminal Session" will now work as expected.  It will NOT be stored in the session configuration, but 
will be used for the first login attempt for an SSH or Kerberos session.

 * Fixed the "Configure Terminal Session" dialog so that if you have your Global configuration set to open it on launch, and then 
change the Host Address field, the modified address will be used.

 * Fixed so leaving the hostname empty will yield your own machine's IP address so it will open a session to itself.  This worked 
in Classic dataComet but was failing under OS X.

       ___________________________________________________
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         10.0.1 -Secure                          4/21/03
       ___________________________________________________

PLEASE UPGRADE TO THIS VERSION IF YOU ARE USING dataComet-Secure 10.0.0!
This version improves handling of several SSH security related problems!

Features:

 * Added support for mouse wheel events; holding down the Option key while wheeling will scroll by pages.

 * The "Comet Default" document now appears first in the list of documents in the File->Sessions submenu to make it easier to 
open and modify the default session configuration.  (This is especially useful for defining the default session document buttons 
and macros which will appear in a New Shell.)

 * Added support for 16-color colormaps for VT100 series emulators ("Use 16 colors" in the "Color" Preferences pane).

 * The option "VT100-wrap (wrap at column 81)" has been added to the "VT100" preferences panel to allow you to disable the VT100 
line-feed glitch.

 * The "dataComet Keyboard.rsrc" has been added to the distribution to allow elimination of dead-key remapping (works only with 
OS X 10.2 or later).  Also, when the "Option is Meta Key" option is selected in the "VT100" Preferences Pane, the keymapping now 
works in a more intuitive way (Option == Meta, Shift-Option == Shift-Meta, Control-Option == Meta-Control).

 * Added new dataComet Launch macro features to improve kiosk functionality under OS X; see Help document "A4. dataComet Kiosk 
Configuration".  Using the "!\000\196" macro to disable the dataComet-Secure menu "Preferences..." command now works correctly; 
disabling the "New -> Shell" submenu item will disable local Shell connections.

Bug Fixes:

 * Addressed problems related to the CERT¨ Advisory CA-2002-36 "Multiple Vulnerabilities in SSH Implementations" (described at 
<http://www.cert.org/advisories/CA-2002-36.html> and <http://www.kb.cert.org/vuls/id/AAMN-5G62GP>).   These might have allowed a 
cracker to cause dataComet-Secure to crash when attempting to open an SSH2 connection (to a host address controlled, or feigned, 
by the attacker).

 * Added a dialog which allows users to skip connection macro execution for local sessions (whether PTY or SSH->self).  This 
helps plug a major security hole, since a hostile systems cracker might induce you to download and execute a dataComet Shell 
session document containing a noxious shell script embedded in the Connection Macro.  

   NOTE that Apple's Terminal application will perform similar shell-scripting functions using ".term" and ".command" files, and 
this is a serious weakness!  (The only way known to me to avoid this vulnerability with Terminal is to disable the Terminal 
application by removing the ".app" suffix or deleting it.)

 * Avoided NULL pointer dereferences which could cause dataComet to crash under some circumstances when a session document is 
opened, or the "Open "Comet Default" automatically on launch" option was enabled (in the "Global" Preferences pane).

 * Fixed so "Comet Default" will load previously saved "Comet Default.edit" window text when opened automatically on launch.

 * Fixed a crash which occurred under OS X 10.2 when opening a session document saved with an empty "Connect to:" field in the 
"Configure Terminal Session" dialog.

 * Fixed Telnet and SSH connection handling so that connections are made asynchronously, and the "Reopen session automatically on 
failure" option (in  the "Session" Preferences panel) works correctly.  SSH disconnects due to session failures are now reported 
without triggering a dialog box requiring a user response.

 * The default connection type is now a local Shell connection.  New Shell connections now include any buttons or key macros 
defined in the "Comet Default" session.

 * Fixed the "Configure Terminal Session" dialog so that renaming the session to clone a new session will properly copy all the 
macros and resources associated with the previously defined session document.

 * Emulator handling of very long files (e.g., "cat /usr/share/dict/words") has been fixed so performance no longer bogs down 
abysmally when scrollback buffering is enabled.  

 * Fixed XModem transfers so that they will work!  (A bug in the filename dialog was causing transfer cancellations.)  

       ___________________________________________________

         10.0.0 -Secure                          1/31/03
       ___________________________________________________

Bug Fixes:

 * The time and packet counter displays have been expanded to display uptimes longer than a month ...
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 * The File menu New -> Clone menu item has been fixed so selecting the menu item directly works.

 * SCP file uploads now update the progress dialog promptly.

       ___________________________________________________

         10.0.0b4 -Secure                        10/1/02
       ___________________________________________________

Features:

 * Serial connections are now supported.  

 * Drag and Drop is now suppported.  
 
Bug Fixes:

 * Fixed a 3270 emulator bug in handling the Start Field command which could cause a crash due to dereferencing a NULL pointer.

 * Fixed a crash which could occur when a session is opened from a session document (SetPortRGBForeColor() was called with a NULL 
colormap pointer).

 * Fixed the Control menu "Internet Config" command so it no longer causes crashes under OS X 10.2.  (It now attempts to 
specifically open the file mapping panel; note that unfortunately user-configurable file mapping is only supported through 
Internet Explorer under OS X... but maybe someday this deficiency will be remedied.)

 * Pastes into the "Set Registration..." and other dialogs have been fixed so they will use the updated scrap when switching in 
from another application.

 * Fixed the "Configure Terminal Session" dialog Authenticate "(Alt. ID)" field so that it will correctly send the string as an 
alternate user login name when making a Kerberos connection.  

 * The "Save Configuration..." dialog has been fixed so sessions now saved to the dataComet "Sessions" Folder by default.

 * Window controls are now deactivated when the window (or dialog) is in the background.
  
 * The buttons in the top of the emulator window have been changed from round to bevel buttons to save space and look a little 
less distracting.

       ___________________________________________________

         10.0.0b3 -Secure                         9/3/02
       ___________________________________________________

Bug Fixes:

 * Fixed a crash which occurred when a "New" session was created with PC-ANSI or SCO-ANSI selected.
  
 * Fixed a crash which could occur in SCP binary file transfers.

 * Fixed crashes which occur under 10.2 (Jaguar) due to failure of calls previously included in the OS X System which have been 
omitted in 10.2 (specifically the tgetent() terminal capability call and the krb5_free_kdc_rep() Kerberos call).  The "Default 
Folder X" extension also triggers this crash by forcing the linker to attempt to resolve all call references.

 * Anti-aliasing is now disabled.  (Per-session control of antialiasing will be added in a future release.)

 * Fixed selection handling overflow problem, so selections in emulator scrollback buffers longer than 32,767 lines will be 
displayed and copied properly.

 * Registered copies of dataComet now work correctly when accessed by users who have read-only access to the application.

 * Documents which are only available to the user with read-only permissions can now be opened using dataComet.  
  
 * Copy and Paste functions have been fixed so the same scrap is used by both the emulator windows and edit/dialog windows.  This 
caused failures to update the scrap correctly when copying and pasting between the two.

 * The "SOCKS proxy" address in the "Configure Terminal Session" dialog is now saved correctly in session documents when the 
"Global" option is not selected.

 * To avoid printing failures where "nothing happens", bitmapped fonts (such as the Comet-fonts) are now remapped to Courier when 
printing.

 * The VT220 delete character and insert character functions have been fixed so they handle Background Color Erase mode 
correctly.
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 * The SCP and IND$FILE transfer dialog boxes are now drawn completely when an upload command is selected.
  
 * Fixed a loop which occurred if an arrow key was pressed in an emulator after the "!W>\000" macro had been executed to direct 
input from the .edit window into the emulator window.  

 * Added "!Ex" macro to clear scrap (replacing obsolete "!cC" macro).

 * Button control sizing was fixed so that no visual artifacts appear  when they are drawn under 10.2.

 * The interpretation of internet addresses and domain names in the "Configure Terminal Session" dialog have been changed so 
Brown TN3270 document "hostaddr::socket" notation is supported.
  
 * The cursor position report is now updated when a selection is being  made in an emulator window (this option is controlled by  
"Preferences/Views/Use mouse position").

       ___________________________________________________

         10.0.0b2 -Secure                        8/13/02
       ___________________________________________________

Bug Fixes:

 * The Enter key on the keypad now sends an IBM 3270 Enter rather than  doing nothing when IBM 3270 emulation is selected.

       ___________________________________________________

         10.0.0b1 -Secure                         8/5/02
       ___________________________________________________

Features:

   Version X runs under Mac OS X as a native Mach-O Carbon application.  Local Shell Terminal sessions are supported as well as 
Telnet/TN3270 and  SSH1/SSH2 connections.  In general X is similar to previous versions of  dataComet-Secure, though some minor 
changes have been made in appearance  and menu arrangement.

BUG NOTES:

 * Note that printing with Comet fonts will probably fail to produce any output, since the system no longer supports printing of 
fonts provided as 'NFNT' bitmap font resources.  Printing emulator screens containing VT100 graphics or other special graphics 
characters may prove problematic.  Versions of these fonts will eventually be made available in a format that will be supported 
under OS X.  

 * Support for direct access to Serial ports under OS X is not yet supported.

________________________________________________________________
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             A1.1. dataComet-Secure Classic MacOS Release Notes

_____________________________________________________________________________

            dataComet and dataComet-Secure documentation is
            Copyright ©1997,©2001 databeast, Inc. All Rights Reserved.

    
   This document has information on (select and use "Find..." to go to the 
section):

         Known Bugs in the current version

         Release Notes:

         Known System Problems affecting dataComet

         dataComet-Secure
            5.0.7     5.0.6     5.0.6b2   5.0.6b1
            5.0.5     5.0.4     5.0.3     5.0.2     5.0.1       
            5.0       5.0b2     5.0b1     5.0a5

         dataComet
            4.6.6     4.6.5     4.6.4     4.6.4b2   4.6.4b1
            4.6.3     4.6.3b1
            4.6.2     4.6.1     4.6.1b4   4.6.1b3   4.6.1b2   4.6.1b1

       ___________________________________________________

         Known System Problems affecting dataComet
       ___________________________________________________

 * WARNING:  Radeon video board display bug (4/18/92):  The ATI Radeon video drivers installed by default with Mac OS 9.2.2 may 
malfunction with dataComet/dataComet-Secure and NiftyTelnet, resulting in incorrect screen displays.  Updated drivers from ATI 
apparently fix this problem; they are available from

   <http://www.ati.com/support/drivers/mac/macos-march-2002-update.html>

 * WARNING:  Kerberos 5 (4/18/92): The "OT AutoPush Support 1.0" System Extension, which may be installed with Interarchy, 
OTSessionWatcher, and other software, causes non-fatal network errors to occur with MIT Kerberos 4.0; you may be better off 
disabling this extension.  (See "5.0.6b2 -Secure" note below.)

 * WARNING:  Mac OS 10.1.2 has a fatal bug which causes a system panic when Internet connections are made to one's own Internet 
address by an application running under Classic (this works correctly in earlier releases of Mac OS X, and either works or 
produces a non-fatal connnection failure in later releases).  dataComet now posts an alert warning of this bug when opening a 
connection to one's own address.

 * NOTE:  When running under System 7.5 and later the Standard Put File dialog used in the "Save As..." commands does not by 
default get set to the home folder of a document, but instead is set to the most recently opened folder.  If you want to get the 
correct folder, you need to open the "General Controls" Control Panel and select "Folder which is set by the application" (under 
the heading "Documents:  When opening or saving a document, take me to..."); this setting will allow dataComet to set the folder 
correctly before displaying the Standard File dialog.   

 * Cancelling an Open Transport PPP session open dialog which has been launched from the "New..." dialog will result in a crash 
due to a bug in PPP's dialog management, which releases dataComet's "New..." modal dialog window rather than the PPP dialog 
window.  This OT/PPP bug only appears when PPP is opened and then cancelled from the "New..." dialog.

 * If Diamondsoft's FontReserve Extension 2.0 or 2.0.1 is installed, it will hang when dataComet attempts to open fonts contained 
in the dataComet Fonts folder.  NOTE: Diamondsoft fixed this problem in version 2.0.2.  You can also avoid this by moving the 
Comet-fonts from the dataComet Fonts folder into the System Fonts folder.  

       ___________________________________________________

         5.0.7 -Secure                            6/4/02
       ___________________________________________________

Bug Fixes:

 * The "SCP configuration..." dialog "File modes" and "Directory modes" options now display and set the applicable modes 
correctly.
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 * Source code was recompiled so all features/bug fixes listed below are properly incorporated... a few which were incorporated 
in the OS X development version had been omitted from the 5.0.6 build (including the SCP wildcard expansion fix and "rcp" mode 
and NCSA-style session logging).

       ___________________________________________________

         5.0.6 -Secure                            5/7/02
       ___________________________________________________

Features:

 * "aixterm" escape sequences for host selection of Intense/Light colors have been added for compatibility with PINE's 16-color 
mode.  (This works only when dataComet's SCO-ANSI 16-color mode is selected; for PINE use, the "Control Emulator..." dialog 
option "Wrap text when line overflows" should also be disabled.)

 * The "Expire Kerberos tickets on Quit" option now disposes of the user's credentials if and only if they were first acquired 
through a dataComet-Secure session.   

Bug Fixes:

 * The Kerberos connection status notes in the "button bar" are now cleared correctly after connecting in cases where the host 
sends display data before the Kerberos negotiations are complete.

 * Using Control-key option to get help for items in the "Help" menu no longer causes dataComet to crash.

       ___________________________________________________

         5.0.6b2 -Secure                         3/26/02
       ___________________________________________________

Features:

 * Added "Expire Kerberos tickets on Quit" to the "Control Global..." dialog; this option is on by default.  Leaving this option 
on helps avoid a Kerberos-related bug, which may cause failures when forwarding tickets to the host (which is enabled when "Fwd 
Creds" is selected for a Kerberos Telnet session).  This bug is apparently caused by interactions with the "OT AutoPush Support 
1.0" System Extension.

       ___________________________________________________

         5.0.6b1 -Secure                          3/9/02
       ___________________________________________________

Modifications:

 * The Kerberos 5 code was modified to improve memory management.

 * The "Comet-APL" font was updated so that it contains 'NFNT' resources rather than 'FONT' resources.

       ___________________________________________________

         5.0.5 -Secure                            2/1/02
       ___________________________________________________

Features:

 * An option to use the "rcp" command rather than "scp" was added to the SCP configuration panel so the rcp/scp file transfer 
method can be used when the SSH server package does not include support for SCP (e.g., SSH.com's SSH server).  Note that using 
"rcp" rather than "scp" has no security impact in this case, since the data is being transmitted over the secure terminal 
connection.

 * Added support for session logging as it is implemented in NCSA Telnet, with the data recorded as it is received, rather than 
when it scrolls off the top or is cleared from the screen.  The Shift-Option-"Open log..." and Shift-Option-"Log session in" 
options to the "Open log" command are used to select this logging mode.  This approach to logging helps preserve the host line-
feed structure (long lines which wrap down automaticaly at the end of a row on the emulator screen will not have additional 
Carriage Returns added).

Bug Fixes:

 * Fixed problem with the correct scrap failing to appear in the "Set dataComet-Secure Registration" dialog.  (This bug was a 
side effect of the OS X paste bug fix in version 5.0.4/4.6.4)

 * ZModem file transfers over serial connections have been fixed so the receive buffer size is correctly initialized in all 
cases.  (Transfers would fail with an "Out of memory" message unless a Telnet session had been previously opened.)

dataComet-Secure Online Documentation - Author: Bonze Anne Rose Blayk 183/231



 * SCP file transfer support has been fixed so that wildcard expansion and automatic transfer type selection (Binary vs. ASCII) 
works correctly when uploading.  

       ___________________________________________________

         4.6.6                                    2/4/02
       ___________________________________________________

Bug Fixes:

 * Fixed bug in handling old registration code format, which was used in registrations prior to 1998.

       ___________________________________________________

         4.6.5                                    2/1/02
       ___________________________________________________

Bug Fixes:

 * Incorporates into dataComet bug fixes from dataComet-Secure releases up to 5.0.5.

       ___________________________________________________

         5.0.4 -Secure                            1/7/02
       ___________________________________________________

Features:

 * A new feature simplifies opening a Terminal-style local SSH session when using MacOS X:  Your own address will be used if no 
address is entered in the "New"/"Reconfigure Session..." dialog's "Connect to:" field when the session is configured to connect 
using Telnet or SSH.  A session document named "Shell" is now included in the "File" menu "Sessions" submenu as an easy-to-use 
example.

 * A dialog now warns that under 10.1.2 connections to one's own machine (such as the "Shell" document makes) may lead to a 
system panic.  This is due to a bug in the operating system; under previous releases this works fine.

 * Added two "Control Emulator..." options for ASCII emulators:

 - "Display full Apple character set", so the characters 0x80 - 0x9F are treated as display rather than control characters.  This 
option allows you to view all the available characters when connecting to a MacOS X machine (note that some applications under OS 
X, e.g. "vi", may still not display characters >= 128 directly).

 - "Do CR-LF when CR received" (CR from host -> CR/LF).

Bug Fixes:

 * Pasting text under Mac OS X now works consistently so you get the most recently cut or copied text from OS X applications 
rather than an out-of-date local scrap.  (OS X is not prepared to deliver the correct scrap when it delivers "Resume" event to a 
Classic application, so dataComet had to delay its request for the current scrap to get the correct text.)

 * Pasting text into dataComet's modal text dialogs now works again.  

 * An empty Terminal Type "Alt. ID" field in the "New..."/"Reconfigure Session..." dialog is now saved correctly in the session 
configuration (this problem occurred only if an alternate string had already been saved).

 * Using the mouse to select the "Download" menu item in the "File" menu "Transfer" submenu now brings up a Download dialog 
(rather than the Upload dialog).

 * A bug which could cause a crash if a PF key greater than 72 (for which no macro had been defined) was triggered by a Shift-
Option-"Mouse button" combination has been fixed.

 * A bug which could cause the wrong labels to appear in the buttons at the top of the emulator window has been fixed.

 * Fixed IBM 3279 display bugs introduced by underline fix in 5.0.2.

 * Fixed the 3270 emulator so that DDM file transfer support is included in the Query Structured Field Summary response.

 * Fixed the format for the "Host key fingerprint" in the SSH1 login trace so garbage characters will not appear at the beginning 
of the fingerprint string.

       ___________________________________________________

         4.6.4                                    1/7/02
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       ___________________________________________________

Bug Fixes:

 * Incorporates into dataComet bug fixes from dataComet-Secure releases up to 5.0.4.

 * The Kerberos plugin interface is no longer supported by dataComet.  For Kerberized Telnet sessions you should use dataComet-
Secure, which incorporates support for Kerberos 5.

       ___________________________________________________

         5.0.3                                    9/2/01
       ___________________________________________________

Bug Fixes:

 * If you have configured a session to do session logging, when the document is opened you can now use the "Cancel" button in the 
"Save File" dialog to cancel logging (this formerly required an "OK" response:  pressing "Cancel" did not turn off the logging 
option, so the "Save File" dialog would reappear as soon as new data was received!).

       ___________________________________________________

         5.0.2                                   7/30/01
       ___________________________________________________

Bug Fixes:

 * The message "Server initiated key re-exchange" no longer appears in SSH2 sessions.

 * A bug was fixed; it affected IBM 3270 emulation, and resulted in underlined blank characters appearing without underlines when 
using fonts other than the Comet-Fonts.

       ___________________________________________________

         5.0.1                                   7/23/01
       ___________________________________________________

Bug Fixes:

 * Telnet sessions now default to sending only a Carriage Return character when the Return key is pressed, rather than Carriage 
Return + Line Feed.  If a host requires the additional Line Feed character, you will need to set the "LF" option in the "Control 
Emulator..." dialog.

 * A bug which could cause passwords to appear in cleartext when entered into the SSH dialog password field has been fixed.

 * Several bugs which occurred on machines running MacOS 7.5 variants have been fixed.  Dialog text and "OK" button rectangles 
have been rearranged for better appearance; two bugs which could cause crashes on 68K machines when using the SSH configuration 
dialogs have been fixed.

       ___________________________________________________

         5.0                                     6/15/01
       ___________________________________________________

Features:

 * Telnet DES3-CFB encryption is now supported.  Note that some host telnet server implementations declare support for this 
encryption type in Telnet negotiations but fail to handle it correctly.

 * A "Telnet Configuration" dialog has been added to allow you to select Telnet options such as Authentication (currently only 
Kerberos 5 is supported) and Encryption (DES or 3DES).

       ___________________________________________________

         5.0b2                                    6/4/01
       ___________________________________________________

Features:

 * Telnet connections authenticated using Kerberos 5 are now supported (on PowerPC machines only).  Encryption using DES-CFB can 
also be negotiated to further enhance session security.  (NB: dataComet no longer supports the use of Telnet Plugins to provide 
an interface to Kerberos.  This enhances dataComet's compliance with the U.S. Federal Export controls on encryption products.)

       ___________________________________________________
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         5.0b1                                    5/10/01
       ___________________________________________________

Features:

 * SSH and Telnet sessions can now use SCP (Secure Copy) to transfer files and folders to a host which has the "scp" application 
installed (note that this is secure ONLY with SSH sessions).  dataComet's SCP implementation brings up a dialog which issues SCP 
commands from the terminal command line, so you can perform file transfers interactively rather than starting a separate session 
for each SCP transfer (which in most implementations also requires that you enter a complicated command string containing the 
file modes and file names).  All of dataComet's standard file transfer features are available when using SCP (Autolaunch, 
Autowrap, Command-U automatic edit window uploads, etc.).  See the document "6. File Transfers" for more information.

 * User names and passwords can be saved in session documents.  Passwords are saved in encrypted form; the user enters a Master 
Passphrase as an encryption key, so by entering the Master Passphrase once the user can enable automatic password entry for a 
number of sessions.  The Master Passphrase is never stored; passwords and SSH RSA session keys are both encrypted using DES-3 
156-bit strong encryption.  A "Change Passphrase" command in the "Control Global..." dialog allows the user to enter a new 
passphrase, and automatically update all passwords in session documents contained in the dataComet "Sessions" folder so they will 
be decrypted properly when the new Passphrase is entered.

 * A "Lock" command allows the user to lock the entry of menu commands and keystrokes until the correct Master Passphrase is 
entered.  This helps provide improved security; you should be especially careful to Lock your sessions when using the automatic 
password entry feature with SSH or when using a "Type password" macro (see "4. Macros").

 * A new keypad mode for VT100 was added so a calculator keypad can be used with cursor application mode, which some applications 
expect.  

Bug fixes:

 * SSH zlib compression now works reliably.  The implementation in 5.0a5 contained an error which could sometimes cause hangs or 
crashes.

       ___________________________________________________

         5.0a5                                   3/15/01
       ___________________________________________________

Features:

 * This Alpha Test version of dataComet-Secure adds support for the SSH1 and SSH2 Secure Shell protocols.  All features of 
dataComet, including ZModem file transfers, work with SSH connections.  SSH features supported include automatic SSH protocol 
selection, client authentication using user passwords (and under SSH1, using RSA public keys), encryption using Triple-DES or 
Blowfish, and compression using zlib.  Host public keys are maintained in files using the known_hosts format (e.g., the 
"NiftyTelnet SSH Known Hosts" document can be copied directly to dataComet's "Security" folder and used as-is).

Features NOT supported in this release:  SSH1 RSA client public key generation; SSH2 public key client authentication; XWindows 
or TCP port tunnelling; and SCP or SFTP file transfer protocols.  NOTE that this release will not run on 68000 machines such as 
the Mac+:  it requires a 68020 or higher processor.

NOTE that enabling zlib compression seems to lead to occasional dropped connnections.  This bug is under investigation.

 * The registration dialog is now a modeless dialog to make it easier to set your registration:  you can now open the dialog, go 
to other windows to copy a registration code, and then paste it into the registration text field.

 * You can now select a vertical cursor in emulator windows using the "Prefer vertical cursor" option in the "Control Session..." 
dialog.  You can also opt to have the emulator cursor off when the window is in the background by using "Hide cursor in 
background windows" in the "Control Global..." dialog.

Bug fixes:

 * Switching windows to a new window while the "Define macros..." dialog is up no longer results in a loop where a dialog 
repeatedly prompts you to save the "new document" until you save the document, rather than allowing you to cancel.

 * Window selection macro commands have been fixed to work more smoothly, so that if you include a window select command (e.g., 
"!WShostwindow\000") in a macro, all the succeeding macro commands will be copied over to that window's macro queue and executed 
in its context.  This makes it much easier to execute a macro which copies data fields from an emulator window and pastes them 
into an edit window.

 * A session document's emulator color maps are now copied when the document is duplicated by changing the document name in the 
"New..." (or "Reconfigure Session") dialog.

       ___________________________________________________

         4.6.4b2                                12/12/00
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       ___________________________________________________

Features:

 * dataComet now supports IND$FILE transfers for IBM 3279 sessions, including features supported in dataComet's ZModem 
implementation such as AutoLaunch, text wrapping and unwrapping, and MacBinary and BinHex encoding and decoding:

 - The "Upload" and "Download" commands in the "File -> Transfer" submenu bring up a dialog which helps you build and execute an 
IND$FILE host command.

 - A dialog has been added to configure options available under IND$FILE, and a "DeTab" option has been added to the "Control 
File Transfer" dialog for expanding tabs when uploading.  (For more information, see the document "6. File Transfer".)

 - Macros have been added to set the Macintosh file name and IND$FILE options so IND$FILE transfers can be executed automatically 
using macro commands.

Bug fixes:

 * The "!WA" macro, which allows you to open items in the Apple Menu from a macro, has been fixed so it works reliably.

       ___________________________________________________

         4.6.4b1                                 11/1/00
       ___________________________________________________

Features:

 * Improved support for SCO-ANSI emulation, adding SCO and XENIX-specific color selection escape sequences, including background 
color selection and reverse color mapping.  A new terminal type option has been adding in the "File New..."/"Reconfigure 
Session..." dialog to allow explicit selection of the SCO-ANSI terminal type and keyboard mapping.

 * For Serial connections you can now enter a telephone number in the "File New..."/"Reconfigure Session..." dialog to which to 
connect, making it easier to configure dataComet sessions for dialup connections.  This uses a global modem dialup macro which 
can be modified using the "Set dialup macro..." command in the Macro menu (the dialup macro is set by default to send "++
+ATH<Return>ATDT" before the number is transmitted to the modem).  The "Host Name/Address:" field is now labelled "Connect to:" 
in the "New..." dialog.

 * An option to "Notify when new data arrives in background" has been added to the "Control Session..." dialog; this sets the 
task menu to flash when dataComet is in the background and new data arrives for the session.  A "!CN" macro command has been 
added to perform this function also.

 * A "Next" command has been added to the Window menu to select the next window.  You can press "Option-Tab" to select the next 
window from the keyboard, and "Shift-Option-Tab" to select the previous window.  To accomodate this new keymapping, the IBM 3270 
"Select Cursor" command is now executed using "Control-Tab".

Bug fixes:

 * SCO-ANSI keymapping now sends a DEL character when Shift-DelRight is pressed (the lower right key in the six-key function 
group).

 * Macintosh international characters are now automatically remapped to 7-bit National characters when a National Character Set 
is selected in VT100/ANSI emulators.

 * Text pasted into the "New..."/"Reconfigure Session..." dialog now triggers item updates correctly (this was occurring only 
when characters were directly entered into the fields).

 * The "ALA" session document has been updated to connect to SUNY Binghamton's library card catalog.

 * The Comet fonts have been modified so that ATM Deluxe no longer complains that two of them are "damaged".  (Please note that 
there were in fact no problems with the fonts which could cause malfunctions.)

       ___________________________________________________

         4.6.3                                   5/22/00
       ___________________________________________________

Bug Fixes:

 * The VT320 soft reset command was fixed so it correctly resets character sets and attributes.

 * The Enter key function, used in an edit window to send text to a host session, has been fixed so that a Carriage Return will 
be added if the last line of text is being sent and it has no Carriage Return at its end.

 * ZModem file transfers have been fixed so that control-character escapes are added correctly.  Note that support for 7-bit data 
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paths (added in ZMODEM-90) has not yet been added, so dataComet's ZModem implementation will fail when using with a 7-bit 
connection.

       ___________________________________________________

         4.6.3b1                                 4/11/00
       ___________________________________________________

Bug Fixes:

 * Printing has been fixed so that crashes will no longer occur when the LaserWriter 8.3.4 driver is used.  

 * Printing screen selections now works correctly when a single line is selected (previously this printed nothing).

 * The font submenus are now fully compatible with Suitcase so the "Font" and "Control Font" submenus now use Suitcase's special 
font display capabilities.  In addition, this change fixes a Telnet connection problem caused by Suitcase's routines, where 
Suitcase's system trap patching caused failures when first attempting to open TCP Telnet sessions (error code -23).

A number of bugs and deficiencies in advanced VT100/VT320 functionality were fixed:

 - The display of underscores can now be turned off using the "Do underscore" option in the "Control Emulator" dialog.

 - Support for the VT320 soft reset command was added.

 - Support has been added for non-standard command sequences using to select the foreground and background colors ("<ESC><nm" for 
foreground and "<ESC>=nm" for background; see "1.1. VT100 Command Set").

 - The VT320 GR character set shift support has been fixed so VT100 graphics characters are displayed properly when mapped into 
GR.

 - The SUB (Control-Z) character now causes the display of a '¿' (reverse question mark) in addition to cancelling an escape 
sequence.

 - Blink attributes now continue to blink when the cursor is hidden.

 - The VT100 "Show Cursor" DEC private command no longer causes cursor glitches to be left onscreen when called repeatedly.

 * The test used by the ASCII emulators for triggering automatic ZModem downloads has been modified to try to handle all cases 
correctly.

       ___________________________________________________

         4.6.2                                    2/7/00
       ___________________________________________________

Features:

 * dataComet now offers a keypad panel with buttons linked to keyboard function keys (and corresponding macros, if any); the 
keypad panel can be opened using the "F" control at the bottom left of the emulator window.

 * New default keymapping for "UNIX tn3270" has been added to the "Host menus and function keys" popup menu to make it easier to 
use UNIX tn3270 sessions to connect indirectly to IBM mainframes.  A new "!K\nnn" macro has been added so the standard keymap 
options can be selected in macros.

 * A "!CU" macro has been added to allow opening URLs in macros.

 * VT100 User Defined Keys now allow the host application to open URLs and execute dataComet macros directly (see "1.1. VT100 
Command Set" for details).

 * The "Control Printing..." dialog now includes "Eject page when host turns off stream printing" to allow disabling automatic 
page feeds when the "end host printing" ESC[4i command sequence is received.  This resolves problems caused by applications which 
repeatedly embed print stream open/close commands on the same page.

Bug Fixes:

 * MacOS X Server host sessions are now negotiated so they work cleanly without changing the default CR-LF settings.  In 
addition, control characters such as ^C now work properly.

 * The launch macro resource ('CONN' ID=2) resource can now be imbedded in the dataComet application to facilitate distributing 
copies of dataComet with restricted feature sets.  Launch macros no longer crash or hang dataComet if they are executed without a 
window open.

 * 14- and 16-point fonts in emulator windows now appear closer to the left margin when fast drawing is not enabled to improve 
the appearance of the screen.
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 * VT100 stream printing now yields to other applications after each page is imaged to help guarantee that print drivers will 
process print jobs correctly.

 * A bug which could lead to hanging when PowerPCs perform X/Y/Z-Modem transfers using Serial connections has been fixed.

 * ZModem downloads now accept Start AutoReceive commands (ZRQINIT) from hosts which contain imbedded commands to avoid 
AutoReceive failures (the imbedded commands are ignored, since they are presumably not relevant in the Mac environment).

 * BinHex decoding of downloaded files now works correctly when the first line contains the "(This file..." encoding message.  

       ___________________________________________________

         4.6.1                                  10/29/99
       ___________________________________________________

Bug Fixes:

 * The Kerberos data encryption negotiation sequence was fixed so data encryption works reliably rather than presenting garbled 
data.  (Encryption of sent data was working properly; reception of inbound data started one byte early in many cases.)

       ___________________________________________________

         4.6.1b4                                 10/1/99
       ___________________________________________________

Bug Fixes:

 * The code handling MacTCP Domain Name Resolution has been updated to be compatible with MacOS 9.

 * The 3270 emulator has been fixed so that Structured Field write commands are handled correctly if a length field is split 
between two TCP packets.

       ___________________________________________________

         4.6.1b3                                 9/23/99
       ___________________________________________________

Bug Fixes:

 * Changed the 3270 Query Reply Color Background response in another effort to improve compatibility.

       ___________________________________________________

         4.6.1b2                                 9/14/99
       ___________________________________________________

Bug Fixes:

 * The 3270 Query Reply Color Background response has been fixed to use $F0 (Neutral-Black) as the default background response.  
If the "Control Color..." dialog item "...except Background" is enabled, the 3270 emulator now generates a Query Reply Color 
response which omits the Background Color capability.

 * VT100 stream printing has been fixed so that pages after the first page are always printed; in some cases following pages were 
omitted.  In addition, print streams have been fixed to work correctly when the Print Dialog has been turned off (using the 
"Control Printing..." dialog item "Show "Print..." Dialog when printing host print streams"). 

 * The XON/XOFF/KILL character fields in the "Control Emulator" dialog have been fixed so that you can use the "delete" key to 
turn off special handling of these characters easily.  In addition, non-numeric characters entered into dialog fields is now 
screened out when it is not appropriate, and pastes have been fixed so that the dialog paste uses the text from the latest copy 
command.

       ___________________________________________________

         4.6.1b1                                  9/3/99
       ___________________________________________________

Bug Fixes:

 * dataComet now handles the Applescript "quit" command in a way that will return a value to the calling script before quitting, 
so scripts using the quit command will continue correctly.

 * The Query macro command (!QS) has been fixed to prevent the appearance of junk characters in the user input area; !QQ has been 
fixed so it now terminates the prompt string correctly.
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 * The macro dialog now displays the timeout number for the match case macro command (!z) correctly.

 * 3270 Extended attribute reporting in responses to Read commands has been fixed so that attributes are only returned when 
requested by the application and default attributes are not reported.  User selection of extended attributes (reverse, 
underscore, and blink) for characters has been fixed so that only one attribute can be applied to a character at once, as 
required by the 3270 specifications.

 * The 3270 Query Reply Color Background response has been fixed to include the length byte so host programs will interpret it 
correctly.

_____________________________________________________________________________
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             A1.2. dataComet Release Notes 4.6b1 - 4.6

_____________________________________________________________________________

            dataComet documentation (Rev. 5/6/00):
            Copyright 1997 databeast, Inc. All Rights Reserved.

    
   This document has information on (select and use "Find..." to go to the 
section):

         Known Bugs in the current version
         Release Notes:

            4.6       4.6fc2    4.6fc1    4.6b7     4.6b6     4.6b5     
            4.6b4     4.6b3     4.6b2     4.6b1     

            Note that with version 4.6, release numbering has been
            changed to better conform with Apple's standard release
            numbering system.  

       ___________________________________________________

         4.6 Final Release                       5/20/99
       ___________________________________________________

Features:

 * Wyse-60 function key mapping has been added to the "Host menus and function keys" popup menu.

Bug Fixes:

 * Modified the printing routines for better compatibility with the LaserWriter 8.6 driver (in accordance with Apple Technote 
#1161, 4/19/99), so that the driver is notified that dataComet correctly handles variant Print Record sizes.  This may fix 
occasional crashes which have been observed when using LaserWriter 8.6.  In addition, the printing routines now guarantee that 
the page number is placed within the visible print page (a problem which could result in printing extra pages with some versions 
of the Epson print drivers).

 * Fixed 3270 Pen Detection to handle Space and Null field responses correctly, so that an 0x7E AID is transmitted with SBAs for 
modified fields and no data.

 * Fixed the TFTP server so that it works on PowerPC machines, and added receive file processing so received files can have their 
file type set from Internet Config and can be launched automatically, and MacBinary and BinHex files can be decoded 
automatically.

 * Added support for the "<ESC>[Png" escape sequence to the ANSI emulator, which is used by some PC-ANSI host applications to 
display a character from the alternate graphics font.  (Note that this usage conflicts directly with the ANSI specification, 
which reserves this escape sequence for the Tab Clear command:  only when Pn > 5 will characters be displayed, otherwise the 
sequence is assumed to be a valid Tab Clear command.)

       ___________________________________________________

         4.6fc2                                  4/26/99
       ___________________________________________________

Bug Fixes:

 * Fixed a crash on 68K machines caused by an uninitialized variable being referenced when no session had been opened and an 
alternate terminal type was selected in the "New..." dialog and the dialog subsequently OK'ed.

 * The VT100 graphics characters now appear correctly when the Comet PC-ANSI font is selected even when the PC-ANSI terminal type 
has not been selected.

 * The ANSI/VT100 emulator now handles SCO-ANSI color selection escape sequences correctly, and ignores other commands which use 
"<ESC>[=" as an introducer so they will not leave garbage from incomplete commands on the display screen.  See "1.1. VT100 
Command Set" for details.

 * Added a "Background Color Erase" option in the "Color..." dialog so that background color erase can be disabled.

 * The selection is now reset after a Control-Click invokes the Contextual Menu Manager and a selection has been made.
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 * The Paste command now automatically applies text translation from the Macintosh character set to the host character set when 
host output translation is selected, so that Copy and Paste using Comet Mona and other Macintosh fonts works seamlessly; formerly 
you needed to hold down the Shift key to select translation when pasting.  Shift-Paste now forces translation (which does not 
occur when output translation is turned off, e.g., when Comet ISO-Latin-1 is selected), and Option-Paste now suppresses 
translation.

3279 bug fixes

 - Fixed handling of extended stream Write Structured Field packets with "zero" length so that the actual packet length is always 
used and set properly.

 - Fixed a bug which in certain unusual circumstances triggered the FT3270 file transfer routines, causing valid PF key commands 
to be ignored.

 - Fixed a bug which sometimes caused 3279 attribute bytes to appear with an extended attribute (such as underline) set.

 - Fixed a bug which caused intermittent reporting of normal characters as APL characters; this occurred in the 3279 emulator 
when extended reply mode was not selected and a Read Buffer All command was received.

 - Fixed a crash which occurred when a 3270 session was closed, was also paged backwards in the scrollback buffer, and dataComet 
was Quit.  The crash was caused by referencing 3270 memory resources which had already been released.

       ___________________________________________________

         4.6fc1                                  4/13/99
       ___________________________________________________

Features:

 * dataComet now supports dialup and other serial connections using Modem and Serial ports added with PowerBook, NuBus, and PCI 
cards or internal Macintosh modem hardware (as with the iMac).  These can be selected from the Serial port list in the "New..." 
dialog.

Bug Fixes:

 * Macro bug fixes and enhancements:

 - Global macros are now processed when no windows are open.

 - The "dataComet Launch macro" can now be used to execute any macro commands, rather than being limited to executing security 
configuration commands for Public Kiosk configurations.

 - Window changes now cause macro commands to be moved to new context, so that recorded macros work in a natural way.  Note that 
if you are currently using macros to open new sessions, you may need to add "!W}" to the macros after the open if the macros 
include subsequent commands (which were executed in the current window context, and would now execute in the new window's 
context).

 - Edit window keystrokes are now recorded when "Record actions for macro" is on.

 - The state of the menu macro Shift and Option keys are now reset correctly when interpreting macros.  Menu items with Shift-
Option variants can now be recorded and executed in macros ("CapsLock-Shift-Option" is now required to generate a disable-item 
macro command when recording).

 - Fixed a bug which caused a crash when a global macro was deleted and the frontmost window had no macros defined.

 * FT3270 IBM mainframe file transfer bug fixes and enhancements:

 - FT3270 downloads now work correctly in the PowerPC version; there was an error in checksum calculations in the C code used 
with the PowerPC.

 - FT3270 now supports automatic download BinHex/MacBinary translation and launching of downloaded documents.

 - FT3270 uploads no longer fail when an 0xFF character is contained in the data.

 * The "Control Keypad" dialog item "VT220 named FKeys sent without Shift key down" is now set properly (this bug was introduced 
in 4.6b7).

 * The standard VT220 function key definitions used when the "Automatic" Host Menus and Function Keys option is selected now send 
"<ESC>OT" when F5 is pressed rather than "<ESC>[15~" so the host Print function works correctly with the default definition.

 * Font scaling is only enabled when printing to help avoid ugly font scaling in emulator display screens (this problem was 
introduced by printing fix included in 4.6b7).

       ___________________________________________________
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         4.6b7                                   3/22/99
       ___________________________________________________

Features:

 * A number of new Mac <-> 3270 Translation tables have been added to support international applications.

 * The "Comet Default" preferences document is now located in the "dataComet Preferences" Folder in the System "Preferences" 
Folder.  User "Documents" and "Sessions" folders are also now located in the "dataComet Preferences" folder, to make upgrading 
dataComet versions easier and provide compatibility with MacOS X Server's NetBoot capabilities.

 * Option-"Open Log..." now selects a file to log all session data transmissions for debugging purposes; this option will provide 
reliable logs even in cases where crashes occur!

 * The VT100/ANSI emulation has a number of improvements and bug fixes:

 - Background Color Erase is now supported, so that erased areas are set to the current background color.

 - A number of new VT320/ISO-6429/ECMA-48 command sequences are now supported by the emulator:  8-bit control transmission 
(S7C1T/S8C1T), Erase Char (ECH), Protected-Areas (SPA), DEC Protected-Areas (DECSCA), Send/Receive mode (SRM), Visible/Invisible 
Cursor (DECTCEM), Character-Position-Absolute (HPA), Cursor-Back-Tab (CBT), Cursor-Character-Absolute (CHA), Cursor-Horizontal-
Index (CHT), Line-Position-Absolute (VPA), Next-Line (CNL), Previous-Line (CPL), Repeat (REP), Pan/Scroll-Down (SD), Pan/Scroll-
Left (SL), Pan/Scroll-Right (SR), and Pan/Scroll-Up (SU).  See "1.1. VT100 Command Set" for the sequences used to invoke these 
commands.

 - New function key mapping options have been added for ANSI emulators in the "Host menus and function keys" popup menu, which 
now appears in the "Control ASCII Emulator..." dialog as well as the "New..." dialog.  (This makes it easier to select function 
key mappings appropriate for connections to hosts using linux, scoansi, xterm, and at386 terminal types.  This option replaces 
the "Select IBM menus and keymapping" option in the "Control Emulator..." dialog and the "NCSA FKey mapping" option in the 
"Control Keypad..." dialog.)

   Function key options have also been expanded so that 72 function keys can be easily selected:  When you press a key or 
function key button, pressing Shift shifts up 12, pressing Control shifts up 24, and pressing Option sends functions associated 
with the "Home" and other middle-pad function keys.  The shifted state is now promptly reflected by the labels on the function 
button names on the left hand side of the emulator screen which are displayed when you press the '?'/'M' button.  

   NOTE that "Command-button" is now used to set button macros rather than "Option-button", and "Command-macro menu" sets menu 
macros rather than "Option-menu".  Also, the "Home" and other middle-pad keys are now mapped in a more "natural" fashion:  See 
"0.1. Shortcuts", which has been updated to reflect these changes in function key mapping.

 - The VT100/ANSI emulator now supports Set Graphics Rendition (SGR) commands to set the default foreground (black, "<ESC>[39m") 
and background (white, "<ESC>[49m") colors.  

 - ESC and SGR commands which are used to select the PC-ANSI alternate characters were also added.  "<ESC><char>" remaps the next 
character for display when it is greater than 159, where 160 -> 127, 161-191 -> 1-31, and 192-223 -> 128-159.  "<ESC>[10m" 
selects the default font, "<ESC>[11m" allows display of the alternate font characters in positions 0-31, and "<ESC>[12m" selects 
the alternate font and displays shifts the character into the high range (128-255).

Bug fixes:

 * Setting the terminal type when first creating a "New..." session no longer results in a crash (this bug was introduced with 
the improved color maps support added in 4.6b6, and was caused by a premature attempt to select the window's screen graphics 
device when it had not yet been identified).

 * PC-ANSI graphics characters less than 32 now display properly (this bug was introduced with support for the 3270 extended 
attributes).

 * 3279 emulation bug fixes:

 - The 3270 now sends only Start Field orders (rather than Start Field Extended) when extended reply mode has not selected by the 
host.  This caused problems with the RDRLIST command failing to execute keyed commands.

 - The 3270 Repeat to Address order now uses the APL translate table to translate characters when the alternate APL character set 
has been selected using a Set Attribute order; failure to do so was causing some characters to appear incorrectly.

 - 3270 fields with extended attributes selected are now drawn correctly when they appear at the end of a line immediately after 
a field which also had extended attributes (rather than using the attributes associated with the previous field).

 * Printing fixes:  

 - Printing a selection in emulator windows sometimes resulted in a crash during recalculation of the character width table... 
this is now done after the Print Driver is closed to avoid this problem.
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 - Printing text windows using monospaced fonts now places words so that they always have a space after the previous word.

 - The Comet fonts are now scaled so that when they are printed they are larger and more legible.  

 - Page range selections made in the "Print..." dialog now work correctly.

 - Fonts have been uniformly updated to use a slashed zero (0) rather than a dotted zero, since the dotted zero could be confused 
with an eight.  The new slashed zero is slashed at the bottom to avoid confusion with the slash-oh character (¯), which is 
slashed in the middle.

       ___________________________________________________

         4.6b6                                    2/3/99
       ___________________________________________________

Features:

 * The IBM 3279 now supports background colors, the Graphics Escape command, and the APL character set.  NOTE that you may need 
to update the color mapping in the "Color..." dialog using the "Default Colors" button to get correct background colors for color 
3279 sessions created using earlier versions of dataComet 4.6!

 * Session Keepalive and "Reopen session automatically on failure" options have been added to the "Control Session" dialog.

 * File Transfer:  An "AutoDecode" option has been added to control BinHex and MacBinary decoding of downloaded files.  Files 
containing multiple binhexes (e.g., mailboxes) now download OK, and all binhexes unpack correctly.

 * When using VT100/VT220/PC-ANSI emulation the buttons on the left side of the screen now send VT220 Function keys by default 
rather than VT100 application keypad commands; you can send the VT220 "Find" and other special keys using F1 through F4 and F23 
and F24 (see "0.1. Shortcuts").  This makes it easier to use dataComet with the new standard Macintosh keyboards, which lack 
these keys.  In VT100 -> IBM key mode the buttons will send the default IBM PF key sequences.

Bug fixes:

 * The IBM 3279 now handles 2-byte long extended stream packets which claim to be of "zero" length correctly rather than 
crashing.

 * In some circumstances the first 3279 screen would be filled with junk characters due to failure to set the NULL character 
variable before screen initialization occurred.  This problem has been fixed.

 * IBM 3270 invisible fields now remain hidden on printed output.

 * The IBM 3270 PF1 and PF3 key combinations (Control-7 and Control-9) have been fixed; these were broken when Control-attribute 
options were added in 4.6b1.

 * The IBM 3279 now sends the NULL query reply correctly.

 * Long session names are now truncated uniformly; variation between the document name and the name in the menu was causing .edit 
save failures when names were longer than 25 characters.
 
 * The "lines in scrollback buffer" in the "Control Session" dialog has been fixed so that it works correctly.

 * The correct alert text is now presented when you launch dataComet, option-key remapping is selected, and the "dataComet 
Keyboard" was not installed; the text said "Receive" rather giving the instructions for installing the resource.

 * Improper placement of the emulator window when the window was placed close to the top of the screen on an alternate monitor 
and the status bar was not displayed has been fixed; the text window now zooms correctly when located on an alternate monitor.

 * Text windows are now positioned below the emulator window by default when the screen is large enough to allow this placement.

 * The default print font size is now 10, and the default QuickDraw left margin is now 72 pixels (1 inch) to give best results 
printing with Courier; the font size menu now includes all font sizes to make it easier to select alternate print font sizes when 
the current display font does not offer all font sizes.  The default text window zoom size is now 512 pixels so the text has an 
optimal width when printing with the default settings.

 * Several minor problems with color map settings have been fixed; the color map is now always set correctly on session open 
without an additional screen update event (e.g., a window selection), the background screen color is always set correctly without 
an update, and the VT100 always inherits a VT100 color map (rather than a PC-ANSI color map)

 * Fixed the Apple Menu so a disabled line is added between the dataComet items and other Apple Menu items when the Appearance 
Manager is not present.

       ___________________________________________________

         4.6b5                                  12/22/98
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       ___________________________________________________

Bug fixes:

 * The IBM 3279 Character Set response to a Read Partition-Query command has been fixed so that TSO & ISPF will no longer crash 
with a divide by zero error (TSO was dividing by the "character set descriptor length" parameter, which as reported by dataComet 
contained an invalid value of zero).

 * 3279 underscore and reverse extended attributes are no longer drawn in field attribute bytes.

 * A bug in the 68K implementation of the 3279 which caused bad output to be sent to the host has been fixed.  (This was 
introduced when 14-bit address support was added in 4.6b3.)  

 * VT100 graphics characters now display correctly when Fast Drawing mode is used.

 * A rare VT100 drawing glitch was fixed; this bug caused extra spaces to be added after zero-width characters from a 
proportional font were drawn.  

       ___________________________________________________

         4.6b4                                  12/17/98
       ___________________________________________________

Bug fixes:

 * The 3270 emulator now includes a Summary reply in its response to a Read Partition-Query command.  The omission of this field 
in the response was causing problems with some IBM host applications.

 * The VT100 emulator has been fixed so that VT100 graphics characters included in packets with less than 20 characters now 
display correctly when a Macintosh font is used (this bug did not appear when using the Comet ISO-Latin-1 or Comet DEC-
Multinational fonts or when the graphics characters were included in larger data packets).

 * The 5250 key mode now sends the default keys supported by the AS/400 for VT100 emulation when ANSI/VT emulation is selected.  
A bug which caused a dataComet to hang when the IBM Clear key or menu item was selected when using ANSI/VT emulation was also 
fixed.

       ___________________________________________________

         4.6b3                                  12/11/98
       ___________________________________________________

Features:

 * An "Alt. ID" field has been added to the "New..."/"Reconfigure Session..." dialog to allow entry of an alternate Telnet 
Terminal Type.

 * "Disable fallback to 24 X 80 screen" has been added to the "Control Emulator" dialog for the 3270.  This option allows you to 
disable host-selected fallback to the 24 X 80 default screen size from larger screen sizes, so the contents of the scrollback 
buffer can be preserved in cases where the default screen size is only temporarily reset and not actually used.

 * Two icon flags have been added to the horizontal scrollbar indicator area:  a lock icon has been added to show when encryption 
is on, and a printer icon has been added to show when VT100 passthru printing is on.

Bug fixes:

 * 3279/Extended Stream bugs:

   * 3270 printing has been fixed to eliminate spurious attributes, which appeared as a result of changes in 4.6b1.

   * The Structured Field Erase/Reset command has been fixed.

   * The Read Modified All command is now supported.  Due to this bug use of the PA1, PA2, and PA3 keys sometimes led to an X-
Clock hang on some systems, requiring a local Reset.

   * 14-bit addresses are now enabled so that custom 3270 sizes > 4096 bytes will work correctly.

   * The buffer size is now reported properly in the Query Usable Area response; the 3270 was always reporting it as 1920 bytes, 
which caused some host systems to fail to use the full buffer for alternate sizes (even though the row and column sizes were 
reported correctly).

   * Under certain conditions the 3270 terminal was not automatically resized when it was re-opened after a new terminal size was 
selected in the "Control Emulator" dialog.  It should now always be resized correctly when it is re-opened. The Row and Column 
options in the ANSI/VT100 Control Emulator dialog are now disabled to prevent resizing while the 3270 is active.
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 * Pointers to the locked default color map resources are now stripped to 24 bits when running on pre-System-7 24-bit color 
systems to prevent address errors.
 
 * The "Control Color" dialog now saves old-style color maps if the "Host selects color" option is toggled; if the old map had 
not been modified, it was lost during the toggle (unless Command-. or Command-Z was used to Revert the color map to its previous 
settings).

 * Command-D now dismisses dialogs which have a "Don't Save" button.

       ___________________________________________________

         4.6b2                                  11/14/98
       ___________________________________________________

Bug fixes:

 * Font settings are now saved when the "Comet Default" document is modified.

 * The Appearance Manager and Contextual Menu Manager interfaces are now incorporated into the code so Mac0S 7 launches work 
correctly if these extensions have not been installed.

 * The "Mac {} IBM_37USA+" character map is now fixed so NULL is mapped correctly to 0x00 (rather than 0x20) when "Send Imbedded 
3270 Nulls as Blanks" is off.

 * A 3278 display bug introduced in 4.6b1 has been fixed; the bug caused the first field in a screen to sometimes be displayed 
with the wrong attribute.  This bug did not affect 3279 displays.

 * The backspace key now works when an edit window is full.

 * Separate Color map resources are now used rather than saving the map in the 'CONF' resource so session colors saved separately 
on a per-termtype basis; colors are now updated immediately when they are modified so there is no need to use "Save 
Configuration..." to make them permanent.

 * The Help document on dialogs has been split into two parts.

       ___________________________________________________

         4.6b1                                   11/1/98
       ___________________________________________________

Features:

 *** dataComet now includes Kerberos Authentication and Encryption support for all Telnet sessions using Telnet Plugins.
 *** dataComet's user interface has been improved: it now uses the Appearance Manager... and...

 * The "New..." dialog has been revised to use popup menu items, and includes Authenticate and Encrypt options to support 
Kerberos Telnet connections, with a new field which allows you to enter an alternate Kerberos User ID to log on to hosts for 
which you have a login name which differs from your Kerberos ID... and...

 * The configuration dialogs have been revised to make it easier to find and select configuration options; they now use Geneva 10 
font, have a more logical arrangement of items and better wording for the option descriptions, and include a dialog bar which 
allows you to jump to the other configuration dialogs... and...

 * Contextual Menu support has been added to provide full compatibility with Apple Data Detectors and other Contextual Menu 
plugins.  The Control-Click "Help" and "Send Selection" features previously implemented in dataComet are now listed in the 
Contextual Menu brought up by a Control-Click.  Control-Clicking on text in an emulator or edit window now sends the selection if 
one has been made, rather than always sending the word which was clicked.

 *** dataComet now supports true IBM 3279 color screens and extended attribute processing (underline, reverse, and blink).  The 
"IBM" menu and macros now include items which allow you to set the attribute for typed characters or the selection range.

 * Escape sequences used by SCO-ANSI emulations have been added to the VT100/VT220 emulator to make it possible to use 
dataComet's VT100 emulation with hosts which expect SCO terminals.

 *** "Comet Mona" and "Comet Mona Bold", a Comet font family which provides a fixed-width rendition of the standard Macintosh 
character set in sizes 8, 9, 12, and 16, are now the default fonts for new sessions; Courier 12 is now the default print font, so 
that printing will have the highest quality appearance, and good results can be obtained without installation of the Comet fonts 
in the System Fonts folder.  The Comet ALA, PC-ANSI, ISO-Latin-1, and DEC-Multinational fonts are still included to make it 
possible to get perfect reproduction of host character sets.

 * All Comet fonts except "Comet ALA" and "Comet PC-ANSI" now include the "Euro" symbol, replacing the "International currency" 
symbol.   

 * The default 3270 Mac <> IBM character mapping has been changed, and now supports all the characters in the IBM ISO-Latin-1 
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character set.  Mappings have been added in the "IBM" menu for the "" (DUP), " " (Field Mark), "..." (Record Separator) keys.

 * A "Selection Word Count..." dialog has been added to the "Edit -> Selection" menu, which can be opened using a new "#" control 
in edit windows.

 * "Erase EOF when pasting to clear previous contents" has been added to the 3270 Emulator dialog to improve paste functionality.  
This is now the default.

Bug fixes:

 * A "Set dataComet Fegistration..." menu item has been added to the Apple menu to make the procedure for registering more 
obvious.

 * The addition of dynamic macro memory allocation in 4.5.2B made it possible to crash if all windows were closed, the last 
session closed had executed macros, and the next session opened executes macros.  This bug has been fixed.

 * "Menu select" macro commands placed in the middle of a macro now now execute in their current place in the macro stream, 
rather than being appended to the end.  E.g., inserting a "Return" using the "ASCII" menu now works as expected if it has been 
placed in the middle of a macro, rather than sending a Return after the rest of the macro has executed. 

 * dataComet no longer sends a Telnet "WILL ECHO" response to request to "DO ECHO" from a host, since this confuses some telnet 
servers.

 * The Bold Font menu has been fixed so the selected bold font item is correctly noted when a new Font has been selected (this 
bug was introduced in disables )

 * Color selection and inversion is now performed reliably on secondary monitors.

 * The VT100 emulator now preserves double width and height attributes when host color mapping is on.  The "Use host color" 
option is now TRUE by default.

 * The default color mappings for both the VT100 and IBM3270 emulators have been improved so the default colors are nicer.  The 
3270 default attribute colors now match the standard defaults for the 3279 extended base color option.

 * Blink attributes now blink when viewing the scrollback buffer.

 * Toggling "Use Host Color" in the "Color" dialog now updates the background color in the frame surrounding the emulator drawing 
area.

 * The emulator drawing area clipping region has been changed to eliminate character overhangs which (infrequently) left garbage 
from oversize characters appearing on the right edge of the screen.

 * Download printing of files has been fixed so that it works correctly with print font selections (4.5.1 introduced a bug which 
made this feature work only when "Use Courier font for printing" was selected).  Download printing now works with Z-Modem 
downloads.

 * Serial printing can now be resumed without closing the window after cancelling the serial print.

 * The edit window now avoids TextEdit "duplicate cursor" images which appeared when a single character selection (at the 
beginning of a line after a Return) was replaced with another character (or cleared).

 * Text copied in dataComet now pastes correctly into the Standard File dialog name field.

 * YMODEM downloads now work correctly.  XMODEM uploads now display the progess indicator correctly.  (Note that the download 
progress indicator does not show the progress, because XMODEM includes no information on the length of the file being 
downloaded).

 * Horizontal scrollbars now track correctly in the 68K version when the scrollbar thumb is used.

_____________________________________________________________________________
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             A1.3. dataComet Release Notes 4.43B6 - 4.5.3A

_____________________________________________________________________________

            dataComet documentation (Rev. 5/6/00):
            Copyright 1995, 1996 databeast, Inc. All Rights Reserved.

    
   This document has information on (select and use "Find..." to go to the 
section):

         Release Notes:

            4.5.3A    4.5.2B    4.51      4.50        4.50B1      
            4.43B8    4.43B7    4.43B6        

       ___________________________________________________

         4.5.3A                                  8/18/98
       ___________________________________________________

Features:

 * There's now a Registration dialog to make registering more intuitive.

 * dataComet documentation is now listed in the Help menu (under System 6, it's listed in a Documents->Help submenu).  The 
Documents and Sessions menus have been moved to the File menu.  

 * "Shift-Open" now displays all files in the Get File Dialog and opens them as text, so dataComet can now be used to edit 
documents such as Apple Modem Scripts or NCSA documents (which are indeed text documents, but are set to a different file type).  
dataComet no longer adds dataComet window and font size resources to files if they are not dataComet documents (either originally 
created as dataComet documents, or saved used Option-Save) so that such documents can be viewed without modifying them.  You can 
save the window and font size resources in non-dataComet documents using "Shift-Save" (this is not done automatically due to the 
low but real risk of Resource ID conflicts).

 * Switching windows is now faster; drawing of controls and menus has been optimized.

 * The "Find" dialog now has an "Ignore case" option; this is now the default behavior for the "Find" command.

 * The "Control Session..." dialog now includes a "Don't Beep" item so you can disable emulator beeps.

 * 5250 keys and menus are now available as alternatives to standard 3270 keymapping to make it easier to use the 3270 emulator 
to connect to IBM AS/400, System/36, and System/38 hosts.  You can enable 5250 key-mapping using the "Use IBM 5250 Keymapping and 
Menus" control in the 3270 "Control Emulator..." dialog.

 * "Cursor Select" has been added to the IBM menu and associated with the Option-Tab key to provide this function on the 
keyboard.  Control-Return now performs a Clear to make it easier to execute a Clear on the keyboard.

 * A large set of Translation tables have been added to the distribution, including IBM, ISO, and Windows mappings for MacArabic, 
MacCE, MacCyrillic, MacGreek, MacHebrew, MacPersian, MacRomanian, MacThai, and MacTurkish.

 * New indicators have been added to the left of the horizontal scrollbar in emulator windows; the 3270 busy symbol and VT100 
LEDs appear here.  In addition you can now display the current emulator cursor row and column coordinates in this area, using 
either the host cursor location or the mouse cursor location (you can control the display of the coordinates using the "Show 
cursor position" and "Use Mouse position" controls in the "Control Controls..." dialog).

 * A macro was added to send the 3270 ATTN key ("!PA").

 * The new built-in support for NCSA and Brown document launches from Netscape now also supports Sets, so these documents can be 
used to open several documents at once.  These documents can be edited using "Shift-Open" or by selecting the document in the 
Sessions menu with the Shift key held down (e.g., "Telnet Set Example" in the Sessions menu).

 * The 3270 emulator now supports the Structured Field Query Reply, so that session passthroughs to IBM mainframes which failed 
when the host (incorrectly) assumed Extended Stream support would be available will now succeed.

 * You can now set Leading in edit windows... this feature makes the dataComet on-line documentation much more legible!  (The 
documentation uses the Monaco font, which really needs the additional leading...)  You can also set Print leading independently 
of the screen leading.

 * The "Define Macro..." dialog now always uses a 9 pt. font when displaying the macro.
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 * Horizontal scrollbars in both edit and emulator windows now update the contents as you are scrolling.

 * The File Transfer submenu now includes several items from the "Control File Transfer..." dialog to make it easier to change 
settings on the fly (e.g., "Use BinHex").  These items can be used with edit windows; the settings are applied temporarily to the 
target upload session when the File "Upload..." command is used to upload an edit window.

Bug fixes:

 * Several dialog items which were truncated when displayed using the Chicago font have been resized so they display correctly.

 * Document and session names are now displayed correctly in menus when they contain characters such as "!" (which are 
interpreted by the standard AppendMenu() calls as commands to use special formatting for the menu item).

 * Pastes into edit windows are now checked to guarantee that adding the text won't exceed the 32K TextEdit limit, and an alert 
is presented if this is the case.

 * The Translation menu is no longer disabled for edit windows, allowing use of the Option-Translation feature documented in "0.1 
Shortcuts".

 * When a window is closed and a dialog window becomes the frontmost window, the next frontmost emulator or edit window becomes 
the key window for the Find and other dialogs.

 * In some situations when an emulator window was opened on a second monitor, it would be resized so it had zero width... this 
side effect from adding horizontal scroll bars and window maximum size constraints has been fixed.

 * The IBM 3270 cursor is now hidden when drawing occurs.  

 * The cursor is now updated promptly when a cursor motion key is held down, rather than not being displayed until the key is 
released.

 * Bugs in the 3270 Alternate screen to Default screen (24 X 80) fallback which cause the screen display to appear incorrectly 
have been fixed.  Also, pressing the Clear key no longer automatically causes the scrollback buffer to be cleared when using an 
Alternate screen size.  The buffer is still cleared if the size changes, since the 3270 buffer display routines can only handle 
one 3270 screen size.

 * Several emulator screen/stream printing bugs have been fixed... Printouts of VT100 scrollback buffers larger than one page may 
have had garbage appearing at the end, and the last line on a page is no longer duplicated at the top of the next page.  VT100 
print streams caused some Print drivers (and network printers) to hang due to failure to call PrClosePage() before calling 
PrCloseDoc().  Printing of emulator screens now works on PowerPCs.

 * ZModem upload throughput and reliability have been improved.  ZModem now avoids prolonged "Sync" states which sometimes 
occurred when slightly out-of-date ACK packets from the host were counted as an error and NAK'ed.  The default ZModem Upload 
Window is now set to 4096 by default to avoid host buffer overflows; you may be able to improve performance by changing this to 
0, but be cautious... some hosts (e.g., UNIX hosts with small tty input buffers) may crash due to buffer overflows on Telnet 
ZModem transfers!  (This generally only occurs during Binary uploads.)

 * The PowerPC version is now compiled with the Metrowerks Global Level 1 register optimization off.  This option was found to 
cause some odd failures in code generation.

       ___________________________________________________

         4.5.2B                                  6/16/98
       ___________________________________________________

Features:

 * dataComet is now distributed as a fat binary which offers native PowerPC support in addition to including 68000 code for older 
Macs.

 * dataComet can now handle Netscape launches directly, so the dataComet-NCSA and dataComet-Brown applications are no longer 
included in the distribution.  (This means NCSA and Brown users can now try out dataComet without confusion from having the 
document icons change to dataComet icons, and existing NCSA and Brown documents will continue to work normally without deleting 
the dataComet-NCSA and dataComet-Brown applications.)

 * A "Sessions" submenu has been added in Apple menu to provide easy opening of emulator sessions.  dataComet now checks the 
"Sessions" folder when performing URL or Netscape launches for existing documents with the same name, so session configurations 
can be retained between browser launches.

 * Horizontal scrollbars have been added to emulator and edit windows.  Edit windows feature controls next to the horizontal 
scrollbar to allow easy execution of text reformatting commands using the mouse.  The "Control Controls..." dialog now includes 
"Show horizontal scrollbar at bottom of window" so you can hide the horizontal scrollbar in emulator windows.

 * "Option-click sends cursor motion key sequences" has been added to the "Control Global..." dialog; this setting is now on by 
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default.  Formerly cursor-key sequences were sent whenever the mouse was clicked in an emulator window; now you need to hold down 
the Option key to send these commands when in ASCII emulator windows.  This option allows you to switch this behavior so a simple 
click will perform cursor positioning.

 * An AppleScript "targetwindow" command has been added.  This command selects a target window for dataComet AppleScript 
commands, rather than using whatever window is frontmost, so AppleScript commands will be executed in that window context even if 
the front window changes.

 * An alert was added to remind the user that selecting non-standard font leading and width options in emulator windows slows 
down drawing performance.

 * An alert was added to note that some menu commands are not executed when a window has been miniaturized (the commands are 
ignored in order to help avoid the possibility of mistakes caused by failure to notice that an iconified window is actually 
topmost).

Bug fixes:

 * The IBM 3270 emulator now handles shifts back to 24X80 mode from larger screen sizes.  This bug resulted in confused displays 
when the host application selected the smaller screen size.

 * Macro dialog fixes:  The "Rename" button is now enabled when no macro exists yet for an emulator button; The "Set" button is 
now enabled without changing a macro (making it easier to configure empty key macros); selecting the "Global" check box now 
prompts an alert to save changes if a macro has been modified rather than updating a macro automatically.  Renaming an emulator 
macro button twice no longer causes a crash.  Assigning macros to buttons now results in correct display immediately when a 
session is configured with "Only one session per document" off (rather than being displayed correctly only after the window is 
closed and re-opened).  

 * Macro handling has been modified so that the queue is resized automatically when  macros add commands to execute which exceed 
the current queue size.  This also saves a lot of memory, since each window saves up to 32K which had been allocated for the 
macro queue in previous versions.

 * The "Macro" menu is now always rebuilt so it appears after the "Control" menu after adding a menu macro to the Macro menu.

 * Pressing "Return" in the "Configure Session" dialog now works as an "OK" rather than being ignored.

 * PPP connections are no longer opened automatically as soon as a session document is opened (this occurred even when the 
session was set not to connect automatically on open; this premature PPP open resulted from resolving the host name before it was 
necessary).

 * Using Control-"Menu select" to get help no longer causes a crash under System 6.

 * The File menu item "Print now" is now disabled unless applicable (i.e., when VT100 a print stream has accumulated without a 
page eject).

 * Outdated items for setting MacTCP options used with obsolete versions of MacTCP were removed from the "Control Global..." 
dialog.

       ___________________________________________________

         4.5.1                                    5/4/98
       ___________________________________________________

Features:

 * dataComet 4.5.1 offers a simplified registration procedure.  Registered users will now receive via plaintext email a 
registration code which sets the registration when it is selected and the menu command Shift-"About dataComet..." is executed.  
The previous method of registering using a dataComet document still works; the new method will make it easier for users to 
receive registrations when they receive email on a host rather than downloaded to their Macintosh.

 * A session timer is now displayed next to the packet counters.  The display of the timer is controlled in the "Control 
Controls..." dialog.

 * A "National" submenu has been added to the "Control" menu to set National Replacement Character sets (this does not yet apply 
to IBM 3270 emulators).

 * The "Find..." dialog now reverses the search or replace direction when the shift key is pressed.

 * An 8-point font has been added to the "Comet ISO-Latin-1" font family to make it possible to display 132-column screens on 
smaller monitors.  A native Macintosh version of this font has also been added ("Comet Mona").  

Bug fixes:

 * The error message "Application predates configuration version" has been removed, since it makes reversion to an earlier 
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version a hassle.

 * Control-Clicking on the menu bar to get help on a menu item no longer brings up "Shortcuts" before user can get to the menu.  
(This worked, but the Control key had to be pressed after clicking on the menu bar.)

 * Native MacTCP sessions can now be reopened after they have been closed from the host end of the connection (as opposed to a 
"Close session" command).  (This bug was not present under OT/MacTCP.)

 * Macros generated using the Record Macro feature now work correctly when used with an IBM 3270 host.  This bug was introduced 
when 3270 translation tables were added.

 * The "Control" submenu "Bold Font" option "Use Normal Font" is now saved correctly in the window's font configuration.  

 * The "Replace All" command in the "Find..." dialog now quits reliably after one time around the text in an edit window.

 * Selections in the emulator window which start on the bottom line and include the last character are now inverted properly; 
previously the selection was copied properly, but the selection was not displayed if the screen was scrolled so only the first 
line appeared.  Also, selections made downward from the far right column of a screen row now add a Carriage Return as the first 
character when a "Copy" command is executed.

 * The emulator cursor is now updated promptly when the emulator screen is not the frontmost screen, so you don't have to bring 
the screen up to see the current location of the cursor.  The cursor blink is now synchronized with emulator blink field 
blinking.

 * Closing an unsaved "Untitled" window no longer changes the window position and font/size settings of the "Comet Default" 
document, so new windows no longer inherit these changes.

       ___________________________________________________

         4.50                                    1/29/98
       ___________________________________________________

Features:

 * The "Bold Font" submenu now allows you to select "None" as an option to avoid bolding, which may draw relatively slowly if a 
standard Macintosh font is selected.

 * The VT100 emulators now map the MacOS 8 "VT100" font graphics character symbols automatically when this font is selected 
without using a Comet font.

 * A "CharcoalMenus" resource file has been added so that menu items line up properly under MacOS 8.

Bug fixes:

 * Prior to opening the Mac standard Select Color dialog the amount of memory available is tested to avoid crashes due to out-of-
memory conditions.

 * When using MacTCP new host data was sometimes written to the screen when a window was scrolled.  The scroll alert should now 
always alert you to scroll to the end of the buffer prior to screen updates, which should only occur after you have scrolled to 
the end.

 * Page sizes should now be correctly initialized when using VT100 print streams with QuickDraw printing, correcting a bug which 
printed pages with only one line of text.  In addition, selecting an alternate print font should work correctly under all 
circumstances (formerly Courier was being substituted for the selected font in many cases).  The serial print Top margin item in 
the "Control Printing..." dialog is now updated and saved correctly when it is modified.

 * The cursor is now reset to an arrow when it's moved off the left hand side of the emulator screen, correcting a bug in which 
it was left as a text selection cursor if "Show cursor-buttons on the left side" was not selected in the "Control Controls..." 
dialog.

 * A separate font translation configuration setting is now saved so that transitions from TN3270 to VT100 sessions will no 
longer produce junk screens caused by inapplicable translation table settings.

 * Resources in the "Fonts" folder are now left in the beginning of the resource chain so that international menu and dialog 
resources can be dropped in the Fonts folder rather than embedded in the application for maximum flexibility.

       ___________________________________________________

         4.50B1                                 11/28/97
       ___________________________________________________

Features:
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 * X/Y/Z-Modem file transfers are now supported, with BinHex and MacBinary file conversion and automatic launching of downloaded 
files using Internet Config File Mappings.  Macros have been added to support Z-Modem file transfer: '!fFfoldername' to set the 
download folder, and '!fUfilename' to transmit a file.

 * Internet Config is supported directly, so that it's no longer necessary to install ICeTEe to resolve URLs in dataComet 
windows.  

 * The Find dialog is now modeless and allows you to enter both the Find and Replace strings.  It also includes buttons which 
allow you to perform "Replace/Find", "Replace All", and "Undo" operations (Undo does not undo "Replace All" changes).

 * The VT100 and PC-ANSI emulators now support VT220 commands which allow the host to set the PFKeys (User Definable Keys, or 
UDK).  The UDK commands can also be used to independently set the labels and macros associated with the buttons in the button bar 
and the left hand side of the screen. 

 * The VT100 emulator now supports displaying and setting an underline color using the "Extended" color mappings control in the 
Color Dialog... NOTE that if an older color VT100 session now displays underlined fields incorrectly (e.g., black on black!), 
updating the "Extended" color settings will fix the problem. 

 * The "Control Print..." dialog now allows you to set top and bottom margins for QuickDraw printing.  (Note: the right margin 
field does not clip the drawing; it is used only to center the page number).

Bug fixes:

 * dataComet's timers no longer rely on a Macintosh Vertical Blanking Retrace (VBL) routine, since this routine fails to keep 
time correctly under OS8 (and must be removed anyway to port dataComet to the PowerPC).

 * Using "Control-Menu Select" to get help no longer causes crashes when items in the "Edit Selection" menu are selected (the 
memory allocated for the names is now longer to avoid overruns).

 * TFTP has been fixed so that turning off the server no longer causes an infinitely repeating error message ("no buffer return") 
under OS8.

 * The Telnet layer no longer reports errors in Telnet terminal type negotiation (since OCLC negotiations always fail...).

 * The File menu "Open..." dialog now shows all documents by rather than only dataComet documents, so it's easier to open text 
documents created by other applications.

 * The Clipboard is now updated correctly when dialog items are cut or copied.  You can now use Command-A to "Select All" in 
dialogs.

 * Text wrapping in edit windows using the Edit menu command "Add Returns" has been fixed so it no longer replaces the first 
Carriage Return with a Space if the first character is non-blank.

 * Cursor motion in edit windows has been fixed so the text cursor moves up and down correctly from the last line when it 
contains only a Carriage Return and no text thereafter.

 * Edit window printing no longer adds a leading blank line on the first page of printed output.

 * "Record macros..." has been fixed so that a rare condition is avoided where the host returned output before the sent data was 
recorded for automatic match generation, resulting in the generation of a match-string which fails to work.

 * Using Enter to send text from an edit window to an emulator window now sends the selection to the host when Key Macros are 
turned off in the emulator window, rather than pasting it at the end of the edit window itself.  Enter now sends the whole 
paragraph, including preceding lines, rather than just the text on and below the line containing the selection.

 * Bold characters are now drawn for Macintosh font families when color is on.

 * An error affecting the drawing of screens when scrolling in the scrollback buffer has been fixed, so that incorrect characters 
no longer appear on the screen.  The problem occurred due to a bad blank count accumulating when fonts needed to be switched from 
a type which has to be clipped for drawing (e.g., Monaco Bold) to one which does not (e.g., Monaco), which could result in the 
failure to erase or draw a character position at the end of a field.

 * Likewise, a problem where garbage is left from previously drawn but not-fully-erased characters on the left hand side of 
characters which require clipping has been fixed.

 * 3270 session character translation is reset to default ASCII when IBM 3270 -> ASCII linemode fallback occurs so ASCII 
characters will display correctly while in linemode.

 
       ___________________________________________________

         4.43B8                                  9/15/97
       ___________________________________________________

dataComet-Secure Online Documentation - Author: Bonze Anne Rose Blayk 202/231



Bug fixes:

 * A bug afflicted 4.43B6 which allowed a junk "global key macro" to be "allocated" without being zeroed, which could cause a 
Type 1 Bus Error crash if 1) a key pressed matched the "key code" in the "key macro" and 2) the "key macro" also had a "pointer" 
to a "macro" to execute which contained an odd address.  You might also have gotten "lucky" and execute the "macro" residing at, 
say, address 0.

 * The CopyPaste utility now works with dataComet, which now copies the TextEdit Scrap to the Application Scrap with every cut or 
copy.  "Copy" commands used in QuickKeys macros should also now work correctly.  You can turn this off if you like using the 
"Control Global..." option "Zero Scrap" if you wish to conserve memory.  In addition, the scrap is no longer "lost" if you "pass 
through" dataComet with a TEXT scrap in either mode (the scrap was being zeroed on entry but was not being updated on exit unless 
it had been modified).

       ___________________________________________________

         4.43B7                                   9/3/97
       ___________________________________________________

Attempted Bug fixes:

 * The startup code sequence was changed somewhat in an attempt to remedy mysterious crashing problems with 4.43B6 (evidently 
caused by the key macro bug noted above, fixed in 4.43B8).  

       ___________________________________________________

         4.43B6                                   9/1/97
       ___________________________________________________

Features:

 * NEW HELP FEATURE!  "Control-Command-Key", "Control-Mouse Click", or "Control-Menu Select" will automatically open the relevant 
dataComet documentation and search for the menu name, button name, or dialog text item selected.

 * INTERNATIONALIZATION:  dataComet 4.43B6 stores all string resources in Macintosh resources so they can be readily translated 
into languages other than English; see "A5. Internationalizing dC" for more information.  

 * SOCKS:  The "Configure Session..." dialog now allows you to specify a SOCKS V4 proxy for Telnet/TN3270 connections.  

 * MODELESS DIALOGS:  All dialogs except "Configure Session" have been made modeless,  including the "Control Color..." and 
"Define Macro..." dialogs!  Setting colors is now much easier than in previous versions of dataComet.

 * You can now set global key macros and menu macros using the "Define Macro..." dialog; these macros are saved in the "Comet 
Default" document, and work in all windows.  Macros defined for a particular window will supersede the global macros.

 * You can now add user-defined macros to the "Macros" menu as named menu items.

 * "Command-Mouse Click" in emulator windows will now select a word and resolve it as a URL through Internet Config; note you 
MUST install ICeTEe to support this feature.

 * "Control-Mouse Click" in emulator windows will now perform an IBM light pen selection, or if that's not appropriate, perform a 
"copy word/paste/CR" operation (which works very well with host application command interfaces that expect words as commands and 
list them separately on-screen!).

 * Translation of "foreign" characters using standard Mac keyboard layouts now works correctly when using either the Comet-Fonts 
or standard Macintosh fonts.  Selecting a new font automatically selects the correct option for "Translation"; you can translate 
from the Macintosh character set to a session's selected character set by using "Shift-Paste".  Using the Enter key to send text 
to a host from an edit window with a Macintosh-native font will cause it to be automatically translated to the target window's 
character set.

 * Bold fonts are automatically selected when a font is selected using the "Font ->" submenu; if no font named "<Fontname> Bold" 
exists, QuickDraw bolding is used with the selected font, using dataComet's automatic character cell clipping, which will draw 
more slowly, but will allow the use of any font.  You can still select alternate bold fonts manually using the "Bold Font ->" 
submenu.

 * New macros:  

   "!AS" performs an IBM light pen operation on the field at the mouse position; 
   "!As" performs an IBM light pen operation on the field at the cursor position.

   "!CV" and "!Cv" allow you to control the VT100 auto-print mode locally.
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   "!Eg" go to mouse location for replacing single click.

   "!FD" now prints the selection using Serial Printing;
   "!Fd" now does a form feed.  

   "!WA" opens items in the Apple menu by name.

   The "Define Macro..." modeless dialog now allows you to enter menu items directly from the menus using the mouse while you are 
editing a macro.

 * The "Control Global" dialog now include two new options, "Open "Comet Default" on launch" and "Clear scrollback buffers 
automatically".

 * The "Control Printing..." dialog now allows you to select Serial Printing as a global default, and also set the page length, 
top offset in lines, and right margin in characters for serial printing.  Serial printing now also adds page numbers. 

 * "Shift-Option-Page Up" now automatically deletes all spaces and tabs in the selected text of an edit window.  

 * "Shift-Option-Page Down" now inserts '>' characters in the selected text of an edit window.  

 * "Option-Add Returns" (Option-/) now allows you to set edit windows so that TextEdit's automatic line-wrapping is turned off; 
the text is shifted automatically so that the cursor will be visible as you move through the text (there is however still no 
horizontal scrollbar).  This makes the edit windows much more useful for editing scripts.

 * The text selection is now preserved after an edit window is closed, so that the selection appears in the same place when it is 
re-opened.

 * The IBM 3278 emulator now indicates insert mode by changing the cursor to a vertical bar, and indicates the "X SYSTEM" wait 
state by swapping between a block and underline cursor (using the opposite of your preference), rather than displaying "HOST 
BUSY" in the control bar.

 * Registered versions of dataComet can have a graphic displayed rather than the standard splash screen (this graphic is stored 
as the 'PICT' 128 resource in the application; it will be displayed in the window 'WIND' 128 if it is defined, in 'WIND' 0 if it 
is not).

Bug Fixes:

 * VT100 background and foreground colors are now set correctly when a single character is drawn.

 * The DEC-Multinational font now includes a 16 point font; the 16 point Bold fonts for DEC-Multinational Bold and ISO-Latin-1 
Bold now have international characters properly bolded.

 * Serial printing wraps edit window text correctly, and inserts three spaces for each Tab character.

 * The print page count is no longer automatically reset whenever a new print is performed; "Shift-Print Page Now" allows you to 
reset the page number without causing page eject.

 * TFTP uploads now work correctly; large uploads crashed due to the failure of some *very* old PC/IP code to allocate a large 
enough buffer.

 * The stack size has been increased from 40K to 64K to help avoid situations where the stack overwrites the Macintosh heap 
(which contains the application's code and data, so this can be very bad!).  This sometimes causes an ID=28 error when it occurs; 
note that the "Stack Sniffer" which generates an ID=28 error only checks for heap collisions every 1/60 second, so heap 
collisions can occur without being detected.

_____________________________________________________________________________
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             A1.4. dataComet Release Notes 4.40 - 4.43B5

_____________________________________________________________________________

            dataComet documentation (Rev. 5/6/00):
            Copyright 1995, 1996 databeast, Inc. All Rights Reserved.

    
   This document has information on (select and use "Find..." to go to the 
section):

         Release Notes:

            4.43B5   4.43B4   4.43B3   4.43B2   4.43B     
            4.42       4.41     4.40

       ___________________________________________________

         4.43B5                                 12/14/96
       ___________________________________________________

Bug Fixes:

 * The cursor no longer disappears when paging in the emulator window and Fast Drawing is on.

 * The 3270 PF Shift state is no longer set incorrectly when the PF key is entered with NO Shift after ordinary characters are 
entered with the Shift key down.

 * IBM 3270 sessions will no longer lock in "HOST BUSY" mode (requiring an IBM "Reset" menu command to continue) when a Telnet 
Timing Mark is received (some implementations of TCP/IP on IBM mainframes use this as a session keepalive, so this would occur 
after a session had been left idle about 10 minutes).  (This problem was introduced with the addition of 3270 -> ASCII fallback 
mode in 4.43B4.)

 * ASCII emulator sessions will now present VT graphics characters even when the selected font does not contain them (e.g., PC-
ANSI or other Mac fonts).  Support for VT300 mode character set selection control sequences has been added so that alternate 
character sets will be displayed correctly (LS1R, LS2, LS2R, LS3, SS2, SS3).

 * You can now enter ^M (using Control-M) to enter CR in dialog text items without the dialog automatically taking the Control-M 
as an return meaning "OK".

 * You can now paste into dialog items using the menu item as well as the menu item key equivalent. 

 * If "Use Command Font" is not checked in the Macro dialogs, buttons will produce the correct macro strings rather than "junk" 
characters (which map into symbols in the "Comet-Chicago" font.  If "Use Command Font" is checked and the "Comet-Chicago" font 
has not been installed in the Fonts folder, the user is prompted to install the font when the Macro dialog appears.

 * The IBM 3270 emulator will no longer report an error when an empty selection is pasted.

 * The "Copy Screen" option in the "Control Global..." dialog is now OFF by default so that executing a macro which performs a 
click-word-copy-paste won't yield huge amounts of screen junk when you click on a blank and get a zero-length selection.

       ___________________________________________________

         4.43B4                                 11/12/96
       ___________________________________________________

Features:

 * Added a "Do Blink" item to the "Control ASCII Emulator..." dialog, which allows you to disable blinking.  

 * The default application size has been increased to 1.5MB from 1MB to make more space available for text documents and multiple 
sessions with scrollback buffers.  This is for the sake of overall usability; dataComet can still run in 600K.

 * The PC-ANSI font now includes the a 12-point font; in addition, the PC-ANSI special graphics characters have been added to the 
fonts (e.g., Carriage Returns appear as musical note symbols!).

 * The ISO-Latin-1 font now includes a 16-point font.

Bug Fixes:

dataComet-Secure Online Documentation - Author: Bonze Anne Rose Blayk 205/231



 * The "Control Global" dialog option "Quit automatically when all windows closed" now works correctly with unregistered copies.

 * The VT220 function keys at the top of the extended keyboard are now mapped by default so that F1 -> F1, F2 -> F2, ..., F15 -> 
F15, Shift-F1 -> F13, Shift-F2 -> F14, ..., Shift-F8 -> F20, rather than the old ("NCSA standard") mapping with F1 -> F6, etc., 
in order to avoid needless confusion and mystification.  

 * The Clipboard is now updated properly after copying from an emulator screen and switching to another application.  (dataComet 
was failing to perform a SystemEdit() call when an emulator screen copies was performed, so sometimes MultiFinder failed to note 
that the System Clipboard needed to be updated.)

 * The AppleScript dataComet "copy" command now waits for up to 45 seconds for dataComet macros executing in the frontmost 
session to be completed before copying the window selection to try to guarantee that select/copy macro scripts will work 
smoothly.  NOTE that during this wait your whole system will have to wait for the loop to complete; if you're using a complicated 
macro to display and select text, it's best to check whether the "status" of a session contains "Executing" before performing a 
copy; this way you can be absolutely certain that complex selection macros will copy the selection you really want. 
 

 * The Telnet "Local Echo" command should now always provide local display; ASCII Telnet sessions now ignore a WILL ECHO when 
this is selected and perform Local Echo anyway (sessions with Lexis failed to display characters because the host was responding 
WILL ECHO when sent the DON'T ECHO, subverting the negotiation process).

 * Default ASCII character translation tables are now reset to avoid junk characters appearing after dropping back into VT100 
from 3270 mode.

 * PC-ANSI and VT220 ANSI host color mapping has been fixed so that the background color is set correctly.   Reversed fields are 
now reversed correctly when host color mapping is on.  The default ANSI color maps have been improved so that they are more 
legible and display correctly in 16-color Monitor mode.  

 * Two macro commands were added to allow more flexible color mapping for those who use multiple monitors ("!Ck" guarantees the 
best color match available on the current display--see "A0. Problem Solving"; "!CK" uses the best match on the main monitor, the 
default).

 * VT100 printing now passes Escape sequences (other than End Print Mode) along to the printer rather than discarding them.  
VT100 print mode is now reset when a session is reset (Shift-Clear Buffer) or closed so that the session will not remain stuck in 
Print mode if the host fails to turn it off.

 * Scrolling in edit windows now scrolls smoothly rather than jumping by half pages to be more typically Macish.  Using "Shift-
Cursor Down" or "Shift-Cursor Right" to extend the text selection in an edit window now scrolls when it passes the bottom of the 
window rather than remaining fixed.

       ___________________________________________________

         4.43B3                                   9/3/96
       ___________________________________________________

Features:

 * Option-Copy now performs a "Copy Table" command, so it is no longer necessary to toggle the Table mode.  (Shift-Option-Copy is 
now used to set the contents of the Clipboard to a string.)

 * NOTE that the pressing the Enter key in a text window now automatically sends text to the next frontmost emulator window 
(holding down the Option key is no longer required; this makes text windows work just like a session's .edit window).  

Bug Fixes:

 * IBM 3270 screens now draw correctly when using fonts other than the Comet fonts.  Attribute bytes which corresponded to zero 
width characters in other fonts (e.g., Character 0 in the Monaco font) were being interpreted as diacritics, so that an 
additional space was added after the attribute at the beginning of a 3270 field.  

 * Pressing Shift-F1 through Shift-F15 when using the 3270 emulator on an extended keyboard now sends a PF key shifted up by 12.

 * VT100 stream printing now maintains the page count properly.

 * If you copy a selection in a dialog it will now always be copied to the Clipboard when you switch applications (this was not 
occurring if only the dialog item had been copied).

 * Serial connections no longer execute the connection macro twice if the Session option "Open session without terminal type 
negotiation" is turned on.

 * If Domain Name resolution takes longer than three seconds, a window now informs you that you're "Waiting for MacTCP to resolve 
domain name...".  

 * Selecting the "Log session in..." menu item to turn off logging now causes the current screen to be appended to the log.
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 * The Font selected for printing (using Shift-Font) is now saved in the session document.

 * Scrolling delays when paging have again been adjusted for optimal usability.

       ___________________________________________________

         4.43B2                                  8/20/96
       ___________________________________________________

Bug Fixes:

 * The "!CB" shield window macro (used with kiosk applications) now works correctly when placed in the "Application Launch" 
macro.  The "Macro" menu "Set Launch macro..." is now named "Set dataComet Launch macro..." to avoid ambiguity.

 * TN3270 sessions now revert to ASCII line mode whenever the Telnet options governing TN3270 now longer apply.  This allows 
sessions made through an SNS/TCP linemode connection to go into 3278 mode and then fall back correctly.

 * The "Window" menu item "Close window" no longer waits for the session to completely close before returning control to the 
user.  This could result in delays if the host failed to close a session promptly.

 * Selections >32K in size are no longer truncated when you switch to another application.  The selection is also now inverted 
correctly when a selection is made; sometimes "Select all" would fail to invert the screen in windows with more than 2000 lines.

 * Scrolling by lines when extending a selection in an ASCII emulator window now scrolls as fast as possible rather than having a 
delay if paging had taken place.

       ___________________________________________________

         4.43B                                   7/31/96
       ___________________________________________________

Features:

 * The splash screen now defaults to a 5-second additional delay for unregistered copies rather than 25 to address complaints 
about the splash screen.  To remind users that registration is required, unregistered copies of dataComet now automatically 
allocate the first window slot to the "About dataComet" window, which cannot be altered or closed.  Registering dataComet will 
free this window slot.

 * MacTCP is now configured to poll MacTCP for new data rather than waiting for it to upcall.  This may provide better 
interactive performance in situations where some MacTCP Extensions deliver "sluggish" performance with the asynchronous MacTCP 
Read calls which dataComet has used in the past.  You can turn on the asynchronous call interface by turning off the "Control 
Global..." "Poll" dialog item (under "MacTCP/OT bug workarounds").

 * The Macintosh cursor in the emulator window is now a standard Macintosh text cursor by default, in order to achieve a more 
consistent Macintosh look-and-feel.  You can select the underscore cursor by turning off the "Control Global..." dialog item "Use 
text cursor only".

 * The window title is enclosed in parentheses to indicate that a session is closed.

 * You can select by whole lines in the emulator window by holding the Option key down while making the selection.

 * "Option-New" now clones the topmost document and opens it.

 * Character translation tables are now supported (with the same format as NCSA's); a "Translation" sub-menu has been added to 
the "Control" menu to allow selection of the tables.

 * You can now select VT100 National replacement character (NRC) mapping for ISO-Latin-1 or Macintosh character sets (e.g., 
Monaco) by using a macro.

 * All ASCII emulators now have an option to let the host select ANSI color mapping; the option is set using the "Use host color" 
item in the "Control Color..." dialog.  A "Default" button has been also been added to the "Control Color..." dialog.  

 * Font width/leading control:  you can now set the font width and leading (additional spacing for each line) using the Control 
menu "Leading" and "Width" submenus.  This allows you to control the width and height of proportional fonts, and to make fixed 
width fonts more compact or more legible (with considerably slower drawing speed).

 * Print font/size control:  you can now select the font and font size used for printing by holding down the Shift key while 
selecting the Control menu items "Font" and "Size".  A '>' character indicates the selected print font and size.  

 * Printed text in edit windows is now aligned correctly when a fixed-width font is used on a LaserWriter.

 * "Show 'Print...' dialog when printing host print streams" has been added to the "Control Print..." dialog to control 
presentation of the Macintosh Print Dialog when QuickDraw printing is selected and the host prints using VT100 print streams.  
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This is now enabled by default.

 * You can now save VT100 print streams to a file by holding down the Shift key while selecting the "Open Log..." menu item.

 * You can now set the ASCII emulators to allow an ASCII Backspace to wrap back and up one line using the "Control Emulator..." 
dialog item "BS wraps".

 * A '!qa' macro allows you to put up an alert or 25th line notice.

Bug Fixes:

 *** IMPORTANT FIX:  When a dataComet document with a higher version number for the configuration data is launched, dataComet 
4.42 erroneously puts up an error message stating "Your document is damaged, using default" and ignores the document.  This has 
been fixed in 4.43.  

   Note that this will require that users upgrade to 4.43 to obtain configuration settings from 4.43 documents, so site licensees 
who redistribute documents need to make them using 4.42 or update users to 4.43; sorry for the inconvenience.

 * A failure to reset a timer properly has been corrected; this could cause an infinite loop if a wait for a match succeeded in a 
very brief interval after the time elapsed but before the timer was reset.

 * "Execute Selection" in the Selection menu now executes properly rather than being ignored when a macro is executed (using 
Shift-Enter).  

 * Several macros have been fixed to use the current context rather than the front window's context when executing so that they 
will execute reliably when a window is not frontmost.  This affected scripted menu execution and the selection macros.

 * Telnet socket specifications using spaces or colons now work correctly with decimal addresses (e.g., "123.88.22.1:23"  or 
"123.88.22.1 23").  The IP address in the "Telnet" menu is now updated properly when the address is changed.

 * The Session menu "Abort..." command is now enabled when a session has been opened but a connection has not yet been made.

 * The ASCII emulators now cancel any current escape sequence and start a new escape sequence when an <ESC> character is 
received.  This resulted (fairly rarely) in confused displays, particularly unexecuted escape sequences which would appear at 
unexpected places on the display (e.g., "[23;1H").

 * The ANSI default color mapping for background intense colors is now the same as the background normal colors so that ANSI 
displays are more legible.  (The background intense color settings are still set separately.)

 * The "VT220 keys sent without shift down" item has been added to the "Control Keypad" dialog when IBM keymapping mode is used 
with the VT100/220 emulator.

 * The beep should no longer sound improperly (as if new data had been received) when dataComet is in the background and a 
session is iconified.

 * Fonts:  ^G has been added to the fonts from which it was missing.  The ISO Latin-1 font has been fixed so that the "^o" 
character appears as a "caret-o" rather than being cut off at the top so it appeared to be an umlaut.

 * The "Control Global..." configuration items are now updated correctly when dataComet is quit in all instances; they were not 
being updated if dataComet quit automatically as a result of a window close.

 * WaitNextEvent() is now called while the splash screen is displayed so the clock and other applications will get background 
cycles.

 * Selecting a window in the "Window" menu no longer toggles between the emulator and edit windows to avoid confusion when 
executing macros.

 * Paging now pauses after the first page ONLY rather than waiting 1/3 second per screen as in 4.42.

 * A beep now sounds when a key is pressed in an emulator window and the connection is not open.

 * The zoomed page width is now set to 540 pixels rather than 580 so that a printed copy of a zoomed page fits properly on the 
printed page.

 * The scrollbar in a .edit window is now deactivated correctly when the window is zoomed automatically on a document launch.  
The scrollbar in an emulator window is now reset correctly when a "Clear buffer" command is used.

       ___________________________________________________

         4.42                                    5/19/96
       ___________________________________________________

Features:
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 * Triggers:  The '!z\255' match case macro can now be used to configure triggers for use with MUDS and other applications by 
terminating the cases with '!Z\001'.  See the document on "Macros".

 * You can now add buttons to the top button bar by holding down the Option key while clicking the mouse in the shaded area.   
You can disable a button by Option-clicking on it and setting the Title to an empty string.  Up to 24 buttons can be configured 
in the button bar.

 * Paging in windows is now limited to 3 pages per second to make it easier to scan the pages as they pass.  This limit only 
applies when the mouse is used; menu paging goes as fast as possible.

 * Edit windows now page rather than just scrolling when the mouse is pulled far up (or down) when performing a mouse-down and 
drag to select text, so this functions the same as it does with the emulator windows.

 * Option-Clicking in an emulator window now resets the selection range.  

 * An option has been added to the "Set keypad..." dialog which allows the 6 VT220 keys to be sent without holding down the Shift 
key (and the Shift key produces the default Apple GUI behavior, e.g., "Page up").

 * Holding down the Shift key while selecting the Edit menu item "Record Session" now performs literal session logging into the 
sessions's .edit window for debugging applications (like the "!CL" macro).

 * The 3270 emulation performs automatic paging when you use Paste or Command-Enter so you can paste whole documents rather than 
only a single page of text, e.g., when using INPUT mode with XEDIT.  An Enter is performed whenever the cursor wraps to the top.  
(Note that you will still need to "Add Returns" to make sure that TextEdit text is wrapped before pasting).

 * The "Log erase" option was added to the "Control Emulator (ASCII)" dialog to allow partially erased lines to be logged in the 
scrollback buffer.

Bug Fixes:

 * Selecting the terminal type no longer causes a crash (this was introduced in 4.41).

 * NOTE: the "Close Window" and "Close Session" command-key equivalents have been switched so that "Close Window" uses the 
standard Command-W rather than Command-\.

 * A case where switching VT100 screen sizes from 80 to 132 columns could cause a crash when using fast drawing has been fixed.

 * VT100 and H19 (VT52) scrollback buffering now includes all lines which are deleted using the 'J' "Erase in Display" commands 
when only part of the screen is erased.  This enhances performance with paging in PINE.

 * The IBM 3270 Erase All Unprotected command now erases all fields rather than just one field.  The "Erase Input" command works 
correctly again, and now also repositions the cursor to the beginning of the current field after erasing it.  "Option-Erase 
Input" erases ALL unprotected characters on the display.

 * Mouse clicks in the emulator window no longer select a character when the mouse moves very slightly (this occurred at the edge 
of a character cell).

 * The default setting for mapping Escape to '`' is now off.  The default setting for Scrollback buffering in the "Control 
Session" macro is now 0 (limited only by memory available).

 * Delete characters sent by ASCII hosts are ignored.

 * All telnet sessions now try to negotiate Telnet window size when a connection is made.

 * Setting "8-bit characters" in the Telnet menu no longer causes Telnet binary mode to be negotiated with the host.  This caused 
confusing results with some hosts.  NOTE that UNIX hosts will now need to be configured to pass 8-bit characters (see the 
document on "Emulators").

 * Quickdraw printing routines now call the Close routines even when the Open routines fail to guarantee that all memory 
associated with a print call is released in the event of a failure.
 
 * QuickDraw printing routines now print "reverse" emulator fields correctly rather than leaving them blank on an ImageWriter.

 * Serial printing now wraps the lines correctly when "Print Screen" is executed in an emulator window without a selection.

 * Serial printing now avoids a condition where the Printer port was erroneously found to be busy, leading to a dialog to close 
the existing *network* connection.  Closing the connection at this point would close a Telnet connection.
 
 * dataComet no longer presents an error message stating "No serial configuration update" the first time it is launched on a 
machine.

 * To help guarantee international menu key compatibility both words of the KeyTrans() result are checked.
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 * The menu items for Cut, Copy, and Paste now work correctly with the "Set key macro..." and "Set macro..." dialogs when they 
are selected from the menu as well as when executed via a Command-X, Command-C, or Command-V.

       ___________________________________________________

         4.41 -- please upgrade to this version!  4/2/96
       ___________________________________________________

Features:

 * dataComet now supports AppleScript!  See the document on AppleScript for more information.

 * You can now send meta-characters using "Control-(Shift-Option)" key combinations.  

 * Added text window commands:  "Option-Copy", which queries the user for text with which to set the clipboard, "Option-Paste", 
which does a search before pasting ("Repeat Paste"), and "Option-Shift-Paste", which does a "Replace all" operation.

 * The "Macros" menu command "Shift-Record" records a session without generating match strings, which don't work well with fixed-
screen formats (e.g. IBM 3270 displays).

 * Scrolling is now turned off automatically after one error alert that there's not enough memory available to append text to the 
buffer; this avoids multiple error alerts.

 * The ASCII "!CL" show literal mode now also logs in the .edit window the characters sent to the host by the user (as does the 
IBM literal mode).  The .edit window now automatically deletes the text at its top when it runs out of space to add and literal 
mode is in use, so that debugging host interactions using literal mode is easier.

Bug Fixes:

 *** IMPORTANT FIX:  MacTCP sessions closed by the host now terminate properly.  The bug (introduced in 4.40) caused sessions 
reopened after a host close (e.g., from a "logout" command) to report "MacTCP:  I/O in progress"; further attempts to open the 
session would cause a crash.

 *** IMPORTANT FIX:  Option key handling now uses the standard Mac keyboard layout properly in emulator windows; the IBM PF keys 
are now sent using Control-key combinations.  The "Control Global..." item "Remap Option-key combinations" is now OFF by default 
for better international compatibility.

 * dataComet-NCSA and dataComet-Brown now launch documents correctly when the "Comet Default" document does not exist (e.g., it 
has not yet been created).

 * The "Comet Default" settings document is now closed after use (even when "Comet Default"'s "Only one session per documet" 
setting is on in the "Control Session..." dialog).  A bug was fixed which could lead to a crash if the "Comet Default" was open 
and a new session was created and then disposed of.

 * Background window switches now activate the new front window correctly.

 * Background emulator screen updates now occur promptly while dataComet is waiting to be switched into the foreground to present 
an error alert rather than being delayed until after the switch.

 * Background Copy and Paste now works correctly (dataComet was using the application scrap and GetScrap(), which are unreliable 
in the background).

 * Timers are now allocated in the System Heap so they are updated properly when dataComet is running in the background.

 * Control key interpretation is now handled through the Script Manager when it is available in order to handle varying keyboard 
layouts correctly (e.g., a Dvorak layout).

 * The "ins", "home", "end", "del (x->)", "page up", and "page down" keys now work when an emulator window is frontmost. To send 
VT220 keys, hold down the Shift key while pressing the key. 

 * The IBM 3270 emulator now always sends an "Enter" when the Return key is pressed; it no longer remaps the Return key to "Line 
Feed" when the ASCII mode "Control Emulator" "Return key sends" item "LF" is on.  This is dataComet's default setting, so the IBM 
"Enter" key could be sent only by pressing the Enter key or remapping the Return key.  Shift-Return still performs a "Line Feed".

 * The IBM Reset key is now handled immediately so that the "Host Busy" condition can be reset (rather than having the Reset wait 
forever on the macro queue for the Busy condition to clear).

 * Text window output is now redirected correctly when the "Shift-Window Select" redirection command (or "!W>" macro) is used so 
that edit windows can be more easily used as sources for boiler-plate text (i.e., you need only press Enter to paste the 
selection into the session with which it's associated).  

 * The default IBM 3270 and PC-ANSI color mappings have been updated to be more attractive.
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 * The "Window" menu "Reconfigure Session..." dialog now resets the terminal when OK'ed so that you do not need to reconnect to 
get the terminal type set correctly.

 * All VT100 Erase in Display commands now reset double high and wide character attributes.

 * The "CometChicagoFont" is now accessed by name rather than number to avoid font ID conflicts.

 * The DEC-Multinational and ISO-Latin fonts have been improved.  Both now have 9 and 12 point sizes and a bold font, and some 
incorrect characters have been fixed.

       ___________________________________________________

         4.40                                    3/13/96
       ___________________________________________________

Enhancements:

 * The "Serial" menu now offers the choice of 115K and 230K connection speeds.

 * Holding down the option key when opening a session document opens the document without opening the connection rather than 
presenting the "Configure Session" dialog.  You can now use a new "Control Session" dialog item, "Connect automatically", to 
configure a document so that you can open it without connecting.

 * You can use dataComet-NCSA or dataComet-Brown Sets to launch sets of dataComet documents.
See the "Telnet Set example" and "Brown Set example" in the Documents menu.

 * You can now reset the emulator using the "Shift-Clear buffer" menu command.  This also resets all vt100 graphics characters 
displayed, the better to fix displays which have been messed up by an inappropriate SO control character in the data stream.

 * The "Control Session" item "Only one session per document" is now on by default, so that the default behavior is more useful 
when launching from browsers or Sets.

Bug fixes:

 *** IMPORTANT FIX:  ALL previous versions of Comet and dataComet have been found to crash the system when the Macintosh Segment 
Loader attempts to launch the application and there is less memory available than the application's "Preferred" size. This 
problem has been resolved by correcting the link order of libraries when dataComet is linked, so that the entry point of the 
program is at offset 0, and the Segment Loader loads the application code correctly when memory is short.  PLEASE AVOID this 
problem by upgrading to dataComet 4.40, dataComet-Brown 4.40, and dataComet-NCSA 4.40!

 *** IMPORTANT FIX:  The error dialog is now fixed so it is pre-loaded and locked and uses ICON resources from dataComet's 
resource fork rather than relying on their presence in the System.  This avoids crashes caused when the dialog executed at a time 
when either dataComet's memory or Finder memory was low.  (This bug was also present in Comet.)

 *** IMPORTANT FIX:  Memory leaks of >6K per session disposed of have been avoided by properly disposing of all session 
resources.

 *** IMPORTANT FIX:  All calls to the Print Manager are made AFTER PrOpen() is called, so that the default is set correctly and 
you are notified if your printer has changed.  Improved error checking handles Print Manager failure modes correctly.  

 *** IMPORTANT FIX:  The serial driver code now tests the serial port to see if it's in use before opening a connection, and 
queries the user whether to proceed if it's already open, and no longer hangs up the line when the application quits if the 
serial driver has been opened.  This prevents MacTCP connection loss when using MacSLIP or interfering with other application 
which use the serial ports.

 * The "Serial" menu items "Hang up phone" and "Reset Parameter RAM" are now executed correctly when they are selected.

 * dataComet now works better under System 6.  Menu keys work correctly even when the Script Manager is not present; the 
scrollbars are drawn properly rather than reversed when using the scrollbar in the emulator window.

 * Document opens now fail with an alert if the whole text can't be opened.  Session documents are not opened unless there is 
enough memory to load the .edit window in its entirety.  

 * Edit windows now have the scrollbars set so that the cursor will display if it is on an empty line at the end of the text.  
This also guarantees that the scrollbars will appear when text is appended to an empty window and the text is scrolled halfway 
down.

 * The document icon mask has been fixed so it inverts correctly when selected.

 * The VT100 and ANSI emulators now handle up to 64 parameters in a command sequence rather than only 10.  This could cause 
incorrect attribute display and other non-fatal errors.

 * The mouse click code now delays handling of keyboard input until the click action is completed so that keyed text appears 
where you clicked.
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 * The "home", "end", "x->", "page up", and "page down" keys now work when an edit window is frontmost.  The "help" key performs 
a "Find selection" command.  If the emulator window is up, these keys still send VT220 escape sequences to help ensure 
compatibility with host applications.

 * The VT100 "Calculator" keypad mode now sends a '+' when the '+' key is pressed rather than an "Application" mode control 
sequence.

_____________________________________________________________________________
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             A1.5. dataComet Release Notes 4.1.2A - 4.30

_____________________________________________________________________________

            dataComet documentation (Rev. 5/6/00):
            Copyright 1995, 1996 databeast, Inc. All Rights Reserved.

    
   This document has information on (select and use "Find..." to go to the 
section):

         Release Notes:

              4.30    4.22B   4.2.1B   4.2.0B    
            4.1.9A   4.1.8A   4.1.7A   4.1.6A
            4.1.5A   4.1.4A   4.1.3A   4.1.2A

       ___________________________________________________

         4.30                                    2/24/96
       ___________________________________________________

Features:

 * dataComet now prompts the user to save or allow automatic deletion of a new dataComet document produced by dataComet-NCSA 4.30 
or dataComet-Brown 4.30 (when those applications are configured to do so).  For best performance of dataComet as a Telnet/TN3270 
helper application, you should use these three applications at version 4.30 or higher; dataComet-NCSA and dataComet-Brown 4.30 
have significant  enhancements in their reliability and functionality over earlier versions.   See "Network helper and GURL 
AppleEvent support" in the "Overview of dataComet"  document.

 * There is now a "Match case" macro; there are also new macros to control Return key mapping for the ASCII emulators (see "Match 
case" and "Telnet commands"  in the document on Macros).

 * The "Control Printing..." dialog now has an option to enable Color printing using the emulator's color map; dataComet now 
defaults to printing emulator screens in black and white to avoid color mapping problems.

Bug fixes:

 * Sessions opened through GURL AppleEvents now have the name set to the host name rather than '@'.

 * The cursor is now set properly when WindowShade is used to hide a dataComet window.

 * Several memory leaks which could affect usability in low memory conditions were fixed.

 * You can now define key macros for a new edit window without causing a crash. You can also now save the configuration for a 
text-only document.

 * Edit windows now check for exactly 32767 characters rather than 32500 so they can display as much text as TextEdit can handle.

 * Each edit window now has a separate scrap; an Undo of a Cut or Undo operation now restores the text that was cut from the 
window rather than the current scrap.

 * Setting the Modem Port as the Serial Printing port in the "Control Printing..." dialog now selects the Modem port when the 
document is reopened rather than incorrectly opening the Printer Port.

 * Printing a page in the scrollback buffer prints correctly rather than showing  incorrect bold, inverse, and other attributes.

 * Pastes with both the ASCII and IBM emulators work more reliably; using the Enter key to paste into a 3270 session now works; 
ASCII pastes now work when delays are set.

 * You can now use the Window menu items when a session is Miniaturized (iconified).

 * Labels now appear in the correct place in the popup list when there are  empty labels preceding them.  Pressing the '?' 
cursor-button now displays the labels when "Show status bar at top of window" is disabled.

 * When the MacTCP Domain Name Resolver returns 0 or -1 for an address, an  alert is presented.

 * The "Set macro" dialogs now use the "Use Command Font" setting correctly;  when it was off, macro actions such as PF entries 
were not being displayed  correctly.

       ___________________________________________________
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         4.22B                                   1/15/96
       ___________________________________________________

Features:

 * You can now define key macros for text-only windows.

 * The Edit Selection menu item "Go to line..." now sets the cursor at the beginning of the line in edit windows.

 * You can now copy and paste the color array from one "Control Color..." dialog panel into another session's "Control Color..." 
dialog panel.

 * 16-color ANSI is now supported; hold down the Shift key when selecting the Control Color... dialog to set the Intense colors.

 * Documents:  A new fedworld.gov Document provides a sample PC-ANSI  configuration.  The ALA sample has been enhanced to provide 
a better example  of  configuring dataComet for card catalog access.  E.g., the single click  now  performs a copy/paste so the 
user can select items using only the mouse.

Bug fixes:

 * PC-ANSI color displays now display properly (the default background color is now white rather than the same as the foreground 
in the default case!).

 * IBM screens no longer display "square boxes" instead of blanks when used with Monaco and some other fonts which use a "square 
box" as character 255, which dataComet is using to represent 3270 NULL characters.

 * Text is now always properly updated in edit windows after a "Find..." is performed.  When the cursor moves outside the window, 
the selection is now displayed at the middle of the window rather than the top or bottom so that scrolling is easier to use.

 * Text window contents no longer "flicker" due to being drawn twice when  a document is opened.

 * Telnet Terminal type negotiation has been fixed so that sessions with OpenVMS (and MultiNet) TCP/IP servers will open even 
though they perform incomplete negotiations (i.e., the negotiation sequence is not terminated by actual data transmission to fix 
the type:  this can cause problems if the host expects a wholly different character set such as IBM EBCDIC).  Keying is allowed 
when one second has elapsed since the last negotiation.

 * An incorrect alert stating "Can't delete macro resource" no longer appears when setting macros.

 * The single click macro or default cursor motion action is not executed  if a double-click is performed.  (Note this slows 
response down somewhat.)

       ___________________________________________________

         4.2.1B                                 12/18/95
       ___________________________________________________

Features:

 * You can now perform a "Power Quit" (using Option-Quit) which closes dataComet without prompts to close windows or save 
documents.

 * You can now set the Option key to function as a meta-key for EMACS using the Control menu "Emulator" item "Option is Meta-
Key".

 * The IBM 3270 PF/Action and ASCII Control key menus now stay up when an edit window is frontmost; in this case, these menus 
produce only a beep unless the Option key is held down, which causes the equivalent macro to be placed in the edit window at the 
cursor.

 * The Option key NO LONGER automatically produces Control characters except on Macs using Mac+ or previous keyboards, which lack 
a Control key.  This allows the entry of standard Option-key characters (e.g., umlaut-U) in edit windows for better compatibility 
with the Keycaps 

 * dataComet now sets the default creator type for downloaded 'TEXT' files to dataComet rather than TeachText.

 * The '!CB' shieldwindow macro command, which puts up a window to conceal the Finder and other applications, has been added to 
provide security when dataComet is used in a public kiosk.  (See "Set Launch Macro" above).

 Bug fixes:

 * The MacTCP DNR code is no longer closed, released, and then called again without being properly opened (this very nasty bug 
has been present in all previous versions of dataComet; under some circumstances it could cause dataComet to crash and leave a 
damaged MacTCP file).
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 * dataComet now updates window positions and fonts when a Quit is done.  This formerly occurred only if the window was closed 
using the File menu "Close" command.

 * The IBM 3270 Action menu has been corrected so that the defined key-equivalents work with all 3270 keypad configurations.

       ___________________________________________________

         4.2.0B                                 12/14/95
       ___________________________________________________

Features:

 * The Option key can now be set to function as a meta key in the "Control Emulator" dialog.

 * If a selection is made in an edit window, "Print..." will print the selection rather than the complete text in the window.  
(The "!Fq" macro was added also to support this function.)

 * Support has been added for disabling menu items, including the Finder menu (See "Menu Commands" in the document on "Macros").  
Used with the "NoForceQuit" extension installed in the System Extensions and a dataComet "Set Launch Macro" which disables the 
menus, you can now set up a secure terminal kiosk for public access using dataComet.  (And remember, with customizable macro 
buttons one can now set up a preconfigured document to simplify access for inexperienced users...). 

 * Key Macros can now be defined in edit-only windows.

 * Fonts:  A Comet-DEC-Multinational font is now provided in the dataComet release package.  The PC-ANSI font has been fixed so 
the box characters align better and a  16-point version is now included.  

Bug fixes:

 * If serial printing is on and the serial port can't be opened, the copy of the data to be printed is released to avoid an 
endless loop.

 * The 3270 emulator now draws the screen correctly when inserting characters and performing "Erase field" commands.

 * Choosing the "File" menu item "Print page now" when using serial printing causes a form feed to be sent to the printer.

 * Edit windows now zoom correctly.

 * Type 4 (Zero Divide) system crashes caused by launching old Comet documents and documents made by dataComet-NCSA are now 
avoided.  The PrDefault() system routine was crashing when it was called without being preceded by a PrOpen() call.

 * "Edit -> Selection" items to move the cursor now use the Shift key to extend the selection range and the Option key to move by 
words in order to comply better with Macintosh user interface standards.

 * The default macro queue size has been upped to 16K from 4K to handle large macros better.

 * The documentation on the Search macro has been corrected to accurately describe the macro.

 * The Latin-1 character y with an umlaut will now display rather than appearing as a blank.

 * Error warnings occurring when an edit window is frontmost are now displayed using a dialog rather than a timed window alert in 
order to avoid conditions which can cause crashes.

 * Using Option-Select button to set a button macro when the button labels are displayed no longer leaves the screen display 
partially blank.  (This condition would persist until the window is closed and reopened.)

 * Using the "Enter" key to paste from an edit window into an  emulator window now send the complete selection rather than 
sending only a portion of it.

       ___________________________________________________

         4.1.9A                                  11/8/95
       ___________________________________________________

Bug fixes:

 * Version 4.1.8A was burned because the resource fork in the StuffIt archive was bad.

 * The 3270 emulator now resets the cursor to 0,0 when the screen is cleared (this affected only the display; the next character 
entered appeared in the correct position).

       ___________________________________________________
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         4.1.8A                                  11/4/95
       ___________________________________________________

Enhancements:

 * Copies of dataComet which have been registered can be shared (launched from AppleShare servers by multiple users).

 * The execute menu macro ("!\<3-digit menunum>\<3-digit itemnum>") has been extended so that the macro "!\<3-digit menunum>\<<3-
digit itemnum> + 192>" disables the menu item so that it cannot be used until dataComet is launched again. 

 * A new "Set Launch Macro..." dialog allows you to set up a macro which is executed on launch, prior to opening any sessions, so 
that dataComet can be easily configured to disable various commands.  This allows dataComet to serve as a relatively user-proof 
kiosk terminal for library or other public access applications.

 * Macros were added to select the word and line at the current mouse cursor position, to delay a number of ticks ("!d\000"), and 
to send text and execute macros in an edit window ("!El", "!Ew", and "!EM" and "!Em").

 * "Command-Enter" and "Command-Return" now send text to the host in a reliable fashion (whereas using the Enter key to execute a 
macro in 4.1.7A often resulted in a failure to send plain text due to '!'s in the text or an overrun of the macro buffer).  
Shifting these commands causes the text to be interpreted as a macro.  

 * Menus and default key-equivalents have been rearranged to improve the interface.  (Note that users can modify key-equivalents 
by editing the MENU resources in the application.)

 * Fonts are now packaged in a separate folder (rather than the application) to save disk space.  dataComet now automatically 
opens resource files in the "Fonts" folder.

 * dataComet now negotiates sessions successfully with IBM mainframe hosts running SNS-TCP.

 * The "Save" command is now executed only if an edit window has been modified.  The window's menu item is underlined to indicate 
that it has been modified.

 * Output can be redirected from an edit window to a host session by pressing Shift while selecting the target window.  See the 
"Summary of special key-action combinations" in the "0. Overview of dataComet" document.

 * A "Control ASCII Emulator" dialog item, "Do CR-LF when LF received (newline mode)" has been added.

Bug fixes:

 * An icon resource for the '3278' configuration type has been added so that host session document icons are displayed correctly 
in the Finder.  This also caused some problems with Easy Open.

 * Macro recording of menu item selections now works reliably for all menu items.

 * The 3270 emulator now handles proportionally-spaced fonts correctly.

 * Drawing of selected text in VT100 emulator screens is now performed correctly for characters which have the Reverse attribute 
set.  As a side effect of this fix, display of selected areas in all emulators is now smooth (no reblanking is performed when 
paging).

 * Macs with 9" screens no longer automatically go into fast drawing mode; the user must now select this option.

 * The "Save Configuration..." dialog now copies all resources from the old session document to the new session document when a 
new session name is entered, including  macros.  Previously one needed to duplicate the document in the Finder to copy the entire 
configuration to a new document.

 * The "Save" command is now uses different files to save the emulator and .edit window text.  This avoids the unpleasant 
possibility of overwriting a .edit window by mistake.  When the emulator selection is being saved, the menus change so the 
"Append" is the default for the "Command-S" Save key equivalent.

 * Text-only edit windows can now be miniaturized.  If a session is selected in the "Window" menu, whichever window was up front 
previously (emualtor or .edit) is brought to the front rather than the emulator window.

 * Error messages are reported in a window when an edit window is frontmost.

 * The button labels on the left hand side are now drawn only when the emulator window is in front, and the default IBM labels no 
longer include ASCII options for buttons numbered above 24.

 * Printer port selection has been enabled.

       ___________________________________________________

         4.1.7A                                  9/14/95
       ___________________________________________________
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Enhancements:

 * The "Map Return to Newline" item in the "Control Ascii Emulator" dialog has been replaced by two items are used to set the 
mapping, "Return key sends [] CR followed by [] LF".  If "Map Return to Newline" was true, it's taken to mean that return -> CR 
LF.

Bug fixes:

 * MacTCP Read calls now rely on asynchronous completion routines rather than the MacTCP Notification routine.  This enhances 
performance by replacing the kluge used in 4.1.6A for OT compatibility of occasionally performing a Read (which required 1 second 
to complete when no data was available) to catch the cases where the Notification routine failed to report data arrival 
correctly.
 
 * The selection scrolls properly now when the top of the buffer scrolls beyond the maximum scrollback buffer limit.  When a copy 
is attempted the selection range is tested for being out of range and an error is reported if it is.

 * Undo resizes the scroll bars correctly.

 * The ASCII emulator drawing routines sometimes left lines blank which should have been drawn if the line was inverted and the 
line before it had blanks at the end. 

 * VT100 character deletion now shifts the on-screen image a double rather than single width when characters are double-wide.

 * The VT100 PF4 key now works correctly (it was sometimes mapped to the cursor right key).

 * Command-key combinations which don't match menu items are now ignored.

 * To prevent confusion and possible mangling of macros, the key macro dialog item "Use Command Font" is disabled while a macro 
is being edited.

 * The Single-click macro is now interpreted if one has been set.

 * Labels for the macro buttons are now updated correctly and saved when the titles are changed.

 * The documentation on Macros was incomplete in 4.1.6A; it has now been updated to include more information.

       ___________________________________________________

         4.1.6A                                  8/31/95
       ___________________________________________________

Bug fixes:

 * Control Global items have been added to control MacTCP status calls and optimization of the MacTCP resend timers.  

 * dataComet 4.1.6A now works with OT.  MacTCP (especially when emulated by OT) intermittently fails to notify applications that 
data is available.  dataComet used to use MacTCP status calls to check this; it now works around this problem by occasionally 
performing a Read without notification.  (You can tell when this is happening because of a lag in typing input...)   

 * Old Comet documents which did not contain a Print Layout resource sometimes crashed when opened.

 * The notification window for sessions which have the status bar disabled is now retained between calls to ensure that it will 
be there if memory is low.  This could cause a crash.

 * The labels displayed by the "?" control are now aligned properly.
 
       ___________________________________________________

         4.1.5A                                  8/13/95
       ___________________________________________________

Enhancements:

 * "Option-Resize Window" now resizes the emulator screen and negotiates a Window Size (NAWS) Telnet option with Telnet hosts.

 * Pasting a sound resource ('snd ') into a dataComet window sets the window's beep to the sound and saves the resource 
automatically.

Bug fixes:

 * The "Control Emulator" item "Answerback" now sets the Answerback message for ASCII emulators.

 * Button macros are now always posted to the correct session when they are executed.
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 * When text windows are saved, the changed flag is set so that the user is not prompted unnecessarily when quitting dataComet.

 * The "!W>windowname\000" macro now works more reliably.  Text windows now discard macro keys which can't be sent out on a 
connection, so connectionless text windows won't fail to post macros after a macro containing characters for a connection is 
executed.  (This makes text windows more useful for running macros.)

 * Font sizes equal to zero are presumed to need a 9-pt font.  (Some helper applications produced NCSA documents which passed on 
an invalid font size to dataComet-NCSA.)

 * Windows have a minimum window size enforced so that scrollbars and old Comet documents with bad window sizes will display 
correctly.

       ___________________________________________________

         4.1.4A                                   8/9/95
       ___________________________________________________

Enhancements:

 * Support for GURL AppleEvents has been added.

 * The buttons at the top and left of the screen can now be associated with macros by holding down the Option key while clicking 
on them.

Bug fixes:

 * The screen erase and scroll rectangle is now set correctly when a session is opened with a font size other than 9 pt.  This 
caused seriously muddled screens!

 * Menus are now set correctly for the document which is frontmost.  Sometimes the menus were set up for a text document rather 
than a session document and vice-versa.

 * dataComet no longer registers an NBP name on AppleTalk network.

 * When a text documents which is already open is opened again, the document is brought to the front rather than being opened 
again.

 * Text document window positions are now saved correctly.

 * Open Transport 1.0.5b4 reports an overlarge maximum segment size on Ethernet which caused dataComet to fail when creating a 
session.  Sessions will now open even though the segment size is reported incorrectly.

 * When new documents are closed, the user is prompted to save them.

       ___________________________________________________

         4.1.3A                                  7/26/95
       ___________________________________________________

Bug fixes:

 * The "Add page numbers at bottom of page" and "Add line feed after carriage return" were switched in the "Control Printing" 
dialog.

 * When windows are closed, the corresponding Window menu entry is disabled.  Selecting a closed but not-disabled window caused 
crashes.

 * When "Show status bar at the top of the window" is disabled, the labels associated with the Macro status rectangle are no 
longer displayed.  This caused crashes if the window was closed with the go-away box.

 * The Telnet Send menu item "Break" now sends a Telnet Break rather than a Telnet Interrupt Process.
 
 * The cursor now blinks in text-only windows.

       ___________________________________________________

         4.1.2A                                  7/21/95
       ___________________________________________________

Enhancements:

 * Text windows.  Using "New..." or "Open..." with the Shift key held down opens a document as a connectionless text-only 
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document.  This is a TextEdit document which has a 32K size limit.

 * GUI improvements.  The Control Controls... dialog allows the user to configure the dataComet emulator window controls to suit 
individual preferences.  The "About dataComet" menu brings up a text window containing the text.  Documentation is contained in 
separate text files rather than within the application.

 * Selectable Fonts.  You can now select fonts other than the dataComet fonts.  ASCII emulators support the display of 
proportional fonts as well as fixed point fonts.

 * PC-ANSI support with 8 colors.

 * VT100 support now includes Print Streaming and the display of blinking and double-width and double-height characters.  The 
dataComet fonts are automatically switched in for the display of characters > 127 when a different font is in use; this can be 
disabled in the Control Emulator dialog.  Scrolling through the scrollback buffer is now much faster than it was in Comet.

 * If the Control Global dialog item "Enable Fast Drawing" is enabled and a session with the correct font/size is launched with 
Color mapping off, dataComet changes the Monitor mode to black-and-white automatically.

 * The Control "Printing..." dialog allows the use of non-QuickDraw serial printers which are connected to the Printer Port.  
Sessions can be configured to print all text off the top of the page automatically. 
 
 * Enhanced text commands.  "Undo" is now supported in edit windows, and the Edit menu "Selection" submenu offers commands for 
cursor motion, bracket matching, and text quoting.

 * Macros:  "Record actions for macro" now has a delay built in so that the user no longer has to type slowly for the recording 
algorithm to work well.  The "Define key macro..." dialog now offers "Ignore Caps Lock" (so that the Caps Lock key is ignored 
when matching key macros) and "Use Command Font" (so that the user can use the whole emulator font rather than the special 
command font which reinterprets ASCII characters > 127 and uses them as command buttons).  "Dump key macros" now formats the 
macros in a nicer fashion.  

 * The "Control Emulator" dialog for the 3270 now offers a new paste option which puts the pasted text into the same starting 
position as the first line pasted.

 * The "Control Session" dialog now allows you to set the Tab Threshold which is used when copying and the Edit menu item "Table 
mode for Copy and Save" is enabled.

Bug fixes:

 * The 3270 now handles an EUA command correctly in all cases; this could cause fields not to be erased correctly if the previous 
field was protected.

 * Failed MacTCP close calls no longer cause crashes.

 * MacTCP receive buffers are now allocated to be (4 * MTU + 1K) with a 16K minimum so that dataComet performs better.

 * dataComet works on the Macintosh 9500 under Open Transport.  For some reason OT failed when dataComet allocated large send 
buffers.

_____________________________________________________________________________
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            A2. dataComet keyboard

________________________________________________________________

      dataComet documentation.  (Rev. 1/27/08) 
      Copyright 1995 databeast, Inc. All Rights Reserved.

       ___________________________________________________

          About the "dataComet Keyboard.rsrc" file
       ___________________________________________________

   If you're using OS X 10.2 or later, you can install the "dataComet 
Keyboard.rsrc" file in order to ease use of EMACS or dataComet key macros; 
this helps by allowing you to disable Option-key remapping (which is used by 
defalt to allow you to enter characters from extended character sets).

   To install the "dataComet Keyboard.rsrc" file, first drag and drop the 
file from the dataComet "Extras" distribution folder into either your user 
account "Library/Keyboard Layouts/" folder or the system's "/Library/Keyboard 
Layouts/" folder.

   After installing the keyboard resource and rebooting, you need to select 
the "dataComet Keyboard" keyboard layout in the "Input Menu" pane of the 
"System Preferences..." "International" Preferences panel (which appears in 
the "Personal" row of the Preferences panel).   Checking the "dataComet 
Keyboard" item in the list will cause "dataComet Keyboard" to appear as an 
option in menu bar's Input Menu.

   If you then select the "VT100" Preferences panel option "Option is Meta 
Key" for a given session, dataComet will automatically switch in the 
"dataComet Keyboard" when that session is frontmost.  
You can also select "dataComet Keyboard" manually from the "Input" menu.

   When you select "dataComet Keyboard", the option key will now have no 
"dead keys" defined, so that a single keystroke will immediately produce a 
character all character keys, rather than waiting for the next keystroke for 
some of the keys (e.g., in the US keymapping, E, I, N, and U, which produce 
accents, carets, and umlauts applied to the next character entered).

________________________________________________________________
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            A3. Public Terminal Kiosk Configuration

________________________________________________________________

      dataComet documentation.  (Rev. 1/27/08) 
      Copyright 1995 databeast, Inc. All Rights Reserved.

   dataComet offers features which help provide more secure and user-proof 
public access terminals.  Many organizations offer public access to their 
records (such as card catalogs) and other databases and services on the 
Internet only through time-sharing systems to ensure that the public access 
workstations are not compromised by user modifications to the workstation's 
environment, or used in inappropriate ways.  

   You can configure dataComet with some functions disabled for kiosk use to 
enhance security, e.g., disabling the ability to run a local Shell session 
(while allowing use of Telnet or SSH to connect to other systems).
   
   To do this, use the "Macro" menu item "Set Launch macro..." to set a macro 
to execute at the time that dataComet is launched.  Holding down the Shift 
key while pressing the "Set" (or "Delete") button in the dialog will write 
the macro to an internal application resource file as well as the user-level 
"Comet Default" document (stored in the user's "~/Preferences/dataComet 
Preferences" folder).

   NOTE WELL:  Make sure that the file permissions on the dataComet 
application bundle are set so that only the owner has write permission... 
otherwise the user will be able to modify the Launch macro, and re-enable the 
functions you wish disabled.

   For the sake of example, to disable the ability for users to open a new 
shell in dataComet, paste

!\028\195

into the "Set launch macro..." dialog edit field, and hold down the Shift key 
while pressing the "Set" button.  (The "!\028\195" macro disables the "File -
> New -> Shell" menu and disables the option in the "Configure Terminal 
Session" dialog.)

   Note that if you press "Delete" without holding down the Shift key, the 
user-level Launch macro will be deleted, without deleting the application-
level Launch macro; if you bring up the dialog again, the application-level 
Launch macro will NOT be displayed.  The user can enter a different user-
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level macro which WILL be displayed in the dialog, which will be executed 
AFTER the application-level macro, so that no restricted commands may be 
executed.  This allows users to configure useful Launch macros, e.g., 
automatically opening a set of user session documents, while retaining 
security.

   Disabling macro functions:  special macro commands are provided 
specifically for the function of disabling specific macro cabilities:  "!--" 
will disable all macro commands entered up to the end of the Launch macro or 
the next "!--" macro; "!-\nnn" or "!-<classCharacter>" will disable the 
functions associated with a macro class.  See "4. Macros" for more 
information on macros, and "4.1. macrocodes.h" for a complete list of 
functions available.

   Here's a detailed example of disabling different menu items on launch, 
using the "Macro" menu item "Set Launch macro..." to set a macro to execute 
at the time that dataComet is launched.  (Please note that this macro cannot 
execute some macro commands, e.g., File "New", since it is executed very 
early in dataComet's configuration process).  Here is an example macro, set 
within quotation marks:

"!\001\193!\001\194!\001\195!\001\196!\001\197!\001\198!\001\199!\001\200!
\001\201!\001\202!\001\203!\001\204!\001\205!\001\206!\001\207!\001\208!
\001\214!\002\202!\013\207!\003\193!\003\194!\003\195!\003\196!\003\197!
\003\198!\003\199!\005\193!\005\194!\005\195!\005\196!\005\197!\005\198!
\005\199!\005\200!\005\201!\005\202!\005\203!\005\204!\005\205!\005\206!
\006\194!\006\195!\006\196!\006\197"

   You can execute this macro (likewise the ones below) by selecting the text 
inside the quotes and pressing "Shift-Enter".  

   You need to copy the macro (again, not including the quotation marks) and 
paste it into the "Set Launch macro..." dialog to set the launch macro 
permanently.  When you press OK, the macro will be saved in the "Comet 
Default" document in the System Folder.

   The macro executes a number of actions which ensure that the user can no 
longer save data on the Macintosh disk or modify the configuration of 
dataComet:
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     a) Disable all File menu items except for those related to printing.

         !\001\193
         !\001\194
         !\001\195
         !\001\196
         !\001\197
         !\001\198
         !\001\199
         !\001\200
         !\001\201
         !\001\202
         !\001\203
         !\001\204
         !\001\205
         !\001\206
         !\001\207
         !\001\208
         !\001\214

      b) Disable the "Edit" menu "Append file to .edit window..." 
         item to prevent users from opening random files.

         !\002\202

      c) Disable the "Edit -> Selection" menu "Execute macro" 
         item to prevent users from executing macros in an edit  
         window.

         !\013\207

      d) Disable the Window menu items "Reopen",  "Close", "Abort",  
         & "Reconfigure...".

         !\003\193
         !\003\194
         !\003\195
         !\003\196
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      e) Disable Macro menu items except for user items.

         !\005\193
         !\005\194
         !\005\195
         !\005\196
         !\005\197
         !\005\198
         !\005\199
         !\005\200
         !\005\201
         !\005\202
         !\005\203
         !\005\204
         !\005\205

      f) Disable Telnet menu items.

         !\006\194
         !\006\195
         !\006\196
         !\006\197

   You can allow users to open sessions with a restricted set of hosts by 
configuring documents for the sessions and including them in the dataComet 
"Documents" folder, even though the "Open..." dialog has been disabled.

   To easily get macro lists of items you want to disable, select the Macro 
menu item "Record actions for macro" and select the menu items while pressing 
"Shift-Option" with the "Caps Lock" key down.  When you're finished selecting 
menu commands you wish to disable, select "Record end--ready to Paste".  You 
can then paste the recorded disable-menu commands into an edit window for 
testing, or directly into the "Set Launch macro..." dialog.

________________________________________________________________
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            A4. Internationalizing dC

________________________________________________________________

      dataComet documentation.  (Rev. 1/27/08) 
      Copyright 1995 databeast, Inc. All Rights Reserved.

      __________________________________________________________________

   To translate dataComet into a language other than English, you need to use 
a tool such as ResEdit to modify string resources embedded in dataComet's 
"resource fork".  If a document containing modified versions of these 
resources is placed in the dataComet "Fonts" folder, the modified versions 
will automatically replace the default English version.

   __________________________________________________________________

    Resource                  Function
      Type      
   __________________________________________________________________

      CNTL      Names of the buttons that appear in the button bar.

      DLOG      You can rearrange the items to fit the new text, as 
                long as the items are not renumbered.

      DITL      Dialog text is contained in the 'DITL' resources.  

                The name of each item should be duplicated exactly in the 
                documentation so that Control-Click command searching will
                work automatically.

      MENU      Menu items.

                The name of each item should be duplicated exactly in the 
                documentation so that Control-Click command searching will
                work automatically.

      STR#      Strings used by dataComet, grouped according to function.
                Empty strings are defined to allow for future expansion
                within a general category, so make sure you translate the
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                ones at the very end!

      TEXT      Some copyright information, which does not have to be 
                translated.

   __________________________________________________________________

   Naturally, the dataComet documentation contained in the "Documents" folder 
should be translated into the target language also for a truly complete 
implementation of a foreign-language version of dataComet.

   __________________________________________________________________

                      String resources (STR#)
   __________________________________________________________________

     128  "General Pascal strings":  Contains some important globals:

           Finder name, names of important documents (e.g., "Comet 
           Default") and folders (e.g., "Fonts"; the "Documents" folder 
           name is an exception, since it is picked up from the menu item 
           title).

     129  "Keycode name table":  for the key macros and the Key Macro 
           dialog; key titles need to correspond to the national keyboard
           key codes being used.

     130  "General strings":  Contains general alert strings.  Note 
           globals:

             String 1, "enablefinder", is the default password for 
                returning from secure kiosk terminal mode;

             ".edit", ".print", etc., control file-suffix actions, e.g.,
                the first identifies a sessions' ".edit" text file, and
                the second triggers automatic printing of downloaded files.

     131  "MacTCP":  Strings specific to MacTCP alerts.

     132  "TFTP":  Strings for the TFTP server.

     134  "VT100 function keys":  Labels for the buttons on the left.
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     135  "IBM function keys":  Labels for the buttons on the left.

     136  "Color dialog strings"

     137  "Terminal responses":  Modify only if you wish to change
           the gruesome details of terminal responses.

     140  "Font names":  You can customize automatic font selection
           by modifying the name pairs; the pairs represent normal/bold
           fonts to be used as the default for IBM 3270, ISO Latin 
           (the primary default), DEC-Multinational, and PC-ANSI 
           emulation when an emulator type is selected.  The correct
           translation is automatically selected.

   __________________________________________________________________

     NOTE:  In translation, always preserve '%d', '%s', and other 
     substrings of the form '%<character>' when they appear in strings:  
     this notation is used by C-language routines called by dataComet 
     to format menu and dialog text.

   __________________________________________________________________

________________________________________________________________
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A5. dataComet "vttest" score

VTTEST Score Sheet - dataComet 4.6

VTTEST VT100/VT102 Compatibility Test Score Sheet

Program and version:  dataComet 4.6      Date:  7 May 99
              Score: 98 + Extra credit:  8 = Final score: 106

Check box if test passed.  Score 1 point per test.
Perfect score = 100 points.  Extra credit at end.

dC         1. Test of cursor movements

 1      1. Text inside frame of E's inside frame of *'s and +'s, 80 columns
 1      2. Text inside frame of E's inside frame of *'s and +'s, 132 columns
 1      3. Cursor-control chars inside ESC sequences
 1      4. Leading 0's in ESC sequences
 
           2. Test of screen features
 
 1      5. Three identical lines of *'s (test of wrap mode)
 1      6. Test of tab setting/resetting
 1      7. 132-column mode, light background
 1      8. 80-column mode, light background
 1      9. 132-column mode, dark background
 1     10. 80-column mode, dark background
 1     11. Soft scroll down
 1     12. Soft scroll up / down
 1     13. Jump scroll down
 1     14. Jump scroll up / down
 1     15. Origin mode test (2 parts)
 
              Graphic Rendition test pattern, dark background
 
 1     16. Normal ("vanilla")
 1     17. Normal underlined distinct from normal
 1     18. Normal blink distinct from all above
 1     19. Normal underline blink distinct from all above
 1     20. Normal reverse ("negative") distinct from all above
 1     21. Normal underline reverse distinct from all above
 1     22. Normal blink reverse distinct from all above
 1     23. Normal underline blink reverse distinct from all above
 1     24. Bold distinct from all above
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 1     25. Bold underlined distinct from all above
 1     26. Bold blink distinct from all above
 1     27. Bold underline blink distinct from all above
 1     28. Bold reverse ("negative") distinct from all above
 1     29. Bold underline reverse distinct from all above
 1     30. Bold blink reverse distinct from all above
 1     31. Bold underline blink reverse distinct from all above
 
              Graphic Rendition test pattern, light background
 
 1     32. Normal ("vanilla")
 1     33. Normal underlined distinct from normal
 1     34. Normal blink distinct from all above
 1     35. Normal underline blink distinct from all above
 1     36. Normal reverse ("negative") distinct from all above
 1     37. Normal underline reverse distinct from all above
 1     38. Normal blink reverse distinct from all above
 1     39. Normal underline blink reverse distinct from all above
 1     40. Bold distinct from all above
 1     41. Bold underlined distinct from all above
 1     42. Bold blink distinct from all above
 1     43. Bold underline blink distinct from all above
 1     44. Bold reverse ("negative") distinct from all above
 1     45. Bold underline reverse distinct from all above
 1     46. Bold blink reverse distinct from all above
 1     47. Bold underline blink reverse distinct from all above
 
              Save/Restore Cursor  
 
 1     48. AAAA's correctly placed
 1     49. Lines correctly rendered (middle of character cell)
 1     50. Diamonds correctly rendered
 
           3. Test of character sets
 
 1     51. UK/National shows Pound Sterling sign in 3rd position
 1     52. US ASCII shows number sign in 3rd position
 1     53. SO/SI works (right columns identical with left columns)
 1     54. True special graphics & line drawing chars, not simulated by ASCII
 
           4. Test of double-sized chars
 
              Test 1 in 80-column mode:
 
 1     55. Left margin correct
 1     56. Width correct
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              Test 2 in 80-column mode:
 
 1     57. Left margin correct
 1     58. Width correct
 
              Test 1 in 132-column mode:
 
 1     59. Left margin correct
 1     60. Width correct
 
              Test 2 in 132-column mode:
 
 1     61. Left margin correct
 1     62. Width correct
 
 1     63. "The mad programmer strikes again" test pattern
 1     64. "Exactly half the box should remain"
 
           5. Test of keyboard
 
 1     65. LEDs.
 1     66. Autorepeat
 1     67. "Press each key" (ability to send each ASCII graphic char)
 1     68. Arrow keys (ANSI/Cursor key mode reset)
 1     69. Arrow keys (ANSI/Cursor key mode set)
 1     70. Arrow keys VT52 mode
 1     71. PF keys numeric mode
 1     72. PF keys application mode
 1     73. PF keys VT52 numeric mode
 1     74. PF keys VT52 application mode
 1     75. Send answerback message from keyboard
 1     76. Ability to send every control character
 
           6. Test of Terminal Reports
 
 1     77. Respond to ENQ with answerback
 1     78. Newline mode set
 1     79. Newline mode reset
 1     80. Device status report 5
 1     81. Device status report 6
 1     82. Device attributes report
 0     83. Request terminal parameters 0
 1     84. Request terminal parameters 1
 
           7. Test of VT52 submode
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 1     85. Centered rectangle
 1     86. Normal character set
 0     87. Graphics character set
 1     88. Identify query
 
           8. VT102 Features
 
 1     89. Insert/delete line, 80 columns
 1     90. Insert (character) mode, 80 columns
 1     91. Delete character, 80 columns
 1     92. Right column staggered by 1 (normal chars), 80 columns
 1     93. Right column staggered by 1 (double-wide chars), 80 columns
 1     94. ANSI insert character, 80 columns
 1     95. Insert/delete line, 132 columns
 1     96. Insert (character) mode, 132 columns
 1     97. Delete character, 132 columns
 1     98. Right column staggered by 1 (normal chars), 132 columns
 1     99. Right column staggered by 1 (double-wide chars), 132 columns
 1    100. ANSI insert character, 132 columns
 
           9. Extra credit
 
 0    101. True soft (smooth) scroll
 1    102. True underline
 1    103. True blink
 1    104. True double-high/wide lines, not simulated
 1    105. Reset terminal (*)
 1    106. Interpret controls (debug mode) (*)
 1    107. Send BREAK (250 msec) (*)
 0    108. Send Long BREAK (1.5 sec) (*)
 1    109. Host-controlled transparent / controller print (*)
 1    110. Host-controlled autoprint (*)
 
          (*) Features of VT100 not tested by vttest.
 
 
------------------------------------------------------------------------
VTTEST Score Sheet / Columbia University / kermit@columbia.edu / 18 Dec 95
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